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1. Introduction

Audience

This reference manual is intended for network administrators and other IT networking professionals
responsible for managing the switch by using the Web User Interface (Web Ul). The Web Ul is the
secondary management interface to the DGS-1510 Series switch, which will be generally be referred
to simply as the 'Switch' within this manual. This manual is written in a way that assumes that you
already have the experience and knowledge of Ethernet and modern networking principles for Local
Area Networks.

Other Documentation

The documents below are a further source of information in regards to configuring and
troubleshooting the switch. All the documents are available either from the CD, bundled with this
switch, or from the D-Link website. Other documents related to this switch are:

o DGS-1510 Series Gigabit Ethernet SmartPro Switch Hardware Installation Guide

o DGS-1510 Series Gigabit Ethernet SmartPro Switch CLI Reference Guide

Conventions

Convention Description

Boldface Font This indicates a button, a toolbar icon, menu, or menu item. For
example, Open the File menu and choose Cancel. Used for
emphasis. This may also indicate system messages or prompts
appearing on screen. For example, You have mail. Bold font is
also used to represent filenames, program names, and commands.
For example, use the copy command.

Initial capital letter This indicates a window name. Names of keys on the keyboard
have initial capitals. For example, click Enter.

Menu Name > Menu Option | This indicates the menu structure. Device > Port > Port
Properties means the Port Properties menu option under the Port
menu option that is located under the Device menu.

Notes, Notices, and Cautions

Below are examples of the three types of indicators used in this manual. When administering your
switch using the information in this document, you should pay special attention to these indicators.
Each example below provides an explanatory remark regarding each type of indicator.

v NOTE: A note indicates important information that helps you make better use of your
device.

ﬂ%’ NOTICE: A notice indicates either potential damage to hardware or loss of data and
tells you how to avoid the problem.

i'i CAUTION: A caution indicates a potential for property damage, personal injury, or
- death.
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2. Web-based Switch Configuration

Management Options
Connecting using the Web
Logging onto the Web
Smart Wizard

Web User Interface (Web Ul)

Management Options

The Switch provides multiple access platforms that can be used to configure, manage and monitor
networking features available on the Switch. Currently there are three management platforms
available and they are described below.

Web User Interface (Web Ul)

The Switch can be managed through any of the RJ4/SFP/SFP+ ports on the front panel of the Switch
by means of an HTTP/HTTPS connection using a Web browser like Microsoft® Internet Explorer,
Mozilla Firefox, Safari, or Google Chrome.

Command Line Interface (CLI)

The Switch can be managed, Out-Of-Band (OOB), through the RJ45 Console port on the front panel
of the Switch. Alternatively, the Switch can also be managed, in-band, through any of the
RJ4/SFP/SFP+ ports on the front panel of the Switch by means of a Telnet connection. The command
line interface provides complete access to all switch management features.

SNMP-based Management

The Switch can be managed with an SNMP-compatible console program. The Switch supports
SNMPv1, SNMPv2c, and SNMPv3. The SNMP agent decodes the incoming SNMP messages and
responds to requests with MIB objects stored in the database. The SNMP agent updates the MIB
objects to generate statistics and counters.

Connecting using the Web Ul

Most software functions of the DGS-1510 Series switches can be managed, configured, and
monitored through the Web Ul. Manage the Switch from remote stations anywhere on the network
through a standard web browser. The web browser acts as a universal access tool and can
communicate directly with the Switch using the HTTP or HTTPS protocol.

L 2 NOTE: The Command Line Interface (CLI) provides the functionality of managing,
configuring, and monitoring all of the software features that are available on the
“ Switch.
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Logging onto the Web Ul

To access the Web Ul, simply open a standard web browser on the management PC, and enter the
Switch’s default IP address into the address bar of the browser and press the Enter key.

& NOTE: The default IP address of this switch is 10.90.90.90, with a subnet mask of
255.0.0.0.

= http:,.-’_a'll:l.gﬂ.gﬂ.gﬂ_.-'I (=2 10.90.90.90

Figure 2-1 IP address in Internet Explorer

& NOTE: By default, one user account is already configured on the Switch. Both the
username and password for this account is admin.

4 NOTE: After upgrading the firmware on the Switch and no user accounts were created,
the default admin user account will automatically be created after rebooting the
“ Switch with the new boot-up configuration file.

2 NOTE: After upgrading the firmware on the Switch and user accounts were created, the
default admin user account will not be created automatically. Only after a
“ factory reset was performed on the Switch will the default admin user account
be created.

This will open the user authentication window, as seen below.

Connect to 10.90.90.90

e
IR
User Name R |
= voses |
Language |English [v|
| Login | | Reset |

Figure 2-2 User Authentication Window

Enter the User Name and Password in the corresponding fields and click Login. This will open the
Web Ul. Management features available in the Web Ul of the Switch are explained below.
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Smart Wizard

After successfully connecting to the Web Ul for the first time, the Smart Wizard embedded Web utility
will be launched. This wizard will guide the user through basic configuration steps that is essential for
first time connection to the Switch.

Step 1 - Web Mode

The Switch supports two Web Modes: Standard Mode and Surveillance Mode. The Standard Mode
is used to configure, manage, and monitor most of the software features on the Switch. The
Surveillance Mode is an additional web mode specifically designed to assist the user with surveillance
features supported by the Switch.

'//\ NOTE: The Web Mode can only be changed when one user session is connected to

the Web Ul of the Switch.

&

Welcome to Smart Wizard

The wizard will guide you to do basic configurations on 4 steps for the Web Mode, IP Information,
User Account and SNMP. If you are not changing the settings, click on "Exit” to go back to the
main page.

Step 1 of 4: Choose the web interface mode.

Figure 2-3 Web Mode

The fields that can be configured are described below:

Parameter Description

Standard Mode Select this option to access the Standard Mode after the Smart
Wizard was completed.

Surveillance Mode Select this option to access the Surveillance Mode after the Smart
Wizard was completed.

Tick the Ignore the wizard next time option to skip the Smart Wizard on the next login.
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Click the Exit button to discard the changes made, exit the Smart Wizard, and continue to the Web
ul.

Click the Next button to accept the changes made and continue to the next step.

Step 2 - System IP Information

In this step, we can configure System IP Information.

'// NOTE: The Switch will probe for surveillance devices every 30 seconds. If a
surveillance device is not in the same subnet as the switch, it will not be
discovered automatically. Place the Switch management IP in the same subnet
as the surveillance devices for ONVIF cameras to be added to the Surveillance
Mode Web Ul automatically.

Welcome to Smart Wizard

Step 2 of 4: The wizard will help to complete settings for System IP address, Netmask, and
Gateway.

10

.90 . 90 . 40
8 (255.0.0.0)
.0 .0 .0

Figure 2-4 System IP Information

The fields that can be configured are described below:

Parameter Description

Static Select this option to manually assign and configure the IP address
settings for the Switch.

DHCP Select this option to obtain IP address settings automatically from a
DHCP server for the Switch.

IP Address After selecting the Static option, manually enter the IP address of
the Switch here.

Netmask After selecting the Static option, manually select the Netmask
option here.
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Parameter Description

Gateway After selecting the Static option, manually enter the IP address of
the default gateway here.

Tick the Ignore the wizard next time option to skip the Smart Wizard on the next login.

Click the Exit button to discard the changes made, exit the Smart Wizard, and continue to the Web
ul.

Click the Next button to accept the changes made and continue to the next step.

Step 3 - User Accounts Settings

In this step, we can configure the user account settings. This step can only be modified by a user
account with the privilege level of 15.

Welcome to Smart Wizard

Step 3 of 4: Configure User Account for management.

Figure 2-5 User Account Settings

The fields that can be configured are described below:

Parameter Description

User Name Select the user name of the administrator level account with the
privilege level of 15.

Password Type Select the password type here. Options to choose from are:

¢ None - Specifies that no password will be configured for this
user account.

¢ Plain Text - Specifies that the password for this user
account will be in the plain text form.

e Encrypted-SHA1 - Specifies that the password for this user
account will be in the encrypted form using the SHA1
encryption method.
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Parameter Description

o Encrypted-MDS5 - Specifies that the password for this user
account will be in the encrypted form using the MD5
encryption method.

Password Enter the password for the user account either in the plain text
format or the encrypted format here based on the previous
selection made.

In the encrypted format, the password will not be encrypted from
plain text to the encrypted format. Instead, the encrypted password
must be entered. To encrypt the password from plain text to the
encrypted format, refer to the Password Encryption window.

Tick the Ignore the wizard next time option to skip the Smart Wizard on the next login.

Click the Exit button to discard the changes made, exit the Smart Wizard, and continue to the Web
Ul

Click the Back button to discard the changes made and return to the previous step.

Click the Apply button to accept the changes made and continue to the Web UI.

Step 4 - SNMP Settings

In this step, we can enable or disable the SNMP feature.

Welcome to Smart Wizard

Step 4 of 4: Enable SNMF for management.

Apply 8 Save

Figure 2-6 SNMP Window

The fields that can be configured are described below:

Parameter Description

SNMP Select the Enabled option to enable the SNMP feature. Select the
Disabled option to disable the SNMP feature.

Tick the Ignore the wizard next time option to skip the Smart Wizard on the next login.

7
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Click the Exit button to discard the changes made, exit the Smart Wizard, and continue to the Web
Ul

Click the Back button to discard the changes made and return to the previous step.

Click the Apply & Save button to accept the changes made and continue to the Web UlI.
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Web User Interface (Web Ul)

Areas of the User Interface

The Web Ul on the Switch can be divided into distinct Areas. Different areas in the Web Ul provide
different manageability options to simplify configuration and feature monitoring.

Standard Mode
After accessing the Web Ul in the Standard Mode, the following will be displayed:

Stack ID

- - orven onsol i s il e — - .| 1 v
-Link e z o =

Refresh Interval

an ®
o t
Building Networks for Peaple il - - g g | - by iy ph i

Device Information
[ system .
8 Management Device Type DGS-1510-28XMP Gigabit Ethernet . MAC Address 3C-1E-04-A1-BS-E0
8 L2 Features System Name Switch IP Address 10.90.80.80
@ L3 Features System Location Mask 255.000
@ Qos System Contact Gateway 0.0.00
@ AcL Boot PROM Version Build 1.00.016 System Time 01/01/2000 00:03:51
5 securty Firmware Version Build 1.70.004 Serial Number RZNV1F1000011
= 0am Hardware Version At
[ Monitoring
& Green Utilization
(EhL - Used
Flash Memery

Average: 18| % 107 %

Figure 2-7 Web Ul (Standard Mode)

The following Areas can be observed in the above window.

Area Number Description

AREA 1 In this area, a graphical near real-time image of the front panel of
the Switch is displayed with ports and expansion modules. Port
activity is displayed, depending on the specified mode. Some
management functions like port monitoring are also accessible
here.

Click the D-Link logo to go to the D-Link website.

AREA 2 In this area is a toolbar used to access functions like Save, Tools,
the Wizard, Online Help, accessing the Web Ul in the
Surveillance Mode, customized Language preference, and a
Logout option.

Click the Surveillance Mode option to change the switch mode
from Standard Mode to Surveillance Mode.

The user account and IP address currently logged into the Web Ul
will also be displayed in this toolbar.

AREA 3 In this area, the software features available in the Web Ul of the
Switch are grouped into folders containing hyperlinks that will open
window frames in area 4.
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Area Number Description

There is also a search option in this area that can be used to
search for specific feature keywords in the Web Ul to easily find the
link to the set of features.

AREA 4 In this area, configuration and monitoring window frames are
available based on the selections made in area 3.

Surveillance Mode

After accessing the Web Ul in the Surveillance Mode, the following will be displayed:

Survelllance Mode

T English  [V] m 4 Logged in as: Administrator, . =] Logout

‘ Surveillance Overview

DGs151I12&P Surveillance Topology | Device Information

= Port Information

= IP-Camera Information

= 2 .

# NVR Information 5 T Dk v .

unit [1 ~ g.p @ Rl u e

= PoE Information ] Camera X 3 e X O nr X 1 A X O ‘*’ X 1

7 PoE Scheduling
[ Management
& Tims

=if _ i

2 Surveillance Settings . . (O

] Surveillance Log @

=] Health Diagnostic - -

o]
LI
I —

AREA 2 DLink
OOl OO e @lgi L N N N
\

3 =

Note: System probes IP-Camera every 305

Figure 2-8 Web Ul (Surveillance Mode)

The following Areas can be observed in the above window.

Area Number Description

AREA 1 In this area is a toolbar used to access functions like the Wizard,
Tools, Save, Help, Online Help, accessing the Web Ul in the
Standard Mode, customized Language preference, and a Logout
option.

Click the Standard Mode option to change the switch mode from
Surveillance Mode to Standard Mode.

The user account and IP address currently logged into the Web Ul
will also be displayed in this toolbar.

AREA 2 In this area, the software features available in the Web Ul of the
Switch are grouped into folders containing hyperlinks that will open
window frames in area 3.

There is also a search option in this area that can be used to
search for specific feature keywords in the Web Ul to find the link to
the set of features.
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Area Number Description

AREA 3 In this area, configuration and monitoring window frames are
available based on the selections made in Area 2.
The status of devices, IP cameras, and NVRs discovered on the
switch will also be displayed in this area.

A NOTE: For more information about the Surveillance Mode, refer to Surveillance Mode
on page 391.
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3. System

Device Information

System Information Settings
Peripheral Settings

Port Configuration

Interface Description

PoE

System Log

Time and SNTP

Time Range

Device Information

In this window, the Device Information, CPU, and Used status are displayed. It appears automatically
when you log in the Switch. To return to the Device Information window after viewing other windows,
click the DGS-1510-28XMP link.

Uevice Information

Device Information
Device Type DGS-1510-28XMP Gigabit Ethernet .. MAC Address 3C-1E-04-A1-B9-ED
System Name Switch IP Address 10.90.90.90
System Location Mask 255000
System Contact Gateway 0.0.0.0
Boot PROM Version Build 1.00.016 System Time 01/01/2000 00:22:56
Firmware Version Build 1.70.005 Serial Number RZNV1F1000011
Hardware Version Al
Utilization
Gl - Used
Flash Memory
1 9967KE 138077KB
20
Ul
Average: 100 % 100 %
67 28

Figure 3-1 Device Information Window

System Information Settings

The user can enter a System Name, System Location, and System Contact to aid in defining the
Switch.

To view the following window, click System > System Information Settings, as shown below:

System Information Settings

System Name [Switch |
System Location [255 chars |
System Contact [255 chars |

Figure 3-2 System Information Settings Window
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The fields that can be configured are described below:

Parameter Description

System Name Enter a system name for the Switch, if so desired. This name will
identify it in the Switch network.

System Location Enter the location of the Switch, if so desired. This string can be up
to 255 characters long.

System Contact Enter a contact name for the Switch, if so desired. This string can
be up to 255 characters long.

Click the Apply button to accept the changes made.

Peripheral Settings

This window is used to configure the environment trap settings and environment temperature
threshold settings.

To view the following window, click System > Peripheral Settings, as shown below:

Eripheral »>e 1(]

Environment Trap Settings

Fan Trap (CEnabled  (@Disabled

Power Trap (_Enabled (e)Disabled

Temperature Trap (Enabled  (eDisabled
Environment Temperature Threshold Settings

Unit 1 (v

Thermal 1 v

High Threshold (-100-200) ¥ Default

Low Threshold {-100-200) ] Default

Figure 3-3 Peripheral Settings Window

The fields that can be configured are described below:

Parameter Description

Fan Trap Click to enable or disable the fan trap state for waning fan event
(fan failed or fan recover).

Power Trap Click to enable or disable the power trap state for waning power
event (power failed or power recover).

Temperature Trap Click to enable or disable the temperature trap state for waning
temperature event (temperature exceeds the thresholds or
temperature recover).

Unit Select the switch unit that will be used for this configuration here.
Thermal Select the thermal sensor ID.
High Threshold Enter the high threshold value of the warning temperature setting.

The range is from -100 to 200 degree Celsius.
Tick the Default check box to return to the default value.

Low Threshold Enter the low threshold value of the warning temperature setting.
The range is from -100 to 200 degree Celsius.

Tick the Default check box to return to the default value.

Click the Apply button to accept the changes made.
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Port Configuration

Port Settings

This window is used to view and configure the Switch’s port settings.

To view the following window, click System > Port Configuration > Port Settings, as shown below:

Port Settings

Port Settings

Unit From Port To Port State MDIX Auto Downgrade Flow Control

[1 [v] [ethtort [~] [ethtort [~] [Enabled  [v] [Auto [v] [Disabled [v] [oOff >

Duplex Speed Capability Adverfised Description

[Auto [v] [Auto [~ ] 10M [¥ 100M [ 1000M [p4 chars | O

Unit 1 Settings

Speed Description
m oo

eth1/0M1 Enabled Auto-MDIX Auto-duplex Auto-speed Disabled
eth1/0/2 Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled
eth1/0/3 Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled
eth1/0/4 Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled
eth1/0/5 Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled
eth1/0/6 Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled
eth1/0/7 Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled
eth1/0/8 Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled
eth1/0/9 Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled
eth1/0M10 Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled
eth1/0/11 Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled
eth1/0/12 Down Enabled Auto-MDIX off Ooff Auto-duplex Auto-speed Disabled
eth1/0M13 Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled
eth1/0/14 Down Enabled Auto-MDIX off Ooff Auto-duplex Auto-speed Disabled
eth1/0M15 Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled
eth1/0M16 Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled
eth1/0M7 Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled
eth1/0M138 Down Enabled Auto-MDIX Off off Auto-duplex Auto-speed Disabled
eth1/0M19% Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled
eth1/0/20 Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled
eth1/0/21 Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled
eth1/0/22 Down Enabled Auto-MDIX Off Off Auto-duplex Auto-speed Disabled

Figure 3-4 Port Settings Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
State Select this option to enable or disable the physical port here.

MDIX Select the Medium Dependent Interface Crossover (MDIX) option

here. Options to choose from are:

e Auto - Select this option for auto-sensing of the optimal type
of cabling.

¢ Normal - Select this option for normal cabling. If this option
is selected, the port is in the MDIX mode and can be
connected to a PC’s NIC using a straight-through cable or a
port (in the MDIX mode) on another switch through a
crossover cable.

e Cross - Select this option for cross cabling. If this option is
selected, the port is in the MDI mode and can be connected

14
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Parameter Description

to a port (in the MDIX mode) on another switch through a
straight cable.

Auto Downgrade Select this option to enable or disable automatically downgrading
advertised speed in case a link cannot be established at the
available speed.

Flow Control Select to turn flow control On or Off here. Ports configured for full-
duplex use 802.3x flow control, half-duplex ports use backpressure
flow control, and Auto ports use an automatic selection of the two.

Duplex Select the duplex mode used here. Options to choose from are
Auto, Half, and Full.

Speed Select the port speed option here. This option will manually force
the connection on the selected port to connect at the speed
specified here. Options to choose from are Auto, 10M, 100M,
1000M, 1000M Master, 1000M Slave, and 10G. The Switch allows
users to configure two types of gigabit connections; 1000M Master
and 1000M Slave, which refer to connections running a
1000BASE-T cable for connection between the Switch port and
another device capable of a gigabit connection. The master setting
(1000M Master) will allow the port to advertise capabilities related
to duplex, speed, and physical layer type. The master setting will
also determine the master and slave relationship between the two
connected physical layers. This relationship is necessary for
establishing the timing control between the two physical layers. The
timing control is set on a master physical layer by a local source.
The slave setting (1000M Slave) uses loop timing, where the timing
comes from a data stream received from the master. If one
connection is set for 1000M Master, the other side of the
connection must be set for 1000M Slave. Any other configuration
will result in a link down status for both ports.

Capability Advertised When the Speed is set to Auto, these capabilities are advertised
during auto-negotiation.

Description Tick the check box to enter a 64 characters description for the
corresponding port here.

Click the Apply button to accept the changes made.
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Port Status

This window is used to view the Switch’s physical port status and settings.

To view the following window, click System > Port Configuration > Port Status, as shown below:

(a

Port Status
Unit 1 [v]
Unit 1 Settings
MAC Address VLAN Speed
s [ oo

eth1/0M1 Connected 3C-1E-04-A1-B9-E1 1 Off Off Auto-Full Auto-100M 1000BASE-T
eth1/0/2 Connected 3C-1E-04-A1-B9-E2 1 o off Auto-Full Auto-100M 1000BASE-T
eth1/0/3 Mot-Connected 3IC-1E-04-A1-B9-E3 1 Off Off Auto Auto 1000BASE-T
eth1/0/4 Not-Connected 3C-1E-04-A1-B9-E4 1 Off Off Auto Auto 1000BASE-T
eth1/0/5 Not-Connected 3C-1E-04-A1-B9-E5 1 Off Off Auto Auto 1000BASE-T
eth1/0/6 Mot-Connected 3C-1E-04-A1-B3-E6 1 Off Off Auto Auto 1000BASE-T
eth1/0/7 Not-Connected 3C-1E-04-A1-B9-E7 1 Off Off Auto Auto 1000BASE-T
eth1/0/8 Not-Connected 3C-1E-04-A1-B9-E8 1 Off Off Auto Auto 1000BASE-T
eth1/0/9 Not-Connected 3C-1E-04-A1-B9-E9 1 Off Off Auto Auto 1000BASE-T
eth1/0/10 Not-Connected JC-1E-04-A1-BS-EA 1 o Off Auto Auto 1000BASE-T

Figure 3-5 Port Status Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

Port GBIC

This window is used to view active GBIC information found on each applicable physical port of this
Switch.

To view the following window, click System > Port Configuration > Port GBIC, as shown below:

Port GBIC

Unit 1 ﬂ

Unit 1 Settings

Interface Type 1000BASE-T
eth1/0/2
Interface Type 1000BASE-T

Interface Type 1000BASE-T

Interface Type 1000BASE-T

Interface Type 1000BASE-T
eth1/0/6
Interface Type 1000BASE-T
eth1/0/7
Interface Type 1000BASE-T

Figure 3-6 Port GBIC Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

16




DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

Port Auto Negotiation

This window is used to view detailed port auto-negotiation information.

To view the following window, click System > Port Configuration > Port Auto Negotiation, as
shown below:

Fort Auto Negouation .
Port Auto Negotiation
Unit 1 [v]
Mote: AN: Auto Negotiation; RS: Remote Signaling; CS: Config Status; CB: Capability Bits;CAB: Capability Advertised Bits;
CRB: Capability Received Bits; RFA- Remote Fault Advertised; RFR: Remote Fault Received
Unit 1 Settings
eth1/0/1 Enabled Complete 10M_Half, . 10M_Half, ... 10M_Half, .
eth1/0/2 Enabled = Complete 10M_Half, .. 10M_Half, ..  10M_Half, ... - B
eth1/0/3 Enabled = Configuring 10M_Half, .. 10M_Half, ... = = =
eth1/0/4 Enabled = Configuring 10M_Half, .. 10M_Half, ... - - B
eth1/0/5 Enabled - Configuring 10M_Half, ... 10M_Half, ... - - -
eth1/0/6 Enabled - Configuring 10M_Half, .. 10M_Half, ... - - -
eth1/0/7 Enabled - Configuring 10M_Half, .. 10M_Half, ... - - -
eth1/0/8 Enabled = Configuring 10M_Half, .. 10M_Half, ... = = =
eth1/0/9 Enabled = Configuring 10M_Half, .. 10M_Half, ... = = =
eth1/0/10 Enabled = Configuring 10M_Half, .. 10M_Half, ... - - B

Figure 3-7 Port Auto Negotiation Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

Error Disable Settings

This window is used to configure the sending of SNMP noatifications for error disable state.

To view the following window, click System > Port Configuration > Error Disable Settings, as
shown below:

Error Disable Trap Settings
Asserted Disabled ﬂ
Cleared Disabled [v]
Error Disable Recovery Settings
ErrDizable Cause All ﬂ State Dizabled ﬂ Interval (5-86400) l:l sec
Ercatecoe e e |
Port Security Disabled 300
Storm Control Disabled 300
EPDU Aftac... Disabled 300
Dynamic AR.. Disabled 300
DHCP Snooping Disabled 300
Loopback Detect Disabled 300
Interfaces that will be recovered at the next timeout:
Erosae ave tmo e

Figure 3-8 Error Disable Settings Window
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The fields that can be configured for Error Disable Trap Settings are described below:

Parameter Description

Asserted Select this option to enable or disable the notifications when
entering into the error disabled state.

Cleared Select this option to enable or disable the notifications when exiting
from the error disabled state.

Notification Rate Enter the number of traps per minute. The packets that exceed the
rate will be dropped. The value is between 0 and 1000.

Click the Apply button to accept the changes made.

The fields that can be configured for Error Disable Recovery Settings are described below:

Parameter Description

ErrDisable Cause Select the error disable causes here. Options to choose from are
All, Port Security, Storm Control, BPDU Attack Protection,
Dynamic ARP Inspection, DHCP Snooping, and Loopback
Detect.

State Select this option to enable or disable the auto-recovery for an
error port caused by the specified cause.

Interval Enter the time between 5 and 86400 seconds to recover the port.

Click the Apply button to accept the changes made.

Jumbo Frame

This window is used to view and configure the Jumbo Frame size and settings. The Switch supports
jumbo frames. Jumbo frames are Ethernet frames with more than 1518 bytes of payload. The Switch
supports jumbo frames with a maximum frame size of up to 9216 bytes.

To view the following window, click System > Port Configuration > Jumbo Frame, as shown below:

Jumbo Frame
Unit From Port To Port Maximum Receive Frame Size (64-9216)
[eth1/01 [=] [eth10n [=] bytes [ apply
Unit 1 Settings
I O e
eth1/0/1 1536
eth1/0/2 1536
eth1/0/3 1536
eth1/0/4 1536
eth1/0/5 1536
eth1/0/6 1536
eth1/0/7 1536
eth1/0/8 1536
eth1/0/9 1536
eth1/0/10 1536
eth1/0/11 1536
eth1/0/12 1536
eth1/0M13 1536
eth1/0/14 1536
eth1/0/15 1536

Figure 3-9 Jumbo Frame Window
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The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

Maximum Receive Frame Enter the maximum receive frame size value here. This value must

Size be between 64 and 9216 bytes. By default, this value is 1536
bytes.

Click the Apply button to accept the changes made.

Interface Description

This window is used to display the status, administrative status, and description of each port on the
Switch.

To view the following window, click System > Interface Description, as shown below:

[ ace Le DO

Interface Description

Total Entries: 28
eth1/0M1 up enabled
eth1/0/2 up enabled
eth1/0/3 down enabled
eth1/0/4 down enabled
eth1/0/5 down enabled
eth1/0/6 down enabled
eth1/0/7 down enabled
eth1/0/8 down enabled
eth1/0/9 down enabled
eth1/010 down enabled

Bz [Z1F [ [

Figure 3-10 Interface Description Window

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

PoE (PoE Switches Only)

The DGS-1510-28P, DGS-1510-28XMP, and DGS-1510-52XMP switches support Power over
Ethernet (PoE) as defined by the IEEE 802.3af and 802.3at.

& NOTE: The Power over Ethernet (PoE) settings are only available on the DGS-1510-
28P, DGS-1510-28XMP, and DGS-1510-52XMP.

All ports can support PoE up to 30W. Ports 1-24 can supply about 48 VDC power to Powered Devices
(PDs) over Category 5 or Category 3 UTP Ethernet cables. The Switch follows the standard PSE
(Power Sourcing Equipment) pin-out Alternative A, whereby power is sent out over pins 1, 2, 3 and 6.
The Switches work with all D-Link 802.3af capable devices.
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The Switch includes the following PoE features:

o Auto-discovery recognizes the connection of a PD and automatically sends power to it.

e The Auto-disable feature occur under two conditions: firstly, if the total power consumption
exceeds the system power limit; and secondly, if the per port power consumption exceeds the
per port power limit.

e Active circuit protection automatically disables the port if there is a short. Other ports will remain
active.

Based on IEEE 802.3af/at, power is received and supplied according to the following classifications:

Class ‘ Maximum power used by the PD Maximum power supplied by the Switch
0 12.95 Watts 15.4 Watts
1 3.84 Watts 4 Watts
2 6.49 Watts 7 Watts
3 12.95 Watts 15.4 Watts
4 25.5 Watts 30 Watts
PoE System

This window is used to configure the PoE system, and display the detailed power information and PoE
chip parameters for POE modules.

To view the following window, click System > PoE > PoE System, as shown below:

PoE System
Unit Usage Threshold (1-89) Policy Preempt Trap State
TR T Diabiedlv]
Com | oseoan | powrsuarcon s s o s
1 1] 370 99 Disabled Disabled

Figure 3-11 PoE System Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

Usage Threshold Enter the usage threshold to generate a log and send the
corresponding standard notification. The range is from 1 to 99
percent.

Policy Preempt Select to enable or disable the policy preempt function.

When this function is Enabled, under the power shortage condition,
power provisioned to PDs with lower priority will instead be
provisioned to PDs with higher priority.

When this function is Disabled, the power management mode will
use the first in, first serviced method.

Trap State Select this option to enable or disable the sending of PoE
notifications.

Click the Apply button to accept the changes made.

Click the Show Detail button to see the PoE system Parameters table at the bottom of the window.
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After clicking the Show Detail button, the following table will appear.

PoE System Parameters

T s e p e
1 24

E1l1 17

Figure 3-12 PoE System (Show Detail) Window

PoE Status

This window is used to configure the description, and display the PoE status of each port.
One of the following PoE port states will be displayed in the table:

e Disabled

e Searching (remote PD is not connected)

¢ Requesting (remote PD is inserted but no power is provided yet)

o Delivering (remote PD is inserted and power is provided)

o Faulty (maintain power signature absent, PD short, overloading, power denied, thermal
shutdown, startup failure, or classification failure)

To view the following window, click System > PoE > PoE Status, as shown below:

“PoESGRES TR

PoE Status

Unit From Fort To Port Description

[eth1/011 [~] 32 chars |

Unit 1 Settings

I S T 7 S
eth1/0/1 Searching MIA 0.0 0.0 Delete Description
eth1/0/2 Searching NIA 0.0 0.0 Delete Description
eth1/0/3 Searching NIA 0.0 0.0 Delete Description
eth1/0/4 Searching MIA 0.0 00 Delete Description
eth1/0/5 Searching NIA 0.0 0.0 Delete Description
eth1/0/6 Searching NIA 0.0 0.0 Delete Description
eth1/0/7 Searching MIA 0.0 00 Delete Description
eth1/0/8 Searching NIA 0.0 0.0 Delete Description
eth1/0/9 Searching NIA 0.0 0.0 Delete Description
eth1/0/10 Searching MNIA 0.0 0.0 Delete Description

Figure 3-13 PoE Status Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

Description Enter the text that describes the PD connected to a PoE interface.
The maximum length is 32 characters.

Click the Delete Description button to clear the setting in the corresponding Description field.

Click the Apply button to accept the changes made.
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PoE Configuration

This window is used to configure the PoE port.

To view the following window, click System > PoE > PoE Configuration, as shown below:

F'O O guraao

PoE Configuration
Unit From Port To Port Priority Legacy Support Maode Max Wattage (1000-30000) Time Range
[ethtor v ] [ethtiar | [Low v |Disabled v | [ato v| | 7
Soply
Unit 1 Settings
I T T S T S

eth1/0i1 Auto Low Dizabled 5}
eth1/0i2 Auto Low Disabled D
eth1/0/3 Auto Low Disabled | Delete Time Range
eth1/0/4 Auto Low Disabled Delete Time Czan_ég
eth1/0/5 Auto Low Disabled Delete Time Range
eth1/0/6 Auto Low Disabled | Delete Time Range
eth1/0/7 Auto Low Disabled | Delete Time Range
eth1/0/8 Auto Low Disabled D
eth1/0/9 Auto Low Dizabled
eth1/0/10 Auto Low Disabled
eth1/0/11 Auto Low Disabled

Figure 3-14 PoE Configuration Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

Priority Select the priority for provisioning power to the port. Options to
choose from are Critical, High and Low.

Legacy Support Select this option to enable or disable the support of legacy PD.

Mode Select the power management mode for the PoE ports. Options to

choose from are Auto and Never.

Max Wattage When selecting Auto in the Mode drop-down list, this option
appears. Tick the check box and enter the maximum wattage of
power that can be provisioned to the auto-detected PD. If the value
is not entered, the class of the PD automatically determines the
maximum wattage, which can be provisioned. The valid range for
maximum wattage is between 1000 mW and 30000 mW.

Time Range When selecting Auto in the Mode drop-down list, this option
appears. Tick the check box and enter the name of the time range
to determine the activation period.

Click the Delete Time Range button to clear the setting in the corresponding Time Range field.

Click the Apply button to accept the changes made.
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PD Alive

This window is used to configure the PD Alive function for PDs connected to the PoE ports. The ping
function is used to check if PDs, connected to the PoE ports, are active or not. When PDs appear to
be inactive, the specified action (Reset, Notify, or Both) will be taken.

To view the following window, click System > PoE > PD Alive, as shown below:

mﬂlﬂ—,\

PD Alive Configuration

Unit From Port To Port FD Alive State  PD IP Address

[ ~] [eth10i1 [~] [eth1/0/1 [v] [Disabled~] [ - - - ]

Foll Interval (10-300) Retry Count (0-5) Waiting Time (30-300) Action

o e P B |sec [Both [v]

Unit 1 Settings

“ PD Alive State PD IP Address Poll Interval Retry Count Waiting Time
30 90

eth1/0/1 Disabled 0.0.0.0 2 Both
eth1/0/2 Disabled 0.0.0.0 30 2 90 Both
eth1/0/2 Disabled 0.0.0.0 30 2 90 Both
eth1/0/4 Disabled 0.0.0.0 30 2 90 Both
eth1/0/5 Disabled 0.0.0.0 30 2 90 Both
eth1/0/6 Disabled 0.0.0.0 30 2 90 Both
eth1/0/7 Disabled 0.0.0.0 30 2 a0 Both
eth1/0/8 Disabled 0.0.00 30 2 90 Both
eth1/0/9 Disabled 0.0.0.0 30 2 90 Both
eth1/0/10 Disabled 0.0.00 30 2 90 Both

Figure 3-15 PD Alive Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

PD Alive State Select to enable or disable the PD Alive function on the specified
port(s).

PD IP Address Enter the IP address of the PD here.

Poll Interval Enter the poll interval here. This is the interval between ping

messages from the system to PDs connected to the PoE port(s).
The range is from 10 to 300 seconds.

Retry Count Enter the retry count here. This is the amount of ping messages
that will be sent (at each interval) when PDs are not responding.
The range is from 0 to 5.

Waiting Time Enter the waiting time here. This is how long the system will wait
before sending ping messages to the PD connected to the PoE port
after a 'Reset' action was taken. The range is from 30 to 300
seconds.

Action Select the action that will be taken here. Options to choose from
are:

e Reset - Specifies to reset the PoE port state (turn PoE off
and on).

¢ Notify - Specifies to send logs and traps to notify the
administrator.

¢ Both - Specifies to send logs and traps to notify the
administrator and to reset the PoE port state (turn PoE off
and on).

Click the Apply button to accept the changes made.
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PoE Statistics

This window is used to display the PoE statistics.

To view the following window, click System > PoE > PoE Statistics, as shown below:

_ A

PoE Statistics Table

Unit 1 ~]

Unit 1 Settings

R R T S
eth1/0/1 0 0 0 0 92
eth1/0/2 0 0 0 0 92
eth1/0/3 0 0 0 0 93
eth1/0/4 0 0 0 0 93
eth1/0/5 0 0 0 0 35
2th1/0/6 0 0 0 0 5
eth1/0/7 0 0 0 0 29
eth1/0/8 0 0 0 0 3
=ih1/0/9 0 0 0 0 22
eth1/0/10 0 0 0 0 81

Figure 3-16 PoE Statistics Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

The fields that are displayed in the table are described below:

Parameter Description

MPS Absent This field is incremented when the PD's Maintain Power Signature
(MPS) is absent.

Overload This field is incremented when the power demand exceeds the
maximum output power supplied.

Short This field is incremented when the internal circuit of the PD shorted
out.

Power Denied This field is incremented when power was denied to the PD by the
system.

Invalid Signature This field is incremented when an invalid PD signature was

detected by the system.

Click the Clear All button to clear PoE statistics for all ports.

Click the Clear button to clear the PoE statistics for the corresponding port.

24




DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

PoE Measurement

This window is used to display the POE measurement.

To view the following window, click System > PoE > PoE Measurement, as shown below:

FOE Measureme

PoE Measurement Table
Unit 1 [v]
Unit 1 Settings
I T S A R R
eth1/0/1 A NIA MR MiA
eth1/0/2 NIA N/A A N/A
eth1/0/3 INA N/A MNiA MNiA
eth1/0/4 NIA N/A A N/A
eth1/0/5 INFA NA MNIA MiA
eth1/0/6 A N/A A MiA
eth1/0/7 NIA N/A N/A N/A
eth1/0/8 INFA NA NIA MiA
eth1/0/8 IA MIA MA MiA
eth1/0/10 NIA N/A A N/A
eth1/0/11 A NA MR MiA
eth1/0/12 A MIA A MN/A

Figure 3-17 PoE Measurement Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
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PoE LLDP Classification

This window is used to display the PoE LLDP Classification.

To view the following window, click System > PoE > PoE LLDP Classification, as shown below:

PoE LLDP Classification Table

m

Port eth1/0/1

PSE TX information
Mone

Information from PD
Mone

Port eth1/0/2

PSE TX information
Mone

Information from PD
Mone

Port eth1/0/3

PSE TX information
None

Information from PD
Mone

Port eth1/0/4

PSE TX information
None

Information from PD
MNone

Figure 3-18 PoE LLDP Classification Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
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System Log

System Log Settings

This window is used to view and configure the system’s log settings.

To view the following window, click System > System Log > System Log Settings, as shown below:

Discriminator Name

Write Delay (0-65535)

Console Log Settings

= (=
[=] (51
Slla
g
wl

Global State

Source Interface State Disabled [v]

Type VLAN [v] VID (1-4094) ]
Buffer Log Seftings

Buffer Log State Enabled [v]

Severity 4(Warnings) et

sec [ ]Infinite Apply

Console Log State Disabled ﬂ

Severity 4(Warnings) ﬂ
Monitor Log Settings

Monitor Log State Disabled v

Severity 5 V]

Figure 3-19 System Log Settings Window

The fields that can be configured for Global State are described below:

Parameter Description

Source Interface State

Select this option to enable or disable the source interface’s global
state.

Type Select the type of interface that will be used. Option to choose from
is VLAN.
VID Enter the VLAN ID used here. The value is between 1 and 4094.

Click the Apply button to accept the changes made.

The fields that can be configured for Buffer Log Settings are described below:

Parameter Description

Buffer Log State

Select whether the enable or disable the buffer log’s global state
here. Options to choose from are Enable, Disabled, and Default.
When selecting the Default option, the buffer log’s global state will
follow the default behavior.

Severity

Select the severity value of the type of information that will be
logged. Options to choose from are 0 (Emergencies), 1 (Alerts), 2
(Critical), 3 (Errors), 4 (Warnings), 5 (Notifications), 6
(Informational), and 7 (Debugging).

Discriminator Name

Enter the discriminator name used here. This name can be up to
15 characters long.
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Parameter Description

Write Delay Enter the interval for periodic writing of the logging buffer to
FLASH. This value must be between 0 and 65535 seconds. By
default, this value is 300 seconds. Tick the Infinite option, to
disable the write delay feature.

Click the Apply button to accept the changes made.

The fields that can be configured for Console Log Settings are described below:

Parameter Description

Console Log State Select to globally enable or disable the state of the console log
here.
Severity Select the severity value of the type of information that will be

logged. Options to choose from are 0 (Emergencies), 1 (Alerts), 2
(Critical), 3 (Errors), 4 (Warnings), 5 (Notifications), 6
(Informational), and 7 (Debugging).

Discriminator Name Enter the discriminator name used here. This name can be up to
15 characters long.

Click the Apply button to accept the changes made.

The fields that can be configured for Monitor Log Settings are described below:

Parameter Description

Monitor Log State Select to globally enable or disable the state of the monitor log
here.
Severity Select the severity value of the type of information that will be

logged. Options to choose from are 0 (Emergencies), 1 (Alerts), 2
(Critical), 3 (Errors), 4 (Warnings), 5 (Notifications), 6
(Informational), and 7 (Debugging).

Discriminator Name Enter the discriminator name used here. This name can be up to
15 characters long.

Click the Apply button to accept the changes made.
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System Log Discriminator Settings

This window is used to view and configure the system log’s discriminator settings.

To view the following window, click System > System Log > System Log Discriminator Settings,
as shown below:

Discriminator Log Settings
Discriminator Name
Action Drops (v
[]svs [] STACKING []PORT []sTP [JLAC
[]VOICE_VL... []FDB []LLDP [JACL []aos
] PORTSEC ] WAC []JWAC []DHCP [] DHCFV6
[]STORM_CT... []SSH cu []WEB [] SNMP
[]ERPS [ ] DDM []AAA []DoS [] DEVICE
[]pal [ ] SURVEILL .. [ ] RADIUS []DOT1X []POE
[JLBD [ ]BPDU_PRO... [ JMAC [ ] SAFEGUAR... []CFG
[ FIRMWARE [JAUTO_SAV... [] DNSRESOV... [ (nuity
Severity Drops (v
["] 0{Emergencies) [ 1{Alerts) [ 2(Critical) [] 3{Errors)
[] 4(Warnings) [] 5(Motifications) [] 6(Informaticnal) [[] 7{Debugging)
Total Entries: 1
I T S N T S
Name Drops ERPS Drops 7

Figure 3-20 System Log Discriminator Settings Window

The fields that can be configured are described below:

Parameter Description

Discriminator Name Enter the discriminator name here. This name can be up to 15
characters long.

Action Select the facility’s behavior option and the type of facility that will
be associated with the selected behavior here. Behavior options to
choose from are Drops and Includes.

Severity Select the severity behavior option and the value of the type of
information that will be logged. Behavior options to choose from
are Drops and Includes. Severity value options to choose from
are 0 (Emergencies), 1 (Alerts), 2 (Critical), 3 (Errors), 4
(Warnings), 5 (Notifications), 6 (Informational), and 7
(Debugging).

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.
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System Log Server Settings

This window is used to view and configure system log’s server settings.

To view the following window, click System > System Log > System Log Server Settings, as
shown below:

Log Server
(@ Host IPv4 Address [ - - ] () Host IPv6 Address 201321
UDP Port (1024-65535) 514 Severity 4(Warmnings) ﬂ
Facility 23 ﬂ Discriminator Name
Total Entries: 1
I T S 2
10.0.90.254 Warnings Delete

Figure 3-21 System Log Server Settings Window

The fields that can be configured are described below:

Parameter Description

Host IPv4 Address Enter the system log server’s IPv4 address here.

Host IPv6 Address Enter the system log server’s IPv6 address here.

UDP Port Enter the system log server’s UDP port number here. This value
must be 514 or between 1024 and 65535. By default, this value is
514.

Severity Select the severity value of the type of information that will be

logged. Options to choose from are 0 (Emergencies), 1 (Alerts), 2
(Critical), 3 (Errors), 4 (Warnings), 5 (Notifications), 6
(Informational), and 7 (Debugging).

Facility Select the facility value here. Options to choose from are 0 to 23.

Discriminator Name Enter the discriminator name here. This name can be up to 15
characters long.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

System Log

This window is used to view and clear the system log.

To view the following window, click System > System Log > System Log, as shown below:

System Log

Total Entries: 2
= =N o ecrpon
2000-01-01 00:00:36 CRIT(2) System started up
1 2000-01-01 00:00:36 CRIT(2) System warm start

11 [ [ee

Figure 3-22 System Log Window
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Click the Clear Log button to clear the system log entries displayed in the table.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

System Attack Log

This window is used to view and clear the system attack log.

To view the following window, click System > System Log > System Attack Log, as shown below:

Attack Log

System Attack Log

N

Total Entries: 0

I S T Lo e

Figure 3-23 System Attack Log Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

Click the Clear Attack Log button to clear the system attack log entries displayed in the table.

Time and SNTP

The Simple Network Time Protocol (SNTP) is a protocol for synchronizing computer clocks through
the Internet. It provides comprehensive mechanisms to access national time and frequency
dissemination services, organize the SNTP subnet of servers and clients, and adjust the system clock
in each participant.

Clock Settings

This window is used to configure the time settings for the Switch.

To view the following window, click System > Time and SNTP > Clock Settings, as shown below:

Clock Settings

Time (HH:MM:55) 00:54:54
Date (DD / MM / YYYY) 01/01/2000

Apply

Figure 3-24 Clock Settings Window

The fields that can be configured are described below:

Parameter Description

Time (HH:MM:SS) Enter the current time in hours, minutes, and seconds.

Date (DD / MM/ YYYY) Enter the current day, month, and year to update the system clock.
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Click the Apply button to accept the changes made.

Time Zone Settings

This window is used to configure time zones and Daylight Savings Time settings for SNTP.

To view the following window, click System > Time and SNTP > Time Zone Settings, as shown

below:

one settings

Summer Time State

Time Zone

Recurring Setting

From: Week of the Month
From: Day of the Week
From: Month

From: Time (HH:MM)
To: Week of the Month
To" Day of the Week

To: Month

To: Time (HH:MM)

Offset

Date Setting

From: Date of the Month
From: Month

From: Year

From: Time (HH:MM)
To: Date of the Month
To: Month

To: Year

To: Time (HH:MM)

Offset

g
B

et [
[s Tl
EEI—
[oo ][00

lLest T
ELN.
[n [l
[oo ][00

C——
o0 T[J
[l T[]
—

[00 ][00
0[]
[n [
—
[oo]-][oo[]

o 1]
Apply

Figure 3-25 Time Zone Settings Window

The fields that can be configured are described below:

Parameter ‘ Description

Summer Time State

Select the summer time setting. Options to choose from are:

o Disabled - Select to disable the summer time setting.

¢ Recurring Setting - Select to configure the summer time
that should start and end on the specified weekday of the
specified month.

o Date Setting - Select to configure the summer time that
should start and end on the specified date of the specified
month.

Time Zone

Select to specify the offset of the local time zone from the
Coordinated Universal Time (UTC).

The fields that can be configured for Recurring Setting are described below:

Parameter

Description

From: Week of the Month

Select week of the month that summer time will start.

32




DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

Parameter Description

From: Day of the Week Select the day of the week that summer time will start.

From: Month Select the month that summer time will start.

From: Time (HH:MM) Select the time of the day that summer time will start.

To: Week of the Month Select week of the month that summer time will end.

To: Day of the Week Select the day of the week that summer time will end.

To: Month Select the month that summer time will end.

To: Time (HH:MM) Select the time of the day that summer time will end.

Offset Enter the number of minutes to add during summer time. The
default value is 60. The range of this offset is 30, 60, 90 and 120.

The fields that can be configured for Date Setting are described below:

Parameter Description

From: Date of the Month Select date of the month that summer time will start.

From: Month Select the month that summer time will start.

From: Year Enter the year that the summer time will start.

From: Time (HH:MM) Select the time of the day that summer time will start.

To: Date of the Month Select date of the month that summer time will end.

To: Month Select the month that summer time will end.

To: Year Enter the year that the summer time will end.

To: Time (HH:MM) Select the time of the day that summer time will end.

Offset Enter the number of minutes to add during summer time. The
default value is 60. The range of this offset is 30, 60, 90 and 120.

Click the Apply button to accept the changes made.

SNTP Settings

This window is used to configure the time settings for the Switch.

To view the following window, click System > Time and SNTP > SNTP Settings, as shown below:

SNTP Global Settings

Current Time Source System Clock

SNTP State Disabled v

Poll Intervl (20-99969)
SNTP Server Setting

Add

Total Entries: 1

T R T S R

Figure 3-26 SNTP Settings Window
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The fields that can be configured for SNTP Global Settings are described below:

Parameter Description

SNTP State Select this option to enable or disable SNTP.

Poll Interval Enter the synchronizing interval in seconds. The value is from 30 to
99999 seconds. The default interval is 720 seconds.

Click the Apply button to accept the changes made.

The fields that can be configured for SNTP Server Setting are described below:

Parameter Description

IPv4 Address Enter the IP address of the SNTP server, which provides the clock
synchronization.

IPv6 Address Enter the IPv6 address of the SNTP server, which provides the
clock synchronization.

Click the Add button to add the SNTP server.

Click the Delete button to remove the specified entry.

Time Range

This window is used to view and configure the time range settings.

To view the following window, click System > Time Range, as shown below:

Time Range
From: Week Sun ﬂ To: Week []End Weekday
Total Entries: 1
[ Range ame | sttt T I R
Weekdays 00:00 2359 Delete Periodic Delete
17 [7] Go

Figure 3-27 Time Range Window

The fields that can be configured are described below:

Parameter Description

Range Name Enter the name of the time range. This name can be up to 32
characters long.

From Week / To Week Select the starting and ending days of the week that will be used
for this time range. Tick the Daily option to use this time range for
every day of the week. Tick the End Week Day option to use this
time range from the starting day of the week until the end of the
week, which is Sunday.

From Time / To Time Select the starting and ending time of the day that will be used for
this time range. The first drop-down menu selects the hour and the
second drop-down menu selects the minute.

Click the Apply button to accept the changes made.
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Click the Find button to locate a specific entry based on the information entered.
Click the Delete Periodic button to delete the periodic entry.
Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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4. Management

User Account Settings
Password Encryption
Login Method

SNMP

RMON

Telnet/Web

Session Timeout
DHCP

DNS

NTP

IP Source Interface
File System

Physical Stacking
Virtual Stacking (SIM)
D-Link Discovery Protocol

User Account Settings

This window is used to create and configure the user accounts. The active user account sessions can
be viewed.

There are several configuration options available in the Web User Interface (Web Ul). The set of
configuration options available to the user depends on the account’s Privilege Level. A user account
created with a higher privilege level will be given access to configure more features than a user
account created with a lower privilege level.

The pre-defined privilege levels for user accounts are:

e Basic User (Privilege Level 1) - This user account level has the lowest priority of the user
accounts. The purpose of this type of user account level is for basic system checking.

e Operator (Privilege Level 12) - This user account level is used to grant system configuration
rights for users who need to change or monitor system configuration, except for security related
information such as user accounts and SNMP account settings.

e Administrator (Privilege Level 15) - This administrator user account level can monitor all
system information and change any of the system configuration settings expressed in this
guide.

To view the following window, click Management > User Account Settings, as shown below:

| User Management Settings | Session Table
User Mame 32 chars Privilege (1-15) l:l
Password Type Password l:l Apply
Total Entries: 1
I O R
admin .- D
o e

Figure 4-1 User Management Settings Window

The fields that can be configured are described below:

Parameter Description

User Name Enter the user account name here. This name can be up to 32
characters long.
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Parameter Description

Privilege Enter the privilege level for this account here. This value must be
between 1 and 15.

Password Type Select the password type for this user account here. Options to
choose from are None, Plain Text, Encrypted-SHA1, and
Encrypted-MD5. When selecting Encrypted-SHA1 or Encrypted-
MDS5, the password will not be encrypted from the plain-text format
to the encrypted format. Instead, the encrypted password must be
entered. To encrypt the password from the plain-text format to the
encrypted format, refer to the Password Encryption window.

Password After selecting Plain Text, Encrypted-SHA1, or Encrypted-MD5
as the Password Type, enter the password for this user account
here.

Click the Apply button to accept the changes made.
Click the Delete button to remove the specified user account entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

After clicking the Session Table tab, the following page will appear.

User Management Settings | Session Table |

Total Entries: 2

I T T e T

console Anonymous 1 8M51S

* web admin 15 5M5S 10.90.90.1
=] e

Figure 4-2 Session Table Window

A list of active user account session will be displayed.
Click the Edit button to access and configure the User Privilege settings.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

After selecting the Edit button, the following page will appear.

User Privilege

Action (@) Engbled () Disabled
Privilege 15 V]

Figure 4-3 User Privilege Window

The fields that can be configured are described below:

Parameter Description

Action Select to enable or disable user level security.
Privilege Select the privilege level here. The range is from 1 to 15.
Password Enter the password here. This can be up to 32 characters long.

Click the Apply button to accept the changes made.
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Click the Back button to return to the previous page.

Password Encryption

This window is used to configure whether to save the encryption of the password in the configuration
file.

To view the following window, click Management > Password Encryption, as shown below:

Password Encryption Settings

Password Encryption State () Enabled (@ Disabled

Figure 4-4 Password Encryption Window

The fields that can be configured are described below:

Parameter Description

Password Encryption State |Select this option to enable or disable the encryption of the
password before stored in the configuration file.

Password Type After the Password Encryption State is Enabled, this filed will be
available. Options to choose from are Encrypted-SHA1 and
Encrypted-MD5.

Click the Apply button to accept the changes made.

Login Method

This window is used to configure the login method for each management interface that this Switch
supports.

To view the following window, click Management > Login Method, as shown below:

Enable Password

Level 1 Sﬂ Password Type | Plain Text ﬂ Password l:l
Login Method
roncon Loonanos I
Console Login Local
Telnet Login Local
S5H Login Local
Login Password
Application Password Type | Plain Text [v] Password I:I
soucan T g

Figure 4-5 Login Method Window
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The fields that can be configured for Enable Password settings are described below:

Parameter Description

Level Select the password level here. This value must be between 1 and
15.
Password Type Select the password type here. Options to choose from are Plain

Text, Encrypted-SHA1, and Encrypted-MD5. When selecting
Encrypted-SHA1 or Encrypted-MDS5, the password will not be
encrypted from the plain-text format to the encrypted format.
Instead, the encrypted password must be entered. To encrypt the
password from the plain-text format to the encrypted format, refer
to the Password Encryption window.

Password After selecting Plain Text, Encrypted-SHA1, or Encrypted-MD5
as the Password Type, enter the password for this user account
here.

Click the Apply button to accept the changes made.

The Login Method section will only be available when Authentication, Authorization, and Accounting
(AAA) feature is disabled. The fields that can be configured for Login Method settings are described

below:
Parameter Description
Login Method After clicking the Edit button, this parameter can be configured.

Select the login method for the specified application here. Options
to choose from are No Login, Login, and Login Local. No Login,
as the name implies, requires no login authentication to access the
specified application. Login will require the user to enter a
password when trying to access the application specified. Login
Local requires the user to enter a username and a password to
access the specified application.

Click the Edit button to modify the corresponding login method.
Click the Apply button to accept the changes made.

The fields that can be configured for Login Password settings are described below:

Parameter Description

Application Select the application that will be configured here. Options to
choose from are Console, Telnet and SSH.

Password Type Select the password encryption type that will be used here. Options
to choose from are Plain Text, Encrypted-SHA1, and Encrypted-
MD5.

Password Enter the password for the selected application here. This

password will be used when the Login Method for the specified
application is set as Login.

Click the Apply button to accept the changes made.

Click the Delete button to remove the password from the specified application.

SNMP

Simple Network Management Protocol (SNMP) is an OSI Layer 7 (Application Layer) designed
specifically for managing and monitoring network devices. SNMP enables network management
stations to read and modify the settings of gateways, routers, switches, and other network devices.
Use SNMP to configure system features for proper operation, monitor performance, and detect
potential problems in the Switch, switch group, or network.
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Managed devices that support SNMP include software (referred to as an agent), which runs locally on
the device. A defined set of variables (managed objects) is maintained by the SNMP agent and used
to manage the device. These objects are defined in a Management Information Base (MIB), which
provides a standard presentation of the information controlled by the on-board SNMP agent. SNMP
defines both the format of the MIB specifications and the protocol used to access this information over
the network.

The Switch supports the SNMP versions 1, 2c¢, and 3. The three versions of SNMP vary in the level of
security provided between the management station and the network device.

In SNMPv1 and SNMPv2c, user authentication is accomplished using ‘community strings’, which
function like passwords. The remote user SNMP application and the Switch SNMP must use the
same community string. SNMP packets from any station that has not been authenticated are ignored
(dropped).

The default community strings for the Switch used for SNMPv1 and SNMPv2c management access
are:

¢ public - Allows authorized management stations to retrieve MIB objects.
e private - Allows authorized management stations to retrieve and modify MIB objects.

SNMPv3 uses a more sophisticated authentication process that is separated into two parts. The first
part is to maintain a list of users and their attributes that are allowed to act as SNMP managers. The
second part describes what each user on that list can do as an SNMP manager.

The Switch allows groups of users to be listed and configured with a shared set of privileges. The
SNMP version may also be set for a listed group of SNMP managers. Thus, you may create a group
of SNMP managers that are allowed to view read-only information or receive traps using SNMPv1
while assigning a higher level of security to another group, granting read/write privileges using
SNMPV3.

Using SNMPv3 individual users or groups of SNMP managers can be allowed to perform or be
restricted from performing specific SNMP management functions. The functions allowed or restricted
are defined using the Object Identifier (OID) associated with a specific MIB. An additional layer of
security is available for SNMPv3 in that SNMP messages may be encrypted. To read more about how
to configure SNMPV3 settings for the Switch read the next section.

Traps

Traps are messages that alert network personnel of events that occur on the Switch. The events can
be as serious as a reboot (someone accidentally turned OFF the Switch), or less serious like a port
status change. The Switch generates traps and sends them to the trap recipient (or network
manager). Typical traps include trap messages for Authentication Failure, Topology Change, and
Broadcast/Multicast Storm.

MIBs

The Switch in the Management Information Base (MIB) stores management and counter information.
The Switch uses the standard MIB-Il Management Information Base module. Consequently, values
for MIB objects can be retrieved from any SNMP-based network management software. In addition to
the standard MIB-II, the Switch also supports its own proprietary enterprise MIB as an extended
Management Information Base. Specifying the MIB Object Identifier may also retrieve the proprietary
MIB. MIB values can be either read-only or read-write.

The Switch incorporates a flexible SNMP management for the switching environment. SNMP
management can be customized to suit the needs of the networks and the preferences of the network
administrator. Use the SNMP V3 menus to select the SNMP version used for specific tasks.
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The administrator can specify the SNMP version used to monitor and control the Switch. The three
versions of SNMP vary in the level of security provided between the management station and the
network device.

SNMP settings are configured using the menus located on the SNMP V3 folder of the Web manager.
Workstations on the network that are allowed SNMP privileged access to the Switch can be restricted
with the Management Station IP Address menu.

SNMP Global Settings

This window is used to configure the SNMP global settings and trap settings.

To view the following window, click Management > SNMP > SNMP Global Settings, as shown
below:

DD

SNMP Global Settings

SNMFP Global State
SNMF Response Broadcast Reguest
SNMP UDP Port (1-65535)

() Enabled
() Enabled
161

(e) Disabled
(@) Disabled

Mot Specified

Trap Source Interface

Note: If source interface is not specified, the egress IP interface’s address will be chosen as the packet's source IP address.
Trap Settings

Trap Global State
[] SNMP Authentication Trap

(O Enabled @) Disabled

[]Port Link Up

[] Port Link Down

[] Coldstart

[] Warmstart

Figure 4-6 SNMP Global Settings Window

The fields that can be configured for SNMP Global Settings are described below:

Parameter Description

SNMP Global State

Select this option to enable or disable the SNMP feature.

SNMP Response Broadcast
Request

Select this option to enable or disable the server to response to
broadcast SNMP GetRequest packets.

SNMP UDP Port

Enter the SNMP UDP port number. The range is from 1 to 65535.

Trap Source Interface

Enter the interface whose IP address will be used as the source
address for sending the SNMP trap packet.

The fields that can be configured for Trap Settings are described below:

Parameter Description

Trap Global State

Select this option to enable or disable the sending of all or specific
SNMP notifications.

SNMP Authentication Trap

Tick this option to control the sending of SNMP authentication
failure notifications. An authenticationFailuretrap is generated when
the device receives an SNMP message that is not properly
authenticated. The authentication method depends on the version
of SNMP being used. For SNMPv1 or SNMPv2c, authentication
failure occurs if packets are formed with an incorrect community
string. For SNMPv3, authentication failure occurs if packets are
formed with an incorrect SHA/MDS5 authentication key.
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Parameter Description

Port Link Up Tick this option to control the sending of port link up notifications. A
linkup trap is generated when the device recognizes that one of the
communication links has come up.

Port Link Down Tick this option to control the sending of port link down
notifications. A linkDown trap is generated when the device
recognizes a failure in one of the communication links.

Coldstart Tick this option to control the sending of SNMP coldStart
notifications.

Warmstart Tick this option to control the sending of SNMP warmStart
notifications.

Click the Apply button to accept the changes made.

SNMP Linkchange Trap Settings

This window is used to configure the SNMP Linkchange trap settings.

To view the following window, click Management > SNMP > SNMP Linkchange Trap Settings, as
shown below:

SNMP Linkchange Trap Settings
Unit From Port To Port Trap Sending Trap State
[ =] [ethiror [7] [eh101 <] [Disabled [~] p—
I N S AT N
eth1/0/1 Enabled Enabled
eth1/0/2 Enabled Enabled
eth1/0/3 Enabled Enabled
eth1/0/4 Enabled Enabled
eth1/0/5 Enabled Enabled
eth1/0/6 Enabled Enabled
eth1/0i7 Enabled Enabled
eth1/0/8 Enabled Enabled
eth1/0/9 Enabled Enabled
eth1/0/10 Enabled Enabled
eth1/0/11 Enabled Enabled
eth1/0/12 Enabled Enabled
eth1/0/13 Enabled Enabled
eth1/0/14 Enabled Enabled
eth1/0/15 Enabled Enabled

Figure 4-7 SNMP Linkchange Trap Settings Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
Trap Sending Select this option to enable or disable the sending of the SNMP

notification traps that is generated by the system.

Trap State Select this option to enable or disable the SNMP link change trap.

Click the Apply button to accept the changes made.
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SNMP View Table Settings

This window is used to assign views to community strings that define which MIB objects can be
accessed by a remote SNMP manager. The SNMP Group created with this table maps SNMP users
(identified in the SNMP User Table) to the views created in the previous window.

To view the following window, click Management > SNMP > SNMP View Table Settings, as shown
below:

SNMP View Settings

View Name

Subtree OID N.N.N_N

View Type Included |Z|
Add

Total Entries: 8

T e S o

restricted 13.6.1.2.1.1 included
restricted 13612111 Included
restricted 1361631021 Included
restricted 13.6.163.11.21 Included
restricted 1361631511 Included
CommunityView 1 Included
CommunityView 13.6.163 Excluded
CommunityView 13.6.1.6.3.1 Included

Figure 4-8 SNMP View Table Settings Window

The fields that can be configured are described below:

Parameter Description

View Name Type an alphanumeric string of up to 32 characters. This is used to
identify the new SNMP view being created.
Subtree OID Type the Object Identifier (OID) Subtree for the view. The OID

identifies an object tree (MIB tree) that will be included or excluded
from access by an SNMP manager.

View Type Select the view type here. Options to choose from are:

¢ Included - Select to include this object in the list of objects
that an SNMP manager can access.

o Excluded - Select to exclude this object from the list of
objects that an SNMP manager can access.

Click the Add button to add a new entry based on the information entered.

Click the Delete button to remove the specified entry.

SNMP Community Table Settings

This window is used to create an SNMP community string to define the relationship between the
SNMP manager and an agent. The community string acts like a password to permit access to the
agent on the Switch.

One or more of the following characteristics can be associated with the community string:
e An Access List of IP addresses of SNMP managers that are permitted to use the community
string to gain access to the Switch’s SNMP agent.

e Any MIB view that defines the subset of all MIB objects will be accessible to the SNMP
community.
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o Read/write or read-only level permission for the MIB objects accessible to the SNMP
community.

To view the following window, click Management > SNMP > SNMP Community Table Settings, as
shown below:

SNMP Community Settings

Key Type Plain Text [~]
Community Name 32 chars

View Mame

Access Right Read Only |Z|

IP Access-List Name

Add

Total Entries: 2

= Commnty e outame | cces T
w

private CommunityView
public CommunityView o

Figure 4-9 SNMP Community Table Settings Window

The fields that can be configured are described below:

Parameter Description

Key Type Select the key type for the SNMP community. Options to choose
from are Plain Text, and Encrypted.

Community Name Enter an alphanumeric string of up to 32 characters that is used to
identify members of an SNMP community. This string is used like a
password to give remote SNMP managers access to MIB objects in
the Switch’s SNMP agent.

View Name Enter an alphanumeric string of up to 32 characters that is used to
identify the group of MIB objects that a remote SNMP manager is

allowed to access on the Switch. The view name must exist in the
SNMP View Table.

Access Right Select the access right here. Options to choose from are:

¢ Read Only - SNMP community members using the
community string created can only read the contents of the
MIBs on the Switch.

¢ Read Write - SNMP community members using the
community string created can read from, and write to the
contents of the MIBs on the Switch.

IP Access-List Name Enter the name of the standard access list to control the user to
use this community string to access to the SNMP agent.

Click the Add button to add a new entry based on the information entered.

Click the Delete button to remove the specified entry.
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SNMP Group Table Settings

An SNMP Group created with this table maps SNMP users (identified in the SNMP User Table) to the
views created in the previous window.

To view the following window, click Management > SNMP > SNMP Group Table Settings, as shown
below:

SNMP Group Settings

Group Name Read View Name
User-based Security Model Write View Name
Security Level Notify View Name
IP Access-List Name

Total Entries: 5

public CommunityV'...

Read View Name Write View Name Notify View Name Security Model Security Level IP Access-List Name
vl

Add

CommunityV..

public CommunityV... CommunityV.. vac Delete
initial restricted restricted v3 NoAuthNoPriv Delete
private CommunityV'... CommunityV.. CommunityV.. V1 Delete
private CommunityV... CommunityV.. CommunityV.. v2c Delete

Figure 4-10 SNMP Group Table Settings Window

The fields that can be configured are described below:

Parameter

Description

Group Name

Enter the group name of a maximum of 32 characters. The syntax
is general string that does not allow space.

User-based Security Model

Select the security model here. Options to choose from are:

e SNMPv1 - Select to allow the group user to use the SNMPv1
security model.

e SNMPv2c - Select to allow the group user to use the
SNMPv2c security model.

e SNMPv3 - Select to allow the group user to use the SNMPv3
security model.

Security Level

When selecting SNMPv3 in the User-based Security Model drop-
down list, this option is available.

¢ NoAuthNoPriv - Specify that there will be no authorization
and no encryption of packets sent between the Switch and a
remote SNMP manager.

e AuthNoPriv - Specify that authorization will be required, but
there will be no encryption of packets sent between the
Switch and a remote SNMP manager.

e AuthPriv - Specify that authorization will be required, and
that packets sent between the Switch and a remote SNMP
manger will be encrypted.

IP Access-List Name

Enter the standard IP access control list (ACL) to associate with the
group.

Read View Name

Enter the read view name that the group user can access.

Write View Name

Enter the write view name that the group user can access.

Notify View Name

Enter a write view name that the group user can access. The notify
view describes the object that can be reported its status via trap
packets to the group user.

Click the Add button to add a new entry based on the information entered.
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Click the Delete button to remove the specified entry.

SNMP Engine ID Local Settings

The Engine ID is a unique identifier used for SNMP V3 implementations on the Switch.

To view the following window, click Management > SNMP > SNMP Engine ID Local Settings, as
shown below:

SNMP Engine ID Local Settings

Engine ID [e000002b033c1204a1b82000 Default | [ Apply

# [Engine ID length is 24, the accepted character is from 0 to F

Figure 4-11 SNMP Engine ID Local Settings Window

The fields that can be configured are described below:

Parameter Description

Engine ID Enter the engine ID string with the maximum of 24 characters.

Click the Default button to revert the engine ID to the default.
Click the Apply button to accept the changes made.

SNMP User Table Settings

This window is used to configure and display the SNMP users that are currently configured on the
Switch.

To view the following window, click Management > SNMP > SNMP User Table Settings, as shown
below:

SNMP User Settings

User Name

Group Name

SNMP Version

SNMP V3 Encryption

Auth-Protocol by Password MD5 [v] Password (8-16 chars) l:l
Priv-Protocol by Password Password (3-16 chars) |:|
Auth-Protocol by Key MD5 [v] Key (32 chars) |:|
Priv-Protocol by Key Key (32 chars) l:l
IP Access-List Name

Add

Total Entries: 1

m Security Model Authentication Protocol Privacy Protocol Engine ID IP Access-List Name _
initial initial V3 Naone None 200000ab03...

Figure 4-12 SNMP User Table Settings Window

The fields that can be configured are described below:

Parameter Description

User Name Enter an alphanumeric string of up to 32 characters. This is used to
identify the SNMP users.
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Parameter Description

Group Name

Enter the SNMP group name to which the user belongs. The syntax
is general string that does not allow spaces.

SNMP Version

Select the SNMP version. Options to choose from are v1, v2¢, and
v3.

SNMP V3 Encryption

After selecting v3 in the SNMP Version drop-down list, this option
is available. Options to choose from are None, Password, and
Key.

Auth-Protocol

After selecting v3 in the SNMP Version drop-down list, and
selecting either Password or Key in the SNMP V3 Encryption
drop-down list, this option is available. Select the authentication
level. Options to choose from are:
e MDS5 - Select to use the HMAC-MD5-96 authentication level.
This field will require the user to enter a password or a key.
e SHA - Specify that the HMAC-SHA authentication protocol
will be used. This field will require the user to enter a
password or a key.

Priv-Protocol

After selecting v3 in the SNMP Version drop-down list, and
selecting either Password or Key in the SNMP V3 Encryption
drop-down list, this option is available. Select the private protocol.
Options to choose from are:

¢ None - Specify that no authorization protocol is in use.
o DESS56 - Specify that DES 56-bit encryption is in use, based

on the CBC-DES (DES-56) standard. This field will require
the user to enter a password or a key.

IP Access-List Name

Enter the standard IP access control list (ACL) to associate with the
user.

Click the Add button to add a new entry based on the information entered.

Click the Delete button to remove the specified entry.

SNMP Host Table Settings

This window is used to configure and display the recipient of the SNMP notification.

To view the following window, click Management > SNMP > SNMP Host Table Settings, as shown

below:

SNMP Host Settings

(@) Host IPv4 Address

() Host IPvE Address

User-based Security Model

Security Level

UDP Port (1-65535)

Community String / SNMPv3 User Name

Total Entries: 1

10.90.90.20

Host IP Address SNMP Version UDP Port Community String / SNMPv3 User Name _
Vi 162

|

SNMPv1 v
NoAuthNoPriv ~ [v]

62

Figure 4-13 SNMP Host Table Settings
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The fields that can be configured are described below:

Parameter Description

Host IPv4 Address Enter the IPv4 address of the SNMP notification host.
Host IPv6 Address Enter the IPv6 address of the SNMP notification host.

User-based Security Model |Select the security model here. Options to choose from are:

e SNMPv1 - Select to allow the group user to use the SNMPv1
security model.

o SNMPv2c - Select to allow the group user to use the
SNMPv2c security model.

e SNMPv3 - Select to allow the group user to use the SNMPv3
security model.

Security Level When selecting SNMPv3 in the User-based Security Model drop-
down list, this option is available.

¢ NoAuthNoPriv - Specify that there will be no authorization
and no encryption of packets sent between the Switch and a
remote SNMP manager.

o AuthNoPriv - Specify that authorization will be required, but
there will be no encryption of packets sent between the
Switch and a remote SNMP manager.

e AuthPriv - Specify that authorization will be required, and
that packets sent between the Switch and a remote SNMP
manger will be encrypted.

UDP Port Enter the UDP port number. The default UDP port number of the
trap is 162. The range of UDP port numbers is from 1 to 65535.
Some port numbers may conflict with other protocols.

Community String / SNMPv3 | Enter the community string to be sent with the notification packet.
User Name

Click the Add button to add a new entry based on the information entered.

Click the Delete button to remove the specified entry.

RMON
RMON Global Settings

This window is used to enable or disable remote monitoring (RMON) for the rising and falling alarm
trap feature for the SNMP function on the Switch.

To view the following window, click Management > RMON > RMON Global Settings, as shown
below:

RMON Global Settings

RMON Rising Alarm Trap @ Enabled Disabled

RMON Falling Alarm Trap @ Enabled Disabled

Figure 4-14 RMON Global Settings Window

The fields that can be configured are described below:

Parameter Description

RMON Rising Alarm Trap Select this option to enable or disable the RMON Rising Alarm
Trap Feature.
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Parameter Description

RMON Falling Alarm Trap Select this option to enable or disable the RMON Falling Alarm
Trap Feature.

Click the Apply button to accept the changes made.

RMON Statistics Settings

This window is used to configure and display the RMON statistics on the specified port.

To view the following window, click Management > RMON > RMON Statistics Settings, as shown

below:
RMON Statistics Settings
Unit Port Index (1-65535) Owner
| mex | ko | ower |
2 eih1/0n RMON

o EE e

Figure 4-15 RMON Statistics Settings Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
Port Select to choose the port.

Index Enter the RMON table index. The value is from 1 to 65535
Owner Enter the owner string. The string can be up to 127 characters.

Click the Add button to add a new entry based on the information entered.
Click the Delete button to remove the specified entry.
Click the Show Detail button to see the detail information of the specific port.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

After clicking the Show Detail button, the following window will appear.

RMON Statistics Table

512- 1024-
Data Rec. Broadcast Undersize | Oversize CRC Drop | 64 | 65127 [128-255|256-511
( Fragments.Jab 5| 1023 1518
Source | Oclets PKTs PKTs PKTs Error Event |Octets| Octets | Octets | Octets
Octets | Octets
727 30 0 0 1] o 1] o 73 79 35 149 245 1]

2 eth1/0M 393486 2338 2377

Back

Figure 4-16 RMON Statistics Table Window

Click the Back button to return to the previous window.

49



DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

RMON History Settings

This window is used to configure and display RMON MIB history statistics gathering on the specified
port.

To view the following window, click Management > RMON > RMON History Settings, as shown
below:

RMON History Settings

Unit Port Index (1-65535) Bucket Number (1-65535) Interval (1-3600) Owner
[ethion =] | | o | ft00 | sec 127 chars
Add
s | —pon | s esos | v et | v o
1 eth1/01 50 50 1800 RMON history

O K e

Figure 4-17 RMON History Settings Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
Port Select to choose the port.

Index Enter the index value here. The value is from 1 to 65535.
Bucket Number Enter Specifies the number of buckets specified for the RMON

collection history group of statistics. The range is from 1 to 65535.
The default value is 50.

Interval Enter the time in seconds in each polling cycle. The range is from 1
to 3600.
Owner Enter the owner string. The string can be up to 127 characters.

Click the Add button to add a new entry based on the information entered.
Click the Delete button to remove the specified entry.
Click the Show Detail button to see the detail information of the specific port.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

After clicking the Show Detail button, the following window will appear.

RMON History Table

e o Ot P et PRI e T3 ilion s T v P s hrs i o Cotins 0 e

Figure 4-18 RMON History Table Window

Click the Back button to return to the previous window.
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RMON Alarm Settings

This window is used to configure and display alarm entries to monitor an interface.

To view the following window, click Management > RMON > RMON Alarm Settings, as shown

below:

LN Ale ELLNgs

RMON Alarm Settings

Index (1-65535) |:| Interval (1-2147483647) |:| sec
Variable Type Absolute v
Rising Threshold (0-2147483647) |:| Falling Threshold (0-2147483647) |:|
Rising Event Number (1-65535) |:| Falling Event Number (1-65535) |:|

Owner 1-127 chars

Total Entries: 1

Add

Intenrd |sec] LastVaIu Rising Threshold|Falling Threshold Rising Event No.|Falling Event No., M-

1.3.6.1.2.1.2.2.1.12.6 Absolute

(1]

Rising or Faling Name
[ [ e

Figure 4-19 RMON Alarm Settings Window

The fields that can be configured are described below:

Parameter Description

Index Enter the alarm index. The range is from 1 to 65535.

Interval Enter the interval in seconds for the sampling of the variable and
checking against the threshold. The valid range is from 1 to
2147483647 seconds.

Variable Enter the object identifier of the variable to be sampled.

Type Select the monitoring type. Options to choose from are Absolute

and Delta.

Rising Threshold

Enter the rising threshold value between 0 and 2147483647.

Falling Threshold

Enter the falling threshold value between 0 and 2147483647.

Rising Event Number

Enter the index of the event entry that is used to notify the rising
threshold-crossing event. The valid range is from 1 to 65535. If not
specified, no action is taken while crossing the ringing threshold.

Falling Event Number

Enter the index of the event entry that is used to notify the falling
threshold-crossing event. The valid range is from 1 to 65535. If not
specified, no action is taken while crossing the falling threshold.

Owner

Enter the owner string up to 127 characters.

Click the Add button to add a new entry based on the information entered.

Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages

exist.
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RMON Event Settings

This window is used to configure and display event entries.

To view the following window, click Management > RMON > RMON Event Settings, as shown
below:

MION Eve ettings
RMON Event Settings

Index (1-65535)

Description

Type

Community

Owner

Add

Total Entries: 1
I I B T A
event commuity Log and Trap owner 0d:0h:0m:0s m m
i el le

Figure 4-20 RMON Event Settings Window

The fields that can be configured are described below:

Parameter Description

Index Enter the index of the alarm entry between 1 and 65535.

Description Enter a description for the RMON event entry. The string is up to
127 characters long.

Type Select the RMON event entry type. Options to choose from are
None, Log, Trap, and Log and Trap.

Community Enter the community string. The string can be up to 127 characters.

Owner Enter the owner string. The string can be up to 127 characters.

Click the Add button to add a new entry based on the information entered.
Click the Delete button to remove the specified entry.
Click the View Logs button to see the detail information of the specific port.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

After clicking the View Logs button, the following window will appear.

0g hle
Event Logs Table
Event Index: 1

Total Entries: 0

on i onDosrion

Figure 4-21 Event Logs Table Window

Click the Back button to return to the previous window.
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Telnet/Web

This window is used to configure Telnet and Web settings on the Switch.

To view the following window, click Management > Telnet/Web, as shown below:

Telnet Settings

Telnet State @ Enabled Disabled

Port (165535) ey
Web Settings

Web State @ Enabled Disabled

Figure 4-22 Telnet/Web Window

The fields that can be configured for Telnet Settings are described below:

Parameter Description

Telnet State Select this option to enable or disable the configuration through
Telnet.

Port Enter the TCP port number used for Telnet management of the
Switch. The default TCP port for the Telnet protocol is 23.

Click the Apply button to accept the changes made.

The fields that can be configured for Web Setting are described below:

Parameter Description

Web State Select this option to enable or disable the configuration through the
web.

Port Enter the TCP port number used for Web-based management of
the Switch. The “well-known” TCP port for the Web-based protocol
is 80.

Click the Apply button to accept the changes made.
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Session Timeout

This window is used to display and configure the session timeout settings. The outgoing session
timeout values are used for Console/Telnet/SSH connections through the CLI of the Switch to the
Telnet interface of another switch.

To view the following window, click Management > Session Timeout, as shown below:

5! +1 POU

Session Timeout
Web Session Timeout (60-36000) sec ] Default
Console Session Timeout (0-1439) min [/ Default
Outgoing Console Session Timeout (0-1439) I:l min [/ Default
Telnet Session Timeout (0-1439) min [ Default
Outgoing Telnet Session Timeout (0-1439) I:l min [/ Default
SSH Session Timeout (0-1439) min [ Default
Outgoing SSH Session Timeout (0-1439) |:| min [ Default

Figure 4-23 Session Timeout Window

The fields that can be configured are described below:

Parameter Description

Web Session Timeout Enter the web session timeout value here. The range is from 60 to
36000 seconds. The default value is 180 seconds.

Select the Default option to use the default value.

Console Session Timeout Enter the console session timeout value here. The range is from 0
to 1439 minutes. Enter 0 to disable the timeout. The default value
is 3 minutes.

Select the Default option to use the default value.

Outgoing Console Session Enter the outgoing console session timeout value here. The range
Timeout is from 0 to 1439 minutes. Enter O to disable the timeout. The
default value is 0.

Select the Default option to use the default value.

Telnet Session Timeout Enter the Telnet session timeout value here. The range is from 0 to
1439 minutes. Enter 0 to disable the timeout. The default value is 3
minutes.

Select the Default option to use the default value.

Outgoing Telnet Session Enter the outgoing Telnet session timeout value here. The range is
Timeout from 0 to 1439 minutes. Enter 0 to disable the timeout. The default
value is 0.

Select the Default option to use the default value.

SSH Session Timeout Enter the SSH session timeout value here. The range is from 0 to
1439 minutes. Enter 0 to disable the timeout. The default value is 3
minutes.

Select the Default option to use the default value.

Outgoing SSH Session Enter the outgoing SSH session timeout value here. The range is
Timeout from 0 to 1439 minutes. Enter O to disable the timeout. The default
value is 0.

Select the Default option to use the default value.

Click the Apply button to accept the changes made.
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DHCP

Service DHCP

This window is used to configure the DHCP relay service on the Switch.

To view the following window, click Management > DHCP > Service DHCP, as shown below:

Service DHCP

Service DHCP State @ Disabled Enabled
Service IPv6 DHCP
Service IPvé DHCP State @ Disabled Enabled

Figure 4-24 Service DHCP Window

The fields that can be configured for Service DHCP are described below:

Parameter Description

Service DHCP State Select this option to enable or disable the DHCP relay service.

Click the Apply button to accept the changes made.

The fields that can be configured for Service IPv6 DHCP are described below:

Parameter Description

Service IPv6 DHCP State Select this option to enable or disable the IPv6 DHCP relay service.

Click the Apply button to accept the changes made.

DHCP Class Settings

This window is used to configure and display the DHCP class and the DHCP option matching pattern
for the DCHP class.

To view the following window, click Management > DHCP > Service DHCP, as shown below:

DRACF d Engs

DHCP Class State
DHCP Use Class State Disabled [v]
DHCP Class Settings
Total Entries: 1
T e
Class Edit Delete
11 1] Go

Figure 4-25 DHCP Class Settings Window

The fields that can be configured for DHCP Class State are described below:

Parameter Description

DHCP Use Class State Select to enable or disable the DHCP class function here.
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Click the Apply button to accept the changes made.

The fields that can be configured for DHCP Class Settings are described below:

Parameter Description

Class Name Enter the DHCP class name with a maximum of 32 characters.

Click the Apply button to accept the changes made.
Click the Edit button to modify the DHCP option-matching pattern for the corresponding DCHP class.
Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

After clicking the Edit button, the following window will appear.

DHCP Class Option Settings
Class Name DHCPClass
s
Total Entries: 1
I N O S A
0 10200

Figure 4-26 DHCP Class Option Settings Window

The fields that can be configured are described below:

Parameter Description

Option Enter the DHCP option number. The range is from 1 to 254.

Hex Enter the hex pattern of the specified DHCP option. Tick the check
box not to match the remaining bits of the option.

Bitmask Enter the hex bit mask for masking of the pattern. The masked
pattern bits will be matched. If not specified, all bits entered in Hex
will be checked.

Click the Apply button to accept the changes made.
Click the Delete button to remove the specified entry.

Click the Back button to return to the previous window.

DHCP Server

The Dynamic Host Configuration Protocol (DHCP) allows the Switch to designate IP addresses,
subnet masks, default gateways and other IP parameters to devices that request this information. This
occurs when a DHCP enabled device is booted on or attached to the locally attached network. This
device is known as the DHCP client and when enabled, it will emit query messages on the network
before any IP parameters are set. When the DHCP server receives this request, it will allocate an IP
address to the client. The DHCP client may be then utilize the IP address allocated by the DHCP
server as its local configuration.

The user can configure many DHCP related parameters that it will utilize on its locally attached
network, to control and limit the IP settings of clients desiring an automatic IP configuration, such as
the lease time of the allocated IP address, the range of IP addresses that will be allowed in its DHCP
pool, the ability to exclude various IP addresses within the range so as not to make identical entries
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on its network, or to assign the IP address of an important device (such as a DNS server or the IP
address of the default route) to another device on the network.

Users also have the ability to bind IP addresses within the DHCP pool to specific MAC addresses in
order to assign the same IP addresses to important devices.

DHCP Server Global Settings

This window is used to display and configure the global DHCP server parameters.

To view the following window, click Management > DHCP > DHCP Server > DHCP Server Global
Settings, as shown below:

DHCP Use Class State
DHCP Use Class State (_)Enabled (e) Disabled
DHCP Server Settings

DHCP Ping Packet (0-10)

Figure 4-27 DHCP Server Global Settings Window

The fields that can be configured in DHCP Use Class State are described below:

Parameter Description

DHCP Use Class State Select to enable or disable the DHCP Use Class State here. When
enabled, the DHCP server will use DHCP classes for address
allocation.

Click the Apply button to accept the changes made.

The fields that can be configured in DHCP Server Settings are described below:

Parameter Description

DHCP Ping Packet Enter the number of ping packets that the Switch will send out on
the network containing the IP address to be allotted. If the ping
request is not returned, the IP address is considered unique to the
local network and then allotted to the requesting client. A value of
0 means there is no ping test. The range is from 0 to 10. The
default value is 2.

DHCP Ping Timeout Enter the amount of time the DHCP server must wait before timing
out a ping packet. The range is from 100 to 10000 milliseconds.
The default value is 500 milliseconds.

Click the Apply button to accept the changes made.
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DHCP Server Pool Settings

This window is used to display and configure the DHCP server pool settings.

To view the following window, click Management > DHCP > DHCP Server > DHCP Server Pool
Settings, as shown below:

DACP Server Fool Settings
DHCP Server Pool
Total Entries: 1
pool Edit Class Edit Option Configure Delete
n [ 1] [ [eo

Figure 4-28 DHCP Server Pool Settings Window

The fields that can be configured are described below:

Parameter Description

Pool Name Enter the DHCP server pool name here. This name can be up to
32 characters long.

Click the Apply button to accept the changes made.

Click the Edit Class button to configure the DHCP class.

Click the Edit Option button to configure the DHCP server pool option settings.
Click the Configure button to configure the DHCP server pool settings.

Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

After clicking the Edit Class button, the following page will appear.

URACF Server Fool ass cetungs
DHCP Server Pool Class Settings
Pool Name pool
Class Mame Please Select  [v]
Total Entries: 1
Class Delete by Name || Delete by Address
Back

Figure 4-29 DHCP Server Pool Class Settings Window

The fields that can be configured are described below:

Parameter Description

Class Name Select an existing DHCP class name here that will be associated
with this DHCP pool.
Start Address Enter the starting IPv4 address that will be associated with the

DHCP class in the DHCP pool here.

End Address Enter the ending IPv4 address that will be associated with the
DHCP class in the DHCP pool here.
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Click the Apply button to accept the changes made.
Click the Delete by Name button to remove the DHCP class association by name.
Click the Delete by Address button to remove the DHCP class association by address.

Click the Back button to return to the previous window.

After clicking the Edit Option button, the following page will appear.

DACF Server Fool Option >ettiings

DHCP Server Pool Option Settings
Pool Name pool
opton (1254 —
Type ASCII [~]
I
o e | e
200 ascii string

Figure 4-30 DHCP Server Pool Option Settings Window

The fields that can be configured are described below:

Parameter Description

Option Enter the DHCP option number here. The range is from 1 to 254.

Type Select the DHCP option type here. Options to choose from are:

e ASCII - Enter the ASCII string in the space provided. This
string can be up to 255 characters long.

¢ Hex - Enter the hexadecimal string in the space provided.
This string can be up to 254 characters long. Select the
None option to specify a zero-length hexadecimal string.

o [P - Enter the IPv4 address(es) in the space(s) provided. Up
to 8 IPv4 addresses can be entered.

Click the Apply button to accept the changes made.
Click the Delete button to remove the specified entry.

Click the Back button to return to the previous window.

After clicking the Configure button, the following page will appear.

DACEF Server Fool Connigure
DHCP Server Pool Configure
Pool Name pool
Network (IP/Mask) [0 -0 -0 - 0] [o- -0 00|
Next Server 0 -0 - 0.0
Default Router [ | \ | [ | [ . |
| | | | - |
DNS Server | - . . | ‘ - . - | | | | - |
L - - -1 - - - ] | | - |
NetBIOS Name Server [ ] [ ] [ | [ . |
L - - - 1 | | | - |
NetBIOS Node Type
Lease Days (0-365)[00 [~ || Hours [00  [] Minutes [ Infinite Back || apply

Figure 4-31 DHCP Server Pool Configure Window
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The fields that can be configured are described below:

Parameter Description

Boot File Enter the boot file name here. This can be up to 64 characters
long.

Domain Name Enter the domain name for the DHCP client here. This can be up
to 64 characters long.

Network (IP/Mask) Enter the network IPv4 address and subnet mask for the DHCP
client here.

Next Server Enter the next server IPv4 address here. The boot image file is

stored on this server and can be retrieved by DHCP clients using
this IP address. The server is typically a TFTP server. Only one
next server IP address can be specified.

Default Router Enter the IPv4 address of the default router for the DHCP client
here. Up to 8 IPv4 addresses can be entered here. The IP address
of the router should be on the same subnet as the client’s subnet.
Routers are listed in the order of preference. If default routers are
already configured, the default routers configured later will be
added to the default interface list.

DNS Server Enter the IPv4 address to be used by the DHCP client as the DNS
server here. Up to 8 IPv4 addresses can be entered here. Servers
are listed in the order of preference. If DNS servers are already
configured, the DNS servers configured later will be added to the
DNS server list.

NetBIOS Name Server Enter the WINS name server IPv4 address for the DHCP client
here. Up to 8 IPv4 addresses can be entered here. Servers are
listed in the order of preference. If name servers are already
configured, the name server configured later will be added to the
default interface list.

NetBIOS Node Type Select the NetBIOS node type for Microsoft DHCP clients here.
The node type determines the method that NetBIOS uses to
register and resolve names.

Options to choose from are:

e Broadcast - This system uses broadcasts.

o Peer To Peer - This system (p-node) uses only point-to-
point name queries to a name server (WINS).

¢ Mixed - This system (m-node) broadcasts first, and then
queries the name server.

e Hybrid - This system (h-node) queries the name server first,
and then broadcasts. This is the recommended type.

Lease Enter and select the lease time for an IPv4 address that is
assigned from the address pool here.
Enter the Days in the range from 0 to 365. Select the Hours and

Minutes from the drop-down menus. Alternatively, the Infinite
option can be selected to specify that the lease time is unlimited.

Click the Apply button to accept the changes made.

Click the Back button to return to the previous window.

DHCP Server Exclude Address

This window is used to view and exclude a range of IPv4 addresses from being allocated to the DHCP
client. The DHCP server automatically allocates addresses in DHCP address pools to DHCP clients.
All the addresses except the interface’s IP address on the router and the excluded address(es)
specified here are available for allocation. Multiple ranges of addresses can be excluded. To remove
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a range of excluded addresses, administrators must specify the exact range of addresses previously
configured.

To view the following window, click Management > DHCP > DHCP Server > DHCP Server Exclude
Address, as shown below:

DHCP Server Exclude Address
DHCP Server Exclude Address
Total Entries: 1
192.162.70.2 192.168.70.100

Figure 4-32 DHCP Server Exclude Address Window

The fields that can be configured are described below:

Parameter Description

Begin Address Enter the first IPv4 address of a range of addresses to be excluded
here.

End Address Enter the last IPv4 address of a range of addresses to be excluded
here.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

DHCP Server Manual Binding

This window is used to display and configure the DHCP server manual binding settings. With a
manual binding entry, the IP address can be bound with a client-identifier or bound with the hardware
address of the host.

To view the following window, click Management > DHCP > DHCP Server > DHCP Server Manual
Binding, as shown below:

DHCP Server Manual Binding
e e ™ w——
®  Hardware Address [C2-F3-22-0A-12-F4
192.168.70.220 255.255,255.0 00-11-22-33-44-55

Figure 4-33 DHCP Server Manual Binding Window

The fields that can be configured are described below:

Parameter Description

Pool Name Enter the DHCP server pool name here. This name can be up to
32 characters long.

Host Enter the DHCP host IPv4 address here.

Mask Enter the DHCP host network subnet mask here.

Hardware Address Enter the DHCP host MAC address here.
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Parameter Description

Client Identifier Enter the DHCP host identifier in hexadecimal notation here. The
client identifier is formatted by the media type and the MAC
address.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

DHCP Server Dynamic Binding

This window is used to view and clear the DHCP server dynamic binding entries.

To view the following window, click Management > DHCP > DHCP Server > DHCP Server Dynamic
Binding, as shown below:

DHCP Server Dynamic Binding

Paol Name 2

Total Entries: 0

IP Address Client-ID/Hardware Address Lease Expiration

Figure 4-34 DHCP Server Dynamic Binding Window

The fields that can be configured are described below:

Parameter Description

IP Address Enter the binding entry IPv4 address here.

Pool Name Enter the DHCP server pool name here. This name can be up to
32 characters long. Select the All option to clear the binding
entries for all pools.

Click the Find button to locate a specific entry based on the information entered.

Click the Clear button to clear the entries based on the information specified.

DHCP Server IP Conflict

This window is used to view and clear the DHCP conflict entries from the DHCP server database.

To view the following window, click Management > DHCP > DHCP Server > DHCP Server IP
Conflict, as shown below:

DHCP Server IP Conflict

Paoi Name g

Total Entries: 0

IP Address Detection Method Detection Time

Figure 4-35 DHCP Server IP Conflict Window
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The fields that can be configured are described below:

Parameter Description

IP Address Enter the IPv4 address of the conflict entry to be located or
cleared.

Pool Name Enter the DHCP server pool name here. This name can be up to
32 characters long. Select the All option to clear the conflict entries
for all pools.

Click the Find button to locate a specific entry based on the information entered.

Click the Clear button to clear the entries based on the information specified.

DHCP Server Statistic

This window is used to display DHCP server statistics.

To view the following window, click Management > DHCP > DHCP Server > DHCP Server Statistic,
as shown below:

Address Pools 1
Automatic Bindings 0
Manual Bindings 1
Malformed Messages 0
Renew Messages ]

lessage Received
BOOTREQUEST
DHCPDISCOVER
DHCPREQUEST
DHCPDECLINE
DHCPRELEASE
DHCPINFORM

o e o o o o

essage Sent
BOOTREPLY
DHCPOFFER
DHCPACK
DHCPMAK

o o o o

Figure 4-36 DHCP Server Statistic Window

Click the Clear button to clear the statistics information displayed here.
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DHCPv6 Server
DHCPv6 Server Pool Settings

This window is used to display and configure the DHCPV6 server pool settings.

To view the following window, click Management > DHCP > DHCPv6 Server > DHCPv6 Server
Pool Settings, as shown below:

DHCPVE Server Pool Settings

DHCPv6 Server Pool

Pool Name Aply

Total Entries: 1

I
Pool

11 [q] [ lee

Figure 4-37 DHCPv6 Server Pool Settings Window

The fields that can be configured are described below:

Parameter Description

Pool Name Enter the DHCPv6 server pool name here. This name can be up to
12 characters long.

Click the Apply button to accept the changes made.
Click the Configure button to configure the DHCPv6 server pool settings.
Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

After clicking the Configure button, the following page will appear.

DACFYD server Fool Configure

DHCPv6E Server Pool Configure

Pool Mame Pool

() Address Prefix 2001:0DB8::0/64

@) Prefix Delegation Poal

valid Lifetime (60-4294967295) [ see

Preferred Lifetime (50-4204967205) |:| sec

DNS Server 20131

DNS Server 2013:1

Domain Mame l:l Back Apply
Static Bindings

() Static Bindings Address [001:0DB8::0 () Static Bindings Prefix 001:0DBS::0/64

Valid Lifetime (60-4294967295) b592000 sec Preferred Lifetime (60-4294957295) 604800 sec

Total Entries: 0

Figure 4-38 DHCPv6 Server Pool Configure Window




DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

The fields that can be configured in DHCPv6 Server Pool Configure are described below:

Parameter Description

Address Prefix

Select and enter the DHCPV6 server pool IPv6 network address
and prefix length here. For example, 2015::0/64.

Prefix Delegation Pool

Select and enter the DHCPV6 server pool prefix delegation name
here. This name can be up to 12 characters long.

Valid Lifetime

Enter the valid lifetime value here. The range is from 60 to
4294967295 seconds. The valid lifetime should be greater than
preferred lifetime. If this value is not specified, then the default
valid lifetime will be 2592000 seconds (30 days).

Preferred Lifetime

Enter the preferred lifetime value here. The range is from 60 to
4294967295 seconds. If this value is not specified, the preferred
lifetime will be 604800 seconds (7 days).

DNS Server

Enter the DNS server IPv6 address to be assigned to requesting
DHCPv6 clients here.

Domain Name

Enter the domain name to be assigned to requesting DHCPv6
clients here.

Click the Apply button to accept the changes made.

Click the Back button to return to the previous window.

The fields that can be configured in Static Bindings are described below:

Parameter Description

Static Bindings Address

Enter the static binding IPv6 address assign to the specific client
here.

Static Bindings Prefix

Enter the static binding IPv6 network address and prefix length
here.

Client DUID Enter the client DHCP Unique Identifier (DUID) here. This string
can be up to 28 characters long.

IAID Enter the Identity Association Identifier (IAID) here. The IAID here
uniquely identifies a collection of non-temporary addresses (IANA)
assigned on the client.

Valid Lifetime Enter the valid lifetime value here. The valid lifetime should be

greater than the preferred lifetime. The range is from 60 to
4294967295 seconds. By default, this value is 2592000 seconds
(30 days).

Preferred Lifetime

Enter the preferred lifetime value here. The range is from 60 to
4294967295 seconds. By default, this value is 604800 seconds (7
days).

Click the Apply button to accept the changes made.
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DHCPv6 Server Local Pool Settings

This window is used to display and configure the DHCPvV6 server local pool settings.

To view the following window, click Management > DHCP > DHCPv6 Server > DHCPv6 Server
Local Pool Settings, as shown below:

DACPYL Server Local Fool Setungs
DHCPv6 Server Local Pool
IPvE Address/Prefix Length 2001:AABS/64
Pool Name
Total Entries: 1
Paol 202064 64 1 0
11 [q] [ e

Figure 4-39 DHCPv6 Server Local Pool Settings Window

The fields that can be configured are described below:

Parameter Description

Pool Name Enter the DHCPv6 server pool name here. This name can be up to
12 characters long.

IPv6 Address / Prefix Length |Enter the IPv6 prefix address and prefix length of the local pool
here.

Assigned Length Enter the prefix length to be delegated to the user from the pool
here. The value of the assigned length cannot be less than the
value of the prefix length.

Click the Apply button to accept the changes made.

Click the Find button to locate a specific entry based on the information entered.
Click the User Detail button to view the user information displayed in the lower table.
Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

DHCPv6 Server Exclude Address

This window is used to specify IPv6 addresses that a DHCPv6 server should not assign to DHCPv6
clients. The DHCPV6 server assumes that all addresses (excluding the Switch’s IPv6 address) can be
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assigned to clients. Use this window to exclude a single IPv6 address or a range of IPv6 addresses.
The excluded addresses are only applied to the pool(s) for address assignment.

To view the following window, click Management > DHCP > DHCPv6 Server > DHCPv6 Server
Exclude Address, as shown below:

DHCPv6 Server Exclude Address

Low IPv6 Address 2013:1
High IPV6 Address po13:1

Total Entries: 1

1 20202100 2020:120

Figure 4-40 DHCPv6 Server Exclude Address Window

The fields that can be configured are described below:

Parameter Description

Low IPv6 Address Enter the excluded IPv6 address or first IPv6 address in the
excluded address range here.

High IPv6 Address Enter the last IPv6 address in the excluded address range here
(optional).

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

DHCPv6 Server Binding

This window is used to view and clear the DHCPvG6 server binding entries.

To view the following window, click Management > DHCP > DHCPv6 Server > DHCPv6 Server
Binding, as shown below:

DHCPv6 Server Binding

IPv6 Address CJAn | Find | [ clear |
Total Entries: 0
Client DUID IPv6 Address Preferred Lifetime Valid Lifetime

Figure 4-41 DHCPv6 Server Binding Window

The fields that can be configured are described below:

Parameter Description

IPv6 Address Enter the binding entry IPv6 address to be displayed or cleared
here. Select the All option to display or clear all DHCPv6 client
prefix bindings in or from the binding table.

Click the Find button to locate a specific entry based on the information entered.

Click the Clear button to clear the entries based on the information specified.
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DHCPv6 Server Interface Settings

This window is used to display and configure the DHCPvV6 server interface settings.

To view the following window, click Management > DHCP > DHCPv6 Server > DHCPv6 Server
Interface Settings, as shown below:

DHCPVE Serv

DHCPv6 Server Interface Settings
mereco VAN (14098 |
Rapid Commit Disabled v Preference (0-255) |:| [] Defautt [ ] Allow Hint
Total Entries: 1
vlan1 pooll Disabled 0 Ignore
1 [ 1| Go

Figure 4-42 DHCPvV6 Server Interface Settings Window

The fields that can be configured are described below:

Parameter Description

Interface VLAN Enter the interface VLAN ID here. The range is from 1 to 4094.

Pool Name Enter the DHCPv6 server pool name here. This name can be up to
12 characters long.

Rapid Commit Select to enable or disable two-message exchange here. By
default, two-message exchange is not allowed.

Preference Enter the preference value here. The range is from 0 to 255.
Select the Default option to use the default value.
Select the Allow Hint option to allow hints.

Interface Name Enter the interface name here.

Click the Apply button to accept the changes made.
Click the Find button to locate a specific entry based on the information entered.
Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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DHCPv6 Server Operational Information

This window is used to display the DHCPv6 server operational information.

To view the following window, click Management > DHCP > DHCPv6 Server > DHCPv6 Server
Operational Information, as shown below:

DACPYD Server Operational ormauon
DHCPv6E Server Operational Information

Total Entries: 1

DHCPv6 Pool: Pool

DNS server:

Domain name:

1n [ 1| [ [ee

Figure 4-43 DHCPv6 Server Operational Information Window

DHCP Relay
DHCP Relay Global Settings

This window is used to configure the smart relay feature of the DHCP relay agent.

To view the following window, click Management > DHCP > DHCP Relay > DHCP Relay Global
Settings, as shown below:

DHCP Relay Global Settings

DHCP Smart Relay State @ Disabled () Enabled

Figure 4-44 DHCP Relay Global Settings Window

The fields that can be configured are described below:

Parameter Description

DCHP Smart Relay State Select this option to enable or disable the DHCP smart relay.

Click the Apply button to accept the changes made.

DHCP Relay Pool Settings
This window is used to configure and display the DHCP relay pool on a DHCP relay agent.

To view the following window, click Management > DHCP > DHCP Relay > DHCP Relay Pool
Settings, as shown below:

DHCP Relay Pool Settings
DHCP Relay Pool Settings
Total Entries: 1
S BN B =R
DHCPpool Edit Edit Edit [ Delete |
1M S

Figure 4-45 DHCP Relay Pool Settings Window
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The fields that can be configured are described below:

Parameter Description

Pool Name Enter the address pool name with a maximum of 32 characters.

Click the Apply button to accept the changes made.
Click the Edit button to modify the corresponding information of the specific DHCP pool.
Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

After clicking the Edit button under Source, the following window will appear.

DHCP Relay Pool Source Settings

Pool Name DHCPpool
Total Entries: 1
soue s St e
10.90.2.10 255.0.0.0

Figure 4-46 DHCP Relay Pool Source Settings Window

The fields that can be configured are described below:

Parameter Description

Source IP Address Enter the source subnet of client packets.

Subnet Mask Enter the network mask of the source subnet.

Click the Apply button to accept the changes made.
Click the Delete button to remove the specified entry.

Click the Back button to return to the previous window.

After clicking the Edit button under Destination, the following window will appear.

DHCP Relay Pool Destination Settings

Fool Name DHCFpool

Relay Destination l:l Apply

Total Entries: 1

e
10.00.12.10

Figure 4-47 DHCP Relay Pool Destination Settings Window

The fields that can be configured are described below:

Parameter Description

Relay Destination Enter the IP address of the relay destination DHCP server here.

Click the Apply button to accept the changes made.
Click the Delete button to remove the specified entry.

Click the Back button to return to the previous window.
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After clicking the Edit button under Class, the following window will appear.

DHCP Relay Pool Class Settings

Pool Name DHCPpool

Class Name Please Select  [v]

Total Entries: 1

(e
DHCPClass Edit Delete

Figure 4-48 DHCP Relay Pool Class Settings Window

The fields that can be configured are described below:

Parameter Description

Class Name Select the DHCP class name.

Click the Apply button to accept the changes made.
Click the Edit button to edit more information.
Click the Delete button to remove the specified entry.

Click the Back button to return to the previous window.

After clicking the Edit button, the following window will appear.

DHCP Relay Pool Class Edit Settings
Pool Mame DHCPpool
Class Name DHCPClass
Total Entries: 1
Torget e ]
10.1.21

Figure 4-49 DHCP Relay Pool Class Edit Settings Window

The fields that can be configured are described below:

Parameter Description

Relay Target Enter the DHCP relay target for relaying packets that matches the
value pattern of the option defined in the DHCP class.

Click the Apply button to accept the changes made.
Click the Delete button to remove the specified entry.

Click the Back button to return to the previous window.
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DHCP Relay Information Settings

This window is used to configure and display the DHCP relay information.

To view the following window, click Management > DHCP > DHCP Relay > DHCP Relay
Information Settings, as shown below:

DHCP Relay Information Global

Information Trust All Disabled [=] Information Check Disabled [~]
Information Policy Replace Information Option Disabled

DHCP Relay Information

Total Entries: 1

T I N S A

viani Disabled Not Configured Not Configured Not Configured

17 l_ Go

Figure 4-50 DHCP Relay Information Settings Window

The fields that can be configured are described below:

Parameter Description

Information Trust All Select this option to enable or disable the DHCP relay agent to
trust the IP DHCP relay information for all interfaces.

Information Check Select this option to enable or disable the DHCP relay agent to
validate and remove the relay agent information option in the
received DHCP reply packet.

Information Policy Select the Option 82 re-forwarding policy for the DHCP relay agent.
Options to choose from are:

o Keep - Select to discard the packet that already has the
relay option.

e Drop - Select that the DHCP request packet that already has
the relay option is left unchanged and directly relayed to the
DHCP server.

o Replace - Select that the DHCP request packet that already
has the relay option will be replaced by a new option.

Information Option Select this option to enable or disable the insertion of relay agent
information (Option 82) during the relay of DHCP request packets.

Click the Apply button to accept the changes made.
Click the Edit button to modify the corresponding interface.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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DHCP Relay Information Option Format Settings

This window is used to configure and display the DHCP information format.

To view the following window, click Management > DHCP > DHCP Relay > DHCP Relay
Information Option Format Settings, as shown below:

DHCP Relay Information Option Format Global
Information Format Remote 1D
Information Format Circuit ID
DHCP Relay Information Option Format Type
Unit From Port To Port Format Type Value
[1 ~][eth1/011 [~] [eth1/01 ~] [vendor3 [~] [RemoteID [~] [32chars |
Unit 1 Settings
o o | Crooves |
eth1/0M1
eth1/0M1
eth1/0/2
eth1/0/2
eth1/0/3
eth1/0/3
eth1/0/4
eth1/0/4
eth1/0/5
eth1/0/5

Figure 4-51 DHCP Relay Information Option Format Settings Window

The fields that can be configured for DHCP Relay Information Option Format Global are described
below:

Parameter Description

Information Format Remote |Select the DHCP information remote ID sub-option. Options to
ID choose from are:

e Default - Select to use the Switch's system MAC address as
the remote ID.

e User Define - Select to use a user-defined remote ID. Enter
the user-defined string with the maximum of 32 characters in
the text box.

e Vendor2 - Select to use vender 2 as the remote ID.

¢ Vendor3 - Select to use vender 3 as the remote ID.

e Export UDF - Select to use the expert UDF remote ID.
Select the Standalone Unit Format after this selection here.

Information Format Circuit ID | Select the DHCP information circuit ID sub-option. Options to
choose from are:

e Default - Select to use the default circuit ID sub-option.

e User Define - Select to use a user-defined circuit ID. Enter
the user-defined string with the maximum of 32 characters in
the text box.

Vendor1 - Select to use vender 1 as the circuit ID.

Vendor2 - Select to use vender 2 as the circuit ID.

Vendor3 - Select to use vender 3 as the circuit ID.

Vendor4 - Select to use vender 4 as the circuit ID.

Vendor5 - Select to use vender 5 as the circuit ID.

Vendor6 - Select to use vender 6 as the circuit ID.

Export UDF - Select to use the expert UDF circuit ID. Select
the Standalone Unit Format after this selection here.

Click the Apply button to accept the changes made.
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The fields that can be configured for DHCP Relay Information Option Format Type are described

below:

Parameter Description

Unit

Select the switch unit that will be used for this configuration here.

From Port/ To Port

Select the appropriate port range used for the configuration here.

Format Select the DHCP information circuit ID format. Options to choose
from are Vendor3 and Expert UDF.

Type Select the DHCP information circuit ID format typ. Options to
choose from are Remote ID and Circuit ID.

Value Enter the vendor-defined string.

Click the Apply button to accept the changes made.

DHCP Relay Information Profile Settings

This window is used to display and configure the DHCP relay information profile settings.

To view the following window, click Management > DHCP > DHCP Relay > DHCP Relay
Information Profile Settings, as shown below:

DHCP Relay Information Option MAC Format

Case Uppercase (v
Delimiter Number
Example AABBCCDDEEFF
DHCP Relay Information Profile Settings
Total Entries: 1
11 [ 1| Go

Figure 4-52 DHCP Relay Information Profile Settings Window

The fields that can be configured in DHCP Relay Information Option MAC Format are described

below:

Parameter Description

Case

Select the case that will be used here. Options to choose from are:

Lowercase - Specifies that when using the lowercase format,
the Option 82 MAC address for the user-defined profile will
be formatted as: aa-bb-cc-dd-ee-ff.

Uppercase - Specifies that when using the uppercase
format, the Option 82 MAC address for the user-defined
profile username will be formatted as: AA-BB-CC-DD-EE-FF.

Delimiter

Select the delimiter that will be used here. Options to choose from
are:

Hyphen - Specifies that the format will be AA-BB-CC-DD-EE-
FF.

Colon - Specifies that the format will be
AA:BB:CC:DD:EE:FF.

Dot - Specifies that the format will be AA.BB.CC.DD.EE.FF.
None - Specifies that when not using any delimiter, the
format will be AABBCCDDEEFF.
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Parameter Description

Delimiter Number Select the delimiter number here. Options to choose from are:

e 1 - Single delimiter, the format is: AABBCC.DDEEFF.
e 2 - Double delimiters, the format is: AABB.CCDD.EEFF.
e 5 - Multiple delimiters, the format is: AA.BB.CC.DD.EE.FF.

Click the Apply button to accept the changes made.

The fields that can be configured in DHCP Relay Information Profile Settings are described below:

Parameter Description

Profile Name Enter the Option 82 profile name here. The profile can be used to
define the flexible, user-defined Option 82 entry.
Format String After clicking the Edit button, enter the user-defined DHCP Option

82 format string here. This string can be up to 251 characters long.
The following rules need to be considered:

¢ This string can be a hexadecimal value, an ASCII string, or
any combination of hexadecimal values and ASCII
characters. An ASCII string needs to be enclosed with
quotation marks (**) like “Ethernet”. Any ASCII characters
outside of the quotation marks will be interpreted as
hexadecimal values.

o A formatted key string is a string that should be translated
before being encapsulated in the packet. A formatted key
string can be contained both ASCII strings and hexadecimal
values. For example, “%” +“$”+“1~32"+ “keyword”+ “:”:

o % - Indicates that the string that follows this character
is a formatted key string.

o “$” or “0” - (Optional) Indicates a fill indicator. This
option specifies how to fill the formatted key string to
meet the length option. This option can be either “$” or
“0”, and cannot be specified as both at the same time.

= “$” - Indicates to fill the leading space (0x20).

= “0” - Indicates to fill the leading 0. The fill the
leading 0 (0) is the default setting.

o 1~32 - (Optional) Indicates a length option. This
specifies how many characters or bytes the translated
key string should occupy. If the actual length of the
translated key string is less than the length specified
by this option, a fill indicator will be used to fill it.
Otherwise, this length option and fill indicator will be
ignored and the actual string will be used directly.

o keyword - Indicates that the keyword will be translated
based on the actual value of the system. The following
keyword definitions specifies that a command will be
refused if an unknown or unsupported keyword is
detected:

= devtype - The model name of the device. Only
an ASCII string is allowed.

= syshame - Indicates the System name of the
Switch. Only an ASCII string is allowed.

= ifdescr - Derived from ifDescr (IF-MIB). Only an
ASCII string is allowed.

= portmac - Indicates the MAC address of a port.
This can be either an ASCII string or a
hexadecimal value. When in the format of an
ASCII string, the MAC address format can be
customized using special CLI commands. When
in the format of a hexadecimal value, the MAC
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Parameter Description

address will be encapsulated in order in
hexadecimal.

= sysmac - Indicates the system MAC address.
This can be either an ASCII string or a
hexadecimal value. In the ASCII string format,
the MAC address format can be customized
using special CLI commands. In the
hexadecimal format, the MAC address will be
encapsulated in order in hexadecimal.

= unit - Indicates the unit ID. This can be either an
ASCII string or a hexadecimal value. For a
standalone device, the unit ID is 0.

= module - Indicates the module ID number. This
can be either an ASCII string or a hexadecimal
value.

= port - Indicates the local port number. This can
be either an ASCII string or a hexadecimal
value.

= svlan - Indicates the outer VLAN ID. This can
be either an ASCII string or a hexadecimal
value.

= cvlan - Indicates the inner VLAN ID. This can
be either an ASCII string or a hexadecimal
value.

o : - Indicates the end of the formatted key sting. If a
formatted key string is the last parameter of the
command, its ending character (“:”) can be ignored.
The space (0x20) between “%” and “:” will be ignored.

Other spaces will be encapsulated.

e ASCII strings can be any combination of formatted key
strings and 0~9, a~z, A~Z, |@#3$%"&*()_+|-=\[I{};:"/?.,<>",
and space characters. “\” is the escape character. The
special character after “\” is the character itself, for example,
“%” is “%” itself, not the start indicator of a formatted key
string. Spaces not in the formatted key string will also be
encapsulated.

¢ Hexadecimal values can be any combination of formatted key
strings and 0~9, A~F, a~f, and space characters. The
formatted key strings only support keywords that support
hexadecimal values. Spaces not in the formatted key string
will be ignored.

Click the Apply button to accept the changes made.

Click the Find button to locate a specific entry based on the information entered.
Click the Edit button to re-configure the specific entry.

Click the Delete button to delete the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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DHCP Local Relay VLAN

This window is used to configure local relay on a VLAN or a group of VLANS.

To view the following window, click Management > DHCP > DHCP Relay > DHCP Local Relay
VLAN, as shown below:

DHCP Local Relay VLAN Settings

DHCP Local Relay VID List [ All VLANS State  [Disabled =]

DHCP Local Relay VID List 1

Figure 4-53 DHCP Local Relay VLAN Window

The fields that can be configured are described below:

Parameter Description

DHCP Local Relay VID List Enter the VLAN ID for DHCP local relay. Tick the All VLANs check
box to select all VLANSs.

State Select this option to enable or disable the DHCP local relay on the
specific VLAN(s).

Click the Apply button to accept the changes made.

DHCPv6 Relay
DHCPv6 Relay Global Settings

This window is used to configure the DHCPVG6 relay remote ID.

To view the following window, click Management > DHCP > DHCPv6 Relay > DHCPv6 Relay
Global Settings, as shown below:

DHCPvE Relay Global Settings

IPvG DHCF Relay Remote 1D Format [Default ]

IPvé DHCP Relay Remote ID UDF [ascll [v] [128 chars

IPvé DHCP Relay Remote ID Policy Keep ﬂ

IPv6 DHCP Relay Remote ID Option Disabled ~]

Figure 4-54 DHCPv6 Relay Global Settings Window

The fields that can be configured are described below:

Parameter Description

IPvé DHCP Relay Remote ID |Select to choose the sub-type of the remote ID. Options to choose

Format from are Default, CID With User Define, and User Define.
IPvé DHCP Relay Remote ID |Select to choose the User Define Field (UDF) for remote ID.
UDF Options to choose from are:

e ASCII - Select to enter the ASCII string with a maximum of
128 characters in the text box.

e HEX - Select to enter the hexadecimal string with a
maximum of 256 characters in the text box.

IPvé DHCP Relay Remote ID |Select to choose Option 37 forwarding policy for the DHCPV6 relay
Policy agent. Options to choose from are:
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Parameter Description

o Keep - Select to discard the packet that already has the
relay agent Remote-ID Option 37.

e Drop - Select that the DHCPV6 request packet that already
has the relay agent Remote-ID option is left unchanged and
directly relayed to the DHCPV6 server.

IPvé DHCP Relay Remote ID |Select this option to enable or disable the insertion of the relay
Option agent remote ID Option 37 during the relay of DHCP for IPv6
request packets.

Click the Apply button to accept the changes made.

DHCPv6 Relay Interface Settings

This window is used to configure and display the DHCPV6 relay interface settings.

To view the following window, click Management > DHCP > DHCPv6 Relay > DHCPv6 Relay
Interface Settings, as shown below:

DHCPv6 Relay Interface Settings

Interiace VLAN (1-4094)
Destination |PvE Address

Output Interface VLAN (1-4004) |:|
inetace VLAN (14094 —
Total Entries: 1
Destination IPv6 Address Qutput Interface _
vian1 2012::100 vian2

1N [ [es

Figure 4-55 DHCPv6 Relay Interface Settings Window

The fields that can be configured are described below:

Parameter Description

Interface VLAN Enter the VLAN from 1 to 4094 for DHCPVG6 relay.

Destination IPv6 Address Enter the DHCPv6 relay destination address.

Output Interface VLAN Enter the output interface for the relay destination.

Click the Apply button to accept the changes made.
Click the Find button to locate a specific entry based on the information entered.
Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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DHCP Auto Configuration

DNS

This window is used to configure the DHCP auto-configuration function.

To view the following window, click Management > DHCP > DHCP Auto Configuration, as shown
below:

DHCP Auto Configuration

Auto Configuration State Enabled @ Disabled Apply

MNote: If autoconfig State enabled, it won't take effect unfil reboot.

Figure 4-56 DHCP Auto Configuration Window

The fields that can be configured are described below:

Parameter Description
Auto Configuration State Select this option to enable or disable the auto-configuration
function.

Click the Apply button to accept the changes made.

Computer users usually prefer to use text names for computers for which they may want to open a
connection. Computers themselves, require 32-bit IP addresses. Somewhere, a database of network
devices’ text names and their corresponding IP addresses must be maintained.

The Domain Name System (DNS) is used to map names to IP addresses throughout the Internet and
has been adapted for use within intranets. For two DNS servers to communicate across different
subnets, the DNS Relay of the Switch must be used. The DNS servers are identified by IP addresses.

Mapping Domain Names to Addresses

Name-to-address translation is performed by a program called a Name server. The client program is
called a Name resolver. A Name resolver may need to contact several Name servers to translate a
name to an address.

The Domain Name System (DNS) servers are organized in a somewhat hierarchical fashion. A single
server often holds names for a single network, which is connected to a root DNS server - usually
maintained by an ISP.

Domain Name Resolution

The domain name system can be used by contacting the name servers one at a time, or by asking the
domain name system to do the complete name translation. The client makes a query containing the
name, the type of answer required, and a code specifying whether the domain name system should
do the entire name translation, or simply return the address of the next DNS server if the server
receiving the query cannot resolve the name.

When a DNS server receives a query, it checks to see if the name is in its sub domain. If it is, the
server translates the name and appends the answer to the query, and sends it back to the client. If the
DNS server cannot translate the name, it determines what type of name resolution the client
requested. A complete translation is called recursive resolution. This requires the server to contact
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DNS

DNS

other DNS servers until the name is resolved. Iterative resolution specifies that if the DNS server
cannot supply an answer, it will return the address of the next DNS server the client contacted.

Each client must be able to contact at least one DNS server, and each DNS server must be able to
contact at least one root server.

The address of the machine that supplies domain name service is often supplied by a DHCP or
BOOTP server, or can be entered manually and configured into the operating system at startup.

Global Settings

This window is used to configure the DNS global settings.

To view the following window, click Management > DNS > DNS Global Settings, as shown below:

DNS Global Settings

IP Domain Lookup Disabled [v]

IP Name Server Timeout (1-60) sec

Figure 4-57 DNS Global Settings Window

The fields that can be configured are described below:

Parameter Description

IP Domain Lookup Select this option to enable or disable the DNS to carry out the
domain name resolution.

IP Name Server Timeout Enter the maximum time to wait for a response from a specified
name server. This value is between 1 and 60 seconds.

Click the Apply button to accept the changes made.

Name Server Settings

This window is used to configure and display the IP address of a domain name server.

To view the following window, click Management > DNS > DNS Name Server Settings, as shown
below:

DNS Name Server Settings
| Name Server IPv6 22331 Apply
Total Entries: 2
I
192 168.5.134
50152

Figure 4-58 DNS Name Server Settings Window
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The fields that can be configured are described below:

Parameter Description

Name Server IPv4 Select and enter the IPv4 address of the DNS server.

Name Server IPv6 Select and enter the IPv6 address of the DNS server.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

DNS Host Settings

This window is used to configure the static mapping entry for the host name and the IP address in the
host table.

To view the following window, click Management > DNS > DNS Host Settings, as shown below:

DNS Host Settings

Static Host Settings

Host Name

@ IP Address

Static Total Entries: 1
Dynamic Total Entries: 0
I O N
DNSHost 192.168.0.100 forever
1n [ [eo

Figure 4-59 DNS Host Settings Window

The fields that can be configured are described below:

Parameter Description

Host Name Enter the host name of the equipment.
IP Address Select and enter the IPv4 address of the equipment.
IPv6 Address Select and enter the IPv6 address of the equipment.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.
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NTP

NTP Global Settings

This window is used to view and configure the Network Time Protocol (NTP) global settings.

To view the following window, click Management > NTP > NTP Global Settings, as shown below:

oba etangs

NTP State

NTP State ()Enabled (@ Disabled
NTP Authentication State

MTP Authentication State @ Enabled () Disabled
NTP Update Calendar

NTF Update Calendar (OEnabled (@) Disabled
NTP Settings

NTP Master Stratum (1-15) |:| Default

NTP Max Associations (1-64)

Figure 4-60 NTP Global Settings Window

The fields that can be configured for NTP State are described below:

Parameter Description

NTP State Select the NTP feature’s global state here. Options to choose from
are Enabled and Disabled.

Click the Apply button to accept the changes made.

The fields that can be configured for NTP Authentication State are described below:

Parameter Description

NTP Authentication State Select the NTP feature’s authentication state here. Options to
choose from are Enabled and Disabled.

Click the Apply button to accept the changes made.

The fields that can be configured for NTP Update Calendar are described below:

Parameter Description

NTP Update Calendar Select the NTP feature’s update calendar state here. Options to
choose from are Enabled and Disabled.

Click the Apply button to accept the changes made.

The fields that can be configured for NTP Settings are described below:

Parameter ‘ Description

NTP Master Stratum Enter the NTP master stratum value here. This value must be
between 1 and 15. Select the Default option to use the default
value.

NTP Max Associations Enter the NTP maximum amount of associations here. This value
must be between 1 and 64.
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Click the Apply button to accept the changes made.

NTP Server Settings

This window is used to view and configure the NTP server’s settings.

To view the following window, click Management > NTP > NTP Server Settings, as shown below:

P Server e 0

NTP Server Settings

@ IP Address | = = = ] () IPV6 Address 23371
versn (14 T I
i -1 — T
TR
Total Entries: 1

N S T N

10.90.90.123 1 1 False [3 10

1 [ 1| [ leo

Figure 4-61 NTP Server Settings Window

The fields that can be configured are described below:

Parameter Description

IP Address Select and enter the NTP server’'s IPv4 address here.

IPv6 Address Select and enter the NTP server’'s IPv6 address here.

Version Enter the NTP server’s version number here. This value must be
between 1 and 4.

Key ID Enter the authentication key ID here. This ID must be between 1
and 255.

Min Poll Enter the minimum poll intervals for NTP messages here. This
value must be between 3 and 16 seconds.

Max Poll Enter the maximum poll intervals for NTP messages here. This
value must be between 4 and 17 seconds.

Prefer Select whether this server is the preferred server in the list or not.
Options to choose from are True and False.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.
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NTP Peer Settings

This window is used to view and configure the NTP peer settings.

To view the following window, click Management > NTP > NTP Peer Settings, as shown below:

NTP Peer Settings
@ IP Address | = = o ] () IP6 Address 23321
versn (10 — T —
o1 210 S T
Total Entries: 1
T N S T T N B
10.90.90.55 4 1 False 6 10
1n E ES

Figure 4-62 NTP Peer Settings Window

The fields that can be configured are described below:

Parameter Description

IP Address Select and enter the NTP peer’s IPv4 address here.

IPv6 Address Select and enter the NTP peer’s IPv6 address here.

Version Enter the NTP peer’s version number here. This value must be
between 1 and 4.

Key ID Enter the authentication key ID here. This ID must be between 1
and 255.

Min Poll Enter the minimum poll intervals for NTP messages here. This
value must be between 3 and 16 seconds.

Max Poll Enter the maximum poll intervals for NTP messages here. This
value must be between 4 and 17 seconds.

Prefer Select whether this peer is the preferred peer in the list or not.
Options to choose from are True and False.

Click the Apply button to accept the changes made.

Click the Delete button to remove

the specified entry.
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NTP Access Group Settings

This window is used to view and configure the NTP access group settings.

To view the following window, click Management > NTP > NTP Access Group Settings, as shown
below:

NTP Access Group Settings

(e) Default

(1P Address |:| Netmask |:|

) IPY6 Address IPv6 Mask 1

[Jignore [ |NoServe [|NoTrust []Version [ |NoPeer [ |NoQuery [_]Mo Modify

Total Entries: 1

e
defautt No Modify No Query [ edit |[ pelete |

M [ 1| ED

Figure 4-63 NTP Access Group Settings Window

The fields that can be configured are described below:

Parameter ‘ Description

Default Select this option to specify that a default entry (address 0.0.0.0,
mask 0.0.0.0) will always be included and is the lowest priority in
the list.

IP Address Select and enter the IPv4 address of the host or network here.

Netmask Select and enter the IPv4 network mask of the host or network
here.

IPv6 Address Select and enter the IPv6 address of the host or network here.

IPv6 Mask Select and enter the IPv6 network mask of the host or network
here.

Ignore Select this option to ignore all NTP related packets.

No Serve Select this option to deny all NTP related packets, except for NTP
control queries.

No Trust Select this option to deny all NTP related packets that are not
cryptographically authenticated.

Version Select this option to deny all NTP related packets that don’t match
the current NTP version.

No Peer Select this option to deny all NTP related packets that might
mobilize an association unless authenticated.

No Query Select this option to deny all NTP control queries.

No Modify Select this option to deny NTP control queries that attempted to
modify the state of the server.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.
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NTP Key Settings

This window is used to view and configure the NTP key settings.

To view the following window, click Management > NTP > NTP Key Settings, as shown below:

NTP Control Key
NTP Request Key
NTP Key Settings

Key1o (1259 I

Total Entries: 1

T T B R S R

] 1 MD5 01234567890123456789012345678901
el -

Figure 4-64 NTP Key Settings Window

The fields that can be configured for NTP Control Key are described below:

Parameter Description

NTP Control Key Enter the NTP control key here. This key must be between 1 and
255. Select the None option not to use an NTP control key.

Click the Apply button to accept the changes made.

The fields that can be configured for NTP Request Key are described below:

Parameter Description

NTP Request Key Enter the NTP request key here. This key must be between 1 and
255. Select the None option not to use an NTP request key.

Click the Apply button to accept the changes made.

The fields that can be configured for NTP Key Settings are described below:

Parameter Description

Key ID Enter the NTP key number here. This authentication key number
must be between 1 and 255.

MD5 Enter the MD5 NTP key here. This key can be up to 32 characters
long.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.
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NTP Interface Settings

This window is used to view and configure the NTP interface settings.

To view the following window, click Management > NTP > NTP Interface Settings, as shown below:

NTP Interface Settings

Total Entries: 1

ot e T
viani Enabled

(1] il [ leo

Figure 4-65 NTP Interface Settings Window

The fields that can be configured are described below:

Parameter Description

NTP State After click the Edit button, select the NTP feature’s state on the
interface specified. Options to choose from are Enabled and
Disabled.

Click the Apply button to accept the changes made.

NTP Associations

This window is used to view a list of NTP associations.

To view the following window, click Management > NTP > NTP Associations, as shown below:

O ALIONS

NTP Associations

Total Entries: 2

T T T T e
64 0

+10.90.90.55 0.0.0.0 16 0.00000 0000000  4.00000
=10.00.90.123 0.0.0.0 16 64 0 0.00000  0.000000  4.00000
1n [ 1| Go

Note: + Symmetric Active, - Symmetric Passive, = Client, * System Peer

Figure 4-66 NTP Associations Window
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Click the Detail button, next to the specified entry, to view more information about the NTP
association, as shown below:

NTP Associations

Remote 10.90.90.55 Local 0.0.0.0

Qur mode sym_active Peer mode unspec

Stratum 16 Precision -7

Leap 11 ReflD [INIT]

RootDistance 0.00000 RootDispersion 0.00000

PPoll 10 HPall [

KeylD 1 Version 4

Associafion 8356 Reach 000

Unreach 0 Flash 0x1400

Timer 42940572275 Flags Config

Reference Time 00000000.00000000 Thu, Feb 7. Originate Timestamp 00000000.00000000 Thu, Feb 7...
Receive Timestamp 00000000.00000000 Thu, Feb 7. Transmit Timestamp 00000000.00000000 Thu, Feb 7...
Filter Delay 0.00000, 0.00000 , 0.00000, ... Filter Offset 0.000000. 0.000000, 0.000000, ...
Filter Order 7.6,54,321,0 Dffset 0.000000

Delay 0.00000 Error Bound 4.00000

Filter Error 0.08838

NTP Status

This window is used to view NTP status information.

Figure 4-67 NTP Associations (Detail) Window

To view the following window, click Management > NTP > NTP Status, as shown below:

[ LLI

NTP Status
Leap Indicator Unsynchronized
Stratum 16
Precision -8
Root Distance 0.00000 s
Root Dispersion 0.00000 s
Reference ID [STEF]
Reference Time 00000000.00000000 Thu, Feb 7 2036 6:28:16.00000
System Flags Monitor NTF Kernel Stats
Jitter 0.003906 5
Stability 0.000 ppm
Auth Delay 0.000000 =

Figure 4-68 NTP Status Window

IP Source Interface

This window is used to configure the IP source interface settings.

To view the following window, click Management > IP Source Interface, as shown below:

IP TFTP Source Interface

Source Interface State Disabled ji
Interface Type VLAN v VID (1-4094) ] L Aeoly |

Figure 4-69 IP Source Interface Window
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The fields that can be configured are described below:

Parameter Description

Source Interface State Select to Enable or Disable the source interface feature’s global
state here.

Interface Type After enabling the Source Interface State option, select the
interface type here. The only option available is VLAN.

VID (1-4094) After selecting the VLAN as the Interface Type, enter the VLAN ID
used here. This value must be between 1 and 4094.

Click the Apply button to accept the changes made.

File System

Why use flash file system?

In old switch system, the firmware, configuration, and log information are saved in a flash with fixed
addresses and size. This means that the maximum configuration file can only be 2Mb, and even if the
current configuration is only 40Kb, it will still take up 2Mb of flash storage space. The configuration file
number and firmware numbers are also fixed. A compatible issue will occur in the event that the
configuration file or firmware size exceeds the originally designed size.

Flash File System (FFS) in our system:

The Flash File System is used to provide the user with flexible file operation on the Flash. All the
firmware, configuration information, and system log information are stored in the Flash as files. This
means that the Flash space taken up by all the files are not fixed, it is the real file size. If the Flash
space is enough, the user could download more configuration files or firmware files and use
commands to display Flash file information, rename file names, and delete it. Furthermore, the user
can also configure the boot up runtime image or the running configuration file if needed.

To view this window, click Management > File System as shown below:

pam e |
Copy

oo e o s o
c 29 FFS

Flash

Figure 4-70 File System Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

Path Enter the path string

Click the Go button to navigate to the path entered.
Click the c: hyperlink to navigate the C: drive.
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After clicking the c: hyperlink, the following window will appear:

T

Unit 1 [v]
path e |
| Previous | | Create Directory | | Copy |
I T T S
1 9892088 Jan 012000 00:35:22 Run-1.70.004.had [ Bootup |[ Rename |[ Delete |
2 RUN() - 9892484 Jan 012000 00:08:30 Run-1.70.005 had BootUp || Rename |[ Delete |
3 CFG(%) - 1534 Jan 012000 00:12:06 config.cfg BootUp | Rename || Delete |
4 d- 0 Jan 01 2000 00:00:02 system
30656000 byles total (10206208 bytes free)
{*) -with boot up info

Figure 4-71 File System - Search for Drive Window

Click the Previous button to return to the previous window.
Click the Create Directory button to create a new directory within the file system of the Switch.

Click the Copy button to copy a specific file to the Switch.
Click the Boot Up button to set a specific runtime image as the boot up image.
Click the Rename button to rename a specific file’s name.

Click the Delete button to remove a specific file from the file system.

Click the Copy button to see the following window.

e e |
Copy File
Source Unit | | [startup-config  [+] [Cconfig cig |
Destination Unit | | | running-config E|| |C'-’cnnﬂg cfg | [F]Replace
[ Apply ] [ Cancel

Figure 4-72 File System - Copy Window

When copying a file to the file system of this switch, the user must enter the Source and Destination
path. Tick the Replace check box to replace the current running configuration with the indicated
configuration file.

Click the Apply button to initiate the copy.

Click the Cancel button the discard the process.

Physical Stacking

The Switch supports switch stacking, where a set of six switches can be combined and managed by
one IP address through Telnet, the Web Ul, the RJ45 console port, or through SNMP. Each switch of
this series has two stacking ports located at the front of the device, which can be used to connect
other devices and make them stack together. After adding these stacking ports, the user may connect
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these ports together using fiber cables or Direct Attach Cables (DAC) in one of two possible

topologies.

Duplex Chain -The Duplex Chain topology stacks switches together in a chain-link format.

Using this method, data transfer is only possible in one direction and if there is a break in the
chain, then data transfer will obviously be affected.

Duplex Ring -The Duplex Ring stacks switches in a ring or circle format where data can be

transferred in two directions. This topology is very resilient because if there is a break in the
ring, data can still be transferred through the stacking cables between switches in the stack.
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Figure 4-73 Switches stacked in a Duplex Chain
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Figure 4-74 Switches stacked in a Duplex Ring

Within each of these topologies, each switch plays a role in the Switch stack. These roles can be set
by the user per individual Switch, or if desired, can be automatically determined by the Switch stack.
Three possible roles exist when stacking with the Switch.

Primary Master - The Primary Master is the leader of the stack. It will maintain normal operations,

monitor operations and the running topology of the Stack. This switch will also assign Stack Unit IDs,
synchronize configurations, and transmit commands to remaining switches in the switch stack. The

Primary Master can be configured manually by assigning the Switch the highest priority (a lower
number denotes a higher priority) before physically assembling the stack or it can be determined
automatically, by the stack, through an election process which determines the lowest MAC address
and will assign that switch as the Primary Master, if all priorities are the same. The Primary master are
physically displayed by the seven segment LED to the far right on the front panel of the switch where
this LED will flash between its given Box ID and ‘H’.

Backup Master - The Backup Master is the backup to the Primary Master, and will take over the
functions of the Primary Master if the Primary Master fails or is removed from the Stack. It also
monitors the status of neighboring switches in the stack, will perform commands assigned to it by the
Primary Master and will monitor the running status of the Primary Master. The Backup Master can be
set by the user by assigning this Switch the second highest priority before physically assembling the
stack, or it can be determined automatically by the stack through an election process that determines
the second lowest MAC address and then will assign that switch as the Backup Master, if all priorities
are the same. The Backup master are physically displayed by the seven segment LED to the far right
on the front panel of the switch where this LED will flash between its given Box ID and ‘h’.

Slave - Slave switches constitute the rest of the switch stack and although not Primary or Backup
Masters, they can be placed into these roles when these other two roles fail or are removed from the
stack. Slave switches perform operations requested by the master, monitor the status of neighbor
switches in the stack and the stack topology, and adhere to the Backup Master’'s commands once it

becomes a Primary Master. Slave switches will do a self-check to determine if it is to become the

Backup Master if the Backup Master is promoted to the Primary Master, or if the Backup Master fails
or is removed from the switch stack. If both Primary and Backup masters fail, or are removed from the
Switch stack, it will determine if it is to become the Primary Master. These roles will be determined,
first by priority and if the priority is the same, the lowest MAC address.
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Once switches have been assembled in the topology desired by the user and powered on, the stack
will undergo three processes until it reaches a functioning state.

Initialization State - This is the first state of the stack, where the runtime codes are set and initialized
and the system conducts a peripheral diagnosis to determine each individual switch is functioning

properly.
Master Election State - Once the codes are loaded and initialized, the stack will undergo the Master

Election State where it will discover the type of topology used, elect a Primary Master and then a
Backup Master.

Synchronization State - Once the Primary Master and the Backup Master have been established,
the Primary Master will assign Stacking Unit IDs to switches in the stack, synchronize configurations
for all switches and then transmit commands to the rest of the switches based on the users
configurations of the Primary Master.

Once these steps have been completed, the switch stack will enter a normal operating mode.

Stack Switch Swapping

The stacking feature of the Switch supports “hot swapping” of switches in and out of the running
stack. Users may remove or add switches to the stack without powering down or largely affecting the
transfer of data between switches in the stack, with a few minor provisions.

When switches are “hot inserted” into the running stack, the new switch may take on the Primary
Master, Backup Master or Slave role, depending on configurations set on the newly added switch,
such as configured priority or MAC address. Yet, if adding two stacks together that have both
previously undergone the election process, and therefore both have a Primary Master and a Backup
master, a new Primary Master will be elected from one of the already existing Primary Masters, based
on priority or MAC address. This Primary Master will take over all of the Primary Master’s roles for all
new switches that were hot inserted. This process is done using discovery packets that circulate
through the switch stack every 1.5 seconds until the discovery process has been completed.

The “hot remove” action means removing a device from the stack while the stack is still running. The
hot removal is detected by the stack when it fails to receive heartbeat packets during its specified
interval from a device, or when one of the stacking ports links is down. Once the device has been
removed, the remaining switches will update their stacking topology database to reflect the change.
Any one of the three roles, Primary Master, Backup Master, or Slave, may be removed from the stack,
yet different processes occur for each specific device removal.

If a Slave device has been removed, the Primary Master will inform other switches of the hot remove
of this device through the use of unit leave messages. Switches in the stack will clear the
configurations of the unit removed. Dynamically learned databases, such as ARP, will also be cleared.

If the Backup Master has been hot removed, a new Backup Master will be chosen through the
election process previously described. Switches in the stack will clear the configurations of the unit
removed. Dynamically learned databases, such as ARP, will also be cleared. Then the Backup Master
will begin backing up the Primary Master when the database synchronization has been completed by
the stack.

If the Primary Master is removed, the Backup Master will assume the Primary Master’s role and a new
Backup Master will be chosen using the election process. Switches in the stack will clear the
configurations of the unit removed. Dynamically learned databases, such as ARP, will also be cleared.
The new Primary Master will inherit the MAC and IP address of the previous Primary Master to avoid
conflict within the stack and the network itself.

If both the Primary Master and the Backup Master are removed, the election process is immediately
processed, and a new Primary Master and Backup Master are determined. Switches in the stack will
clear the configurations of the units removed, and dynamically learned databases, such as ARP, will
be cleared as well. Static switch configurations still remain in the database of the remaining switches
in the stack and those functions will not be affected.

NOTE: If there is a Box ID conflict when the stack is in the discovery phase, the device
L4 will enter a special standalone topology mode. Users can only get device
information, configure Box IDs, save and reboot. All stacking ports will be
A disabled and an error message will be produced on the local console port of
each device in the stack. Users must reconfigure Box IDs and reboot the stack.
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Physical Stacking
Stacking Mode @ Enabled () Disabled
Stack Preempt @ Enabled () Disabled
Trap State () Enabled  (® Disabled
Stack ID
Current Unit 1D 1 v| New Box ID Auto v Priority (1-63) | [ apply
Topology: Duplex_Chain My Box ID: 1
Master ID: 1 BK Master 1D:
Box Count:
m e ) B e M BT
Auto DGS-1510-28XMP Exist 3C-1E-04-A1-BS-EQ 1.00.016 1.70.005
2 NOT_EXIST Mo
3 NOT_EXIST Mo
4 = NOT_EXIST Mo
5 NOT_EXIST Mo
i} NOT_EXIST Mo

Figure 4-75 Physical Stacking Window

The fields that can be configured for Physical Stacking are described below:

Parameter Description

Stacking Mode Select this option to enable or disable the stacking mode.

Stack Preempt Select this option to enable or disable preemption of the master
role to come into play when a unit with a better priority is added to
the Switch later.

Trap State Select this option to enable or disable sending of stacking related
traps.

Click the Apply button to accept the changes made.

The fields that can be configured for Stack ID are described below:

Parameter Description

Current Unit ID Select the unit ID of the switch in the stack.

New Box ID Select the new box ID for the switch that is selected in the Current
Unit ID. The user may choose any number between 1 and 6 to
identify the switch in the switch stack. Auto will automatically
assign a box number to the switch in the switch stack.

Priority Enter the priority of the Switch stacking unit. The range is from 1 to
63.

Click the Apply button to accept the changes made.

Virtual Stacking (SIM)

D-Link Single IP Management (SIM) is a concept that will stack switches together over Ethernet
instead of using stacking ports or modules. There are some advantages in implementing the Single IP
Management feature:

e SIM can simplify management of small workgroups or wiring closets while scaling the network
to handle increased bandwidth demand.

e SIM can reduce the number of IP address needed in your network.

94



DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

SIM can eliminate any specialized cables for stacking connectivity and remove the distance
barriers that typically limit your topology options when using other stacking technology.

Switches using D-Link Single IP Management (labeled here as SIM) must conform to the following

rules:

SIM is an optional feature on the Switch and can easily be enabled or disabled through the
Command Line Interface or Web Interface. SIM grouping has no effect on the normal operation
of the Switch in the user’s network.

There are three classifications for switches using SIM. The Commander Switch (CS), which is
the master switch of the group, Member Switch (MS), which is a switch that is recognized by
the CS a member of a SIM group, and a Candidate Switch (CaS), which is a Switch that has a
physical link to the SIM group but has not been recognized by the CS as a member of the SIM
group.

A SIM group can only have one Commander Switch (CS).

A SIM group accepts up to 32 switches (numbered 1-32), not including the Commander Switch
(numbered 0).

Members of a SIM group cannot cross a router.

There is no limit to the number of SIM groups in the same IP subnet (broadcast domain);
however, a single switch can only belong to one group.

If multiple VLANSs are configured, the SIM group will only utilize the management VLAN on any
switch.

SIM allows intermediate devices that do not support SIM. This enables the user to manage
switches that are more than one hop away from the CS.

The SIM group is a group of switches that are managed as a single entity. The Switch may take on
three different roles:

Commander Switch (CS) - This is a switch that has been manually configured as the
controlling device for a group, and takes on the following characteristics:

o It has an IP Address.
o ltis not a command switch or member switch of another Single IP group.
o Itis connected to the member switches through its management VLAN.

Member Switch (MS) - This is a switch that has joined a single IP group and is accessible from
the CS, and it takes on the following characteristics:

o ltis nota CS or MS of another IP group.
o ltis connected to the CS through the CS management VLAN.

Candidate Switch (CaS) - This is a switch that is ready to join a SIM group but is not yet a
member of the SIM group. The Candidate Switch may join the SIM group of the Switch by
manually configuring it to be a MS of a SIM group. A switch configured as a CaS is not a
member of a SIM group and will take on the following characteristics:

o ltis nota CS or MS of another Single IP group.

o lItis connected to the CS through the CS management VLAN

The following rules also apply to the above roles:

Each device begins in a Candidate state.

A CS must change its role to CaS and then to MS, to become a MS of a SIM group. Thus, the
CS cannot directly be converted to a MS.

The user can manually configure a CS to become a CaS.
A MS can become a CaS by:
o Being configured as a CaS through the CS.
o If report packets from the CS to the MS time out.
The user can manually configure a CaS to become a CS
The CaS can be configured through the CS to become a MS.
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After configuring one switch to operate as the CS of a SIM group, additional DGS-1510 Series
switches may join the group by manually configuring the Switch to be a MS. The CS will then serve as
the in band entry point for access to the MS. The CS’s IP address will become the path to all MS’s of
the group and the CS’s Administrator’s password, and/or authentication will control access to all MS’s
of the SIM group.

With SIM enabled, the applications in the CS will redirect the packet instead of executing the packets.
The applications will decode the packet from the administrator, modify some data, and then send it to
the MS. After execution, the CS may receive a response packet from the MS, which it will encode and
send it back to the administrator.

When a CaS becomes a MS, it automatically becomes a member of the first SNMP community
(includes read/write and read only) to which the CS belongs. However, if a MS has its own IP
address, it can belong to SNMP communities to which other switches in the group, including the CS,
do not belong.

Upgrade to Version 1.61

To better improve SIM management, the DGS-1510 Series switches have been upgraded to version
1.61 in this release. Many improvements have been made, including the Commander Switch (CS)
now having the capability to automatically rediscover member switches that have left the SIM group,
either through a reboot or web malfunction. This is accomplished through the use of Discover packets
and Maintenance packets that previously configured SIM members will send and receive after a
reboot. Once a MS has had its MAC address and password saved to the CS’s database, if a reboot
occurs in the MS, the CS will keep this MS information in its database and when a MS has been
rediscovered, it will add the MS back into the SIM tree automatically. No configuration will be
necessary to rediscover these switches.

There are some instances where pre-saved MS Switches cannot be rediscovered. For example, if the
Switch is still powered down, if it has become the member of another group, or if it has been
configured to be a Commander Switch, the rediscovery process cannot occur.

The topology map now includes new features for connections that are a member of a port trunking
group. It will display the speed and number of Ethernet connections creating this port trunk group.
e Firmware - The switch now supports MS firmware downloads from a TFTP server.

e Configuration Files - This switch now supports downloading and uploading of configuration
files both to (for configuration restoration) and from (for configuration backup) MS’s, using a
TFTP server.

e Log - The Switch now supports uploading MS log files to a TFTP server.

The user may zoom in and zoom out when utilizing the topology window to get a better, more defined
view of the configurations.
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Single IP Settings

This window is used to configure the SIM settings. The Switch is set as a Candidate (CaS) as the
factory default configuration and Single IP Management is disabled.

To view the following window, click Management > Virtual Stacking (SIM) > Single IP Settings, as

shown below:

gle IF 3 (S
SIM State Configure

SIM State

SIM Role Configure

Role State

Group Name

SIM Settings

Trap State

Interval (30-90)

Hold Time (100-255)
Management VLAN (1-4094)

Disabled ]
Candidate (v
Disabled [v]

Figure 4-76 Single IP Settings Window

The fields that can be configured for SIM State Configure are described below:

Parameter

Description

SIM State

Select this option to enable or disable the SIM state on the Switch.
Select Disabled to render all SIM functions on the Switch
inoperable.

Click the Apply button to accept the changes made.

The fields that can be configured for SIM Role Configure are described below:

Parameter Description

Role State

Select to change the SIM role of the Switch. Options to choose
from are:

e Candidate - A Candidate Switch (CaS) is not the member of
a SIM group but is connected to a Commander Switch. This
is the default setting for the SIM role of the Switch.

e Commander - Select to make the Switch a Commander
Switch (CS). The user may join other switches to this Switch,
over Ethernet, to be part of its SIM group. Choosing this
option will also enable the Switch to be configured for SIM.

Group Name

Enter a group name. This is optional. This name is used to segment
switches into different SIM groups.

Click the Apply button to accept the changes made.

The fields that can be configured for SIM Settings are described below:

Parameter Description

Traps State

Select to enable or disable the SIM trap state.

Interval

Enter the interval in seconds. The range is from 30 to 90.

Hold Time

Enter the hold-time in seconds. The range is from 100 t0255.
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Parameter

Management VLAN

Description

Enter the single IP management message VLAN ID.

Click the Apply button to accept the changes made.

After enabling the Switch to be a Commander Switch (CS), the Single IP Management folder will
then contain four added links to aid the user in configuring SIM through the web, including Topology,
Firmware Upgrade, Configuration Backup/Restore, and Upload Log File.

Topology

This window is used to configure and manage the Switch within the SIM group.

File

To view the following window, click Management > Virtual Stacking (SIM) > Topology, as shown

below:
File Group Device View Help
Cluster 1 Device Name Local Port Speed Remote Port MAC Address Model Name
Switch 3C-1E-04-A1-CC-00 DGS-1510-28XMP
@s\unch : . _— - P
Switch 2 Gigabit-Full C-1E-04-52-10-E0 DGS-1510-52XMP
@Switch Switch 3 Gigabit-Full FC-75-16-15-52-F0 DGS-1510-52%

Figure 4-77 Topology Window

There is a menu bar at the top of the window containing File, Group, Device, View, and Help.

Print Topology

On the File menu, select Print Topology to print the SIM topology map to any of the printers
configured on the PC accessing the Web UI.
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Preference

On the File menu, select Preference to configure the display properties for the SIM topology map.

Preference

Interval (10-300) |20 |

(@) Show All i) Show Member Only

| QK || Cancel |

Figure 4-78 Preference

The fields that can be configured are described below:

Parameter Description

Interval Enter the SIM topology display refresh interval value here. The
range is from 10 to 300.

Show All Select this option to display all available SIM devices in the
topology.

Show Member Only Select this option to only display SIM member devices in the
topology.

Click the OK button to accept the changes made.

Click the Cancel button to discard the changes made.

Group

Add to Group

Select a Candidate Switch (CaS) from the list and then select Add to Group on the Group menu to
add the selected CaS to the SIM group. Password authentication is required when a CaS is added to
the SIM group.

Input Password

Password | |

| Apply | | Cancel |

Figure 4-79 Add to Group (Input Password)

The fields that can be configured are described below:

Parameter Description

Password Enter the password of the CaS.

Click the Apply button to add the CaS to the SIM group.

Click the Cancel button to discard the addition and return to the Topology window.
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Remove from Group

Select a Member Switch (MS) from the list and then select Remove from Group on the Group menu
to remove the selected MS from the SIM group.

Device

Configure

Select a device from the list and then select Configure on the Device menu to connect to the Web
User Interface (if available) on the selected device.

View

Refresh

On the View menu, select Fresh to refresh the items displayed in the page.

Topology

On the View menu, select Topology to view the following:

[ zoomout |[  zoomm || Save || Back |

Switch

S

Switch

9 &6

Switch Switch

Figure 4-80 Topology Window

Click the Zoom In button enlarge the size of the displayed items.
Click the Zoom Out button reduce the size of the displayed items.
Click the Save button to save the display.

Click the Back button to return to the previous window.
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This window will display how the devices within the SIM Group connect to other groups and devices.
Possible icons on this window are as follows:

o
o
3

Ilcon Description Description

Group

Layer 3 Member Switch

Layer 2 Commander Switch

Member Switch of other group

Layer 3 Commander Switch

Layer 2 Candidate Switch

Commander Switch of other group Layer 3 Candidate Switch

Layer 2 Member Switch Unknown device

[ & @b

|
T

Non-SIM devices

Tool Tips

In the Topology view window, the mouse plays an important role in configuration and in viewing
device information. Point to a specific device in the Topology window to display more information

about the device

Mame: Switch Ewitch Mame: Switch Ewitch
Iodel: DGES-1510-28XMP Iodel: DGES5-1510-52XMP

MAC: 3C-1E-04-A1-CC-00 MAC: 3C-1E-04-52-10-E0

Local Port: - Local Port: 2

Remote Port: - Remote Port: 2

Fort Speed:. - Port Speed: Gigabit-Full

Figure 4-81 Device Information Utilizing the Tool Tip

Point to a line between two devices to display the connection speed between the two devices.

Swité‘t]
Port Speed: Gigabit-Full \‘x\‘
\
Switch Switch

Figure 4-82 Port Speed Utilizing the Tool Tip
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Righ-Click

Right-click a device to allow the user to perform various
in the SIM group and the icon associated with it.

functions, depending on the role of the Switch

Commander Switch Member Switch Candidate Switch

Swi|pmperty | /5“1P|”0D9I15‘ | Swi

«|Remove from Group swilAdd to Group
Configure Property
Property

The fields that can be configured are described below:

Parameter Description

Property Specifies to display more information about the device.

Configure (Member Switch Only
Interface (if available)

) Specifies to connect to the Web User
on the selected device.

SIM group. Password

Add to Group (Candidate Switch Only) Specifies to add the selected CaS to the

added to the SIM group.

authentication is required when a CaS is

Remove from Group (Member Switch Only
the SIM group.

) Specifies to remove the selected MS from

Mame: Switch Name: Switch

Model Group Model: DGS-1510-28XMP
MAC: 3C-1E-04-A1-CC-00 MAC: 3C-1E-04-A1-CC-00
Local Port: = Local Port: =

Remote Port: = Remote Port:

Port Speed: - Port Speed:

Figure 4-83 Group Property

Figure 4-84 Commander Switch Property

Name: Switch Name: Switch

Model: DGS-1510-52XMP Model: DGS-1510-52X
MAC 3C-1E-04-52-10-E0 MAC: FC-75-16-15-52-F0
Local Port: 2 Local Port: 3

Remote Port: 2 Remote Port: 3

Port Speed: Gigabit-Full Port Speed: Gigabit-Full

Figure 4-85 Member Switch Property

The fields displayed are described below:

Figure 4-86 Candidate Switch Property

Parameter Description

Name Displays the Device Name of the Switches in the SIM group
configured. If the device is not configured with a name, it will be
given the name default and tagged with the last six digits of the
MAC address to identify it.
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Parameter Description

Model Displays the model name of the Switch.

MAC Displays the MAC address of the Switch.

Local Port Displays the number of the physical port on the CS that the MS or
CaS is connected to. The CS will have no entry in this field.

Remote Port Displays the number of the physical port on the MS or CaS that the
CS is connected to. The CS will have no entry in this field.

Port Speed Displays the connection speed between the CS and the MS or
CasS.

Help
About

On the Help menu, select About to display the SIM Copyright information and release date.

Message from webpage

Single IP Management
Copyright© 2019 D-Link Corporation.
Release Date: 2019/7/26

Figure 4-87 About Window

Firmware Upgrade

This window is used to upgrade firmware from the Commander Switch to the Member Switch.
Member Switches will be listed in the table.

To view the following window, click Management > Virtual Stacking (SIM) > Firmware Upgrade, as
shown below:

Firmware Upgrade

TFTP Server IP Path\Filename
R —
Total Entries: 1

3C-1E-04-52-10-E0 DGS-1510-52XMP 1.60.004 Switch

11 [Ed| [ [eo

Figure 4-88 Firmware Upgrade Window

The fields that can be configured are described below:

Parameter Description

TFTP Server IP Enter the TFTP server IP address.

Path\Filename Enter the path and file name.

Click the Download button to update the firmware.

To specify a certain Switch for firmware download, tick its corresponding check box.
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Configuration File Backup/Restore

This window is used to upgrade configuration files from the Commander Switch to the Member Switch
using a TFTP server. Member Switches will be listed in the table.

To view the following window, click Management > Virtual Stacking (SIM) > Configuration File
Backup/Restore, as shown below:

Configuration File Backup/Restore

TFTP Server IP Path\Filename
[ ] I [ reoe ][ e ]
Total Entries: 1

] 3C-1E-04-52-10-E0 DGS-1510-52XMP 1.60.004 Switch

11 G =

Figure 4-89 Configuration File Backup/Restore Window

The fields that can be configured are described below:

Parameter Description

TFTP Server IP Enter the TFTP server IP address.

Path\Filename Enter the path and file name.

Click the Restore button to update the configuration from a TFTP server to the member switch.

Click the Backup button to back up the configuration file to a TFTP server.

Upload Log File

This window is used to upload log files from SIM member switches to a specified PC.

To view the following window, click Management > Virtual Stacking (SIM) > Upload Log File, as
shown below:

Upload Log File

TFTP Server IP Path\Filename
[ ] ]
Total Entries: 1

] 3C-1E-04-52-10-E0 DGS-1510-52XMP 1.60.004 Switch

11 G =

Figure 4-90 Upload Log File Window

The fields that can be configured are described below:

Parameter Description

TFTP Server IP Enter the TFTP server IP address.

Path\Filename Enter the path and file name.

Click the Upload button to initiate the file transfer.
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D-Link Discovery Protocol

This window is used to configure and display D-Link Discovery Protocol (DDP).

To view the following window, click Management > D-Link Discovery Protocol, as shown below:

[} ) L pvery Frotoco

D-Link Discovery Protocol
DDP Global Settings

D-Link Discovery Protocol State @ Enabled Disabled

DDP Port Settings

Unit From Port | eth1/0/1 =] ToPort | eth1/0/1 =] State |Disabled [7]

Unit 1 Settings

I S
eth1/0/1 Enabled
eth1/0/2 Enabled
eth1/0/3 Enabled
eth1/0/4 Enabled
eth1/0/5 Enabled
eth1/0/6 Enabled
eth1/07 Enabled
eth1/0/8 Enabled
eth1/0/9 Enabled
eth1/0/10 Enabled
eth1/0M11 Enabled
eth1/0/12 Enabled
eth1/0/13 Enabled
eth1/0/14 Enabled
eth1/0/15 Enabled

Figure 4-91 D-Link Discovery Protocol Window

The fields that can be configured for D-Link Discovery Protocol are described below:

Parameter Description

D-Link Discovery Protocol Select this option to enable or disable DDP global state.

State

Report Timer Select the interval in seconds between two consecutive DDP report
messages. Options to choose from are 30, 60, 90,120, and Never.

Click the Apply button to accept the changes made.

The fields that can be configured for DDP Port Settings are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
State Select this option to enable or disable DDP port state.

Click the Apply button to accept the changes made.
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5. Layer 2 Features

FDB

ERPS (G.8032)
Loopback Detection
Link Aggregation

L2 Multicast Control
LLDP

Static FDB
Unicast Static FDB

This window is used to view and configure the static unicast forwarding settings on the Switch.

To view the following window, click L2 Features > FDB > Static FDB > Unicast Static FDB, as
shown below:

§ cas [atl b=
Unicast Static FDB
[Pot [7] [eth1/0n1 [[] wvoc-0say [ | MACAddress [D0E257000000 ] [ Aoy |
Total Entries: 1 Delete All
I S S
00-84-57-00-00-00 eth1/0/3
17 [ 1] [ [ee

Figure 5-1 Unicast Static FDB Window

The fields that can be configured are described below:

Parameter Description

Port / Drop Allows the selection of the port number on which the MAC address
entered resides. This option could also drop the MAC address from
the unicast static FDB. When selecting Port, select the switch unit

and port number.

Unit Number Select the switch unit that will be used for this configuration here,
when Port is selected in the previous drop-down list.

Port Number Select the port number used here, when Port is selected in the
previous drop-down list.

VID Enter the VLAN ID on which the associated unicast MAC address
resides.

MAC Address Enter the MAC address to which packets will be statically

forwarded or dropped. This must be a unicast MAC address.

Click the Apply button to accept the changes made.
Click the Delete All button to delete all the entries found in the display table.
Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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Multicast Static FDB

This window is used to view and configure the multicast static FDB settings.

To view the following window, click L2 Features > FDB > Static FDB > Multicast Static FDB, as
shown below:

ta DB
Multicast Static FDB

Unit From Port To Port VID (1-4094) MAC Address

EEY Leth1/011 [~] eth1/01_[~] | | [z |
Total Entries: 1 Delete All
I wc s Earss pors ]

01-00-00-00-00-02 eth1/012
11 [ 1] [ [eo

Figure 5-2 Multicast Static FDB Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

VID Enter the VLAN ID of the VLAN the corresponding MAC address
belongs to.

MAC Address Enter the static destination MAC address of the multicast packets.
This must be a multicast MAC address. The destination MAC
address should start with 01. For example, 01-00-00-00-00-02.

Click the Apply button to accept the changes made.
Click the Delete All button to remove all the entries.
Click the Delete button to remove the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

MAC Address Table Settings

This window is used to view and configure the MAC address table’s global settings.

To view the following window, click L2 Features > FDB > MAC Address Table Settings, as shown
below:

V1A

| Global Settings | MAC Address Learning
Aging Time (0, 10-1000000) sec
Aging Destination Hit ("Enabled @ Disabled

Figure 5-3 MAC Address Table Settings (Global Settings) Window
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The fields that can be configured are described below:

Parameter Description

Aging Time Enter the MAC address table’s aging time value here. This value
must be between 10 and 1000000 seconds. Entering 0 will disable
MAC address aging. By default, this value is 300 seconds.

Aging Destination Hit Select to enable or disable the aging destination hit function.

Click the Apply button to accept the changes made.

After clicking the MAC Address Learning tab, at the top of the page, the following page will be
available.

Global Settings | MAC Address Learning |
Unit From Port To Port State
[ =] [ehton [-] Lethti0/1 [~]
Unit 1 Settings
e e
eth1/0/1 Enabled
eth1/0/2 Enabled
eth1/0/3 Enabled
eth1/0/4 Enabled
eth1/0/5 Enabled
eth1/0/6 Enabled
eth /07 Enabled
eth1/0/8 Enabled
eth1/0/9 Enabled H
eth1/0/10 Enabled
eth1/0/11 Enabled
eth1/0/12 Enabled
eth1/0/13 Enabled
eth1/0/14 Enabled
eth1/0115 Enabled

Figure 5-4 MAC Address Table Settings (MAC Address Learning) Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the range of ports that will be used for this configuration
here.

State Select to enable or disable the MAC address learning function on
the ports specified here.

Click the Apply button to accept the changes made.
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MAC Address Table

This window is used to view the entries listed in the MAC address table.

To view the following window, click L2 Features > FDB > MAC Address Table, as shown below:

MAC Address Table

Port | Clear Dynamic by Port ] [ Find ]
VID (1-4094) [ clear Dynamic by vLAN | Find ]
MAC Address | Clear Dynamic by MAC | [ Find ]
Total Entries: 4 Clearall [ viewal |
m_“

1) 00-01-02-03-04-00

1 00-03-FF-BE-2E-18 Dynamic eth1/0/1

1 00-84-57-00-00-00 Static eth1/0/3

1 01-00-00-00-00-02 Static eth1/072

7 [ [eo

Figure 5-5 MAC Address Table Window

The fields that can be configured are described below:

Parameter Description

Port Select the switch unit and the port that will be used for this
configuration here.

VID Enter the VLAN ID that will be used for this configuration here.

MAC Address Enter the MAC address that will be used for this configuration here.

Click the Clear Dynamic by Port button to clear the dynamic MAC address listed on the
corresponding port.

Click the Clear Dynamic by VLAN button to clear the dynamic MAC address listed on the
corresponding VLAN.

Click the Clear Dynamic by MAC button to clear the dynamic MAC address entered.

Click the Find button to locate a specific entry based on the information entered.

Click the Clear All button to clear all dynamic MAC addresses.

Click the View All button to display all the MAC addresses recorded in the MAC address table.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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MAC Notification

This window is used to view and configure MAC notification.

To view the following window, click L2 Features > FDB > MAC Notification, as shown below:

| MAC Notification Settings | MAC Notification History

MAC Notification Global Settings

MAC Address Notification )Enabled @ Disabled

Interval (1-2147483647) sec

History Size (0-500)

MAC Notification Trap State (Enabled (@ Disabled [ apply |

Unit From Port To Port Added Trap Removed Trap

[Disabled[=]  [Disabled[~] [ apoly |

Unit 1 Settings
eth1/0/1 Disabled Disabled
eth1/0/2 Disabled Disabled
eth1/0/3 Disabled Disabled
eth1/0/4 Disabled Disabled
eth1/0Vs Disabled Disabled
eth1/0/6 Disabled Disabled
eth1/0/7 Disabled Disabled
eth1/0/8 Disabled Disabled
eth1/0/9 Digabled Disabled
eth1/0/10 Disabled Disabled
eth1/0/11 Disabled Disabled
eth1/0/12 Disabled Disabled
eth1/0/13 Disabled Disabled
eth1/0/14 Disabled Disabled
eth1/0/15 Disabled Disabled

Figure 5-6 MAC Notification (MAC Notification Settings) Window

The fields that can be configured are described below:

Parameter Description

MAC Address Notification

Select to enable or disable MAC notification globally on the Switch.

Interval

Enter the time value between notifications. This value must be
between 1 and 2147483647 seconds. By default, this value is 1
second.

History Size

Enter the maximum number of entries listed in the history log used
for notification. This value must be between 0 and 500. By default,
this value is 1.

MAC Notification Trap State

Select this option to enable or disable the MAC natification trap
state.

Unit

Select the switch unit that will be used for this configuration here.

From Port/ To Port

Select the range of ports that will be used for this configuration
here.

Added Trap

Select this option to enable or disable the added trap for the port(s)
selected.

Removed Trap

Select this option to enable or disable the removed trap for the
port(s) selected.

Click the Apply button to accept the changes made for each individual section.
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After clicking the MAC Notification History tab, the following page will be available.

MAC Notification Settings | MAC Notification History |

Total Entries: 0

[ s i W e s

Figure 5-7 MAC Notification (MAC Notification History) Window

A list of MAC notification messages will be displayed.

VLAN

VLAN Configuration Wizard

This window is used to start the VLAN configuration wizard.

Create/Configure VLAN

To view the following window, click L2 Features > VLAN > VLAN Configuration Wizard, as shown
below:

VLAN Conhiguration Wizard
VLAN Configuration Wizard

(®) Create VLAN

YT E—

() Configure VLAN

N —

Mext

Figure 5-8 VLAN Configuration Wizard (Step 1) Window

The fields that can be configured are described below:

Parameter Description

Create VLAN Select this option to create a new VLAN.

e VID - Enter the VLAN ID here. The range is from 1 to 4094.
Configure VLAN Select this option to configure an existing VLAN.

¢ VID - Enter the VLAN ID here. The range is from 1 to 4094.

Click the Next button to continue to the next step.
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Create VLAN

After selecting the Create VLAN option and clicking the Next button, the following window will appear.

VLAN Connguration Wizard

Create VLAN

VID 2

VLAN Name

Unit 1 [v]

| Pt | SokdAl |1 2[3]4]5]6/7]8]9[10/11]42]13]14]15]16]17 18 10[20]21]22|23 24125 |26
Tagged All
Untagged All
Mot Member All ® (o (o) (8 (8 (8 (o (® () (8 (8 (0 (® (8 (o (@ (8 (0 (» (8 (@ (» (o @ (» (o

Native VLAN (PVID) All T o o A A R W

VLAN Mode HHHHHHHHMHMHM HMHMHMHMHHMHMHMHMHMHMHHMHHH

A-Access; H-Hybrid, T-Trunk
Note: The selected member port(s) will be mandatory configured to Hybird mode.

Access Mode: The port will be an untagged member of VLAN.
Trunk Mode: The port is either a tagged port or an untagged member port of it's nafive VLAN and can be a tagged member of other VLANs configured.
Hybrid Mode: The port can be an untagoed or a tagged member of all VLANS configured.

[ eack ][ seoly

Figure 5-9 VLAN Configuration Wizard (Create VLAN) Window

The fields that can be configured are described below:

Parameter Description

VLAN Name Enter the name for the VLAN here.

Tagged Select the switch ports that are tagged members of this VLAN here.

Untagged Select the switch ports that are untagged members of this VLAN
here.

Not Member Select the switch ports that are not members of this VLAN here.

Native VLAN (PVID) Select the switch ports that support the native VLAN here.

Click the View Allowed VLAN button view the allowed VLAN settings.
Click the Back button to return to the previous step.

Click the Apply button to accept the changes made.

After clicking the View Allowed VLAN button, the following window will appear.

~
I S O 7
eth1/0/1 Hybrid 1 1
eth1/0/2 Hybrid 1 1
eth1/0/3 Hybrid 1 1
eth1/0/4 Hybrid 1 1
eth1/0/5 Hybrid 1 1
eth1/0/6 Hybrid 1 1
eth1/0/7 Hybrid 1 1
eth1/0/8 Hybrid 1 1
eth1/0/9 Hybrid 1 1
eth1/010 Hybrid 1 1
eth1/0/11 Hybrid 1 1
eth1/012 Hybrid 1 1

Figure 5-10 Allowed VLAN Window
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Configure VLAN

After selecting the Configure VLAN option and clicking the Next button, the following window will
appear.

VLAN

Configure VLAN
VID 2
VLAN Name
Unit 1 [v]
| Pt | selectAl [ 1]2]3]4]5]07]8]9 10 11]12]13]14]15]16]17 18[19]20]21]22|23]24]25] 26
Tagged All - @
Untagged All
Not Member All ()
Native VLAN (PVID) All ]
VLAN Mode H
A-Access; H-Hybrid; T-Trunk
e [ ey ]

Figure 5-11 VLAN Configuration Wizard (Configure VLAN) Window

The fields that can be configured are described below:

Parameter Description

VLAN Name Enter the name for the VLAN here.

Tagged Select the switch ports that are tagged members of this VLAN here.

Untagged Select the switch ports that are untagged members of this VLAN
here.

Not Member Select the switch ports that are not members of this VLAN here.

Native VLAN (PVID) Select the switch ports that support the native VLAN here.

Click the View Allowed VLAN button view the allowed VLAN settings.
Click the Back button to return to the previous step.

Click the Apply button to accept the changes made.

After clicking the View Allowed VLAN button, the following window will appear.

UL —————————
I I = O = I Ao O T O

eth1/0/1 Hybrid 1 1

eth1/0/2 Hybrid 1 1

eth1/0/3 Hybrid 1 1

eth1/0/4 Hybrid 1 1

eth1/0/5 Hybrid 1 1

eth1/0/6 Hybrid 1 1

eth1/0/7 Hybrid 1 1

eth1/0/8 Hybrid 1 1

eth1/0/9 Hybrid 1 1

eth1/0M10 Hybrid 1 1 2

eth1/0/11 Hybrid 1 1-2

eth1/0M12 Hybrid 2 1 2

eth1/013 Hybrid 2 12

eth1/0/14 Hybrid 1 1

Figure 5-12 Allowed VLAN Window
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802.1Q VLAN

This window is used to view and configure the VLAN settings on this switch.

To view the following window, click L2 Features > VLAN > 802.1Q VLAN, as shown below:

B0, ] VLAN
802.1Q VLAN
-
Find VLAN
VID (1-4094) [ | Find [ viewar |
Total Entries: 1
I e e e T
1 default 1/0/1-1/0/50 Delete
11 [ 1] Go

Figure 5-13 802.1Q VLAN Window

The fields that can be configured for 802.1Q VLAN are described below:

Parameter Description
VID List Enter the VLAN ID list that will be created here.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specific entry.

The fields that can be configured for Find VLAN are described below:

Parameter Description
VID Enter the VLAN ID that will be displayed here.

Click the Find button to locate a specific entry based on the information entered.
Click the View All button to locate all the entries.
Click the Edit button to re-configure the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

114



DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

VLAN Interface
VLAN Interface Settings

This window is used to view and configure VLAN interface settings.

To view the following window, click L2 Features > VLAN > VLAN Interface, as shown below:

VLAN Interface
~
| VLAN Interface Settings | Port Summary
Unit 1 ~]
Unit 1 Settings
I T T
eth1/0/1 Hybrid Enabled Admit-All
eth1/0/2 Hybrid Enabled Admit-All Show Detail
eth1/0/3 Hybrid Enabled Admit-All
eth1/0/4 Hybrid Enabled Admit-All
eth1/0/5 Hybrid Enabled Admit-All Show Detail
eth1/0/6 Hybrid Enabled Admit-All
eth1/0/7 Hybrid Enabled Admit-All
eth1/0/8 Hybrid Enabled Admit-All
eth1/0/9 Hybrid Enabled Admit-All Show Detail
eth1/0/10 Hybrid Enabled Admit-All Show Detail

Figure 5-14 VLAN Interface Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

Click the Show Detail button to view detailed information about the VLAN on the specific interface.

Click the Edit button to re-configure the specific entry.

After clicking the VLAN Detail button, the following page will appear.

VLAN Interface Information
Port eth1/0/1
VLAN Mode Hybrid
Native VLAN 1
Hybrid Untagged VLAN 1
Hybrid Tagged VLAN
Dynamic Tagged VLAN
Ingress Checking Enabled
Acceptable Frame Type Admit-Al

Figure 5-15 VLAN Interface Information Window

On this page, detailed information about the VLAN of the specific interface is displayed.

Click the Back button to return to the previous page.
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After click the Edit button, the following window will appear. This is a dynamic window that will change
when a different VLAN Mode was selected. When Access was selected as the VLAN Mode, the
following page will appear.

Configure VLAN Interface

Port eth1/0/1 [] Clone

VLAN Mode Access ﬂ Unit From Port To Port

Acceptable Frame Admit Al v 1[¥] [eth1/01 ] [eth1/0 ~]
Ingress Checking (@) Enabled () Disabled

VD 14094

‘ Back |

Apply

Figure 5-16 Configure VLAN Interface - Access Window

The fields that can be configured are described below:

Parameter Description

VLAN Mode Select the VLAN mode option here. Options to choose from are
Access, Hybrid, and Trunk.

Acceptable Frame Select the acceptable frame behavior option here. Options to

choose from are Tagged Only, Untagged Only, and Admit All.

Ingress Checking Select this option to enable or disable the ingress checking

function.
VID Enter the VLAN ID used for this configuration here. This value must
be between 1 and 4094.
Clone Tick this option to apply the configuration to the specified ports.
Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

Click the Apply button to accept the changes made.

Click the Back button to return to the previous window.

When Hybrid was selected as the VLAN Mode, the following page will appear.

Configure VLAN Interface
Port eth1/0/1 [] Clone
VLAN Mode Unit From Port To Port
Acceptable Frame Admit All ﬂ 1[v] |eth‘|.-":l.-'1 ﬂ| |et'11.'D.-"I ﬂ|
Ingress Checking (@) Enabled () Disabled
Mative VLAN Native VLAN
o 4088
Action Add v
Add Mode (@) Untagged () Tagged
Allowed VLAN Range I:I
Current Hybrid Untagged VLAN Range 1
Current Hybrid Tagged WVLAN Range
‘ Back | | Apply

Figure 5-17 Configure VLAN Interface - Hybrid Window

The fields that can be configured are described below:

Parameter
VLAN Mode

Description

Select the VLAN mode option here. Options to choose from are
Access, Hybrid, and Trunk.
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Parameter Description

Acceptable Frame

Select the acceptable frame behavior option here. Options to
choose from are Tagged Only, Untagged Only, and Admit All.

Ingress Checking

Select the check box to enable or disable the ingress checking
function.

Native VLAN Tick this option to enable the native VLAN function.

VID After ticking the Native VLAN check box, this option will be
available. Enter the VLAN ID used for this configuration here. This
value must be between 1 and 4094.

Action Select the action that will be taken here. Options to choose from
are Add, Remove, Tagged, and Untagged.

Add Mode Select whether to add an Untagged or Tagged parameters.

Allowed VLAN Range

Enter the allowed VLAN range information here.

Clone

Tick this option to apply the configuration to the specified ports.

Unit

Select the switch unit that will be used for this configuration here.

From Port/ To Port

Select the appropriate port range used for the configuration here.

Click the Apply button to accept the changes made.

Click the Back button to return to the previous window.

When Trunk was selected as the VLAN Mode, the following page will appear.

Configure VLAN Interface

Port

VLAN Mode
Acceptable Frame
Ingress Checking
Native VLAN

VID (1-4004)
Action

Allowed VLAN Range
Current Allowed VLAN Range

eth1/0M1 [] Clone
Unit From Port To Port
Admit Al ] 1[7] [eth1/0/1 ~] [eth /01 ~]

(@) Enabled () Disabled

Native VLAN
(@) Untagged () Tagged

ILI

None

|

‘ Back || Apply

Figure 5-18 Configure VLAN Interface - Trunk Window

The fields that can be configured are described below:

Parameter Description

VLAN Mode

Select the VLAN mode option here. Options to choose from are
Access, Hybrid, and Trunk.

Acceptable Frame

Select the acceptable frame behavior option here. Options to
choose from are Tagged Only, Untagged Only, and Admit All.

Ingress Checking

After selecting Trunk as the VLAN Mode the following parameter
will be available. Select to enable or disable the ingress checking
function.

Native VLAN Tick the check box to enable the native VLAN function. Select if
this VLAN supports Untagged or Tagged frames.
VID After ticking the Native VLAN check box, this option will be

available. Enter the VLAN ID used for this configuration here. This
value must be between 1 and 4094.
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Parameter Description

Action Select the action that will be taken here. Options to choose from
are All, Add, Remove, Except, and Replace.

Allowed VLAN Range Enter the allowed VLAN range information here.

Clone Tick this option to apply the configuration to the specified ports.

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

Click the Apply button to accept the changes made.

Click the Back button to return to the previous window.

Port Summary

After selecting the Port Summary tab, the following page will be available.

VLAN Interface
~
VLAN Interface Settings ‘ Port Summary |
Unit 1 B2
Unit 1 Settings
I S N T R T
eth1/0/1 Hybrid 1 1
eth1/0/2 Hybrid 1 1
eth1/0/3 Hybrid 1 1
eth1/0/4 Hybrid 1 1
eth1/0/5 Hybrid 1 1
eth1/0/6 Hybrid 1 1
eth1/0/7 Hybrid 1 1
eth1/0/8 Hybrid 1 1
eth1/0/8 Hybrid 1 1
eth1/0/M10 Hybrid 1 1

Figure 5-19 VLAN Interface Port Summary Window

802.1v Protocol VLAN
Protocol VLAN Profile

This window is used to view and configure the Protocol VLAN profile.

To view the following window, click L2 Features > VLAN > 802.1v Protocol VLAN > Protocol VLAN
Profile, as shown below:

Add Protocol VLAN Profile
ProflelD(1-18) [ | Frame Type | Ethemet2 [v| Ether Type (0x0-0xFFFF) =
Total Entries: 1
1 Ethemet2 OXFFFF(User defined)

Figure 5-20 9 Protocol VLAN Profile Window

The fields that can be configured are described below:

Parameter Description

Profile ID Enter the profile ID that will be created here.
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Parameter Description

Frame Type Select the frame type here. Options to choose from are Ethernet2,
SNAP and LLC.
Ether Type Enter the Ethernet type in hexadecimal form.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

Protocol VLAN Profile Interface

This window is used to view and configure the Protocol VLAN profile interface.

To view the following window, click L2 Features > VLAN > 802.1v Protocol VLAN > Protocol VLAN
Profile Interface, as shown below:

Protocol VLAN Pre

Add New Protocol VLAN Interface

Port eth1/0/1 [v] Profile ID VID (1-4094) | | Priority [0 [~] [ apply |
Unit 1 Settings

T O T N

eth1//1 1 1 7

Figure 5-21 Protocol VLAN Profile Interface Window

The fields that can be configured are described below:

Parameter Description

Port Select the switch unit and the port that will be used for this
configuration here.

Profile ID Select the ID of the protocol group.
VID Enter the VLAN ID of the Protocol VLAN.
Priority Select the priority of the Protocol VLAN.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

GVRP

GVRP Global

This window is used to view and configure the GARP VLAN Registration Protocol (GVRP) global
settings.

To view the following window, click L2 Features > VLAN > GVRP > GVRP Global, as shown below:

GVRP Global

Global GVRP State Enabled gDisabled
Dynamic VLAN Creation @ Enabled Dizabled

Apply

Figure 5-22 GVRP Global Window
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The fields that can be configured are described below:

Parameter Description

Global GVRP State Select this option to enable or disable the global GVRP state here.

Dynamic VLAN Creation Select this option to enable or disable the dynamic VLAN creation
function here.

Click the Apply button to accept the changes made.

GVRP Port

This window is used to view and configure the GVRP port settings.

To view the following window, click L2 Features > VLAN > GVRP > GVRP Port, as shown below:

ia.l L

GVRP Port
F Join Time Leave Time Leave All Time
Unit  From Port To Port GVRF Status {10-10000) (10-10000) {10-10000)
[eth1/011 [] eth1/01 [v] Disabled[~] [0 | centiseconds centiseconds (1000 centiseconds
Note:

The Leave Time should be no less than 3 * Join Time.
Leave All Time should be greater than Leave Time.

Unit 1 Settings

o s e e
0 60

eth1/01 Disabled 2 1000
eth1/0/2 Disabled 20 60 1000
eth1/0/3 Disabled 20 60 1000
eth1/0/4 Disabled 20 60 1000
eth1/0/5 Disabled 20 60 1000
eth1/0/6 Disabled 20 60 1000
eth1/0/7 Disabled 20 60 1000
eth1/0/8 Disabled 20 60 1000
eth1/0/9 Disabled 20 60 1000
eth1/0/10 Disabled 20 60 1000
eth1/0/11 Disabled 20 60 1000

Figure 5-23 GVRP Port Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
GVRP Status Select this option to enable or disable the GVRP port status. This

enables the port to dynamically become a member of a VLAN. By
default, this option is disabled.

Join Time Enter the Join Time value in centiseconds. This value must be
between 10 and 10000 centiseconds. By default, this value is 20
centiseconds.

Leave Time Enter the Leave Time value in centiseconds. This value must be
between 10 and 10000 centiseconds. By default, this value is 60
centiseconds.

Leave All Time Enter the Leave All Time value in centiseconds. This value must be
between 10 and 10000 centiseconds. By default, this value is 1000
centiseconds.

Click the Apply button to accept the changes made.
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GVRP Advertise VLAN

This window is used to view and configure the GVRP advertised VLAN settings.

To view the following window, click L2 Features > VLAN > GVRP > GVRP Advertise VLAN, as
shown below:

GVRP Advertise VLAN

Unit From Port To Port Action Advertise VID List
[Add 7] ELES

Unit 1 Settings

L o

eth1/0/1
eth1/0/2
eth1/0/3
eth1/0/4
eth1/0/5
eth1/0/6
eth 1/0i7
eth1/0/8
eth1/0/9
eth1/0/10
eth1/0/11
eth1/0/12
eth1/0/13
eth1/0/14
eth1/0/15

.

Figure 5-24 GVRP Advertise VLAN Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
Action Select the advertised VLAN to port mapping action that will be

taken here. Options to choose from are All, Add, Remove, and
Replace. When selecting All, all the advertised VLANs will be
used.

Advertise VID List Enter the advertised VLAN ID list here.

Click the Apply button to accept the changes made.
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GVRP Forbidden VLAN
This window is used to view and configure the GVRP forbidden VLAN settings.

To view the following window, click L2 Features > VLAN > GVRP > GVRP Forbidden VLAN, as
shown below:

GVRP Forbidden VLAN

Unit From Port To Port Action Forbidden VID List
[Add 7] 25K

Unit 1 Settings

L romsaen

eth1/0/1
eth1/0/2
eth1/0/3
eth1/0/4
eth1/0/5
eth1/0/6
eth1/7
eth1/0/8
eth1/0/9
eth1/0/10
eth1/0/11
eth1/0/12
eth1/0/13
eth1/0/14
eth1/0/15

.

Figure 5-25 GVRP Forbidden VLAN Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
Action Select the forbidden VLAN to port mapping action that will be taken

here. Options to choose from are All, Add, Remove, and Replace.
When selecting All, all the forbidden VLANs will be used.

Forbidden VID List Enter the forbidden VLAN ID list here.

Click the Apply button to accept the changes made.
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GVRP Statistics Table

This window is used to display GVRP statistics information.

To view the following window, click L2 Features > VLAN > GVRP > GVRP Statistics Table, as
shown below:

GVRP Statistics Table
Unit Port eth1/0A [~] [ _Fnd J[__ dear |
[ Wiew All ] [ Clear All ]
Unit 1 Settings
RX o o 0 0 0 ]
eth1/0M1
TX o o 0 0 0 0
RX 0 0 i 0 0 0 3
eth1/0/2
T o o 0 0 0 ]
RX 0 o 0 0 0 ]
eth1/0/3
> 1] o 0 0 0 0
RX 1] o 0 0 0 0
eth1/0/4
™ o i} 0 0 0 0
RX 0 0 0 0 0 0
eth1/0/5
X L] ] 0 0 0 0
RX o o 0 0 0 ]
eth1/0/6
TX o o 0 0 0 0
RX o o 0 0 0 0
eth1/0/7
T o o 0 0 0 0
RX o o 0 0 0 0
eth1/0/8
T o o 0 0 0 ]

Figure 5-26 GVRP Statistics Table Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
Port Select the port number of which GVRP statistic information will be
displayed.

Click the Find button to locate a specific entry based on the information entered.
Click the Clear button to clear all the information for the specific port.
Click the View All button to view all GVRP statistic information.

Click the Clear All button to clear all the information in this table.

Asymmetric VLAN

This window is used to configure the asymmetric VLAN function.

To view the following window, click L2 Features > VLAN > Asymmetric VLAN, as shown below:

Asymmetric VLAN

Asymmetric VLAN State [Enabled (g Disabled Apply

Figure 5-27 Asymmetric VLAN Window
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The fields that can be configured are described below:

Parameter Description
Asymmetric VLAN State Select this option to enable or disable the asymmetric VLAN
function

Click the Apply button to accept the changes made.

MAC VLAN

This window is used to view and configure MAC-based VLAN settings.

To view the following window, click L2 Features > VLAN > MAC VLAN, as shown below:

A VLAN

MAC VLAN

werwes  frommme ] vogssy [ ] eew [ ]

Total Entries: 1
I N N S
AA-BB-CC-DD-EE-FF 1 3 Active
11 E L

Figure 5-28 MAC VLAN Window

The fields that can be configured are described below:

Parameter Description

MAC Address Enter the MAC address that will be used for this configuration here.
VID Enter the VLAN ID for the MAC-based VLAN.
Priority Select the priority of the MAC-based VLAN.

Click the Apply button to accept the changes made.
Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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L2VLAN Interface Description

This window is used to display and configure the Layer 2 VLAN interface description.

To view the following window, click L2 Features > VLAN > L2VLAN Interface Description, as
shown below:

Create L2VLAN Interface Description

L2VLAN Interface Description

—
Find L2VLAN Interface Description

L2VLAN Interface

I [ viewal |

Total Entries: 1

L2VLAN 1 up enabled
11 [7] [ [eo

Figure 5-29 L2VLAN Interface Description Window

The fields that can be configured for Create L2VLAN Interface Description are described below:

Parameter Description

L2VLAN Interface Enter the ID of the Layer 2 VLAN interface here.

Description Enter the description for the Layer 2 VLAN interface here.

Click the Apply button to accept the changes made.

The fields that can be configured for Find L2VLAN Interface Description are described below:

Parameter Description
L2VLAN Interface Enter the ID of the Layer 2 VLAN interface here.

Click the Find button to locate a specific entry based on the information entered.
Click the View All button to view all the entries.
Click the Delete Description button to remove the description from the specified Layer 2 VLAN.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

Auto Surveillance VLAN

Auto Surveillance Properties

This window is used to configure the auto surveillance VLAN global settings and display the ports
surveillance VLAN information.

The Switch regards a host as an NVR once it connects to the IPC via HTTP, HTTPS, or RTSP. The
Switch will learn the NVR on this port and move it into the surveillance VLAN until the triggered aging
mechanism age-out or the LAN cable is removed.

When the host sends an ARP request to an IPC, the Switch still regards the host as an NVR but only
temporarily move it into the surveillance VLAN. The host will automatically be moved out of the
surveillance VLAN after about 30 seconds if it is not recognized as an NVR anymore.

125



DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

& NOTE: The same PC, or PCs connected to the same LAN port on the Switch,
cannot simultaneously manage the Switch and the IP cameras connected to the
N Switch.

To view the following window, click L2 Features > VLAN > Auto Surveillance VLAN > Auto
Surveillance Properties, as shown below:

Global Settings

Surveillance VLAN State (@Enabled  (")Disabled
Surveillance VLAN 1D (2-4094)
Surveillance VLAN CoS
Aging Time (1-65535) min
ONVIF Discover Port (554, 1025-65535) 554
Member Poris 1/0/1-1/0/3,1/0/5,1/0/24
Dynamic Member Poris 1/0/1,1/0/3 11005
Note: Surveillance VLAN ID and Voice VLAN ID cannot be the same.

ONVIF Global Status
Surveillance Device Detected (OUI}
|P-Camera Detected (ONVIF)
NVR Detected (ONVIF)

Port Settings
Unit From Port To Port State
eth1/0/1 [ v] [eth1/0/1 [v] [Disabled[v]

Unit 1 Settings

eth1/01 Enabled
eth1/0/2 Enabled
eth1/0/3 Enabled
eth1/0/4 Enabled
eth1/0/5 Enabled
eth1/0/6 Enabled
eth1/0/7 Enabled
eth1/0/8 Enabled
eth1/0/9 Enabled
eih1/0/10 Enabled

Figure 5-30 Auto Surveillance Properties Window

The fields that can be configured for Global Settings are described below:

Parameter Description

Surveillance VLAN State Select this option to enable or disable the surveillance VLAN state
Surveillance VLAN ID Enter the surveillance VLAN ID. The range is from 2 to 4094.
Surveillance VLAN CoS Select the priority of the surveillance VLAN from 0 to 7.

Aging Time Enter the aging time of surveillance VLAN. The range is from 1 to

65535 minutes. The default value is 720 minutes. The aging time is
used to remove a port from surveillance VLAN if the port is an
automatic surveillance VLAN member. When the last surveillance
device stops sending traffic and the MAC address of this
surveillance device is aged out, the surveillance VLAN aging timer
will be started. The port will be removed from the surveillance
VLAN after expiration of surveillance VLAN aging timer. If the
surveillance traffic resumes during the aging time, the aging timer
will be reset and stop.

ONVIF Discover Port Enter the TCP/UDP port number here. The range is either 554, or
from 1025 to 65535. This is used to configure the TCP/UDP port
number for RTSP stream snooping. ONVIF-capable IPC and
ONVIF-capable NVR utilize WS-Discovery to find other devices.
Once IPCs are discovered, the Switch can further discover NVRs
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Parameter Description

by snooping RTSP, HTTP, and HTTPS packets between NVRs
and IPCs. These packets cannot be snooped if the TCP/UDP port
is not equal to the RTSP port number.

Click the Apply button to accept the changes made.

The fields that can be configured for Port Settings are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
State Select this option to enable or disable the state of the port.

Click the Apply button to accept the changes made.

MAC Settings and Surveillance Device

This window is used to configure the user-defined surveillance device OUI and display the
surveillance VLAN information.

To view the following window, click L2 Features > VLAN > Auto Surveillance VLAN > MAC
Settings and Surveillance Device, as shown below:

| User-defined MAC Settings | Auto Surveillance VLAN Summary
To add more device(s) for Auto Surveillance VLAN by user-defined configuration as below.
Compenent Type |Other IP Surveillance Deviceﬂ| Description 32 chars
MAC Address 00-01-02-03-00-00 Mask 1
Total Entries: 4
o e | o | wchwes | e |
1 D-Link Device IP Surveillance... 28-10-7B-00-00-00 FF-FF-FF-E0-00-00 Delete
2 D-Link Device IP Surveillance... 28-10-TB-20-00-00 FF-FF-FF-FO-00-00 Delate
5 D-Link Device IP Surveillance. .. BO0-C5-54-00-00-00 FF-FF-FF-80-00-00 Delate
4 D-Link Device IP Surveillance. .. FO-TD-68-00-00-00 FF-FF-FF-F0-00-00 Delate

Figure 5-31 User -defined MAC Settings Window

The fields that can be configured are described below:

Parameter Description

Component Type Select the surveillance component type. Options to choose from
are Video Management Server, VMS Client/Remote Viewer,
Video Encoder, Network Storage, and Other IP Surveillance
Device.

Description Enter the description for the user-defined OUI with a maximum of
32 characters.

MAC Address Enter the OUI MAC address.

Mask Enter the OUI MAC address matching bitmask.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.
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After clicking the Auto Surveillance VLAN Summary tab, the following page will appear.

User-defined MAC Settings | Auto Surveillance VLAN Summary |

Unit 1ﬂ

Total Entries: 0

o o o s

Figure 5-32 Auto Surveillance VLAN Summary Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

ONVIF IP-Camera Information

This window is used to display ONVIF IP camera information.

To view the following window, click L2 Features > VLAN > Auto Surveillance VLAN > ONVIF IP-
Camera Information, as shown below:

ONV

ONVIF IP-Camera Information

Unit 1 [~]
Unit 1 Settings

Total Entries Discovered: 3

Throughput
IP Address MAC Address Traffic Description
{Mbps)

eth1/01 192168022  F0-7D-68-0C-CA-CC DCS5222L  DCS-5222L  Enabled 0 More Detail
eth1/0/3 | 192.168.0.21 BO-C5-54-26-B7-A3  DCS-942LB1  DCS-942LB1  Enabled 0

eth1/05  192.168.0.23 28-10-7B-04-60-EC DCS-5211L DCS-5211L Enabled 0

MNote: System probes IP-Camera every 30s.

More Detail

Figure 5-33 ONVIF IP-Camera Information Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used in the display here.

Click the IP Address hyperlink to connect to the Web Interface of the IP camera.
Click the More Detail button to view detailed ONVIF IP camera information.

Click the Edit button to configure the state and description of the IP camera.
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After click the More Detail button, the following window will appear.

ONVIF IP-Camera Information
Port eth1/0/1
IF Address 192 168.022
MAC Address FO-7TD-63-0C-CA-CC
Model DCS8-5222L
Manufacturer DCS-52221
State Enabled
Description
Throughput 0 Mbps
Protocol ONVIF
Power Consumption 0.0 (W) /0.0 (W)
PoE Unknow
FoE Status searching

Figure 5-34 ONVIF IP-Camera Information (More Detail) Window

After click the Edit button, the following window will appear.

ONVIF IP-Camera Settings

Port

IP Address 192.168.0.22
MAC Address F0-7D-68-0C-CA-CC
IP-Camera State Enabled [v]

eth1/0M1

| Back | | Apply

Figure 5-35 ONVIF IP-Camera Information (Edit) Window

The fields that can be configured are described below:

Parameter Description

IP-Camera State Select to enable or disable the IP camera state here.

Description Enter the description for this IP camera here.

Click the Back button to discard the changes made and return to the previous window.

Click the Apply button to accept the changes made.

ONVIF NVR Information
This window is used to display ONVIF Network Video Recorder (NVR) information.

To view the following window, click L2 Features > VLAN > Auto Surveillance VLAN > ONVIF NVR
Information, as shown below:

DNV

'ONVIF NVR Information

Unit 1 [v]

Unit 1 Settings
Total Entries Discovered: 2

Throughput
IP Address MAC Address IP-Camera Number Description
(Mbps)

ethi/is  192.168.0.205 1C-BD-BI-E3-CE-25 [Pcameravist][  Edit |
ethi/i15 1321650207 00-0E-C5-C1-F6-02 [1p-Camera List][  Ecit |

Note: System probes IP-Camera every 30s.

Figure 5-36 ONVIF NVR Information Window
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The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used in the display here.

Click the IP Address hyperlink to connect to the Web Interface of the NVR.
Click the IP-Camera List button to view the list of IP cameras that are connected to the NVR.
Click the Edit button to configure the description of the NVR.

After click the IP-Camera List button, the following window will appear.

ONVIF IP-Camera List

e e e T

eth1/0/5 182.168.0.20 B0-C5-54-26-B7-86

Figure 5-37 ONVIF NVR Information (IP-Camera List) Window
Click the IP Address hyperlink to connect to the Web Interface of the IP camera.

Click the Back button to return to the previous window.

After click the Edit button, the following window will appear.

'ONVIF NVR Information
Unit 1 [v]
Unit 1 Settings
Total Entries Discovered: 2
ﬂ---ﬁ-_
IP Address MAC Address IP-Camera Number Description
(Mbps)
eth1/0/5 192.168.0. 20 1G-BD-B9-E3-CE-25 IP-Camera List Apply
Sth1/0/15 192.163.0.202 00-0E-C8-C1-Fé-02 [1p-Camera List][  Ecit |
Note: System probes IP-Camera every 30s.

Figure 5-38 ONVIF NVR Information (Edit) Window

The additional fields that can be configured are described below:

Parameter Description

Description Enter the description for this NVR here.

Click the Apply button to accept the changes made.

Voice VLAN
Voice VLAN Global

Voice VLAN is a VLAN used to carry voice traffic from IP phone. Because the sound quality of an IP
phone call will be deteriorated if the data is unevenly sent, the quality of service (QoS) for voice traffic
shall be configured to ensure the transmission priority of voice packet is higher than normal traffic.

The switches determine whether a received packet is a voice packet by checking its source MAC
address. If the source MAC addresses of packets comply with the organizationally unique identifier
(OUI) addresses configured by the system, the packets are determined as voice packets and
transmitted in voice VLAN.

130



DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

To view the following window, click L2 Features > VLAN > Voice VLAN > Voice VLAN Global, as
shown below:

Voice VLAN Global

Voice VLAN State Enabled (g Disabled
TR N E—
Agng Time (1-65535)

Figure 5-39 Voice VLAN Global Window

The fields that can be configured are described below:

Parameter Description

Voice VLAN State Select this option to enable or disable the voice VLAN.

Voice VLAN ID Enter the voice VLAN ID. The value is range from 2 to 4094.
Voice VLAN CoS Select the priority of the voice VLAN from 0 to 7.

Aging Time Enter the aging time of surveillance VLAN. The range is from 1 to

65535 minutes. The default value is 720 minutes. The aging time is
used to remove a port from voice VLAN if the port is an automatic
VLAN member. When the last voice device stops sending traffic
and the MAC address of this voice device is aged out, the voice
VLAN aging timer will be started. The port will be removed from the
voice VLAN after expiration of voice VLAN aging timer. If the voice
traffic resumes during the aging time, the aging timer will be reset
and stop.

Click the Apply button to accept the changes made for each individual section.
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Voice VLAN Port

This window is used to show the ports voice VLAN information.

To view the following window, click L2 Features > VLAN > Voice VLAN > Voice VLAN Port, as

shown below:

Voice VLAN Port
Unit From Port To Port State Mode
[eth/0n [] [Disabled[~]
Unit 1 Settings
kot s M
eth1/0/1 Disabled Auto/Untag
eth1/0/2 Disabled Auto/Untag
eth1/0/3 Disabled Auto/Untag
eth1/0/4 Dizabled Auto/Untag
eth1/0/5 Dizabled Auto/Untag
eth1/0/6 Disabled Auto/Untag
eth1/0/7 Disabled Auto/Untag
eth1/0/8 Disabled Auto/Untag
eth1/0/9 Disabled Auto/Untag E
eth1/0/10 Disabled Auto/Untag 1
eth1/0/11 Disabled Auto/Untag
eth1/0/12 Disabled Auto/Untag
eth1/0/13 Disabled Auto/Untag
eth1/0/14 Disabled Auto/Untag
eth1/0/15 Dizabled Auto/Untag
eth1/0M16 Disabled Auto/Untag
eth1/0M17 Disabled Auto/Untag

Figure 5-40 Voice VLAN Port Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

State Select this option to enable or disable the state of the port.

Mode Select the mode of the port. Options to choose from are Auto
Untagged, Auto Tagged, and Manual.

Click the Apply button to accept the changes made.
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Voice VLAN OUI

This window is used to configure the user-defined voice traffic’'s OUI. The OUI is used to identify the
voice traffic. There are a number of pre-defined OUls. The user can further define the user-defined
OUls if needed. The user-defined OUI cannot be the same as the pre-defined OUI.

To view the following window, click L2 Features > VLAN > Voice VLAN > Voice VLAN OUI, as
shown below:

Voice VLAN OUI

OUl Address Description

Total Entries:

00-01-E3-00-00-00 FF-FF-FF-00-00-00 Siemens
00-03-6B-00-00-00 FF-FF-FF-00-00-00 Cisco
00-09-6E-00-00-00 FF-FF-FF-00-00-00 Avaya
00-0F-E2-00-00-00 FF-FF-FF-00-00-00 Huawei&3COM
00-60-B9-00-00-00 FF-FF-FF-00-00-00 NECS&Philips
00-D0-1E-00-00-00 FF-FF-FF-00-00-00 Pingtel
00-E0-75-00-00-00 FF-FF-FF-00-00-00 Veritel
00-E0-BB-00-00-00 FF-FF-FF-00-00-00 3Com

Figure 5-41 Voice VLAN OUI Window

The fields that can be configured are described below:

Parameter Description

OUI Address Enter the OUI MAC address.

Mask Enter the OUI MAC address matching bitmask.

Description Enter the description for the user-defined OUI with a maximum of
32 characters.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

Voice VLAN Device

This window is used to show voice devices that are connected to the ports. The start time is the time
when the device is detected on this port, the activate time is the latest time saw the device sending
the traffic.

To view the following window, click L2 Features > VLAN > Voice VLAN > Voice VLAN Device, as
shown below:

\ I AN De

Voice VLAN Device Table

Total Entries: 0

T s o s T

Figure 5-42 Voice VLAN Device Window
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The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

Voice VLAN LLDP-MED Device
This window displays the voice VLAN LLDP-MED voice devices connected to the Switch.

To view the following window, click L2 Features > VLAN > Voice VLAN > Voice VLAN LLDP-MED
Device, as shown below:

Voice VLAN LLDP-MED Device Table

Total Entries: 0

mm Chassis ID Subtype Chassis ID Port ID Subtype m Remain Time (sec)

Figure 5-43 Voice VLAN LLDP-MED Device Window

STP

This Switch supports three versions of the Spanning Tree Protocol: 802.1D-1998 STP, 802.1D-2004
Rapid STP, and 802.1Q-2005 MSTP. 802.1D-1998 STP will be familiar to most networking
professionals. However, since 802.1D-2004 RSTP and 802.1Q-2005 MSTP have been recently
introduced to D-Link managed Ethernet switches, a brief introduction to the technology is provided
below followed by a description of how to set up 802.1D-1998 STP, 802.1D-2004 RSTP, and 802.1Q-
2005 MSTP.

802.1Q-2005 MSTP

Multiple Spanning Tree Protocol, or MSTP, is a standard defined by the IEEE community that allows
multiple VLANSs to be mapped to a single spanning tree instance, which will provide multiple pathways
across the network. Therefore, these MSTP configurations will balance the traffic load, preventing
wide scale disruptions when a single spanning tree instance fails. This will allow for faster
convergences of new topologies for the failed instance. Frames designated for these VLANs will be
processed quickly and completely throughout interconnected bridges utilizing any of the three
spanning tree protocols (STP, RSTP, or MSTP).

This protocol will also tag BPDU packets so receiving devices can distinguish spanning tree
instances, spanning tree regions and the VLANs associated with them. An MSTI ID will classify these
instances. MSTP will connect multiple spanning trees with a Common and Internal Spanning Tree
(CIST). The CIST will automatically determine each MSTP region, its maximum possible extent and
will appear as one virtual bridge that runs a single spanning tree. Consequentially, frames assigned to
different VLANs will follow different data routes within administratively established regions on the
network, continuing to allow simple and full processing of frames, regardless of administrative errors
in defining VLANs and their respective spanning trees.

Each switch utilizing the MSTP on a network will have a single MSTP configuration that will have the
following three attributes:

¢ A configuration name defined by an alphanumeric string of up to 32 characters (defined in the
MST Configuration Identification window in the Configuration Name field).

¢ A configuration revision number (named here as a Revision Level and found in the MST
Configuration ldentification window) and;
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o A 4094-element table (defined here as a VID List in the MST Configuration Identification
window), which will associate each of the possible 4094 VVLANs supported by the Switch for a
given instance.

To utilize the MSTP function on the Switch, three steps need to be taken:

e The Switch must be set to the MSTP setting (found in the STP Bridge Global Settings window
in the STP Version field)

e The correct spanning tree priority for the MSTP instance must be entered (defined here as a
Priority in the MSTI Config Information window when configuring MSTI ID settings).

¢ VLANSs that will be shared must be added to the MSTP Instance ID (defined here as a VID List
in the MST Configuration Identification window when configuring an MSTI ID settings).

802.1D-2004 Rapid Spanning Tree

The Switch implements three versions of the Spanning Tree Protocol, the Multiple Spanning Tree
Protocol (MSTP) as defined by the IEEE 802.1Q-2005, the Rapid Spanning Tree Protocol (RSTP) as
defined by the IEEE 802.1D-2004 specification and a version compatible with the IEEE 802.1D-1998
STP. RSTP can operate with legacy equipment implementing IEEE 802.1D-1998; however, the
advantages of using RSTP will be lost.

The IEEE 802.1D-2004 Rapid Spanning Tree Protocol (RSTP) evolved from the 802.1D-1998 STP
standard. RSTP was developed in order to overcome some limitations of STP that impede the
function of some recent switching innovations, in particular, certain Layer 3 functions that are
increasingly handled by Ethernet switches. The basic function and much of the terminology is the
same as STP. Most of the settings configured for STP are also used for RSTP. This section
introduces some new Spanning Tree concepts and illustrates the main differences between the two
protocols.

Port Transition States

An essential difference between the three protocols is in the way ports transition to a forwarding state
and in the way, this transition relates to the role of the port (forwarding or not forwarding) in the
topology. MSTP and RSTP combine the transition states disabled, blocking and listening used in
802.1D-1998 and creates a single state Discarding. In either case, ports do not forward packets. In
the STP port transition states disabled, blocking or listening or in the RSTP/MSTP port state
discarding, there is no functional difference, the port is not active in the network topology. Table 7-3
below compares how the three protocols differ regarding the port state transition.

All three protocols calculate a stable topology in the same way. Every segment will have a single path
to the root bridge. All bridges listen for BPDU packets. However, BPDU packets are sent more
frequently - with every Hello packet. BPDU packets are sent even if a BPDU packet was not received.
Therefore, each link between bridges is sensitive to the status of the link. Ultimately, this difference
results in faster detection of failed links, and thus faster topology adjustment. A drawback of 802.1D-
1998 is this absence of immediate feedback from adjacent bridges.

802.1Q-2005 802.1D-2004 802.1D-1998 STP Forwarding Learning
MSTP RSTP

Disabled Disabled Disabled No No
Discarding Discarding Blocking No No
Discarding Discarding Listening No No
Learning Learning Learning No Yes
Forwarding Forwarding Forwarding Yes Yes
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RSTP is capable of a more rapid transition to a forwarding state - it no longer relies on timer
configurations - RSTP compliant bridges are sensitive to feedback from other RSTP compliant bridge
links. Ports do not need to wait for the topology to stabilize before transitioning to a forwarding state.
In order to allow this rapid transition, the protocol introduces two new variables: the edge port and the
point-to-point (P2P) port.

Edge Port

The edge port is a configurable designation used for a port that is directly connected to a segment
where a loop cannot be created. An example would be a port connected directly to a single
workstation. Ports that are designated as edge ports transition to a forwarding state immediately
without going through the listening and learning states. An edge port loses its status if it receives a
BPDU packet, immediately becoming a normal spanning tree port.

P2P Port

A P2P port is also capable of rapid transition. P2P ports may be used to connect to other bridges.
Under RSTP/MSTP, all ports operating in full-duplex mode are considered to be P2P ports, unless
manually overridden through configuration.

802.1D-1998/802.1D-2004/802.1Q-2005 Compatibility

MSTP or RSTP can interoperate with legacy equipment and is capable of automatically adjusting
BPDU packets to 802.1D-1998 format when necessary. However, any segment using 802.1D-1998
STP will not benefit from the rapid transition and rapid topology change detection of MSTP or RSTP.
The protocol also provides for a variable used for migration in the event that legacy equipment on a
segment is updated to use RSTP or MSTP.

The Spanning Tree Protocol (STP) operates on two levels:

¢ On the switch level, the settings are globally implemented.
¢ On the port level, the settings are implemented on a per-user-defined group of ports basis.

STP Global Settings

This window is used to view and configure the STP global settings.

To view the following window, click L2 Features > STP > STP Global Settings, as shown below:

DD3 g s

STP State

STP State (@ Disabled (") Enabled
STP Traps

STP Mew Root Trap (@) Disabled (") Enabled

STF Topology Change Trap (@) Disabled () Enabled
STP Mode
STP Priority

Friority (0-61440)
STP Configuration

Bridge Max Age (6-40) sec Bridge Hello Time (1-2) sec

Bridge Forward Time (4-30) sec TX Hold Count (1-10) [ tmes

Max Hops (6-40) fimes

Figure 5-44 STP Global Settings Window
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The field that can be configured for Spanning Tree State is described below:

Parameter Description

Spanning Tree State Select this option to enable or disable the STP global state here.

Click the Apply button to accept the changes made.

The fields that can be configured for STP Traps are described below:

Parameter Description

STP New Root Trap Select this option to enable or disable the STP new root trap option
here.

STP Topology Change Trap |Select this option to enable or disable the STP topology change
trap option here.

Click the Apply button to accept the changes made.

The fields that can be configured for STP Mode are described below:

Parameter Description

STP Mode Select the STP mode used here. Options to choose from are
MSTP, RSTP, and STP.

Click the Apply button to accept the changes made.

The fields that can be configured for Spanning Tree Priority are described below:

Parameter Description

Priority Select the STP priority value here. This value is between 0 and
61440. By default, this value is 32768. The lower the value, the
higher the priority.

Click the Apply button to accept the changes made.

The fields that can be configured for Spanning Tree Configuration are described below:

Parameter Description

Bridge Max Age Enter the bridge’s maximum age value here. This value must be
between 6 and 40 seconds. By default, this value is 20 seconds.
The maximum age value may be set to ensure that old information
does not endlessly circulate through redundant paths in the
network, preventing the effective propagation of the new
information. Set by the Root Bridge, this value will aid in
determining that the Switch has spanning tree configuration values
consistent with other devices on the bridged LAN.

Bridge Hello Time After selecting RSTP/STP as the STP Mode, this parameter will be
available. Enter the bridge’s hello time value here. This value must
be between 1 and 2 seconds. By default, this value is 2 seconds.
This is the interval between two transmissions of BPDU packets
sent by the Root Bridge to tell all other switches that it is indeed the
Root Bridge. This field will only appear here when STP or RSTP is
selected for the STP Version. For MSTP, the Hello Time must be
set on a port per port basis.

Bridge Forward Time Enter the bridge’s forwarding time value here. This value must be
between 4 and 30 seconds. By default, this value is 15 seconds.
Any port on the Switch spends this time in the listening state while
moving from the blocking state to the forwarding state.
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Parameter Description

TX Hold Count Enter the transmit hold count value here. This value must be
between 1 and 10 times. By default, this value is 6 times. This
value is used to set the maximum number of Hello packets
transmitted per interval.

Max Hops Enter the maximum number of hops that are allowed. This value
must be between 6 and 40 hops. By default, this value is 20 hops.
This value is used to set the number of hops between devices in a
spanning tree region before the BPDU (bridge protocol data unit)
packet sent by the Switch will be discarded. Each switch on the
hop count will reduce the hop count by one until the value reaches
zero. The Switch will then discard the BDPU packet and the
information held for the port will age out.

Click the Apply button to accept the changes made.

STP Port Settings

This window is used to view and configure the STP port settings.

To view the following window, click L2 Features > STP > STP Port Settings, as shown below:

STP Port Settings

Unit 1 [v]  FromPort To Port eth1/0/1 V]
Cost(1-200000000,0=Aute) | | stk Enabled [v] GuardRoot
Link Type Auto [~]  PortFast TCN Filter Disabled V]
BPDU Forward Disabled ~] oty [128 ~] HemtoTime(t2y [ sec

Unit 1 Settings

I T T T

eth1/0/1 Enabled 0/200000 Disabled Auto/P2P Edge/Mon-Edge Disabled Disabled

eth1/0/2 Enabled 0/200000 Disabled Auto/P2P Edge/Mon-Edge Disabled Disabled 128
eth1/0/3 Enabled 0200000 Disabled Auto/P2P Edge/Mon-Edge Disabled Disabled 128
eth1/0/4 Enabled 0/200000 Disabled Auto/P2P Edge/Non-Edge Disabled Disabled 128
eth1/0/5 Enabled /200000 Disabled Auto/P2P Edge/Mon-Edge Disabled Disabled 128
eth1/0/6 Enabled 0/200000 Disabled Auto/P2P Edge/Non-Edge Disabled Disabled 128
eth1/0/7 Enabled /200000 Disabled Auto/P2P Edge/Mon-Edge Disabled Disabled 128
eth1/0/8 Enabled 0/200000 Disabled Auto/P2P Edge/Non-Edge Disabled Disabled 128
eth1/0/9 Enabled 0/200000 Disabled Auto/P2P Edge/Mon-Edge Disabled Disabled 128
eth1/0/10 Enabled 0200000 Disabled Auto/P2P Edge/Mon-Edge Disabled Disabled 128

Figure 5-45 STP Port Settings Window

The fields that can be configured are described below:

Parameter ‘ Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
Cost Enter the cost value here. This value must be between 1 and

200000000. This value defines a metric that indicates the relative
cost of forwarding packets to the specified port list. Port cost can be
set automatically or as a metric value. The default value is 0 (auto).
Setting 0 for the external cost will automatically set the speed for
forwarding packets to the specified port(s) in the list for optimal
efficiency. The default port cost for a 100Mbps port is 200000 and
the default port cost for a Gigabit port is 20000. The lower the
number, the greater the probability the port will be chosen to
forward packets.

State Select to enable or disable the STP port state.

138




DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

Parameter ‘ Description

Guard Root

Select to enable or disable the guard root function.

Link Type

Select the link type option here. Options to choose from are Auto,
P2P, and Shared. A full-duplex port is considered to have a point-
to-point (P2P) connection. On the opposite, a half-duplex port is
considered to have a Shared connection. The port cannot transit
into the forwarding state rapidly by setting the link type to Shared.
By default, this option is Auto.

Port Fast

Select the port fast option here. Options to choose from are:

o Network - The port remains in the non-port-fast state for
three seconds. The port will change to the port-fast state if
no BPDU is received and changes to the forwarding state. If
the port received the BPDU later, it will change to the non-
port-fast state. This is the default option.

o Disabled - The port is always in the non-port-fast state. It will
always wait for the forward-time delay to change to the
forwarding state.

o Edge - The port directly changes to the spanning-tree
forwarding state when a link-up occurs without waiting for the
forward-time delay. If the interface receives a BPDU later, its
operation state changes to the non-port-fast state.

TCN Filter

Select to enable or disable the TCN filter option. Enabling TC
filtering on a port is useful for an ISP to prevent the external bridge
to a core region of the network, causing address flushing in that
region, possibly, because those bridges are not under the full
control of the administrator. When a port is set to the TCN filter
mode, the TC event received by the port will be ignored. By default,
this option is Disabled.

BPDU Forward

Select to enable or disable BPDU forwarding. If enabled, the
received STP BPDU will be forwarded to all VLAN member ports in
the untagged form. By default, this option is Disabled.

Priority Select the priority value here. Options to choose from are 0 to 240.
By default, this option is 128. A lower value has higher priority.
Hello Time Enter the hello time value here. This value must be between 1 and

2 seconds. This value specifies the interval that a designated port
will wait between the periodic transmissions of each configuration
message.

Click the Apply button to accept the changes made.

MST Configuration Identification

This window is used to view and configure the MST configuration identification settings. These
settings will uniquely identify a multiple spanning tree instance set on the Switch. The Switch initially
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possesses one CIST, or Common Internal Spanning Tree, of which the user may modify the
parameters for but cannot change the MSTI ID for, and cannot be deleted.

To view the following window, click L2 Features > STP > MST Configuration Identification, as
shown below:

MST Configuration Identification

Configuration Name 3C:1E:04:AT:BI.ED

Revision Level (0-65535) b

Digest AC36177F50283C04B83821D8AB26DEG2
Instance ID Settings

Action Add VID [v]

Total Entries: 1

cIST 1-4094 Edit Delete
11 [ 1| Go

Figure 5-46 MST Configuration Identification Window

The fields that can be configured for MST Configuration Identification are described below:

Parameter Description

Configuration Name Enter the MST This name uniquely identifies the MSTI (Multiple
Spanning Tree Instance). If a Configuration Name is not set, this
field will show the MAC address to the device running MSTP.

Revision Level Enter the revision level value here. This value must be between 0
and 65535. By default, this value is 0. This value, along with the
Configuration Name, identifies the MSTP region configured on the
Switch.

Click the Apply button to accept the changes made.

The fields that can be configured for Instance ID Settings are described below:

Parameter Description

Instance ID Enter the instance ID here. This value must be between 1 and 16.

Action Select the action that will be taken here. Options to choose from
are Add VID and Remove VID.

VID List Enter the VID list value here. This field is used to specify the VID
range from configured VLANSs set on the Switch.

Click the Apply button to accept the changes made.
Click the Edit button to re-configure the specific entry.
Click the Delete button to remove the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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STP Instance

This window is used to view and configure the STP instance settings.

To view the following window, click L2 Features > STP > STP Instance, as shown below:

Total Entries: 1

cisT Disabled 32768(32768 sysid 0)
] e

Instance CIST

o G5 s e 5T

Bridge Address 00-01-02-03-04-00
Designated Root Address / Priority 00-00-00-00-00-00/ 0
Regional Root Bridge Address / Priority 00-00-00-00-00-00/ 0
Designated Bridge Addrass / Priority 00-00-00-00-00-00/ 0

Figure 5-47 STP Instance Window

Click the Edit button to re-configure the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

MSTP Port Information

This window is used to view and configure the MSTP port information settings.

To view the following window, click L2 Features > STP > MSTP Port Information, as shown below:

MSTP Port Information

Unit Port [ Clear Detected Protocol ][ Find ]

eth1/0/1 Settings

cisT 200000 128 Forwarding NonStp
n 2l 1 | [ [Es

Figure 5-48 MSTP Port Information Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

Port Select the port number that will be cleared here.

Click the Clear Detected Protocol button to clear the detected protocol settings for the port selected.
Click the Find button to locate a specific entry based on the information entered.
Click the Edit button to re-configure the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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ERPS (G.8032)
For more information, refer to Appendix E - ERPS Information.

ERPS

This window is used to view and configure Ethernet Ring Protection Switching (ERPS) settings.

To view the following window, click L2 Features > ERPS (G.8032) > ERPS, as shown below:
R —

Ethernet Ring G.8032

Ring Name

Total Entries: 1

Ring 1 Edit Ring Edit Instance| |Show Status Delete

(1] i [ e

Figure 5-49 ERPS Window

The fields that can be configured are described below:

Parameter Description

Ring Name Enter the Ethernet Ring Protection (ERP) instance’s name here.
This name can be up to 32 characters long.

Click the Apply button to create an ITU-T G.8032 ERP physical ring.

Click the Edit Ring button to modify an ITU-T G.8032 ERP physical ring.

Click the Edit Instance button to configure the ERP instance.

Click the Show Status button to view the ITU-T G.8032 ERP physical ring’s status information.
Click the Delete button to delete the specified ITU-T G.8032 ERP physical ring.

After click the Edit Ring button, the following window will appear.

Ethernet Ring Settings

Ethernet Ring Name Ring

Instance 1D (1-32) |:||:| (_None (@Specify
Sub Ring Name |:| (CMone (@Specify
Portd |:| (CNone (@Specify
Port1 |:| (_MNone (@)Specify

Back | | Apply

Figure 5-50 ERPS (Edit Ring) Window

The fields that can be configured are described below:

Parameter Description

Instance ID Select the checkbox and enter the ERP instance number here. This
value must be between 1 and 32. Select the Specify radio button
to configure this parameter as per normal. Select the None radio
button to revert this parameter to the default setting.

Sub Ring Name Select the checkbox and enter the physical ring’s sub-ring name
here. This name can be up to 32 characters long. Select the
Specify radio button to configure this parameter as per normal.
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Parameter Description

Select the None radio button to revert this parameter to the default
setting.

Port0 Select the checkbox and then select the switch’s unit ID and the
port number that will be the first ring port of the physical ring. Select
the Specify radio button to configure this parameter as per normal.
Select the None radio button to revert this parameter to the default
setting.

Port1 Select the checkbox and then select the switch’s unit ID and the
port number that will be the second ring port of the physical ring.
Select the None option, from the drop-down menu, specifies that
the inter-connected node is a local node endpoint of an open ring.
Select the Specify radio button to configure this parameter as per
normal. Select the None radio button to revert this parameter to the
default setting.

Click the Back button to discard the changes made and return to the previous window.

Click the Apply button to accept the changes made.

After click the Edit Instance button, the following window will appear.

[ [NE E [ANnCce

Ethernet Instance Settings
Ethemnet Ring Name Ring
Instance ID 1
Description [] (CNone (@Specify
R-APS Channel VLAN (1-4094) |:| ] Mone @Specify
Inclusion VLAN List [] (" None (@ Specify
MEL (0-7) [] CNone @Specify
Profile Name [] (CNone (@Specify
s
RPL Owner Disabled ~O
Activate Disabled [~

Back | | Apply

Figure 5-51 ERPS (Edit Instance) Window

The fields that can be configured are described below:

Parameter Description

Description Select the checkbox and enter the ERP instance’s description
here. This description can be up to 64 characters long. Select the
Specify radio button to configure this parameter as per normal.
Select the None radio button to revert this parameter to the default
setting.

R-APS Channel VLAN Select the checkbox and enter the R-APS channel VLAN's ID for
the ERP instance here. The APS channel VLAN of a sub-ring
instance is also the virtual channel of the sub-ring. This value must
be between 1 and 4094. Select the Specify radio button to
configure this parameter as per normal. Select the None radio
button to revert this parameter to the default setting.

Inclusion VLAN List Select the checkbox and enter the inclusion VLAN list here. A
range is identified when a hyphen (-) is used. For example, VLANs
1 to 5 can be entered as 1-5. A list is identified when commas (,)
are used. For example, use VLANs 1,3,5. The VLANs specified
here will be protected by the ERP mechanism. Select the Specify
radio button to configure this parameter as per normal. Select the
None radio button to revert this parameter to the default setting.
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Parameter Description

MEL Select the checkbox and enter the ring MEL value of the ERP
instance here. This value must be between 0 and 7. The
configured MEL value of all ring nodes that participate in the same
ERP instance should be identical. Select the Specify radio button
to configure this parameter as per normal. Select the None radio
button to revert this parameter to the default setting.

Profile Name Select the checkbox and enter the G.8032 profile’s name here that
will be associated with this ERP instance. Multiple ERP instances
can be associated with the same G.8032 profile. The instances
associated with the same profile protect the same set of VLANS, or
the VLANSs protected by one instance are a subset of LANs
protected by another instance. This name can be up to 32
characters long. Select the Specify radio button to configure this
parameter as per normal. Select the None radio button to revert
this parameter to the default setting.

RPL Port Select the checkbox and then select the RPL port option here.
Options to choose from are Port0 and Port1. The option selected
will be configured as the RPL port.

RPL Owner Select the checkbox and then select whether this node is the RPL
owner or neighbor. Options to choose from are Enabled and
Disabled. Enabling this option will specify this RPL as an owner.

Activate Select the checkbox and then select whether or not to active this
ERP instance. Options to choose from are Enabled and Disabled.
Enabling this option will active this ERP instance.

Click the Back button to discard the changes made and return to the previous window.

Click the Apply button to accept the changes made.

After click the Show Status button, the following window will appear.

ERPS Status Information
Ethernet Ring Ring
Instance ID 1
Description
MEL 1
R-APS Channel invalid r-aps vlan
Frotected VLAN
Profile
Guard Timer 500 ms
Hold-Off Timer 0ms
WTR Timer 5 min
Revertive Enabled
Instance State Deactivated
Admin RPL
Operational RPL
FPort0 State Forwarding
Fort State Forwarding
Admin RPL Port
Operational RPL Port

Figure 5-52 ERPS (Show Status) Window

Click the Back button to return to the previous window.
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ERPS Profile

This window is used to view and configure the Ethernet Ring G.8032 profile settings.

To view the following window, click L2 Features > ERPS (G.8032) > ERPS Profile, as shown below:

e ———

Ethernet Ring G.8032 Profile

Profie Name [ sty |[ pelere |
Total Entries: 1
woace | s por st ]
P0:eth1/0/20,-(RPL)
Frofile 1 Frotection Edit
o e 1I021

(] & [ e

Figure 5-53 ERPS Profile Window

The fields that can be configured are described below:

Parameter Description

Profile Name Enter the G.8032 profile’s name here. This name can be up to 32
characters long. Multiple ERP instances can be associated with the
same G.8032 profile. The instances associated with the same
profile protect the same set of VLANSs, or the VLANs protected by
one instance are a subset of LANs protected by another instance.

Click the Apply button to associate the G.8032 profile with the ERP instance created.
Click the Delete button to disassociate the G.8032 profile based on the Profile Name entered.
Click the Edit button to modify the specified G.8032 profile.

After click the Edit button, the following window will appear.

Ethernet Profile Settings

Profile Name Frofile

TCN Propagation O

Revertive (|

Guard Timer {10-2000) 500 ms ]
Hold-Off Timer (0-10000) |:| ms []
WTR Timer (1-12) B mng

Back | | Apply

Figure 5-54 ERPS Profile (Edit) Window

The fields that can be configured are described below:

Parameter Description

TCN Propagation Select the checkbox and then select the TCN propagation state.
Options to choose from are Enable and Disabled. This function is
used to enable the propagation of the topology change natifications
from the sub-ERP instance to the major instance.

Revertive Select the checkbox and then select the revertive state. Options to
choose from are Enable and Disabled. This function is used to
revert back to the working transport entity, for example, when the
RPL was blocked.
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Parameter Description

Guard Timer Select the checkbox and enter the guard timer value here. This
value must be between 10 and 2000 milliseconds. By default, this
value is 500 milliseconds.

Hold-Off Timer Select the checkbox and enter hold-off timer value here. This value
must be between 0 and 10000 milliseconds. By default, this value
is 0 milliseconds.

WTR Timer Select the checkbox and enter the WTR timer value here. This
value must be between 1 and 12 minutes. By default, this value is
5 minutes.

Click the Back button to discard the changes made and return to the previous window.

Click the Apply button to accept the changes made.

Loopback Detection

The Loopback Detection (LBD) function is used to detect the loop created by a specific port. This
feature is used to temporarily shut down a port on the Switch when a CTP (Configuration Testing
Protocol) packet has been looped back to the Switch. When the Switch detects CTP packets received
from a port or a VLAN, this signifies a loop on the network. The Switch will automatically block the port
or the VLAN and send an alert to the administrator. The Loopback Detection function can be
implemented on a range of ports at a time. The user may enable or disable this function using the
drop-down menu.

To view the following window, click L2 Features > Loopback Detection, as shown below:

popback Detectio

Loopback Detection Global Settings
Loopback Detection State Enabled ~] Mode Port-based v
Enabled VLAN ID List 1-4094 Interval {1-32767) sec
Trap State Disabled v Action Shutdown ]
Address Type Multicast [v] Function Version v4.07
Loopback Detection Port Settings
Unit 1 [v]| From Port eth1/0/1 [v] To Port eth1/0/1 [v] State Disabled B
[ o Loopback Detocton iat ke | Timo Lot 500
eth1/0/1 Enabled Normal =
eth1/0/2 Enabled Normal
eth1/0/3 Enabled Normal
eth1/0/4 Enabled Normal
eth1/0/5 Enabled Normal
eth1/0/6 Enabled Normal
eth 1/0/7 Enabled Normal
eth1/0/8 Enabled Normal

Figure 5-55 Loopback Detection Window

The fields that can be configured for Loopback Detection Global Settings are described below:

Parameter Description

Loopback Detection State Select to enable or disable loopback detection. The default is
Disabled.

Mode Select the loopback detection mode. Options to choose from are
Port-based and VLAN-based.

Enable VLAN ID List Enter the VLAN ID for loop detection. This only takes effect when
the VLAN-based is selected in the Mode drop-down list.
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Parameter Description

Interval

Enter the interval in seconds that the device will transmit all the
CTP (Configuration Test Protocol) packets to detect a loop-back
event. The valid range is from 1 to 32767 seconds. The default
setting is 10 seconds.

Traps State

Select to enable or disable the loopback detection trap state.

Action

Select the action that will be taken here. Options to choose from
are:

e Shutdown - Specifies that when a loop was detected, the
port will be shut down (disabled) in the port-based mode.
Traffic will be blocked on the specific VLAN in the VLAN-
based mode.

¢ None - Specifies that when a loop was detected, the port will
not be disabled in the port-based mode. Traffic will not be
block on the specific VLAN in the VLAN-based mode. Only
log and trap messages will be sent.

Address Type

Select the address type here. This is used to configure the
destination address type in LBD packets for loopback detection.
Options to choose from are:
e Multicast - Specifies that only multicast LBD packet will be
sent. The destination address is CF-00-00-00-00-00.
¢ Broadcast - Specifies that only broadcast LBD packet will
be sent. The destination address is FF-FF-FF-FF-FF-FF.

Click the Apply button to accept the changes made.

The fields that can be configured for Loopback Detection Port Settings are described below:

Parameter Description

Unit

Select the switch unit that will be used for this configuration here.

From Port/ To Port

Select the appropriate port range used for the configuration here.

State

Select this option to enable or disable the state of the port.

Click the Apply button to accept the changes made.
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Link Aggregation

Understanding Port Trunk Groups

Port trunk groups are used to combine a number of ports together to make a single high-bandwidth
data pipeline. The Switch supports up to 32 port trunk groups with 1 to 8 ports in each group.

An Example of Link Aggregation

Ethemet Backbone
Uplink

1000 Mbps

gt

1000 Mbps Connection 1000 Mbps Connection 1000 Mbps Connection

ol |o| le
IS

‘b Q@ < < %ED

End Station Clients

Figure 5-56 Example of Port Trunk Group

The Switch treats all ports in a trunk group as a single port. Data transmitted to a specific host
(destination address) will always be transmitted over the same port in a trunk group. This allows
packets in a data stream to arrive in the same order they were sent.

Link aggregation allows several ports to be grouped together and to act as a single link. This gives a
bandwidth that is a multiple of a single link's bandwidth.

Link aggregation is most commonly used to link a bandwidth intensive network device or devices,
such as a server, to the backbone of a network.

The Switch allows the creation of up to 32 link aggregation groups, each group consisting of 1 to 8
links (ports). Each port can only belong to a single link aggregation group.

All of the ports in the group must be members of the same VLAN, and their STP status, static
multicast, traffic control; traffic segmentation and 802.1p default priority configurations must be
identical. Port locking and 802.1X must not be enabled on the trunk group. Further, the LACP
aggregated links must all be of the same speed and should be configured as full duplex.

Load balancing is automatically applied to the ports in the aggregated group, and a link failure within
the group causes the network traffic to be directed to the remaining links in the group.
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The Spanning Tree Protocol will treat a link aggregation group as a single link, on the switch level. On
the port level, the STP will use the port parameters of the Master Port in the calculation of port cost
and in determining the state of the link aggregation group. If two redundant link aggregation groups
are configured on the Switch, STP will block one entire group; in the same way STP will block a single
port that has a redundant link.

6//'" NOTE: If any ports within the trunk group become disconnected, packets intended for
the disconnected port will be load shared among the other linked ports of the
b, link aggregation group.

This window is used to view and configure the link aggregation settings.

To view the following window, click L2 Features > Link Aggregation, as shown below:

System Priority (1-65535) 32768
Load Balance Algorithm |Source Destination MAC ﬂ|
System ID 32768,3C-1E-04-A1-B9-E0

Channel Group Information

Unit From Port To Port Group ID (1-32) Mode
1[v] eth1/0/1 [v] eth1/0/1 [v] on ] Add |[Delete Member Port]

Note: Each Channel Group supports up to 8 member poris.

Total Entries: 1

Cr o T R
Pori-channel1 Static 1/0M10-1/0/13 Delete Channel || Channel Detail

Figure 5-57 Link Aggregation Window

The fields that can be configured for Link Aggregation are described below:

Parameter Description

System Priority Enter the system’s priority value used here. This value must be
between 1 and 65535. By default, this value is 32768. The system
priority determines which ports can join a port-channel and which
ports are put in the stand-alone mode. The lower value has a
higher priority. If two or more ports have the same priority, the port
number determines the priority.

Load Balance Algorithm Select the load-balancing algorithm that will be used here. Options
to choose from are Source MAC, Destination MAC, Source
Destination MAC, Source IP, Destination IP, and Source
Destination IP. By default, this option is Source MAC.

Click the Apply button to accept the changes made.

The fields that can be configured for Channel Group Information are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
Group ID Enter the channel group number here. This value must be between

1 and 32. The system will automatically create the port-channel
when a physical port first joins a channel group. An interface can
only join one channel-group.

Mode Select the mode option here. Options to choose from are On,
Active, and Passive. If the mode On is specified, the channel
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Parameter Description

group type is static. If the mode Active or Passive is specified, the
channel group type is LACP. A channel group can only consist of
either static members or LACP members. Once the type of channel
group has been determined, other types of interfaces cannot join
the channel group.

Click the Add button to add a new entry based on the information entered.
Click the Delete Member Port button to remove the specific member port.
Click the Delete Channel button to remove the specific entry.

Click the Channel Detail button to view detailed information about the channel.

After clicking the Channel Detail button, the following page will be available.

Port Channel Description

Fort Channel 1
Fori-channeli enabled Delete Description
Port Channel Information
Port Channel 1
Frotocol Static

Port Channel Detail Information

“ LACP Timeout Working Mode LACP State Port Priority Port Number _

eth1/0/10 None None None None Edit
eth1/0/11 None None down Nong Mone Edit
eth1/0M12 None None down None MNone Edit
eth1/0M13 MNone None down None Mone Edit

Port Channel Neighbor Information

m Partner System ID Partner PortNo Partner LACP Timeout —— Partner Port Priority

eth1/0/10 None Mone None None None

eth1/0/11 Mone MNone None MNone Mone

eth1/0M12 Mone Mone None Mone Mone

eth1/0/13 None MNone None None None
LACP State:

bndl: Port is attached to an aggregator and bundled with other poris.

indep: Port is in an independent state(not bundled but able to swiich data traffic).
hot-sby- Port is in & hot-standby state

down: Portis down.

Figure 5-58 Port Channel Window

The fields that can be configured for Port Channel Description are described below:

Parameter Description

Description Enter the description for the port channel here. This can be up to
64 characters long.

Click the Apply button to accept the changes made.
Click the Delete Description button to clear the setting in the corresponding Description field.
Click the Edit button to re-configure the specific entry.

Click the Back button to return to the previous window.
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L2 Multicast Control

IGMP Snooping

Internet Group Management Protocol (IGMP) snooping allows the Switch to recognize IGMP queries
and reports sent between network stations or devices and an IGMP host.

IGMP Snooping Settings

In order to use IGMP Snooping it must first be enabled for the entire Switch under IGMP Global
Settings at the top of the window. You may then fine-tune the settings for each VLAN by clicking the
corresponding Edit button. When enabled for IGMP snooping, the Switch can open or close a port to
a specific multicast group member based on IGMP messages sent from the device to the IGMP host
or vice versa. The Switch monitors IGMP messages and discontinues forwarding multicast packets
when there are no longer hosts requesting that they continue.

To view the following window, click L2 Features > L2 Multicast Control > IGMP Snooping > IGMP
Snooping Settings, as shown below:

Global Settings

Global State Enabled (g Disabled [ apply |
VLAN Status Settings

vi(oen[ ] Enabled @ Disabled
IGMP Snooping Table

vigoen ] \ Find | [ Findan |
Total Entries: 1

= = N e

1 default Enabled [Show Detail| [ Edit |
1N [ [es

Figure 5-59 IGMP Snooping Settings Window

The field that can be configured for Global Settings is described below:

Parameter Description

Global State Select this option to enable or disable IGMP snooping global state.

Click the Apply button to accept the changes made.

The fields that can be configured for VLAN Status Settings are described below:

Parameter Description

VID Enter a VLAN ID from 1 to 4094, and select to enable or disable
IGMP snooping on the VLAN.

Click the Apply button to accept the changes made.

The fields that can be configured for IGMP Snooping Table are described below:

Parameter Description
VID Enter a VLAN ID from 1 to 4094.

Click the Find button to locate a specific entry based on the information entered.

Click the Find All button to view all the entries.
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Click the Show Detail button to see the detail information of the specific VLAN.
Click the Edit button to re-configure the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

After clicking the Show Detail button, the following window will appear.

O VAN Fara

IGMP Snooping VLAN Parameters

VID 1

Status Enabled
Minimum Version 'l
FastLeave Disabled (host-based)
Report Suppression Disabled
Suppression Time 10 seconds
Querier State Disabled
Query Version W3

Query Interval 125 seconds
Max Response Time 10 seconds
Robustness Value 2

Last Member Cuery Interval 1 seconds

Proxy Reporting

Disabled Source Address (0.0.0.0)
Modify

Figure 5-60 IGMP Snooping VLAN Parameters Window

The window displays the detail information about IGMP snooping VLAN. Click the Modify button to
edit the information in the following window.

After clicking the Modify or Edit button in IGMP Snooping Settings window, the following window will

appear.

IGMP Snooping VLAN Settings

VID (1-4094)

Status

Minimum Version

Fast Leave

Report Suppression
Suppression Time (1-300)
Querier State

Query Version

Query Interval (1-31744)

Max Response Time (1-25)

Robustness Value (1-7)

Enabled ' Disabled

Enabled (®Disabled
Enabled (# Disabled

Enabled (» Disabled

Last Member Query Interval {(1-25) sec
i Enabled (e Disabled
Proxy Reporting

Source Address

Apply

Figure 5-61 IGMP Snooping VLAN Settings Window
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The fields that can be configured are described below:

Parameter Description

Minimum Version

Select the minimum version of IGMP hosts that is allowed on the
VLAN.

Fast Leave

Select this option to enable or disable the IGMP snooping fast
leave function. If enabled, the membership is immediately removed
when the system receive the IGMP leave message.

Report Suppression

Select this option to enable or disable the report suppression. The
report suppression function only works for IGMPv1 and IGMPv2
traffic. When report suppression is enabled, the Switch suppresses
the duplicate reports sent by hosts. The suppression for the same
group report or leave will continue until the suppression time
expired. For report or leave messages to the same group, only one
report or leave message is forwarded. The remaining report and
leave messages are suppressed.

Suppression Time

Enter the interval of suppressing duplicate IGMP reports or leaves.
The range is from 1 to 300.

Querier State

Select this option to enable or disable the querier state.

Query Version

Select the general query packet version sent by the IGMP
snooping querier. Options to choose from are 1, 2, and 3.

Query Interval

Enter the interval at which the IGMP snooping querier sends IGMP
general query messages periodically.

Max Response Time

Enter the maximum response time, in seconds, advertised in IGMP
snooping queries. The range is 1 to 25.

Robustness Value

Enter the robustness variable used in IGMP snooping.

Last Member Query Interval

Enter the interval at which the IGMP snooping querier sends IGMP
group-specific or group-source-specific (channel) query messages.

Proxy Reporting

Select this option to enable or disable the proxy-reporting function.

Source Address

Enter the source IP of proxy reporting. This is available when
Enabled is selected in Proxy Reporting.

Click the Apply button to accept the changes made.
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IGMP Snooping Groups Settings

This window is used to configure and view the IGMP snooping static group, and view IGMP snooping
group.

To view the following window, click L2 Features > L2 Multicast Control > IGMP Snooping > IGMP
Snooping Groups Settings, as shown below:

ooping Toups Setting

IGMP Sncoping Static Groups Settings

VID (1-4094) Group Address Unit From Port To Port

| | (I E [=] [ethtin [=] [ethtiort ] [ oy ) [ beete ]

VID (1-4094) Group Address

o[ ] (| [ Fnd ] [ Fndal ]

Total Entries: 1

I Y S R S
1 224111 1/0/3

1N B
IGMP Snooping Groups Table

VID (1-4094) Group Address

o ] i g v

Total Entries: 0

Figure 5-62 IGMP Snooping Groups Settings

The fields that can be configured for IGMP Snooping Static Groups Settings are described below:

Parameter Description

VID Enter a VLAN ID of the multicast group.

Group Address Enter an IP multicast group address.

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
VID Click the radio button and enter a VLAN ID of the multicast group.
Group Address Click the radio button and enter an IP multicast group address.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

Click the Find button to locate a specific entry based on the information entered.
Click the Find All button to view all the entries.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

The fields that can be configured or displayed for IGMP Snooping Groups Table are described

below:
VID Click the radio button and enter a VLAN ID of the multicast group.
Group Address Click the radio button and enter an IP multicast group address.
FM Displays the filter mode. The value of the filter mode can be either
IN (Include) or EX (Exclude).
e IN (Include) - The filter mode is Include.
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Parameter Description

e EX (Exclude) - The filter mode is Exclude.

Exp (sec) Display the time left in seconds before the entry expires.

Click the Find button to locate a specific entry based on the information entered.

Click the Find All button to view all the entries.

IGMP Snooping Mrouter Settings

This window is used to configure the specified interface(s) as the multicast router ports or as
forbidden to be multicast router ports on the Switch.

To view the following window, click L2 Features > L2 Multicast Control > IGMP Snooping > IGMP
Snooping Mrouter Settings, as shown below:

IGMP Snooping Mrouter Settings

VID (1-4024) Configuration Unit From Port To Port

| | [Port =] [t =] [eth1on =] [ethinA ] [ seely | [ Dekete
IGMP Snooping Mrouter Table

VD@08 ] ( Find ] [ Findan |

Total Entries: 1

1 1/0/5-1/0/9 (Static)

Figure 5-63 IGMP Snooping Mrouter Settings Window

The fields that can be configured for IGMP Snooping Mrouter Settings are described below:

Parameter Description

VID Enter a VLAN ID between 1 and 4094.

Configuration Select the port configuration. Options to choose from are:

e Port - Select to have the configured ports to be static
multicast router ports.

e Forbidden Port - Select to have the configured ports not to
be multicast router ports.

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

The fields that can be configured for IGMP Snooping Mrouter Table are described below:

Parameter Description
VID Enter a VLAN ID between 1 and 4094.

Click the Find button to locate a specific entry based on the information entered.
Click the Find All button to view all the entries.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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IGMP Snooping Statistics Settings

This window is used to clear and display the IGMP snooping related statistics.

To view the following window, click L2 Features > L2 Multicast Control > IGMP Snooping > IGMP
Snooping Statistics Settings, as shown below:

DO

IGMP Snooping Statistics Settings

Statistics VID (1-4004) Unit From Port To Port

LAl 2 | | || [ Clear ]
IGMP Snooping Statistics Table

Find Type VID (1-4004) Unit From Port To Port

[VLAN =] | | | | | | | | (_Fnd ] [_Findan ]

Total Entries: 1

[ = = T = T = [ & ] =
et | cumy | e | vy | vt | ey | v | o | vy | tome | g | oy | o | v |
eth1/0r5 0 0 0 1] 1] 0 0 0 0 0 0 0 0 0
n [ [E8

Figure 5-64 IGMP Snooping Statistics Settings Window

The fields that can be configured for IGMP Snooping Statistics Settings are described below:

Parameter Description

Statistics Select the interface here. Options to choose from are All, VLAN,
and Port.

VID Enter a VLAN ID between 1 and 4094. This is available when
VLAN is selected in the Statistics drop-down list.

Unit Select the switch unit that will be used for this configuration here.
This is available when Port is selected in the Statistics drop-down
list.

From Port/ To Port Select the appropriate port range used for the configuration here.
This is available when Port is selected in the Statistics drop-down
list.

Click the Clear button to clear the IGMP snooping related statistics.

The fields that can be configured for IGMP Snooping Statistics Table are described below:

Parameter Description

Find Type Select the interface type. Options to choose from are VLAN, and
Port.

VID Enter a VLAN ID between 1 and 4094. This is available when
VLAN is selected in the Find Type drop-down list.

Unit Select the switch unit that will be used for this configuration here.
This is available when Port is selected in the Find Type drop-down
list.

From Port/ To Port Select the appropriate port range used for the configuration here.
This is available when Port is selected in the Find Type drop-down
list.

Click the Find button to locate a specific entry based on the information entered.

Click the Find All button to view all the entries.
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Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

MLD Snooping

Multicast Listener Discovery (MLD) Snooping is an IPv6 function used similarly to IGMP snooping in
IPv4. It is used to discover ports on a VLAN that are requesting multicast data. Instead of flooding all
ports on a selected VLAN with multicast traffic, MLD snooping will only forward multicast data to ports
that wish to receive this data through the use of queries and reports produced by the requesting ports
and the source of the multicast traffic.

MLD snooping is accomplished through the examination of the layer 3 part of an MLD control packet
transferred between end nodes and a MLD router. When the Switch discovers that this route is
requesting multicast traffic, it adds the port directly attached to it into the correct IPv6 multicast table,
and begins the process of forwarding multicast traffic to that port. This entry in the multicast routing
table records the port, the VLAN ID, and the associated multicast IPv6 multicast group address, and
then considers this port to be an active listening port. The active listening ports are the only ones to
receive multicast group data.

MLD Control Messages

Three types of messages are transferred between devices using MLD snooping. These three
messages are all defined by four ICMPv6 packet headers, labeled 130, 131, 132, and 143.

e Multicast Listener Query - Similar to the IGMPv2 Host Membership Query for IPv4, and
labeled as 130 in the ICMPv6 packet header, this message is sent by the router to ask if any
link is requesting multicast data. There are two types of MLD query messages emitted by the
router. The General Query is used to advertise all multicast addresses that are ready to send
multicast data to all listening ports, and the Multicast Specific query, which advertises a specific
multicast address that is also ready. These two types of messages are distinguished by a
multicast destination address located in the IPv6 header and a multicast address in the
Multicast Listener Query Message.

o Multicast Listener Report, Version 1 - Comparable to the Host Membership Report in
IGMPv2, and labeled as 131 in the ICMP packet header, this message is sent by the listening
port to the Switch stating that it is interested in receiving multicast data from a multicast
address in response to the Multicast Listener Query message.

e Multicast Listener Done - Akin to the Leave Group Message in IGMPv2, and labeled as 132
in the ICMPV6 packet header, this message is sent by the multicast listening port stating that it
is no longer interested in receiving multicast data from a specific multicast group address,
therefore stating that it is “done” with the multicast data from this address. Once this message
is received by the Switch, it will no longer forward multicast traffic from a specific multicast
group address to this listening port.

¢ Multicast Listener Report, Version 2 - Comparable to the Host Membership Report in
IGMPv3, and labeled as 143 in the ICMP packet header, this message is sent by the listening
port to the Switch stating that it is interested in receiving multicast data from a multicast
address in response to the Multicast Listener Query message.
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MLD Snooping Settings

This window is used to configure the MLD snooping settings.

To view the following window, click L2 Features > L2 Multicast Control > MLD Snooping > MLD
Snooping Settings, as shown below:

Global Settings

Global State Enabled (g Disabled
VLAN Siatus Settings

viogoen ] Enabled @ Disabled
MLD Snooping Table

VD08 ] [ Ffind ][ Fndan |
Total Entries: 1

I~ R N - R

1 default Enabled [Show Detail| [ Edit |
1n [ [ee

Figure 5-65 MLD Snooping Settings Window

The field that can be configured for Global Settings is described below:

Parameter Description

Global State Select this option to enable or disable MLD snooping global state.

Click the Apply button to accept the changes made.

The fields that can be configured for VLAN Status Settings are described below:

Parameter Description

VID Enter a VLAN ID from 1 to 4094, and select to enable or disable
MLD snooping on the VLAN.

Click the Apply button to accept the changes made.

The fields that can be configured for MLD Snooping Table are described below:

Parameter Description

VID Enter a VLAN ID from 1 to 4094.

Click the Find button to locate a specific entry based on the information entered.
Click the Find All button to view all the entries.

Click the Show Detail button to see the detail information of the specific VLAN.
Click the Edit button to re-configure the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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After clicking the Show Detail button, the following window will appear.

MLD Snooping VLAN Parameters

viD
Status

Minimum Version
FastLeave

Report Suppression
Suppression Time
Proxy Reporting

4
Enabled

vl

Disabled (host-based)
Disabled

10 seconds

Disabled Source Address ()

Mrouter Port Learning Enabled
Querier State Disabled
Query Version w2

Query Interval

125 seconds

Max Response Time 10 seconds
Robustness Value 2
Last Listener Ctuery Interval 1 seconds

Figure 5-66 MLD Snooping VLAN Parameters Window

Modify

The window displays the detail information about MLD snooping VLAN. Click the Modify button to edit
the information in the following window.

After clicking the Modify or Edit button in MLD Snooping Settings window, the following window will

appear.

MLD Snooping VLAN Settings

VID (1-4094)

Status

Minimum Version

Fast Leave

Report Suppression
Suppression Time (1-300)

I

Enabled = Disabled

I

Enabled ®Disabled

=
=
m
=
w
=2
I
=%
(]
! =]
n
[
=
@
=%

Mrouter Port Learning # Enabled | Disabled
Querier State Enabled ® Disabled

Query Version

CQuery Interval (1-31744)

o
m
a1

Max Response Time (1-25)

Robustness Value (1-7)

p—ry [%] pury —
o | | pa| |M2
o
-
U:-
@
o

o
m
]

Last Listener Cuery Interval (1-25)

Apply

Figure 5-67 MLD Snooping VLAN Settings Window

The fields that can be configured are described below:

Parameter Description

Minimum Version Select the minimum version of MLD hosts that is allowed on the
VLAN.
Fast Leave Select this option to enable or disable the MLD snooping fast leave

function. If enabled, the membership is immediately removed when
the system receive the MLD leave message.
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Parameter Description

Report Suppression Select this option to enable or disable the report suppression.

Suppression Time Enter the interval of suppressing duplicate MLD reports or leaves.
The range is from 1 to 300.

Proxy Reporting Select this option to enable or disable the proxy-reporting function.

Source Address Enter the source IPv6 of proxy reporting. This is available when
Enabled is selected in Proxy Reporting.

Mrouter Port Learning Select this option to enable or disable Mrouter port learning.

Querier State Select this option to enable or disable the querier state.

Query Version Select the general query packet version sent by the MLD snooping

querier. Options to choose from are 1, and 2.

Query Interval Enter the interval at which the MLD snooping querier sends MLD
general query messages periodically.

Max Response Time Enter the maximum response time, in seconds, advertised in MLD
snooping queries. The range is 1 to 25.

Robustness Value Enter the robustness variable used in MLD snooping.

Last Listener Query Interval |Enter the interval at which the MLD snooping querier sends MLD
group-specific or group-source-specific (channel) query messages.

Click the Apply button to accept the changes made.

MLD Snooping Groups Settings

This window is used to configure and view the MLD snooping static group, and view MLD snooping
group.

To view the following window, click L2 Features > L2 Multicast Control > MLD Snooping > MLD
Snooping Groups Settings, as shown below:

DUPS Setiing

MLD Snooping Static Groups Settings

VID (1-4094) Group Address Unit From Port To Port
| | FFiea | [1 [v] [ethii0i1 [v] [ethtion M [ aely | [ Delete |
VID (1-4094) Group Address
o ] [ Fnd ][ _Fnda ]
Total Entries: 1
I Y S R S
1 FF56::123 1/0/4-110/6

1n [7] [ e
MLD Snooping Groups Table
VID (1-4094) Group Address
o ] [ Fa ] [ rmaa ]
Total Entries: 0
I Y S Y S N N

Figure 5-68 MLD Snooping Group Settings Window

The fields that can be configured for MLD Snooping Static Groups Settings are described below:

Parameter Description

VID Enter a VLAN ID of the multicast group.

Group Address Enter an IPv6 multicast group address.
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Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
VID Click the radio button and enter a VLAN ID of the multicast group.
Group Address Click the radio button and enter an IP multicast group address.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

Click the Find button to locate a specific entry based on the information entered.
Click the Find All button to view all the entries.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

The fields that can be configured or displayed for MLD Snooping Groups Table are described

below:
VID Click the radio button and enter a VLAN ID of the multicast group.
Group Address Click the radio button and enter an IPv6 multicast group address.
FM Display the filter mode. The value of the filter mode can be either IN
or EX.

¢ IN (Include) - The filter mode is Include.

o EX (Exclude) - The filter mode is Exclude.
Exp (sec) Display the time left in seconds before the entry expires.

Click the Find button to locate a specific entry based on the information entered.

Click the Find All button to view all the entries.

MLD Snooping Mrouter Settings

This window is used to configure the specified interface(s) as the router ports or forbidden to be IPv6
multicast router ports on the VLAN interface on the Switch.

To view the following window, click L2 Features > L2 Multicast Control > MLD Snooping > MLD
Snooping Mrouter Settings, as shown below:

MLD Snooping Mrouter Settings

VID (1-4094) Configuration Unit From Port To Port
| | [Port [=] [ =] [ethion =] [ethtion ] [ ol ] [ Deete
MLD Snooping Mrouter Table
vipeoen ] ( Find ] [ Findal ]
Total Entries: 1
W pors

1 17078 (Static)

Figure 5-69 MLD Snooping Mrouter Settings Window
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The fields that can be configured for MLD Snooping Mrouter Settings are described below:

Parameter Description

VID Enter a VLAN ID between 1 and 4094.

Configuration Select the port configuration. Options to choose from are:

o Port - Select to have the configured ports as being
connected to multicast-enabled routers.

o Forbidden Port - Select to have the configured ports as
being not connected to multicast-enabled routers.

e Learn pimv6 - Select to enable dynamic learning of
multicast router port.

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

The fields that can be configured for MLD Snooping Mrouter Table are described below:

Parameter Description
VID Enter a VLAN ID between 1 and 4094.

Click the Find button to locate a specific entry based on the information entered.
Click the Find All button to view all the entries.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

MLD Snooping Statistics Settings

This window is used to clear and display the MLD snooping related statistics.

To view the following window, click L2 Features > L2 Multicast Control > MLD Snooping > MLD
Snooping Statistics Settings, as shown below:

D nooping fatistics Setting

MLD Snooping Statistics Settings

Statistics WVID (1-4094) Unit From Port To Port

Al (] | | | | | ([ Clear ]
MLD Snooping Statistics Table

Find Type VID (1-4094) Unit From Port To Port

[VLAN = | | | | | | | | [_Fnd ][ Fndan ]

Total Entries: 1

T e T v

1P

o [ W w [ ow

B I I N T N IR
1] ] 0 0 ] 0 1] 1]

1n [ =8

eth1/0/8

Figure 5-70 MLD Snooping Statistics Settings Window

The fields that can be configured for MLD Snooping Statistics Settings are described below:

Parameter Description
Statistics Select the interface here. Options to choose from are All, VLAN,
and Port.
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Parameter Description

VID Enter a VLAN ID between 1 and 4094. This is available when
VLAN is selected in the Statistics drop-down list.

Unit Select the switch unit that will be used for this configuration here.
This is available when Port is selected in the Statistics drop-down
list.

From Port/ To Port Select the appropriate port range used for the configuration here.
This is available when Port is selected in the Statistics drop-down
list.

Click the Clear button to clear the MLD snooping related statistics.

The fields that can be configured for MLD Snooping Statistics Table are described below:

Parameter Description

Find Type Select the interface type. Options to choose from are VLAN, and
Port.

VID Enter a VLAN ID between 1 and 4094. This is available when
VLAN is selected in the Find Type drop-down list.

Unit Select the switch unit that will be used for this configuration here.
This is available when Port is selected in the Find Type drop-down
list.

From Port / To Port Select the appropriate port range used for the configuration here.
This is available when Port is selected in the Find Type drop-down
list.

Click the Find button to locate a specific entry based on the information entered.
Click the Find All button to view all the entries.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

Multicast Filtering

This window is used to view and configure the Layer 2 multicast filtering settings.

To view the following window, click L2 Features > L2 Multicast Control > Multicast Filtering, as
shown below:

Viulticas fering

Multicast Filtering

VID List Multicast Filter Mode | Forward UnreqisteredE”

Total Entries: 1

default Forward Unregistered Groups

n [ [se

Figure 5-71 Multicast Filtering Window

The fields that can be configured are described below:

Parameter Description

VID List Enter the VLAN ID list that will be used for this configuration here.

Multicast Filter Mode Select the multicast filter mode here. Options to choose from are:
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Parameter Description

o Forward Unregistered - Specifies that registered multicast
packets will be forwarded based on the forwarding table and
all unregistered multicast packets will be flooded based on
the VLAN domain.

o Forward All - Specifies that all multicast packets will be
flooded based on the VLAN domain.

¢ Filter Unregistered - Specifies that registered packets will
be forwarded based on the forwarding table and all
unregistered multicast packets will be filtered.

Click the Apply button to accept the changes made.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

LLDP

LLDP Global Settings

This window is used to configure the LLDP global settings.

To view the following window, click L2 Features > LLDP > LLDP Global Settings, as shown below:

LLDF obpal setuang

LLDP Global Settings

LLDF State (_)Enabled

LLDP Forward State (_)Enabled

LLDP Trap State (_)Enabled

LLDP-MED Trap State (OEnabled  (@Disabled
LLDP-MED Configuration

Fast Start Repeat Count (1-10) :Itimes
LLDP Configurations

Message TX Interval (5-32768) sec

Message TX Hold Multiplier (2-10) }:| sec

Relnit Delay (1-10) :Isec
LLDP System Information

Chassis |D Subfype MAC Address

Chassis ID 3C-1E-04-A1-B9-E0

System Name Switch

System Description
System Capabilities Supported
System Capabilities Enabled

LLDP-MED System Information

Device Class
Hardware Revision
Firmware Revision
Software Revision
Serial Number

Gigabit Ethernet SmartPro Switch
Repeater, Bridge
Repeater, Bridge

MNetwork Connecfivity Device
Al

1.00.016

1.70.007

RZNV1F1000011

Figure 5-72 LLDP Global Settings Window

The fields that can be configured for LLDP Global Settings are described below:

Parameter
LLDP State

Description

Select this option to enable or disable the LLDP feature
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Parameter Description

LLDP Forward State Select this option to enable or disable LLDP forward state. When
the LLDP State is disabled and LLDP Forward Sate is enabled,
the received LLDPDU packet will be forwarded.

LLDP Trap State Select this option to enable or disable the LLDP trap state.
LLDP-MED Trap State Select this option to enable or disable the LLDP-MED trap state.

Click the Apply button to accept the changes made.

The fields that can be configured for LLDP-MED Configuration are described below:

Parameter Description

Fast Start Repeat Count Enter the LLDP-MED fast start repeat count value. This value must
be between 1 and 10.

Click the Apply button to accept the changes made.

The fields that can be configured for LLDP Configurations are described below:

Parameter Description

Message TX Interval Enter the interval between consecutive transmissions of LLDP
advertisements on each physical interface. The range is from 5 to
32768 seconds.

Message TX Hold Multiplier |Enter the multiplier on the LLDPDUs transmission interval that used
to compute the TTL value of an LLDPDU. This value must be
between 2 and 10.

Relnit Delay Enter the delay value for LLDP initialization on an interface. This
value must be between 1 and 10 seconds.

TX Delay Enter the delay value for sending successive LLDPDUs on an
interface. The valid values are from 1 to 8192 seconds and should
not be greater than one-fourth of the transmission interval timer.

Click the Apply button to accept the changes made.
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LLDP Port Settings

This window is used to configure the LLDP port settings.

To view the following window, click L2 Features > LLDP > LLDP Port Settings, as shown below:

[ I'DP Port Setting
LLDP Port Settings
Unit  From Port To Port Notification Subtype Admin State IP Subtype Action Address
[eth1/0i1 [v]  [ethtioi [v]  [Disabled[~] [Local ] [TXandRx[¥] [Default[~] [Remove[~] | |
Note: The address should be the switch's address.
Unit 1 Settings
I T O T Y S
eth1/0M1 Disabled Local TX and RX
eth1/0/2 Disabled Local TX and RX
eth1/0/3 Disabled Local TX and RX
eth1/0/4 Disabled Local TX and RX
eth1/0/5 Disabled Local TX and RX
eth1/0/6 Disabled Local TX and RX
eth /07 Disabled Local TX and RX
eth1/0/8 Disabled Local TX and RX
eth1/0/9 Disabled Local TX and RX
eth1/010 Disabled Local TX and RX
eth1/0/11 Disabled Local TX and RX
eth1/0M12 Disabled Local TX and RX
eth1/0M3 Disabled Local TX and RX
eth1/0M14 Dizabled Local TX and RX
eth1/0M5 Disabled Local TX and RX
eth1/0M6 Dizabled Local TX and RX
eth1/0M7 Disabled Local TX and RX
eth1/0/18 Disabled Local TX and RX
eth1/019 Disabled Local TX and RX
eth1/0/20 Disabled Local TX and RX
eth1/0/21 Disabled Local TX and RX
eth1/0/22 Disabled Local TX and RX
eth1/0/23 Disabled Local TX and RX
eth1/0/24 Disabled Local TX and RX
eth1/0/25 Disabled Local TX and RX

Figure 5-73 LLDP Port Settings Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

Notification Select this option to enable or disable the sending of LLDP
notifications.

Subtype Select the subtype of LLDP TLV(s). Options to choose from are

MAC Address, and Local.

Admin State Select the local LLDP agent and allow it to send and receive LLDP
frames on the port. Options to choose from are:

e TX- The local LLDP agent can only transmit LLDP frames.

e RX- The local LLDP agent can only receive LLDP frames.

e TXand RX - The local LLDP agent can both transmit and
receive LLDP frames. This is the default option.

e Disabled - The local LLDP agent can neither transmit nor
receive LLDP frames.

IP Subtype Select the type of the IP address information to be sent. Options to
choose from are Default, IPv4, and IPv6.
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Parameter Description

Action Select the action that will be taken here. Options to choose from
are Remove and Add.

Address Enter the IP address that will be sent.

Click the Apply button to accept the changes made.

‘// NOTE: The IPv4 or IPv6 address entered here should be an existing LLDP
management IP address.

LLDP Management Address List

This window is used to view the LLDP management address list.

To view the following window, click L2 Features > LLDP > LLDP Management Address List, as
shown below:

Al 5]
I S O A S

IPvd 10.90.90.90(default) Ifindex 1.3.6.1.4.1.171.10.1... -

IPvd 10.90.90.90 Ifindex 1.3.6.1.4.1.171.10.1... =

Figure 5-74 LLDP Management Address List Window

The fields that can be configured are described below:

Parameter Description
All/IPv4/IPv6 Select the subtype. Options to choose from are All, IPv4, and
IPv6.

Click the Find button to locate a specific entry based on the information entered.

LLDP Basic TLVs Settings

Type-length-value (TLV) allows the specific sending information as a TLV element within LLDP
packets. This window is used to enable the settings for the Basic TLVs Settings. An active LLDP port
on the Switch always included mandatory data in its outbound advertisements. There are four optional
data types that can be configured for an individual port or group of ports to exclude one or more of
these data types from outbound LLDP advertisements. The mandatory data type includes four basic
types of information (end of LLDPDU TLV, chassis ID TLV, port ID TLV, and Time to Live TLV). The
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mandatory data types cannot be disabled. There are also four data types, which can be optionally
selected. These include Port Description, System Name, System Description, and System Capability.

To view the following window, click L2 Features > LLDP > LLDP Basic TLVs Settings, as shown
below:

LLDP Basic TLVs Settings

Unit From Port To Port Port Description System Name System Description System Capabilities

[eth1/01 [=]  [ethti0 [z]  [Disabled[=] [Disabled[=]  [Disabled[=] [ Disabled [~]

Unit 1 Settings

| eouvesimion | Spmtone | Semvesawion | sysemcambites |
eth1/01 Disabled Disabled Disabled Disabled
eth1/0/2 Disabled Disabled Disabled Disabled
eth1/0/3 Disabled Disabled Disabled Disabled
eth1/0/4 Disabled Disabled Disabled Disabled
eth1/0/5 Disabled Disabled Disabled Disabled
eth1/0/6 Disabled Disabled Disabled Disabled
eth1/0/7 Disabled Digabled Disabled Disabled
eth1/0/8 Disabled Disabled Disabled Disabled
eth1/0/9 Disabled Disabled Disabled Disabled 2
eth1/0/10 Disabled Disabled Disabled Disabled [
eth1/0/11 Disabled Disabled Disabled Disabled
eth1/0r12 Disabled Disabled Disabled Disabled
eth1/0/13 Disabled Disabled Disabled Disabled
eth1/0/14 Disabled Disabled Disabled Disabled
eth1/0/15 Disabled Disabled Disabled Disabled

Figure 5-75 LLDP Basic TLVs Settings Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

Port Description Select this option to enable or disable the Port Description option.

System Name Select this option to enable or disable the System Name option.

System Description Select this option to enable or disable the System Description
option.

System Capabilities Select this option to enable or disable the System Capabilities
option.

Click the Apply button to accept the changes made.
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LLDP Dot1 TLVs Settings

LLDP Dot1 TLVs are organizationally specific TLVs, which are defined in IEEE 802.1 and used to
configure an individual port or group of ports to exclude one or more of the IEEE 802.1 organizational
port VLAN ID TLV data types from outbound LLDP advertisements.

To view the following window, click L2 Features > LLDP > LLDP Dot1 TLVs Settings, as shown
below:

UF Lo v =ettng

LLDP Dot1 TLVs Settings
Unit From Port To Port Port VLAN Protocol VLAN VLAN Mame Protocol Identity
[eth1/01 [z]  [eth10/1 [z]  [Disabled[=] |Disabled[=]| | [Disabled[~]| | [Disabled [~][None  [~]
Unit 1 Settings
[ bt | ponvanh | Crakdpotand oo V0| ErabiedLakame | Erabd o ey
eth1/0/1 Disabled
eth1/0/2 Disabled
eth1/0/3 Disabled
eth1/0/4 Disabled
eth1/0/5 Disabled
eth1/0/6 Disabled
eth1/0/7 Disabled
eth1/0/8 Disabled
eth1/0/9 Disabled
eth1/0/10 Disabled
eth1/0/11 Disabled
eth1/0M12 Disabled
eth1/0/13 Disabled
eth1/0/14 Disabled
eth1/0M15 Disabled

Figure 5-76 LLDP Dot1 TLVs Settings Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
Port VLAN Select this option to enable or disable the port VLAN ID TLV to

send. The Port VLAN ID TLV is an optional fixed length TLV that
allows a VLAN bridge port to advertise the port’'s VLAN identifier
(PVID) that will be associated with untagged or priority tagged

frames.
Protocol VLAN Select this option to enable or disable Port and Protocol VLAN ID
(PPVID) TLV to send, and enter the VLAN ID in PPVID TLV.
VLAN Name Select this option to enable or disable the VLAN name TLV to

send, and enter the ID of the VLAN in the VLAN name TLV.

Protocol Identity Select this option to enable or disable the Protocol Identity TLV to
send, and the protocol name. Options for protocol name to choose
from are None, EAPOL, LACP, GVRP, STP, and All.

Click the Apply button to accept the changes made.
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LLDP Dot3 TLVs Settings

This window is used to configure an individual port or group of ports to exclude one or more IEEE
802.3 organizational specific TLV data type from outbound LLDP advertisements.

To view the following window, click L2 Features > LLDP > LLDP Dot3 TLVs Settings, as shown
below:

DP Do /s Setting
LLDP Dot3 TLVs Settings

MACIPHY
Configuration/Status

[etht/oi1 []  [eth10/1 [=]  [Disabled[=] Disabled[~]

Unit From Port To Port Link Aggregation Maximum Frame Size Power Via MDI

Unit 1 Settings

[ ro T Contpntonsas Lk s Fow a0

eth1/0/1 Disabled Disabled Disabled Disabled
eth1/0/2 Disabled Disabled Disabled Disabled
eth1/0/3 Disabled Disabled Disabled Disabled
eth1/0/4 Disabled Disabled Disabled Disabled
eth1/0/5 Disabled Disabled Disabled Disabled
eth1/0/6 Disabled Disabled Disabled Disabled
eth1/0/7 Disabled Disabled Disabled Disabled
eth1/0/2 Disabled Disabled Disabled Disabled
eth1/0/9 Disabled Disabled Disabled Disabled
eth1/0/10 Disabled Disabled Disabled Disabled
eth1/0/11 Disabled Disabled Disabled Disabled
eth1/0/12 Disabled Disabled Disabled Disabled
eth1/0M13 Disabled Disabled Disabled Disabled
eth1/0/14 Disabled Disabled Disabled Disabled
eth1/0M15 Disabled Disabled Disabled Disabled

Figure 5-77 LLDP Dot3 TLVs Settings Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
MAC/PHY Select this option to enable or disable the MAC/PHY
Configuration/Status Configuration/Status TLV to send. The MAC/PHY

Configuration/Status TLV is an optional TLV that identifies (1) the
duplex and bit-rate capability of the sending IEEE 802.3 LAN
node, and (2) the current duplex and bit-rate settings of the
sending IEEE 802.3 LAN node.

Link Aggregation Select this option to enable or disable the Link Aggregation TLV to
send. The Link Aggregation TLV indicates contains the following
information. Whether the link is capable of being aggregated,
whether the link is currently in an aggregation, and the aggregated
port channel ID of the port. If the port is not aggregated, then the
IDis 0.

Maximum Frame Size Select this option to enable or disable the Maximum Frame Size
TLV to send. The Maximum Frame Size TLV indicates the
maximum frame size capability of the implemented MAC and PHY.

Power Via MDI Select this option to enable or disable the power via MDI TLV to
send. Three IEEE 802.3 PMD implementations (10BASE-T,
100BASE-TX, and 1000BASE-T) allow power to be supplied over
the link for connected non-powered systems. The Power Via MDI
TLV allows network management to advertise and discover the
MDI power support capabilities of the sending IEEE 802.3 LAN
station.
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Click the Apply button to accept the changes made.

LLDP-MED Port Settings

This window is used to enable or disable transmitting LLDP-MED TLVs.

To view the following window, click L2 Features > LLDP > LLDP-MED Port Settings, as shown

below:
LLDP-MED Port Settings
Unit From Port To Port Notification Capabilities Inventory Network Policy PSE
1[¥]  [emt01 [»] [ethtor [v]  [Disabled[v]  [Disabled[~]  [Disabled[~]  [Disabled[v]  [Disabled ] [  apply |

Unit 1 Settings

I N A
eth1/0/1 Disabled Disabled Disabled Disabled Disabled
eth1/0/2 Disabled Disabled Disablad Disablad Disabled
eth1/0/3 Disabled Disabled Disabled Disabled Disabled
eth1/0/4 Disabled Disabled Disablad Disablad Disabled
eth1/0/5 Disabled Disabled Disabled Disabled Disabled
eth1/0/6 Disabled Disabled Disablad Disablad Disabled
eth1/0/7 Disabled Disabled Disabled Disabled Disabled
eth1/0/8 Disabled Disabled Disabled Disabled Disabled
eth1/0/9 Disabled Disabled Disabled Disabled Disabled
eth1/D/10 Disabled Disabled Disabled Disabled Disabled
eth1/011 Disabled Disabled Disabled Disabled Disabled
eth1/0/12 Disabled Disabled Disabled Disabled Disabled
eth1/013 Disabled Disabled Disabled Disabled Disabled
eth1/0/14 Disabled Disabled Disabled Disabled Disabled
eth1/0M15 Disabled Disabled Disabled Disabled Disabled
eth1/0M16 Disabled Disabled Disabled Disabled Disabled
eth1/0M17 Disabled Disabled Disabled Disabled Disabled
eth1/0M18 Disabled Disabled Disabled Disabled Disabled
eth1/0M19 Disabled Disabled Disabled Disabled Disabled
eth1/0/20 Disabled Disabled Disabled Disabled Disabled
eth1/0/21 Disabled Disabled Disabled Disabled Disabled
eth1/0/22 Disabled Disabled Disablad Disablad Disabled
eth1/0/23 Disabled Disabled Disabled Disabled Disabled
eth1/0/24 Disabled Disabled Disablad Disablad Disabled
eth1/0/25 Disabled Disabled Disabled Disabled Disabled
eth1/0/26 Disabled Disabled Disabled Disabled Disabled v

Figure 5-78 LLDP-MED Port Settings Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

Notification Select this option to enable or disable the sending of LLDP-MED
notifications.

Capabilities Select this option to enable or disable transmitting the LLDP-MED
capabilities TLV.

Network Policy Select this option to enable or disable transmitting the LLDP-MED
network policy TLV.

PSE Select this option to enable or disable transmitting the LLDP-MED
extended power via MDI TLV, if the local device is PSE device or
PD device.

Inventory Select this option to enable or disable transmitting the LLDP-MED

inventory management TLV.
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Click the Apply button to accept the changes made.

LLDP Statistics Information

This window is used to view the neighbor detection activity, LLDP Statistics, and the settings for
individual ports on the Switch.

To view the following window, click L2 Features > LLDP > LLDP Statistics Information, as shown

below:

LLDP Statistics Information

Last Change Time
Total Inseris

Total Deletes
Total Drops

Total Ageouts

LLDP Statistics Ports

Unit 1 ]

Unit 1 Settings

™ Pot | ot Tarsmis
eth1/0/1 a1
eth1/0/2 0
eth1/0/3 0
eth1/0r4 0
eth1/0/5 0
eth1/0/6 0
eth1/0/7 0
eth1/0/8 0
eth1/0/9 0
eth1/0/10 0

0DOHSN24S
3
1
0
1
Port eth1/0/1 [v] | Clear Counter H Clear All |

Total Discards Total Emmors Total Receives Total TLV Discards Total TLV Unknowns Total Ageouts
0 T0

o o o o 2 o o o o o
© o ® o e o & o ©
o ola cle o el e
o oo o o o o o o o O
oo o o o o 28 o oo O
o o o ole o o o o =

Figure 5-79 LLDP Statistics Information Window

The fields that can be configured are described below:

Parameter Description

Unit

Select the switch unit that will be displayed.

Port

Select the port number that will be displayed.

Click the Clear Counter button to clear the counter information for the statistics displayed.

Click the Clear All button to clear all the counter information displayed.
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LLDP Local Port Information

This window is used to display the information on a per port basis currently available for populating
outbound LLDP advertisements in the local port brief table shown below.

To view the following window, click L2 Features > LLDP > LLDP Local Port Information, as shown

below:
LLDP Local Port Brief Table

Unit Part Find Show Detail

Unit 1 Settings

I T S T S
eth1/0/1 Local eth1/0/1 D-Link Corporation DGS-1510-28...
eth1/0/2 Laocal eth1/0/2 D-Link Corporation DGS-1510-28...
eth1/0/3 Local eth1/0/3 D-Link Corporation DGS-1510-25...
eth1/0/4 Local eth1/0/4 D-Link Corporation DGS-1510-28...
eth1/0/5 Local eth1/0/5 D-Link Corporation DG5-1510-28...
eth1/0/6 Laocal eth1/0/6 D-Link Corporation DGS-1510-28..
eth1/0/7 Local eth1/0/7 D-Link Corporation DGS-1510-28...
eth1/0/8 Local eth1/0/8 D-Link Corporation DGS-1510-28...
eth1/0/9 Laocal eth1/0/9 D-Link Corporation DGS-1510-28..
eth1/0i10 Laocal eth1/0/10 D-Link Corporation DGS-1510-25...
eth1/0/11 Local eth1/0/11 D-Link Corporation DGS-1510-28...
eth1/012 Local eth1/0M12 D-Link Corporation DG5-1510-28...

Figure 5-80 LLDP Local Port Information Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be displayed.

Port Select the port number that will be displayed.

Click the Find button to locate a specific entry based on the information entered.

Click the Show Detail button to view detailed information of the specific port.

After clicking the Show Detail button, the following window will appear.

LLDP Local Information Table

Port eth1/0M1
Port ID Subtype Local

Port ID eth1/0M1
Port Description D-Link Corporation DGS-1510-28XMP HW A1 firmware 1.70.007 Port 1 on Unit 1
Port PVID 1
Management Address Count 2

FPPVID Entries 0

VLAN Name Enfries Count 1

Protocol Identity Entries Count 0
MAC/PHY Configuration/Status Show Detail
Power Via MDI Show Detail
Link Aggregation Show Detail
Maximum Frame Size 1536
LLDP-MED Capabilities Show Detail
Metwork Folicy Show Detail
Extended power via MDI Show Detail

Figure 5-81 LLDP Local Port Information - Show Detail Window

To view more details about, for example, the MAC/PHY Configuration/Status, click the Show Detalil
hyperlink.
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Click the Back button to return to the previous window.

After clicking the Show Detail hyperlink, a new section will appear at the bottom of the window.

L1 DF Local Fort Information

LLDP Local Information Table

Port eth1/0M1
Port ID Subtyps Local
Port ID eth1/0M1
Port Description D-Link Corporation DGS-1510-28XMP HW A1 firmware 1.70.007 Port 1 on Unit 1
Port PVID 1
Management Address Count 2
PPVID Entries 0
VLAM Name Enfries Count 1
Protocol Identity Entries Count 1]
MAC/PHY Configuration/Status Show Detail
Power Via MDI Show Detail
Link Aggregation Show Detail
Maximum Frame Size 1536
LLDP-MED Capabilities Show Detail
Network Policy Show Detail
Extended power via MDI Show Detail
MAC/PHY Configuration/Status
Auto-Megotiation Support Supportad
Auto-Negofiation Enabled Enabled
Auto-Negotiation Advertised Capability 6c01{hex}
Auto-Megotiation Operational MAU Type 0010(hex)

Figure 5-82 LLDP Local Port Information - Show Detail Window

LLDP Neighbor Port Information

This window is used to display the information learned from the neighbors. The switch receives
packets from a remote station but is able to store the information as local.

To view the following window, click L2 Features > LLDP > LLDP Neighbor Port Information, as
shown below:

LLDP Neighbor Port Brief Table

Unit 1 ] Port eth1/0/9 [~] Find [ clear |

Clear All

Total Entries: 1

m Chassis ID Subtype Chassis ID Port ID Subtype Port ID Port Description _

MAC Address FO0-7D-63-30-36-00 Local &th1/0/10

Figure 5-83 LLDP Neighbor Port Information Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be displayed.

Port Select the port number that will be displayed.

Click the Find button to locate a specific entry based on the information entered.
Click the Clear button to clear the specific port information.
Click the Clear All button to clear all the port information displayed.

Click the Show Detail button to view detailed information of the specific port.
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After clicking the Show Detail button, the following window will appear.

LLDP Neighbor Information Table

Entry 1D 1
Chassis 1D Subtype MAC Address
Chassis ID FO-7D-68-30-36-00
Port 1D Subtype Local

Port 1D eth1/0/10

Port Description

System Name

System Description
System Capabilities

Management Address Entries Show Detail
PPVID Entries Show Detail
VLAN Name Entries Show Detail
Protocol [dentity Entries Show Detail
MAC/PHY Configuration/Status Show Detail
Power Via MDI Show Detail
Link Aggregation Show Detail
Maximum Frame Size 0

Unknown TLVs Show Detail
LLDP-MED Capabilities Show Detail
Network Policy Show Detail
Extended Power Via MDI Show Detail
Inventory Management Show Detail

Figure 5-84 LLDP Neighbor Port Information - Show Detail Window

To view more details about, for example, the LLDP-MED Capabilities, click the Show Detail
hyperlink.

Click the Back button to return to the previous window.

After clicking the Show Detail hyperlink, a new section will appear at the bottom of the window.

LLDP Neighbor Information Table

Entry 1D 1

Chassis 1D Subtype MAC Address
Chassis ID FO-7D-68-30-36-00
Port 1D Subtype Local

Port ID eth1/0/10

Port Description

System Name

System Description
System Capabilities

Management Address Entries Show Detail
PPVID Eniries Show Detail
VLAN Name Entries Show Detail
Protocol Identity Enftries Show Detail
MAC/PHY Configuration/Status Show Detail
Power Via MDI Show Detail
Link Aggregation Show Detail
Maximum Frame Size 0

Unknown TLVs Show Detail
LLDP-MED Capabilities Show Detail
Network Policy Show Detail
Extended Power Via MDI Show Detail
Inventory Management Show Detail

LLDP-MED Capabilities

LLDP-MED Capabilities Enabled:

LLDP-MED Capabilities Mot Support
Metwork Policy Mot Support
Location Identification Mot Support
Extended Power Via MDI Mot Support
Inventory Mot Support

Figure 5-85 LLDP Neighbor Port Information - Show Detail Window

Click the Back button to return to the previous window.

175



DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

6. Layer 3 Features

ARP

ARP

Gratuitous ARP

UDP Helper

IPv4 Interface

IPv4 Static/Default Route
IPv4 Route Table

IPv6 Interface

IPv6 Neighbor

IPv6 Static/Default Route
IPv6 Route Table

IPMC

ARP Aging Time

This window is used to view and configure the ARP aging time settings.

To view the following window, click L3 Features > ARP > ARP Aging Time, as shown below:

ARF Aging

ARP Aging Time

Total Entries: 1

240

" [7] [ [eo

Figure 6-1 ARP Aging Time Window

The fields that can be configured are described below:

Parameter Description

Timeout Enter the ARP aging timeout value here.

Click the Edit button to re-configure the specific entry.
Click the Apply button to accept the changes made.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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Static ARP

This window is used to view and configure the static ARP settings.

To view the following window, click L3 Features > ARP > Static ARP, as shown below:

Static ARP
IP Address [ | Hardware Address 00-11-22-33-44-AA
Total Entries: 1

e B e S
viani 10.90.90.90 3C-1E-04-A1-B9-EQ Forever Edit Delete
11 [ 1] [ leo

Figure 6-2 Static ARP Window

The fields that can be configured are described below:

Parameter Description

IP Address Enter the IP address that will be associated with the MAC address
here.

Hardware Address Enter the MAC address that will be associated with the IP address
here.

Click the Apply button to accept the changes made.
Click the Edit button to re-configure the specific entry.
Click the Delete button to remove the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

Proxy ARP

This window is used to view and configure the proxy ARP settings. The Proxy ARP feature of the
Switch will allow the Switch to reply to ARP requests destined for another device by faking its identity
(IP and MAC Address) as the original ARP responder. Therefore, the Switch can then route packets
to the intended destination without configuring static routing or a default gateway. The host, usually a
Layer 3 switch, will respond to packets destined for another device.

To view the following window, click L3 Features > ARP > Proxy ARP, as shown below:

Proxy ARP

Total Entries: 1
I R 7 S
vian1 Disabled Disabled
1 Ed [ [ee

Figure 6-3 Proxy ARP Window

The fields that can be configured are described below:

Parameter Description

Proxy ARP State Select to enable or disable the proxy ARP state here.
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Parameter Description

Local Proxy ARP State Select to enable or disable the local proxy ARP state here. This
local proxy ARP function allows the Switch to respond to the proxy
ARRP, if the source IP and destination IP are in the same interface.

Click the Apply button to accept the changes made.
Click the Edit button to re-configure the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

ARP Table

This window is used to view and configure the ARP table settings.

To view the following window, click L3 Features > ARP > ARP Table, as shown below:

ARP Search

() Hardware Address 001122334455 | (O Type
Total Entries: 3 Clear Al

m—
vian 10.90.90.1 00-23-7D-BC-2E-18
viani 10.90.90.14 10-BF-48-D6-E2-E2 240
vian1 10.90.90.90 3C-1E-04-A1-BY-E0 Forever Clear

1 E [ [eo

Figure 6-4 ARP Table Window

The fields that can be configured are described below:

Parameter Description

Interface VLAN Select and enter the interface’s VLAN ID used here. This value
must be between 1 and 4094.

IP Address Select and enter the IP address to display here.

Mask After the IP Address option was selected, enter the mask address
for the IP address here.

Hardware Address Select and enter the MAC address to display here.

Type Select the type option here. Options to choose from are All and
Dynamic.

Click the Find button to locate a specific entry based on the information entered.
Click the Clear All button to clear all the information.
Click the Clear button to clear the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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Gratuitous ARP

This window is used to view and configure the gratuitous ARP settings. A gratuitous ARP request
packet is an ARP request packet where the source and the destination IP address are both set to the
IP address of the sending device and the destination MAC address is the broadcast address.

Generally, a device use the gratuitous ARP request packet to discover whether the IP address is
duplicated by other hosts or to preload or reconfigure the ARP cache entry of hosts connected to the
interface.

To view the following window, click L3 Features > Gratuitous ARP, as shown below:

Gratuitous ARP Global Settings

IP Gratuitous ARP State () Enabled (@ Disabled
Gratuitous ARP Trap State ) Enabled @ Disabled
IP Gratuitous ARP Dad-Reply Siate (&) Enabled @ Disabled
Graluilous ARP Learning State @ Enabled () Disabled

Gratuitous ARP Send Interval

Total Entries: 1

viant 0
n [T] [ [ee

Figure 6-5 Gratuitous ARP Window

The fields that can be configured are described below:

Parameter Description

IP Gratuitous ARP State Select option to enable or disable the transmission of gratuitous
ARP request packets.

Gratuitous ARP Trap State Select this option to enable or disable the ARP trap state.
IP Gratuitous ARP Dad-Reply | Select this option to enable or disable the IP gratuitous ARP Dad-

State reply state.
Gratuitous ARP Learning Select this option to enable or disable the gratuitous ARP learning
State state. Normally, the system will only learn the ARP reply packet or

a normal ARP request packet that asks for the MAC address that
corresponds to the system’s IP address. This option used to enable
or disable the learning of ARP entries in the ARP cache based on
the received gratuitous ARP packet. The gratuitous ARP packet is
sent by a source IP address that is identical to the IP that the
packet is queries for.

Click the Apply button to accept the changes made.
Click the Edit button to re-configure the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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UDP Helper

IP Forward Protocol

This window is used to display and configure the IP forward protocol settings. This feature is used to
enable the forwarding of a specific UDP service type of packets.

To view the following window, click L3 Features > UDP Helper > IP Forward Protocol, as shown
below:

IP Forward Protocol
IP Forward Protocol UDP Port (1-65535) 1
Total Entries: 7
a7 Time Service
42 IEN-116 Name Service
49 TACACS
53 DNS
137 NetBIOS-NS
138 NetBIOS-DS
11 (1] Go

Figure 6-6 IP Forward Protocol Window

The fields that can be configured are described below:

Parameter Description
IP Forward Protocol UDP Enter the destination port of the UDP service to be forwarded.
Port

Click the Apply button to accept the changes made.
Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

IP Helper Address

This window is used to add or remove a target address for the forwarding of UDP broadcast packets.
This feature takes effect only when the received interface has an IP address assigned.

The system only forwards packets that satisfy the following restrictions:

e The destination MAC address must be a broadcast address.
e The destination IP address must be an all-one broadcast.

o The packets are IPv4 UDP packets.

e The IP TTL value must be greater than or equal to 2.
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To view the following window, click L3 Features > UDP Helper > IP Helper Address, as shown
below:

IP Helper Address

Interface VLAN (1-4094) |:|
Total Entries: 1
et e P e R E——
1 10.5.5.10

1n [ [ e

Figure 6-7 IP Helper Address Window

The fields that can be configured are described below:

Parameter Description

Interface VLAN Enter the VLAN interface ID used here. The range is from 1 to
4094.

IP Helper Address Enter the target IPv4 address for the forwarding of the UDP
broadcast packet here.

Click the Apply button to accept the changes made.
Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

IPv4 Interface

This window is used to view and configure the IPv4 interface settings.

To view the following window, click L3 Features > IPv4 Interface, as shown below:

Dy A tarface

IPv4 Interface
Interface VLAN (1-4094) [ [ appoly | Find ]
Total Entries: 1
vian1 Enabled 10.90.90.90/255.0.0.0 Manual Edit Delete
n El [ &

Figure 6-8 IPv4 Interface Window

The fields that can be configured are described below:

Parameter Description
Interface VLAN Enter the interface’s VLAN ID here. This value must be between 1
and 4094.

Click the Apply button to accept the changes made.
Click the Find button to locate a specific entry based on the information entered.
Click the Edit button to re-configure the specific entry.

Click the Delete button to remove the specific entry.
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Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

After clicking the Edit button, the following window will be available.

| IPv4 Interface Settings | DHCP Client
Interface vian1
Settings
State Enabled [v]
Description 64 chars Apply

Primary IP Settings

Get IP From Static [v]

IP Address 10 - 80 - 90 - @0

Mask 2.0 -0 . 0 Apply I Delete
Secondary IP Settings

Secondary IP Entry

Total Entries: 1

T ™ S ™ S ™ e N
20.1.1.1 255.0.0.0 Manual Yes

1n [ [ e

Figure 6-9 IPv4 Interface Configure Window
Click the Back button to return to the previous window.

The field that can be configured for Settings is described below:

Parameter Description

State Select this option to enable or disable the IPv4 interface’s global
state.

Description Enter the description for the IPv4 interface here. This can be up to
64 characters long.

Click the Apply button to accept the changes made.

The field that can be configured for Primary IP Settings is described below:

Parameter Description

Get IP From Select the get IP from option here. Options to choose from are:

e Static - Users can enter the IPv4 address of this interface
manually in the fields provided.

e DHCP - This interface will obtain IPv4 information
automatically from the DHCP server located on the local

network.
IP Address Enter the IPv4 address for this interface here.
Mask Enter the IPv4 subnet mask for this interface here.

Click the Apply button to accept the changes made.
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The fields that can be configured for Secondary IP Settings are described below:

Parameter Description

IP Address Enter the IPv4 address as the secondary interface here.

Mask Enter the IPv4 subnet mask as the secondary interface here.

Click the Apply button to accept the changes made.
Click the Delete button to remove the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

After clicking the DHCP Client tab, the following page will appear.

IPv4 Interface Settings | DHCP Client |
DHCF Client Client-ID (1-4094) [
Class ID String 32 chars Hex

Host Name

Lease l:l Days (0—10000)‘ [1]i] E“ Hours | 00 E“ Minutes

Figure 6-10 DHCP Client Window

The fields that can be configured are described below:

Parameter Description

DHCP Client Client-ID Enter the VLAN interface, whose hexadecimal MAC address will be
used as the client ID to be sent with the discover message.

Class ID String Enter the vendor class identifier with the maximum of 32
characters. Tick the Hex check box to have the class identifier in
the hexadecimal form.

Host Name Enter the host name. The maximum length is 64 characters. The
host name must start with a letter, end with a letter or digit, and
only with interior characters letters, digits, and hyphens.

Lease Specify the preferred lease time for the IP address to request from
the DHCP server. Enter the day duration of the lease, or select the
hour and minute duration of the lease.

Click the Apply button to accept the changes made.

IPv4 Static/Default Route

This window is used to view and configure the IPv4 static and default route settings. The Switch
supports static routing for IPv4 formatted addressing. Users can create up to 64 static route entries for
IPv4. For IPv4 static routes, once a static route has been set, the Switch will send an ARP request
packet to the next hop router that has been set by the user. Once an ARP response has been
retrieved by the Switch from that next hop, the route becomes enabled. However, if the ARP entry
already exists, an ARP request will not be sent.

The Switch also supports a floating static route, which means that the user may create an alternative
static route to a different next hop. This secondary next hop device route is considered as a backup
static route for when the primary static route is down. If the primary route is lost, the backup route will
uplink and its status will become active.

Entries into the Switch’s forwarding table can be made using both an IP address subnet mask and a
gateway.
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To view the following window, click L3 Features > IPv4 Static/Default Route, as shown below:

IPv4 Static/Default Route
Backup State Please Select |Z|
Total Entries: 1
0000 0.00.0 10.1.1.254 vian1
n 1| Go

Figure 6-11 IPv4 Static/Default Route Window

The fields that can be configured are described below:

Parameter Description

IP Address Enter the IPv4 address for this route here. Tick the Default Route
check box to use the default route as the IPv4 address.

Mask Enter the IPv4 network mask for this route here.

Gateway Enter the gateway address for this route here.

Backup State Select the backup state option here. Options to choose from are:

e Primary - The route is used as the primary route to the
destination.

o Backup - The route is used as the backup route to the
destination.

Click the Apply button to accept the changes made.
Click the Delete button to remove the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

IPv4 Route Table

This window is used to view and configure the IPv4 route table settings.

To view the following window, click L3 Features > IPv4 Route Table, as shown below:

IPv4 Route Table

@ IP Address |:|
= Network Address | | [ |
() Connected () Hardware () Summary
Total Entries: 1
I S T S A
10.0.0.0 255.0.0.0 Directly Connected viani c

11 [ [eo

Note: C - Connected, S - Static, * - Candidate Default

Figure 6-12 IPv4 Route Table Window
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The fields that can be configured are described below:

Parameter Description

IP Address Select and enter the single IPv4 address here.

Network Address Select and enter the IPv4 network address here. In the first space
enter the network prefix and in the second space enter the network
mask.

Connected Select this option to display only connected routes.

Hardware Select this option to display only hardware routes. Hardware routes
are routes that have been written into the hardware chip.

Summary Display the brief information of the active routing entries.

Click the Find button to locate a specific entry based on the information entered.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

IPv6 Interface

This window is used to view and configure the IPv6 interface’s settings.

To view the following window, click L3 Features > IPv6 Interface, as shown below:

IPvé Interface
Interface VLAN (1-4094) [ [ mpoly | Find |
Total Entries: 1
1Pvs stze _ uesas
viani Enabled Up
" Go

Figure 6-13 IPv6 Interface Window

The fields that can be configured are described below:

Parameter Description
Interface VLAN Enter the VLAN interface’s ID that will be associated with the IPv6
entry.

Click the Apply button to accept the changes made.
Click the Find button to locate a specific entry based on the information entered.
Click the Detail button to view and configure detailed settings for the IPv6 interface entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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After clicking the Detail button, the following page will be available.

| IPvE Interface Settings | Interface IPv6 Address Neighbor Discover DHCPvE Client
Interface vian1
IPv6 State Disabled [v] Back I Apply |
Static IPv6 Address Settings
NS Interval Settings
ND Settings
Hap Limit (0-255) P ] Reachable Time (0-3600000) o ms
Managed Config Flag Off I~ Other Cenfig Flag Off I~
RA Min Interval (3-1350) P Jsec  RAMaxinterval (4-1800) b e
RA Lifetime (0-9000) :l sec RA Suppress Disabled ﬂ

Figure 6-14 IPv6 Interface (Detail, IPv6 Interface Settings) Window

The fields that can be configured for Interface are described below:

Parameter Description

IPv6 State Select to enable or disable the IPv6 interface’s global state here.

Click the Back button to return to the previous window.

Click the Apply button to accept the changes made.

The fields that can be configured for Static IPv6 Address Settings are described below:

Parameter Description

IPv6 Address Enter the IPv6 address for this IPv6 interface here.

Select the EUI-64 option to configure an IPv6 address on the
interface using the EUI-64 interface ID.

Select the Link Local option to configure a link-local address for
the IPv6 interface.

Click the Apply button to accept the changes made.

The fields that can be configured for NS Interval Settings are described below:

Parameter Description

NS Interval Enter the NS interval between 0 and 3600000 milliseconds.

Click the Apply button to accept the changes made.

The fields that can be configured for ND Settings are described below:

Parameter Description

Hop Limit Enter the IPv6 hop limit value here. This is used to configure the
hop limit to be advertised in RA messages. The IPv6 packet
originated at the system will also use this value as the initial hop
limit. To use the default value on this interface, configure this value
as 0. The range is from 0 to 255.

Reachable Time Enter the reachable time used in the ND protocol here. The
configured time is used by the router on the interface and is also
advertised in RA message. If the specified time is 0, the router will
use 30 seconds on the interface and advertise 0 (unspecified) in
RA message. The reachable time is used by the IPv6 node in
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Parameter Description

determining the reachability of the neighboring nodes. The range is
from 0 to 3600000 milliseconds in multiples of 1000 milliseconds.

Managed Config Flag Select to turn the managed configure flag On or Off here. This is
used to enable or disable the management configure flag in the
advertised RA message. When the neighboring host receives the
RA with an enabled flag, the host should use a stateful
configuration protocol to obtain IPv6 addresses.

Other Config Flag Select to turn the other configure flag On or Off here. This is used
to enable or disable the other configure flag in the advertised RA
message. When this feature is enabled, the router will instruct the
connected hosts to use a stateful configuration protocol to obtain
auto-configuration information other than IPv6 address.

RA Min Interval Enter the minimum value of the interval between retransmission of
RA messages here. The range is from 3 to 1350 seconds. This
value must be smaller than 75% of the maximum value.

RA Max Interval Enter the maximum value of the interval between retransmission of
RA messages here. The range is from 4 to 1800 seconds.
RA Lifetime Enter the RA lifetime value here. The range is from 0 to 9000

seconds. The lifetime value in RA informs the received host of the
lifetime for taking the router as the default router.

RA Suppress Select to enable or disable the sending of RA messages on the
interface here. By default, this feature is enabled on a VLAN
interface and disabled on a tunnel interface.

Click the Apply button to accept the changes made.

After clicking the Interface IPv6 Address tab, at the top of the page, the following page will be
available.

IPvE Interface Settings | Interface IPv6 Address | Meighbor Discover DHCPv6 Client
Total Entries: 1
o e o e I
Link-Local Address FE20::3E1E:4FF:FEA1:B9EQ Delete

Figure 6-15 IPv6 Interface (Detail, Interface IPv6 Address) Window

Click the Delete button to delete the specified entry.

After clicking the Neighbor Discover tab, at the top of the page, the following page will be available.

IPv6 Interface Settings Interface IPv6 Address | Meighbor Discover | DHCPv6 Client
Total Entries: 1
IPv6 Prefix/Prefix Length Preferred Life Time (sec) Valid Life Time (sec) Link Flag Autoconfig Flag _
3FFE:501:FFFF::/64 604800 2592000 Enabled Enabled

Figure 6-16 IPv6 Interface (Detail, Neighbor Discover) Window
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Click the Edit button to configure the following parameters:

IPv6 Interface Settings Interface IPvG Address | Meighbor Discover | DHCPv6 Client
Total Entries: 1
IPv Prefix/Prefix Length Preferred Life Time (sec) Valid Life Time (sec) Link Flag Autoconfig Flag _
3FFE:501:FFFF:./64 04800 2562000 Enabled Enabled Apply

Figure 6-17 IPv6 Interface (Detail, Neighbor Discover, Edit) Window

The fields that can be configured are described below:

Parameter Description

Preferred Life Time Enter the preferred lifetime value here. The range is from 0 to
4294967295 seconds. The default value is 604800 seconds (7
days).

Valid Life Time Enter the valid lifetime value here. The range is from 0 to
4294967295 seconds. The default value is 2592000 seconds (30
days).

Link Flag Select to enable or disable the on-link flag here. The default option
is Enabled.

Autoconfig Flag Select to enable or disable the auto-configure flag here. The default
option is Enabled.

Click the Apply button to accept the changes made.

After clicking the DHCPv6 Client tab, at the top of the page, the following page will be available.

IPvE Interface Settings Interface IPv6 Address Meighbor Discover | DHCPv6 Client |
DHCP6 Client
DHCPv6 Client Settings
Client State Disabled ﬂ Rapid Commit

Figure 6-18 IPv6 Interface (Detail, DHCPv6 Client) Window

Click the Restart button to restart DHCPv6 client on an interface.

The fields that can be configured for DHCPv6 Client Settings are described below:

Parameter Description

Client State Select this option to enable or disable the DHCPv6 client state.
Tick the Rapid Commit check box to proceed with two-message
exchange for prefix delegation.

Click the Apply button to accept the changes made.
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IPv6 Neighbor

This window is used to configure and view the IPv6 neighbor settings.

To view the following window, click L3 Features > IPv6 Neighbor, as shown below:

IPVE Neighbor Settings
Interface VLAN (1-4084) [ | IPvGAddress [ Find ][ clear ]
Total Entries: 1
P s e T N N
20131 11-22-33-44-AA-FF vian1 Static
11 [T] Go

Figure 6-19 IPv6 Neighbor Window

The fields that can be configured are described below:

Parameter Description

Interface VLAN Enter an interface VLAN ID.
IPv6 Address Enter the IPv6 address.
MAC Address Enter the MAC address.

Click the Apply button to accept the changes made.

Click the Find button to locate a specific entry based on the information entered.
Click the Clear button to clear all the information for the specific port.

Click the Clear All button to clear all the information in this table.

Click the Delete button to remove the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

IPv6 Static/Default Route

This window is used to view and configure the IPv6 static or default routes.

To view the following window, click L3 Features > IPv6 Static/Default Route, as shown below:

b Static/Default Rou
IPvE Static/Default Route
|PV6 Address/Prefix Length Default Route
Interface VLAN (1-4094) [ ]
Next Hop IPv6 Address SFE
Backup State Please Select |Z|
Total Entries: 0
P st g I T S T N

Figure 6-20 IPv6 Static/Default Route Window
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The fields that can be configured are described below:

Parameter Description

IPv6 Address/Prefix Length

Enter the IPv6 address and prefix length for this route here. Tick
the Default Route option to use the default route as the IPv6
address.

Interface VLAN

Enter the interface’s VLAN ID that will be associated with this route
here.

Next Hop IPv6 Address

Enter the next hop IPv6 address here.

Backup State

Select the backup state option here. Options to choose from are:

e Primary - The route is specified as the primary route to the
destination.

e Backup - The route is specified as the backup route to the
destination.

Click the Apply button to accept the changes made.

IPv6 Route Table

This window is used to view and configure the IPv6 route table.

To view the following window, click L3 Features > IPv6 Route Table, as shown below:

IPvé Route Table
~ IPv6 Address/Prefix Length 201371764 Longer Prefixes
“ Interface VLAN (1-4094) |:|
- Connected [ Database  [|Hardware  [] Summary
Total Entries: 0
s st g T T
Mote: C - Connected, S - Static, > - Selected Route, * - Valid Route

Figure 6-21 IPv6 Route Table Window

The fields that can be configured are described below:

Parameter Description

IPv6 Address Select and enter the IPv6 address to display here.

IPv6 Address/Prefix Length |Select and enter the IPv6 address and prefix length to display
here. Select the Longer Prefixes option to display IPv6 routes with
prefixes greater than and equal to the prefix length.

Interface VLAN Select and enter the interface’s VLAN ID to display here.

Connected Select this option to display only connected routes.

Database Select to view all the related entries in the routing database instead
of just the best route.

Hardware Select this option to display only hardware routes. Hardware routes
are routes that have been written into the hardware chip.

Summary Display the brief information of the active routing entries.

Click the Find button to locate a specific entry based on the information entered.
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IPMC

IP Multicast Global Settings

This window is used to display and configure the global IP Multicast (IPMC) settings.

To view the following window, click L3 Features > IPMC > IP Multicast Global Settings, as shown
below:

IP Multicast Table Lookup Mode

Table Lookup Mode @ P O MAC

Figure 6-22 IP Multicast Global Settings Window

The fields that can be configured are described below:

Parameter Description

Table Lookup Mode Select the IP multicast forwarding lookup mode here. Options to
choose from are:

o [P - Specifies multicast forwarding lookup based on the IP
address.

e MAC - Specifies multicast forwarding lookup based on the
MAC address.

Click the Apply button to accept the changes made.

IP Multicast Forwarding Cache

This window is used to display the content of the IP multicast routing forwarding cache database.

To view the following window, click L3 Features > IPMC > IP Multicast Forwarding Cache, as
shown below:

IP Multicast Forwarding Table

Group Address l:l Source Address l:l | Find | | Show All |

Total Entries: 0

Group Address Incoming Interface Outgoing Interface

Figure 6-23 IP Multicast Forwarding Cache Window

The fields that can be configured are described below:

Parameter Description

Group Address Enter the multicast group IP address here.

Source Address Enter the source IP address here.

Click the Find button to locate a specific entry based on the information entered.

Click the Show All button to display all the entries.
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7. Quality of Service (QoS)

Basic Settings
Advanced Settings

Basic Settings

Port Default CoS

This window is used to view and configure the port’s default CoS settings.

To view the following window, click QoS > Basic Settings > Port Default CoS, as shown below:

Port Default CoS

Unit From Port To Port Default CoS

[1 =] [eth10/1 [=] [eth1/0/1 [=] ® [0[=] [ override None

Unit 1 Settings
eth1/0/1 0 No
eth1/0/2 0 No
eth1/0/3 0 No
eth1/0/4 0 No
eth1/0/5 0 No
eth1/0/6 0 No
eth1/0/7 0 No
eth1/0/8 0 No
eth1/0/9 0 No
eth1/0/10 0 No
eth1/0/11 0 No
eth1/0/12 0 No
eth1/0/13 0 No
eth1/0/14 0 No
eth1/0/15 0 No

Figure 7-1 Port Default CoS Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
Default CoS Select the default CoS option for the port(s) specified here. Options

to choose from are 0 to 7.

Click the Override check box to apply the port's default CoS to all
packets (tagged or untagged) received by the port.

Select the None option to use the default settings.

Click the Apply button to accept the changes made.
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Port Scheduler Method

This window is used to view and configure the port scheduler method settings.

To view the following window, click QoS > Basic Settings > Port Scheduler Method, as shown

below:

Port Scheduler Method

Unit From Port

To Port

Scheduler Method

[1 = [sth1i011 [7]

Letht/o_[3] [WRR_[~]

Unit 1 Settings

eth1/0i1
eth1/0i2
eth1/0V3
eth1/0/4
eth1/V5
eth1/0/6
eth1/0/7
eth1/0/8
eth1/0/9
eth1/0/10
eth1/0/11
eth1/0/12
eth1/0/13
eth1/0/14
eth1/0/15

Fig

Scheduler Method

WRR
WRR
WRR
WRR
WRR
WRR
WRR
WRR
WRR
WRR
WRR
WRR
WRR
WRR
WRR

ure 7-2 Port Scheduler Method Window

The fields that can be configured are described below:

Parameter Description

Unit

Select the switch unit that will be used for this configuration here.

From Port/ To Port

Select the appropriate port range used for the configuration here.

Scheduler Method

Select the scheduler method that will be applied to the specified
port(s). Options to choose from are Strict Priority (SP), Round-
Robin (RR), Weighted Round-Robin (WRR), and Weighted Deficit
Round-Robin (WDRR). By default, the output queue-scheduling
algorithm is WRR.

WDRR operates by serving an accumulated set of backlogged
credits in the transmit queue in a round robin order. Initially, each
queue sets its credit counter to a configurable quantum value.
Every time a packet from a CoS queue is sent, the size of the
packet is subtracted from the corresponding credit counter and the
service right is turned over to the next lower CoS queue. When the
credit counter drops below 0, the queue is no longer serviced until
its credits are replenished. When the credit counters of all CoS
queues reaches 0, the credit counters will be replenished at that
time. All packets are serviced until their credit counter is zero or
negative and the last packet is transmitted completely. When this
condition happens, the credits are replenished. When the credits
are replenished, a quantum of credits are added to each CoS
queue credit counter. The quantum for each CoS queue may be
different based on the user configuration.

To set a CoS queue in the SP mode, any higher priority CoS queue
must also be in the strict priority mode.

WRR operates by transmitting permitted packets into the transmit
queue in a round robin order. Initially, each queue sets its weight to
a configurable weighting. Every time a packet from a higher priority
CoS queue is sent, the corresponding weight is subtracted by 1
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Parameter Description

and the packet in the next lower CoS queue will be serviced. When
the weight of a CoS queue reaches zero, the queue will not be
serviced until its weight is replenished. When weights of all CoS
queues reach 0, the weights get replenished at a time.

Click the Apply button to accept the changes made.

Queue Settings

This window is used to view and configure the queue settings.

To view the following window, click QoS > Basic Settings > Queue Settings, as shown below:

Queue Settings
Unit From Port To Port Clueue 1D WRR Weight (0-127) 'WDRR Quantum (0-127)
] [emion o] [emon ] [0 ] | | ]
Unit 1 Settings
e
0 1 1
1 1 1
2 1 1
3 1 1
eth1/0/1 a n :
5 1 1
6 1 1
7 0 1
0 1 1
1 1 1
2 1 1
& 1 1
eth1/0/2 a 7 -
5 1 1
6 1 1
i 1] 1
0 1 1
1 1 1
2 1 1
3 1 1
eth1/0/3 a n :
5 1 1
6 1 1
T 1] 1

Figure 7-3 Queue Settings Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

Queue ID Enter the queue ID value here. This value must be between 0 and
7.

WRR Weight Enter the WRR weight value here. This value must be between 0

and 127. To satisfy the behavior requirements of Expedited
Forwarding (EF), the highest queue is always selected by the Per-
hop Behavior (PHB) EF and the schedule mode of this queue
should be strict priority scheduling. The weight of the last queue
should be zero while the Differentiate Service is supported.

WDRR Quantum Enter the WDRR quantum value here. This value must be between
0 and 127.
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Click the Apply button to accept the changes made.

CoS to Queue Mapping

This window is used to view and configure the CoS-to-Queue mapping settings.

To view the following window, click QoS > Basic Settings > CoS to Queue Mapping, as shown
below:

0
1
2
3
4
J
6
7

Figure 7-4 CoS to Queue Mapping Window

Apply

The fields that can be configured are described below:

Parameter Description

Queue ID Select the queue ID that will be mapped to the corresponding CoS
value. Options to choose from are 0 to 7.

Click the Apply button to accept the changes made.
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Port Rate Limiting

This window is used to view and configure the port rate limiting settings.

To view the following window, click QoS > Basic Settings > Port Rate Limiting, as shown below:

Port Rate Limiting

Unit From Port To Port Direction Rate Limit
[eth1an [=]  [eth1011 [=]  [input [] @ Banduwidth (54-10000000) [ |«ops  BurstSize(0-128000) [ |Kbyte
) Percent (1-100) |:| % Burst Size (0-128000) |:| Koyte

Unit 1 Settings

= me | e

eth1/0/1 No Limit No Limit No Limit No Limit
eth1/0/2 Mo Limit No Limit Mo Limit No Limit
eth1/0/3 Mo Limit No Limit Mo Limit No Limit
eth1/0/4 Mo Limit No Limit Mo Limit No Limit
eth1/0/5 Mo Limit No Limit Mo Limit No Limit E
eth1/0/6 Mo Limit No Limit Mo Limit No Limit
eth1/0/7 Mo Limit No Limit Mo Limit No Limit
eth1/0/2 Mo Limit No Limit Mo Limit No Limit
eth1/0/9 Mo Limit No Limit No Limit No Limit
eth1/0/10 No Limit No Limit No Limit No Limit
eth1/0/11 Mo Limit Mo Limit No Limit Mo Limit
eth1/0/12 No Limit No Limit No Limit No Limit
eth1/0M13 Mo Limit No Limit Mo Limit No Limit
eth1/0/14 Mo Limit No Limit Mo Limit No Limit
eth1/0M15 Mo Limit No Limit Mo Limit No Limit

Figure 7-5 Port Rate Limiting Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
Direction Select the direction option here. Options to choose from are:

e Input - The rate limit for ingress packets is configured.
e Output - The rate limit for egress packets is configured.

Rate Limit Select and enter the rate limit value here.

When Bandwidth is selected, enter the input/output bandwidth
value used in the space provided. This value must be between 64
and 10000000 kbps. Also, enter the Burst Size value in the space
provided. This value must be between 0 and 128000 kilobytes.

When Percent is selected, enter the input/output bandwidth
percentage value used in the space provided. This value must be
between 1 and 100 percent (%). Also, enter the Burst Size value in
the space provided. This value must be between 0 and 128000
kilobytes.

Select the None option to remove the rate limit on the specified
port(s). The specified limitation cannot exceed the maximum speed
of the specified interface. For the ingress bandwidth limitation, the
ingress can trigger a pause frame or a flow control frame when the
received traffic exceeds the limitation.

Click the Apply button to accept the changes made.
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Queue Rate Limiting

This window is used to view and configure the queue rate limiting settings.

To view the following window, click QoS > Basic Settings > Queue Rate Limiting, as shown below:

Queue Rate Limiting

Unit  From Port To Port Queue ID Rate Limit
[ethtion [=]  [eth1/01 [=] [0 [=] @ MinBandwidth(54-10000000) | |Kbps MaxBandwicth (4-10000000) | |Kbps
) Min Percent (1-100) |:|% Max Percent (1-100) |:|%
- Nore

Unit 1 Settings

H e e | e | awe | ome |

Hax Max Max Max
Rate Rate Rate Rate Rate Rate Rate Rate Rate

eth1/0/1 Noli.. NoLi. MNoLi. NoL.. MNoli. NoL.. NoLi.. Noli. NoLi. NoLi. NoLi. MNoLi. NoLi. NoL.. NolLi. Noli.
efh1/0/2 NoLi.. NoLi. MNoLi. NoL.. MNoli. NoL.. NoLi.. Noli. NoLi. Noli. NoL.. MNoLi.. NoL.. NoL.. NolLi. NolLi.
eth1//3 MNoLi.. NoLi. MNoLi.. NoLi. NoLi.. NolLi.. MNoLi.. NolLi. NoLi.. MNoLi.. MoLi. NoLi.. NoLi. MNoL.. NoLi. Noli.
eth1/0/4 Noli.. MNoLi. NoLi.. NoL.. NoLi.. NoL.. NoLi.. NoL. NoL.. NoLi.. MNoLL.. NoL.. NoL.. NoL.. NoL.. Noli.
eth1/0/5 Noli.. MNoLi. NoLi.. NoLi. NoL.. NolL.. NoL.. NeolL. NoLi. NoLi. MNoL.. NoL.. NoL.. NoL.. NolL.. NolLi.
eth1/0/6 Noli. MNoLi. NoLi.. NoLi. NoLi. NoL.. NolLi. Noli. NoLi. NoLi. MNoL.. NoLi.. NoL.. NolL.. NoLi.. RNoli.
eth1/0/7 Noli.. MNoLi. NoLi. NoLi. NoLi.. NoL.. NeolLi.. NeclLi. MNoLi. NoLi. NoLi. NoLi.. NoL.. NoL.. Noli. Noli.
eth1/0/8 Noli.. MNolLi. NoLi. NoLi. NolLi. NoL. NoLi.. Neoli. MNoLi. NoLi. MNoL.. NoLi. NoL.. NolL.. NoL.. RNoli.
eth1/0/9 Noli.. MNolLi. NoLi. NoLi. NoLi. HNoL.. NoLi. Neli. MoLi. NeoLi. MoLi.. NoLi.. NoL.. NoL.. Noli. NolLi.
eth1/0/10 Noli.. MNolLi.. NoLi. NoLi. NoLi.. NoL.. NoLi. Noli. MoLi. MNoLi. NoL.. NoLi.. NoL.. NoL.. NoLi. NolLi.
eth1/0/11 No Li. NolLi.. MNolLi. NoLi. MNoli. NolLi Mo Li. No Li. No Li... No Li... MolLi.. NoLi. NoLi. Noli Mo Li. Mo Li.

eth1/0/12 NolLi.. MoLi. MoLi. NoLi. Noli. HNoL.. NoLi.. NoLi.. MoLi. MNoLi. NoLi. MNoL. NoL. NoL.. NoLi.. NolLi.
eth1/0/13 NoLi.. MoLi. MNoLi.. NoLi.. Moli. HNolLi.. NoLi.. MoLi. MoLi. NoLi. Moli. NoLi.. NoL.. NoL.. NoLi. Noli.
eth1/0/14 Noli.. MNolLi. NoLi. NoLi. NoLi.. NolL.. NoLi.. NolLi.. NoL.. NoL.. MNoL.. NoLi.. NoL.. NoL.. NoLi.. Noli.
eth1/0/15 NolLi.. MNoLi. NoLi.. NoL.. NoLi. NoLi.. NoLi.. NoL. MNolLi. NolLi. MoLi. NoL.. NoL.. NoL.. NolLi.. NolL.

.

Figure 7-6 Queue Rate Limiting Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
Queue ID Select the queue ID that will be configured here. Options to choose

fromare 0to 7.

Rate Limit Select and enter the queue rate limit settings here.

When the Min Bandwidth option is selected, enter the minimum
bandwidth rate limit value in the space provided. This value must
be between 64 and 10000000 kbps. Also, enter the maximum
bandwidth (Max Bandwidth) rate limit in the space provided. This
value must be between 64 and 10000000 kbps. The granularity is
64.

When the minimal bandwidth is configured, the packet transmitted
from the queue can be guaranteed. When the maximum bandwidth
is configured, packets transmitted from the queue cannot exceed
the maximum bandwidth even if the bandwidth is available.

When configuring the minimal bandwidth, the aggregate of the
configured minimum bandwidth must be less than 75 percent of the
interface bandwidth to make sure the configured minimal
bandwidth can be guaranteed. It is not necessary to set the
minimum guaranteed bandwidth for the highest strict priority queue.
This is because the traffic in this queue will be serviced first if the
minimal bandwidth of all queues is satisfied.

The configuration of this command can only be attached to a
physical port but not a port-channel. That is the minimum
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Parameter Description

guaranteed bandwidth of one CoS cannot be used across physical
ports.

When the Min Percent option is selected, enter the minimum
bandwidth percentage value in the space provided. This value must
be between 1 and 100 percent (%). Also, enter the maximum
percentage value (Max Percent) in the space provided. This value
must be between 1 and 100 percent (%).

Click the Apply button to accept the changes made.

Advanced Settings

DSCP Mutation Map

This window is used to view and configure the Differentiated Services Code Point (DSCP) mutation
map settings. When a packet is received by an interface, based on a DSCP mutation map, the
incoming DSCP can be mutated to another DSCP immediately before any QoS operations. The
DSCP mutation is helpful to integrate domains with different DSCP assignments. The DSCP-CoS
map and DSCP-color map will still be based on the packet’s original DSCP. All the subsequent
operations will base on the mutated DSCP.

To view the following window, click QoS > Advanced Settings > DSCP Mutation Map, as shown

below:
DSCP Mutation Map
Mutation Name Input DSCP List (0-63) Output DSCP (0-63)
wision v N T N N N N
00 0 1 2 3 4 5 6 7 1 9
10 20 1 12 13 14 15 16 17 18 19
20 n A 22 23 24 a5 [ons N | Nag g
Mutation1 30 a0 {21 | ez [ as e s s S S| ae ] (g
40 0 4 42 43 44 45 46 4T 48 49
50 50 51 52 53 54 55 56 57 58 59
&0 60 61 62 63

Figure 7-7 DSCP Mutation Map Window

The fields that can be configured are described below:

Parameter Description

Mutation Name Enter the DSCP mutation map name here. This name can be up to
32 characters long.

Input DSCP List Enter the input DSCP list value here. This value must be between 0
and 63.

Output DSCP Enter the output DSCP value here. This value must be between 0
and 63.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specific entry.
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Port Trust State and Mutation Binding

This window is used to view and configure port trust state and mutation binding settings.

To view the following window, click QoS > Advanced Settings > Port Trust State and Mutation
Binding, as shown below:

Mitation Bindina

Port Trust State and Mutation Binding

Unit From Port To Port Trust State DSCP Mutation Map
1 [=] [eth1/0/1 [=] None
Unit 1 Settings

eth1/0/1 Trust CoS

eth1/0/2 Trust CoS

eth1/0/3 Trust CoS

eth1/0/4 Trust CoS

eth1//5 Trust CoS

eth1/0/6 Trust CoS

eth1//7 Trust CoS

eth1/0/8 Trust CoS

eth1/0/9 Trust CoS

eth1/0/10 Trust CoS

eth1/0M11 Trust CoS

eth1/0M12 Trust CoS

eth1/0M13 Trust CoS

eth1/0/14 Trust CoS

eth1/0M15 Trust CoS

Figure 7-8 Port Trust State and Mutation Binding Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
Trust State Select the port trust state option here. Options to choose from are
CoS and DSCP.
DSCP Mutation Map Select and enter the DSCP mutation map name used here. This
name can be up to 32 characters long.
Select the None option to not allocate a DSCP mutation map to the
port(s).

Click the Apply button to accept the changes made.
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DSCP CoS Mapping

This window is used to view and configure the DSCP CoS mapping settings.

To view the following window, click QoS > Advanced Settings > DSCP CoS Mapping, as shown
below:

[} . D viapping
DSCP CoS Mapping

Unit From Port To Port CoS DSCP List (0-63)

B[] [ethton o] [etion [5] [0 [~] | |

Unit 1 Settings
DSCP List

0-7
815
16-23
2431
32-29
40-47
4365
56-A3
07
815
16-23
2431
32-39
40-47
43-55
56-63
07
215
16-23
2431
32-39
40-47
43-55
56-63

g
w

eth1/0/1

eth1/0/2

eth1/0/3

N O R WM SO N OO R W NSO NG 0 R W N e O

Figure 7-9 DSCP CoS Mapping Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

CoS Select the CoS value. Options to choose from are 0 to 7.

DSCP List Enter the DSCP list value to map to the CoS value here. This value
must be between 0 and 63.

Click the Apply button to accept the changes made.
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CoS Color Mapping

This window is used to view and configure the CoS color mapping settings.

To view the following window, click QoS > Advanced Settings > CoS Color Mapping, as shown
below:

0 DIC viapp ]

CoS Color Mapping
Unit From Port To Port CoS List (0-7) Color
[1 [  [ethtion [=]  [ettion [=] | |
Unit 1 Settings
I N T
Green 0-7
eth1/0/1 Yellow
Red
Green -7
eth1/0/2 Yellow
Red
Green 0-7
eth1/0/3 Yellow
Red
Green 0-7
eth1/0/4 Yellow
Red
Green 0-7
eth 1/0/5 Yellow
Red
Green 07
eth1/0/6 Yellow
Red
Green 0-7
eth1/0/7 Yellow
Red

Figure 7-10 CoS Color Mapping Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

CoS List Enter the CoS value that will be mapped to the color. This value
must be between 0 and 7.

Color Select the color option. Options to choose from are Green, Yellow,
and Red.

Click the Apply button to accept the changes made.
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DSCP Color Mapping

This window is used to view and configure the DSCP color mapping settings.

To view the following window, click QoS > Advanced Settings > DSCP Color Mapping, as shown

below:
DSCP Color Mapping
Unit From Port To Port DSCP List (0-63) Color
1 [=]  [ethton =] [ethton [=] | | | Green [=]
Unit 1 Settings
Cowr
Green 0-63
eth1/0/1 Yellow
Red
Green 0-63
eth1/0/2 Yellow
Red
Green 0-63
eth1/0/3 Yellow
Red
Green 0-63
eth1/0/4 Yellow
Red
Green 0-63
eth1/0/5 Yellow
Red
Green 0-63
eth1/0/6 Yellow
Red
Green 0-63
eth1/0/7 Yellow
Red

Figure 7-11 DSCP Color Mapping Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

DSCP List Enter the DSCP list value here that will be mapped to a color. This
value must be between 0 and 63.

Color Select the color option that will be mapped to the DSCP value.
Options to choose from are Green, Yellow, and Red.

Click the Apply button to accept the changes made.
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Class Map

This window is used to view and configure the class map settings.

To view the following window, click QoS > Advanced Settings > Class Map, as shown below:
Multiple Match Criteria

Class Map Name

Total Entries: 2

s e Mt o cr e

class-map Match Any
class-default Match Any
n [ [e

Figure 7-12 Class Map Window

The fields that can be configured are described below:

Parameter Description

Class Map Name Enter the class map name here. This name can be up to 32
characters long.

Multiple Match Criteria Select the multiple match criteria option here. Options to choose
from are Match All and Match Any.

Click the Apply button to accept the changes made.
Click the Match button to configure the specific entry.
Click the Delete button to remove the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

After clicking the Match button, the following window will appear.

Class Map Name class-map
Match:
None
@ Specify
©® ACL Name 32 chars
") DSCP List (0-63) [~ IPv4 anly
Precedence List (0-7) [~ IPv4 only
VD Lt 14080

[ Back ][ Apply ]

Figure 7-13 Match Rule Window

The fields that can be configured are described below:

Parameter Description

None Select this option to match nothing to this class map.
Specify Select the option to match something to this class map.
ACL Name Select and enter the access list name that will be matched with this

class map here. This name can be up to 32 characters long.

CoS List Select and enter the CoS list value that will be matched with this
class map here. This value must be between 0 and 7.
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Parameter Description

DSCP List

Select and enter the DSCP list value that will be matched with this
class map here. This value must be between 0 and 63.

Tick the IPv4 only check box to match IPv4 packets only. If not
specified, the match is for both IPv4 and IPv6 packets.

Precedence List

Select and enter the precedence list value that will be matched with
this class map here. This value must be between 0 and 7.

Tick the IPv4 only check box to match IPv4 packets only. If not
specified, the match is for both IPv4 and IPv6 packets. For IPv6
packets, the precedence is most three significant bits of traffic
class of IPv6 header.

Protocol Name

Select the protocol name that will be matched with the class map
here. Options to choose from are None, ARP, BGP, DHCP, DNS,
EGP, FTP, IPv4, IPv6, NetBIOS, NFS, NTP, OSPF, PPPOE, RIP,
RTSP, SSH, Telnet, and TFTP.

VID List

Select and enter the VLAN list value that will be matched with the
class map here. This value must be between 1 and 4094.

Click the Apply button to accept the changes made.

Click the Back button to return to the previous window.

Aggregate Policer

This window is used to view and configure the aggregate policer settings.

To view the following window, click QoS > Advanced Settings > Aggregate Policer, as shown

below:

| Single Rate Settings |

Two Rate Settings

APN-1

Agaregate Policer Name [ ] Average Rate * (0-10000000) [ kmps

Mormal Burst Size (0-16384) [ xoye Maximum Burst Size (0-16324) [ ko

Conform Action [ Transmit [=][PSCP][TF] Exceed Action [Transmit [~JPSCP] [P ]
Violate Action | None E" |DSCF || P | Color Aware

m Average Rate Normal Burst Size Max. Burst Size Conform Action Exceed Action Violate Action _
100 100

Transmit Transmit Disabled

Figure 7-14 Aggregate Policer Window

The fields that can be configured are described below:

Parameter Description

Aggregate Policer Name

Enter the aggregate policer's name here.

Average Rate

Enter the average rate value here. This value must be between 0
and 10000000 kbps.

Normal Burst Size

Enter the normal burst size value here. This value must be between
0 and 16384 Kbytes.

Maximum Burst Size

Enter the maximum burst size value here. This value must be
between 0 and 16384 Kbytes.

Confirm Action

Select the confirm action here. The confirm action specifies the
action to take on green color packets. If the confirm action is not
specified, the default action is to Transmit. Options to choose from
are:
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Parameter Description

e Drop - Specifies that the packet will be dropped.

o Set-DSCP-Transmit - Enter the IP DSCP value in the space
provided. This value sets the IP Differentiated Services Code
Point (DSCP) value and transmits the packet with the new IP
DSCP value.

e Set-1P-Transmit - Enter the 1P transmit value in the space
provided. This value sets the IEEE 802.1p value and
transmits the packet with the new value.

o Set-DSCP-1P - Enter the IP DSCP and 1P transmit values in
the spaces provided.

e Transmit - Specifies that packets will be transmitted
unaltered.

Exceed Action Select the exceed action here. The exceed action specifies the
action to take on packets that exceed the rate limit. For a two rate
policer, if the exceed action is not specified, the default action is
Drop. Options to choose from are:

e Drop - Specifies that the packet will be dropped.

e Set-DSCP-Transmit - Enter the IP DSCP value in the space
provided. This value sets the IP DSCP value and transmits
the packet with the new IP DSCP value.

e Set-1P-Transmit - Enter the 1P transmit value in the space
provided. This value sets the IEEE 802.1p value and
transmits the packet with the new value.

e Set-DSCP-1P - Enter the IP DSCP and 1P transmit values in
the spaces provided.

o Transmit - Specifies that packets will be transmitted
unaltered.

Violate Action Select the violate action here. The violate action specifies the
action to take on packets that violate the normal and maximum
burst sizes for singe rate policing. It specifies the action to take for
those packets that did not conform to both CIR and PIR. For a
single rate policer, if the violate action is not specified, it will create
a single-rate two-color policer. For a two-rate policer, if the violation
action is not specified, the default action is equal to the exceed
action. Options to choose from are:

e Drop - Specifies that the packet will be dropped.

o Set-DSCP-Transmit - Enter the IP DSCP value in the space
provided. This value sets the IP DSCP value and transmits
the packet with the new IP DSCP value.

e Set-1P-Transmit - Enter the 1P transmit value in the space
provided. This value sets the IEEE 802.1p value and
transmits the packet with the new value.

o Set-DSCP-1P - Enter the IP DSCP and 1P transmit values in
the spaces provided.

¢ Transmit - Specifies that packets will be transmitted
unaltered.

Color Aware Select this option to enable or disable color aware option here.
When color aware is not specified, the policer works in the
colorblind mode. When color aware is enabled, the policer works in
the color aware mode.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specific entry.
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After clicking the Two Rate Setting tab, at the top of the page, the following page will be available.

Single Rate Settings |

Two Rate Settings |

Aggregate Policer Name l:l

CIR * (0-10000000) |:| Kbps Confirm Burst (0-16384) |:| Kbyte

PIR * (0-10000000) |:| Kbps Peak Burst (0-16384) |:| Kbyte

Conform Action [ Transmit [=][PSCR][P ] Exceed Action [Drop [=]PSCF][FF_]
Violate Action [ Drop [=][PSCF][TF_] Color Aware

APN-2 100 100

m Confirm Burst m Peak Burst
100 120

Apply

T T

Transmit Drop Drop Disabled

Figure 7-15 Two Rate Settings Window

The fields that can be configured are described below:

Parameter Description

Aggregate Policer Name

Enter the aggregate policer's name here.

CIR

Enter the Committed Information Rate (CIR) value here. This value
must be between 0 and 10000000 kbps. The committed packet rate
is the first token bucket for the two-rate metering.

Confirm Burst

Enter the confirm burst value here. This value must be between 0
and 16384 Kbytes. The confirm burst value specifies the burst size
for the first token bucket in kbps.

PIR Enter the Peak information Rate (PIR) value here. This value must
be between 0 and 10000000 kbps. The peak information rate is the
second token bucket for the two-rate metering.

Peak Burst Enter the peak burst value here. This value must be between 0 and

16384 Kbytes. The peak burst value is the burst size for the second
token bucket in kilobytes.

Confirm Action

Select the confirm action here. The confirm action specifies the
action to take on green color packets. If the confirm action is not
specified, the default action is to Transmit. Options to choose from
are:

e Drop - Specifies that the packet will be dropped.

o Set-DSCP-Transmit - Enter the IP DSCP value in the space
provided. This value sets the IP DSCP value and transmits
the packet with the new IP DSCP value.

e Set-1P-Transmit - Enter the 1P transmit value in the space
provided. This value sets the IEEE 802.1p value and
transmits the packet with the new value.

o Set-DSCP-1P - Enter the IP DSCP and 1P transmit values in
the spaces provided.

e Transmit - Specifies that packets will be transmitted
unaltered.

Exceed Action

Select the exceed action here. The exceed action specifies the
action to take on packets that exceed the rate limit. For a two rate
policer, if the exceed action is not specified, the default action is
Drop. Options to choose from are:

e Drop - Specifies that the packet will be dropped.

e Set-DSCP-Transmit - Enter the IP DSCP value in the space
provided. This value sets the IP DSCP value and transmits
the packet with the new IP DSCP value.

o Set-1P-Transmit - Enter the 1P transmit value in the space
provided. This value sets the IEEE 802.1p value and
transmits the packet with the new value.

e Set-DSCP-1P - Enter the IP DSCP and 1P transmit values in
the spaces provided.
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Parameter Description

e Transmit - Specifies that packets will be transmitted
unaltered.

Violate Action

Select the violate action here. The violate action specifies the
action to take on packets that violate the normal and maximum
burst sizes for singe rate policing. It specifies the action to take for
those packets that did not conform to both CIR and PIR. For a
single rate policer, if the violate action is not specified, it will create
a single-rate two-color policer. For a two-rate policer, if the violation
action is not specified, the default action is equal to the exceed
action. Options to choose from are:

¢ Drop - Specifies that the packet will be dropped.

e Set-DSCP-Transmit - Enter the IP DSCP value in the space
provided. This value sets the IP DSCP value and transmits
the packet with the new IP DSCP value.

o Set-1P-Transmit - Enter the 1P transmit value in the space
provided. This value sets the IEEE 802.1p value and
transmits the packet with the new value.

o Set-DSCP-1P - Enter the IP DSCP and 1P transmit values in
the spaces provided.

e Transmit - Specifies that packets will be transmitted
unaltered.

Color Aware

Select this option to enable or disable color aware option here.
When color aware is not specified, the policer works in the
colorblind mode. When color aware is enabled, the policer works in
the color aware mode.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specific entry.

Policy Map

This window is used to view and configure the policy map settings.

To view the following window, click QoS > Advanced Settings > Policy Map, as shown below:

Create/Delete Policy Map

Class Rules

Figure 7-16 Policy Map Window

The fields that can be configured for Create/Delete Policy Map are described below:

Traffic Policy
Total Entries: 1
r—— I
Policy-Map-1
n M [ [ee

Parameter

Description

Policy Map Name
This name can be up to 32 characters long.

Enter the policy map’s name here that will be created or deleted.

Click the Apply button to accept the changes made.
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The fields that can be configured for Traffic Policy are described below:

Parameter Description

Policy Map Name Enter the policy map’s name here. This name can be up to 32
characters long.

Class Map Name Enter the class map’s name here. This name can be up to 32
characters long.

Click the Apply button to accept the changes made.
Click the Delete button to remove the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

To view the rules of a specific policy map, click the policy map name in the table (the Policy Map
Name will toggle to the bold font).

Create/Delete Policy Map

Traffic Policy
Total Entries: 1
Pt o oo I
Policy-Map-1

(L A [ [eo

Policy-Map-1 Rules

Class Map Name

class-default [ Set Action ] [ Policer ] [ Delete ]

(1] Bl [ e

Figure 7-17 Policy Map (View Rules) Window
Click the Set Action button to configure the action for the policy map.
Click the Policer button to configure the policer action for the policy map.

Click the Delete button to remove the specific entry.

After clicking the Set Action button, the following window will appear.

et Actio

Policy Map Name Policy
Class Map Name Class
Set Action
(CNone
(w)Specify
(@New Precedence (0-7) []1Pv4 onty
(OMew DSCF (0-63) None [~] []1Pv4 only
(CMew CoS (0-7) None [v]
(CMew CoS Queue (0-T) None [v]
Back | ‘ Apply

Figure 7-18 Set Action Window
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The fields that can be configured are described below:

Parameter Description

None

Select this option to match nothing to this policy map.

Specify

Select the option to match something to this policy map.

New Precedence

Select a new precedence for the packet. This value must be
between 0 and 7. Tick the IPv4 only to only mark IPv4
precedence. Setting the precedence will not affect the CoS queue
selection.

New DSCP Select a new DSCP for the packet. This value must be between 0
and 63. Tick the IPv4 only to only mark IPv4 precedence. Setting
DSCP will not affect the CoS queue selection.

New CoS Select a new CoS value for the packet. This value must be

between 0 and 7. Setting CoS will not affect the CoS queue
selection.

New CoS Queue

Select a new CoS queue for the packet. This value must be
between 0 and 7. This overwrites the original CoS queue selection.

Click the Apply button to accept the changes made.

Click the Back button to return to the previous window.

After clicking the Policer button, the following window will appear.

Policy Map Mame
Class Map Name

Police Action

Mone

@ Specify
Average Rate * (0-10000000)
Mormal Burst Size (0-16384)
Maximum Burst Size (0-16384)
Conform Action
Exceed Action
Violate Action

Color Aware

Paolicy-Map-1

class-default

Puolice -
[ IKops
[ ko
[ ko
Disabled -

Back I Apply

Figure 7-19 Police Action Window

The fields that can be configured are described below:

Parameter Description

None

Select this option to match nothing to this policy map.

Specify

Select the option to match something to this policy map.

Average Rate

Enter the average rate in Kilobits per second.

Normal Burst Size

Enter the normal burst size in kilobytes.

Maximum Burst Size

Enter the maximum burst in kilobytes.

Conform Action

Select the action to take on green color packets. Options to choose
from are Drop, Set-DSCP-Transmit, Set-1P-Transmit, Transmit,
and Set-DSCP-1P.
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Parameter Description

Exceed Action Select the action to take on yellow color packets. Options to
choose from are Drop, Set-DSCP-Transmit, Set-1P-Transmit,
Transmit, and Set-DSCP-1P.

Violate Action Select the action to take on red color packets. Options to choose
from are None, Drop, Set-DSCP-Transmit, Set-1P-Transmit,
Transmit, and Set-DSCP-1P.

Color Aware Select this option to enable or disable color aware mode.

Click the Apply button to accept the changes made.

Click the Back button to return to the previous window.

Policy Binding

This window is used to view and configure the policy binding settings.

To view the following window, click QoS > Advanced Settings > Policy Binding, as shown below:

Policy Binding
Policy Binding Setting

Unit From Port To Port Direction Policy Map Name

[1 =] [etiioin [=]  [ethtoit [=]  [input[=] g [32 chars | None Apply

Unit 1 Settings
Direction Policy Map Name

eth1/0/1
eth1/0/2
eth1/0/3
eth1/0/4
eth1/0/5
eth1/0/6
eth1/0i7
eth1/0/8
eth1/0/9
eth1/0/10
eth1/0/11
eth1/0/12
eth1/0/13
eth1/0/14
eth1/0/15

Figure 7-20 Policy Binding Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

Direction Select the direction option here. Option to choose from is Input.
Input represents Input specified ingress traffic.

Policy Map Name Enter the policy map name here. This name can be up to 32
characters long. Select the None option to not tie a policy map to
this entry.

Click the Apply button to accept the changes made.
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8. Access Control List (ACL)

ACL Configuration Wizard
ACL Access List

ACL Interface Access Group
ACL VLAN Access Map

ACL VLAN Filter

ACL Configuration Wizard

This window is used to guide the user to create a new ACL access list or configure an existing ACL
access list.

To view the following window, click ACL > ACL Configuration Wizard, as shown below:

a onfiguration Wizard

ACL Configuration Wizard

Access-List Assignment >> Select Packet Type >> Add Rule >> Apply Port

Do you want to create a new ACL access-list or update an existing access-list?

@ Create
() Update

Note: The first character of ACL name must be a letter.

Figure 8-1 ACL Configuration Wizard (Access-List Assignment) - Create Window

a onfiguration Wizard

ACL Configuration Wizard

Access-List Assignment >> Select Packet Type >> Add Rule >> Apply Port

Do you want to create a new ACL access-list or update an existing access-list?

(") Create

@ Update

Note: The first character of ACL name must be a letter.

Total Entries: 1
- ACL Name ACL Type Total Rules
@) ACL 1

Extended IPvE ACL
11 7] [ [ce

Figure 8-2 ACL Configuration Wizard (Access-List Assignment) - Update Window

The fields that can be configured are described below:
Parameter Description
Create Select and enter the ACL name with a maximum of 32 characters.

Update Select to see a table below with the existing ACL access lists.
Select the specific re-configure the entry.

Click the Next button to continue.
Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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After clicking the Next button, the following window will appear.

a onfguration Yizard

ACL Configuration Wizard

Access-List Assignment >> Select Packet Type => Add Rule >> Apply Port

Which type of packet do you want to monitor?
@ MAC
@) IPvd

=) IPvB

[ Back ][ Next ]

Figure 8-3 ACL Configuration Wizard (Select Packet Type) Window

The fields that can be configured are described below:

Parameter Description

MAC Select to be MAC ACL.
IPv4 Select to be IPv4 ACL.
IPv6 Select to be IPv6 ACL.

Click the Back button to return to the previous window.

Click the Next button to continue.

After clicking the MAC radio button and the Next button, the following window will appear.

ACL Configuration Wizard

Access-List Assignment >> Select Packet Type >» Add Rule >> Apply Port

Please assign a sequence number to create a new rule.

(®)Sequence No. (1-65535) l:l (OAuto Assign

Assign rule criteria

MAC Address | | Ethernet Type | | 802.1Q VLAN |
MAC Address
(®) Any (@) Any
() Host 11-DF-36-4B-A7-CC (JHost 11-DF-36-4B-A7-CC
Source Destination
(OMAC 11-DF-36-4B-A7-CC (OMAC 11-DF-36-4B-A7-CC
Wildcard (11-DF-36-4B-A7-CC Wildcard 11-DF-36-4B-A7-CC
Ethernet Type
Specify Ethernet Type Please Select [V

RN RIS RORRED [ ]
Ethemet Type Mask (x0-0xFFFF) [ |

202.1Q VLAN

CoS |Please Select  |[v|
T

() VLAN Range| |~
Action (@) Pemmit () Deny

| Back || Next

Figure 8-4 ACL Configuration Wizard (Add Rule for MAC ACL) Window

212



DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

The fields that can be configured are described below:

Parameter Description

Sequence No. Enter the ACL rule number here. This value must be between 1
and 65535. Select Auto Assign to automatically generate an ACL
rule number for this entry.

Source Select and enter the source information here. Options to choose
from are:

¢ Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host's MAC address here.

e MAC - The Wildcard option will also be available. Enter the
source MAC address and wildcard value in the spaces
provided.

Destination Select and enter the destination information here. Options to
choose from are:

¢ Any - Any destination traffic will be evaluated according to
the conditions of this rule.

¢ Host - Enter the destination host's MAC address here.

e MAC - The Wildcard option will also be available. Enter the
destination MAC address and wildcard value in the spaces
provided.

Specify Ethernet Type Select the Ethernet type option here. Options to choose from are
aarp, appletalk, decent-iv, etype-6000, etype-8042, lat, lavc-
sca, mop-console, mop-dump, vines-echo, vines-ip, xns-idp,
and arp.

Ethernet Type Enter the Ethernet type hexadecimal value here. This value must
be between 0x0 and OxFFFF. When any Ethernet type profile is
selected in the Specify Ethernet Type drop-down list, the
appropriate hexadecimal value will automatically be entered.

Ethernet Type Mask Enter the Ethernet type mask hexadecimal value here. This value
must be between 0x0 and OxFFFF. When any Ethernet type profile
is selected in the Specify Ethernet Type drop-down list, the
appropriate hexadecimal value will automatically be entered.

CoS Select the CoS value used here. This value is between 0 and 7.

VID Enter the VLAN ID that will be associated with this ACL rule here.
This value must be between 1 and 4094.

VLAN Range Enter the VLAN range here. Enter the minimum and maximum
VLAN ID in the range here.

Time Range Enter the name of the time range to associate with this ACL rule.

Action Select the action that this rule will take here. Options to choose

from are Permit and Deny.

Click the Back button to return to the previous window.

Click the Next button to continue.
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After clicking the IPv4 radio button and the Next button, the following window will appear.

0 gurato ywizard
ACL Configuration Wizard

Access-List Assignment >> Select Packet Type => Add Rule >> Apply Port

Please assign a sequence number to create a new rule.

@ Sequence No. (1-65535) [ 1 ®Auohssion
Protocol Type TCP M I:l (0-255) Fragments

Assign rule criteria

IPv4 Address Port IPvd4 DSCP TCP Flag

Time Range

Action @ Permit () Deny

l Back ] l MNext ]

Figure 8-5 ACL Configuration Wizard (Add Rule for IPv4 ACL) Window

This window has a dynamic section. Every selection made in the Protocol Type drop-down list will
change the bottom part of this window.

The fixed fields that can be configured are described below:

Parameter Description

Sequence No. Enter the ACL rule number here. This value must be between 1
and 65535. Select Auto Assign to automatically generate an ACL
rule number for this entry.

Protocol Type Select the protocol type option here. Options to choose from are
TCP, UDP, ICMP, EIGRP, ESP, GRE, IGMP, OSPF, PIM, VRRP,
IP-in-IP, PCP, Protocol ID, and None.
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After selecting the TCP option as the Protocol Type, the following section will appear.

pnfiguration Wizard
ACL Configuration Wizard

Access-List Assignment >> Select Packet Type >> Add Rule => Apply Port

Please assign a sequence number to create a new rule.

(®)Sequence No. (1-65535) l:l (OAuto Assign

Protocol Type | TCP ﬂ| | (0-255) Fragments

Assign rule criteria

IPv4 Address | | Port | | IPv4 DSCP | | TCP Flag |
IPv4 Address
@ Any ®Any

Source Destination
Port
Source Port | Please Select [v]

[Please Select [V] | | (0-65535) | Please Select [V] | | (0-65535)
Destination Port| Please Select [v]

[Please Select [v] | | (0-65535) | Please Select [v] | | (0-65535)
IPv4 DSCP

(®IP Precedence| Please Select ﬂ‘ToS| Please Select ﬂ|

(ODSCP (0-63) [Please Select [v] | |

TCP Flag
TCP Flag[Jack [Ifin [Jpsh [Jrst [Jsyn [Jurg
Action (®) Permit () Deny

| Back || Next

Figure 8-6 ACL Configuration Wizard (Add Rule for IPv4 ACL) TCP Window

The dynamic fields that can be configured are described below:

Parameter ‘ Description

Source Select and enter the source information here. Options to choose
from are:

e Any - Any source traffic will be evaluated according to the
conditions of this rule.

o Host - Enter the source host’s IP address here.

o [P - The Wildcard option will also be available. Enter the
group of source IP addresses by using a wildcard bitmap.
The bit corresponding to the bit value 1 will be ignored. The
bit corresponding to the bit value 0 will be checked.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

¢ Host - Enter the destination host’s IP address here.

e [P - The Wildcard option will also be available. Enter the
group of destination IP addresses by using a wildcard
bitmap. The bit corresponding to the bit value 1 will be
ignored. The bit corresponding to the bit value 0 will be

checked.
Source Port Select and enter the source port value here. Options to choose
from are:
o =-The specific selected port number will be used.

o > - All ports greater than the selected port, will be used.
o < - All ports smaller than the selected port, will be used.
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Parameter ‘ Description

o # - All ports, excluding the selected port, will be used.

e Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s) provided,
if the port number(s) is/are not available in the drop-down
list.

Destination Port Select and enter the destination port value here. Options to choose
from are:

= - The specific selected port number will be used.

> - All ports greater than the selected port, will be used.

< - All ports smaller than the selected port, will be used.

# - All ports, excluding the selected port, will be used.

Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s) provided,
if the port number(s) is/are not available in the drop-down
list.

IP Precedence Select the IP precedence value used here. Options to choose from
are 0 (routine), 1 (priority), 2, (immediate), 3 (flash), 4 (flash-
override), 5 (critical), 6 (internet), and 7 (network).

ToS After selecting the IP precedence value, select the Type-of-Service
(ToS) value that will be used here. Options to choose from are 0
(normal), 1 (min-monetary-cost), 2 (max-reliability), 3, 4 (max-
throughput), 5, 6, 7, 8 (min-delay), 9, 10, 11, 12, 13, 14, and 15.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

TCP Flag Tick the appropriate TCP flag option to include the flag in this rule.
Options to choose from are ack, fin, psh, rst, syn, and urg.

Time Range Enter the name of the time range to associate with this ACL rule.

Action Select the action that this rule will take here. Options to choose

from are Permit and Deny.
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After selecting the UDP option as the Protocol Type, the following section will appear.

O guratio Wwizard

ACL Configuration Wizard

Access-List Assignment >> Select Packet Type >> Add Rule >> Apply Port

Please assign a sequence number to create a new rule.

@ Sequence Mo. (1-65535) I:I Auto Assign
Protocol Type UDP M l:l (0-255) Fragments
Assign rule criteria
IPv4 Address | | Port | | IPv4 DSCP |
IPv4 Address
@ Any @ Any

Host [ ] Host [ ]
Source Destination

L p T

wigeara [ ] wigeara [ ]
Port
Source Port Please Select =

[ Jeesss [ lossss
Destination Port Please Select -
[ eesss [ ossses
IPv4 DSCP
@) IP Precedence Please Select ~ ToS Please Select -
psor 0-) I

Time Range 32
Action @ Permit Deny

Back I Next

Figure 8-7 ACL Configuration Wizard (Add Rule for IPv4 ACL) UDP Window

The dynamic fields that can be configured are described below:

Parameter Description

Source Select and enter the source information here. Options to choose
from are:

e Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IP address here.

e [P - The Wildcard option will also be available. Enter the
group of source IP addresses by using a wildcard bitmap.
The bit corresponding to the bit value 1 will be ignored. The
bit corresponding to the bit value 0 will be checked.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

e Host - Enter the destination host’s IP address here.

e [P - The Wildcard option will also be available. Enter the
group of destination IP addresses by using a wildcard
bitmap. The bit corresponding to the bit value 1 will be
ignored. The bit corresponding to the bit value 0 will be
checked.

Source Port Select and enter the source port value here. Options to choose
from are:

= - The specific selected port number will be used.

> - All ports greater than the selected port, will be used.
< - All ports smaller than the selected port, will be used.
# - All ports, excluding the selected port, will be used.
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Parameter Description

¢ Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s)
provided, if the port number(s) is/are not available in the
drop-down list.

Destination Port Select and enter the destination port value here. Options to choose
from are:

= - The specific selected port number will be used.

> - All ports greater than the selected port, will be used.

< - All ports smaller than the selected port, will be used.
# - All ports, excluding the selected port, will be used.
Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s)
provided, if the port number(s) is/are not available in the
drop-down list.

IP Precedence Select the IP precedence value used here. Options to choose from
are 0 (routine), 1 (priority), 2, (immediate), 3 (flash), 4 (flash-
override), 5 (critical), 6 (internet), and 7 (network).

ToS After selecting the IP precedence value, select the Type-of-Service
(ToS) value that will be used here. Options to choose from are 0
(normal), 1 (min-monetary-cost), 2 (max-reliability), 3, 4 (max-
throughput), 5, 6, 7, 8 (min-delay), 9, 10, 11, 12, 13, 14, and 15.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

Time Range Enter the name of the time range to associate with this ACL rule.

Action Select the action that this rule will take here. Options to choose
from are Permit and Deny.
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After selecting the ICMP option as the Protocol Type, the following section will appear.

0 guratio ywiZzard

ACL Configuration Wizard

Access-List Assignment >> Select Packet Type => Add Rule >> Apply Port

Please assign a sequence number to create a new rule.

@ Sequence Mo. (1-685535) l:l “) Auto Assign
Protocol Type ICMP M I:l (0-255) Fragments
Assign rule criteria
IPv4 Address | | ICmp | | IPv4 DSCP |
IPv4 Address
@ Any @ Any
owest [ ] owest [ ]
Source Destination
or [ or [
ICMp
Specify ICMP Message Type Please Select v
ICWP Message Type (0-265)  |MessageCode (0-258) |
IPv4 DSCP
@ IP Precedence Please Select ~ ToS Please Select -
5 bsor 04 I
Time Range
Action @ Permit () Deny

[ Back ] l Mext ]

Figure 8-8 ACL Configuration Wizard (Add Rule for IPv4 ACL) ICMP Window

The dynamic fields that can be configured are described below:

Parameter Description

Source Select and enter the source information here. Options to choose
from are:

e Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IP address here.

e [P - The Wildcard option will also be available. Enter the
group of source IP addresses by using a wildcard bitmap.
The bit corresponding to the bit value 1 will be ignored. The
bit corresponding to the bit value 0 will be checked.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

e Host - Enter the destination host’s IP address here.

e |IP - The Wildcard option will also be available. Enter the
group of destination IP addresses by using a wildcard
bitmap. The bit corresponding to the bit value 1 will be
ignored. The bit corresponding to the bit value 0 will be
checked.

Specify ICMP Message Type |Select the ICMP message type used here.

ICMP Message Type When the ICMP Message Type is not selected, enter the ICMP
Message Type numerical value used here. When the ICMP
Message Type is selected, this numerical value will automatically
be entered.
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Parameter Description

Message Code When the ICMP Message Type is not selected, enter the Message
Code numerical value used here. When the ICMP Message Type
is selected, this numerical value will automatically be entered.

IP Precedence Select the IP precedence value used here. Options to choose from
are 0 (routine), 1 (priority), 2, (immediate), 3 (flash), 4 (flash-
override), 5 (critical), 6 (internet), and 7 (network).

ToS After selecting the IP precedence value, select the Type-of-Service
(ToS) value that will be used here. Options to choose from are 0
(normal), 1 (min-monetary-cost), 2 (max-reliability), 3, 4 (max-
throughput), 5, 6, 7, 8 (min-delay), 9, 10, 11, 12, 13, 14, and 15.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

Time Range Enter the name of the time range to associate with this ACL rule.

Action Select the action that this rule will take here. Options to choose
from are Permit and Deny.

After selecting the EIGRP, ESP, GRE, IGMP, OSPF, PIM, VRRP, IP-in-IP, PCP, or Protocol ID
option as the Protocol Type, the following section will appear.

0 gurato yviZard

ACL Configuration Wizard
Access-List Assignment >> Select Packet Type => Add Rule >> Apply Port
Please assign a sequence number to create a new rule.
@ Sequence Mo. (1-65535) I:l Auto Assign
Protocol Type EIGRP - (0-255) Fragments
Assign rule criteria
IPv4 Address | | IPv4 DSCP |
IPv4 Address
@ Any @ Any
Source Destination
L I L
IPvd DSCP
@ |P Precedence Please Select * ToS Please Select M
pscp 043 o
Time Range |32 chars
Action @ Permit Deny
Back J Next

Figure 8-9 ACL Configuration Wizard (Add Rule for IPv4 ACL) EIGRP Window

The dynamic fields that can be configured are described below:

Parameter Description

Fragments Select the Fragments option to include packet fragment filtering.
Source Select and enter the source information here. Options to choose
from are:

e Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IP address here.

e |IP - The Wildcard option will also be available. Enter the
group of source IP addresses by using a wildcard bitmap.
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Parameter Description

The bit corresponding to the bit value 1 will be ignored. The
bit corresponding to the bit value 0 will be checked.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

e Host - Enter the destination host’s IP address here.

e |IP - The Wildcard option will also be available. Enter the
group of destination IP addresses by using a wildcard
bitmap. The bit corresponding to the bit value 1 will be
ignored. The bit corresponding to the bit value 0 will be
checked.

IP Precedence Select the IP precedence value used here. Options to choose from
are 0 (routine), 1 (priority), 2, (immediate), 3 (flash), 4 (flash-
override), 5 (critical), 6 (internet), and 7 (network).

ToS After selecting the IP precedence value, select the Type-of-Service
(ToS) value that will be used here. Options to choose from are 0
(normal), 1 (min-monetary-cost), 2 (max-reliability), 3, 4 (max-
throughput), 5, 6, 7, 8 (min-delay), 9, 10, 11, 12, 13, 14, and 15.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

Time Range Enter the name of the time range to associate with this ACL rule.

Action Select the action that this rule will take here. Options to choose
from are Permit and Deny.

After selecting the None option as the Protocol Type, the following section will appear.

0 gurato wizard
ACL Configuration Wizard

Access-List Assignment == Select Packet Type => Add Rule »> Apply Port

Please assign a sequence number to create a new rule.

i@ Sequence No. (1-65535) l:l Auto Assign
Protocol Type None - I:l (0-255) Fragments
Assign rule criteria
IPv4 Address | | IPv4 DSCP |
IPv4 Address
@ Any @ Any
Source Destination
e T N
IPv4 DSCP
@ IP Precedence Please Select ¥ ToS Please Select M

oscr @49 I

Time Range

Action @ Permit Deny

Back J Next

Figure 8-10 ACL Configuration Wizard (Add Rule for IPv4 ACL) None Window

The dynamic fields that can be configured are described below:

Parameter Description

Fragments Select the Fragments option to include packet fragment filtering.
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Parameter Description

Source Select and enter the source information here. Options to choose
from are:

e Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IP address here.

e [P - The Wildcard option will also be available. Enter the
group of source IP addresses by using a wildcard bitmap.
The bit corresponding to the bit value 1 will be ignored. The
bit corresponding to the bit value 0 will be checked.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

e Host - Enter the destination host’s IP address here.

e [P - The Wildcard option will also be available. Enter the
group of destination IP addresses by using a wildcard
bitmap. The bit corresponding to the bit value 1 will be
ignored. The bit corresponding to the bit value 0 will be
checked.

IP Precedence Select the IP precedence value used here. Options to choose from
are 0 (routine), 1 (priority), 2, (immediate), 3 (flash), 4 (flash-
override), 5 (critical), 6 (internet), and 7 (network).

ToS After selecting the IP precedence value, select the Type-of-Service
(ToS) value that will be used here. Options to choose from are 0
(normal), 1 (min-monetary-cost), 2 (max-reliability), 3, 4 (max-
throughput), 5, 6, 7, 8 (min-delay), 9, 10, 11, 12, 13, 14, and 15.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

Time Range Enter the name of the time range to associate with this ACL rule.

Action Select the action that this rule will take here. Options to choose
from are Permit and Deny.

Click the Back button to return to the previous window.

Click the Next button to continue.

After clicking the IPv6 radio button and the Next button, the following window will appear.

0 guratio ! ard
ACL Configuration Wizard

Access-List Assignment >> Select Packet Type >> Add Rule >> Apply Port

Please assign a sequence number to create a new rule.

@ Sequence No. (1-65535) [ ] ¢ autoAssion
Protocol Type TCP M I:I (0-255) Fragments
Assign rule criteria
IPv6 Address Port IPvG DSCP TCP Flag Flow Label
Time Range

Action @ Permit Deny

Back I Next

Figure 8-11 ACL Configuration Wizard (Add Rule for IPvé ACL) Window

This window has a dynamic section. Every selection made in the Protocol Type drop-down list will
change the bottom part of this window.
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The fixed fields that can be configured are described below:

Parameter Description

Sequence No. Enter the ACL rule number here. This value must be between 1
and 65535. Select Auto Assign to automatically generate an ACL
rule number for this entry.

Protocol Type Select the protocol type option here. Options to choose from are
TCP, UDP, ICMP, Protocol ID, ESP, PCP, SCTP, and None.

After selecting the TCP option as the Protocol Type, the following section will appear.

U urato viZara
ACL Configuration Wizard

Access-List Assignment >> Select Packet Type >> Add Rule >> Apply Port

Please assign a sequence number to create a new rule.

(®)Sequence No. (1-65535) l:l (iAuto Assign

Protocol Type [Tcp M (0-255) Fragments

Assign rule criteria

IPv6 Address || Port || IPvG DSCP || TCP Flag || Flow Label
IPvE Address
(®) Any (®) Any
() Host () Host Q01271
Source Destination N
) IPvE ED'IQ 1 (O IPvE 20121
Port
Source Port Please Select [v]|
[Please Select [¥] | | (0-65535) | Please Select [¥] | | (0-65535)
Destination Port| Please Select |[v|
[Please Select [v] | | (0-65535)| Please Select [v] | | (0-65535)
IPvG6 DSCP

DSCF (0-63)|Please Select [V |

TCP Flag

TCP Flag[Jack [Ifin [“Jpsh [Jrst [Jsyn [Jurg

Flow Label

Flow Label (0-1 D48575}|:|

Time Range
Action (@) Permit () Deny

| Back || Next

Figure 8-12 ACL Configuration Wizard (Add Rule for IPvé ACL) TCP Window

The dynamic fields that can be configured are described below:

Parameter Description

Source Select and enter the source information here. Options to choose
from are:

e Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IPv6 address here.

e [Pv6 - The Prefix Length option will also be available. Enter
the source IPv6 address and prefix length value in the
spaces provided.

Destination Select and enter the destination information here. Options to
choose from are:
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Parameter Description

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

o Host - Enter the destination host’s IPv6 address here.

e [Pv6 - The Prefix Length option will also be available. Enter
the destination IPv6 address and prefix length value in the
spaces provided.

Source Port Select and enter the source port value here. Options to choose
from are:

e =-The specific selected port number will be used.

e > - All ports greater than the selected port, will be used.

e < - All ports smaller than the selected port, will be used.

o # - All ports, excluding the selected port, will be used.

¢ Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s) provided,
if the port number(s) is/are not available in the drop-down
list.

Destination Port Select and enter the destination port value here. Options to choose
from are:

= - The specific selected port number will be used.

> - All ports greater than the selected port, will be used.

< - All ports smaller than the selected port, will be used.

# - All ports, excluding the selected port, will be used.

Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s) provided,
if the port number(s) is/are not available in the drop-down
list.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

TCP Flag Tick the appropriate TCP flag option to include the flag in this rule.
Options to choose from are ack, fin, psh, rst, syn, and urg.

Flow Label Enter the flow label value here. This value must be between 0 and
1048575.

Time Range Enter the name of the time range to associate with this ACL rule.

Action Select the action that this rule will take here. Options to choose
from are Permit and Deny.
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After selecting the UDP option as the Protocol Type, the following section will appear.

ACL Configuration Wizard

Access-List Assignment >> Select Packet Type >> Add Rule *> Apply Port

Please assign a sequence number to create a new rule.

© Sequence . (1-65535) [ ] ©aoassn
Protocol Type upr - l:l (0-255) Fragments

Assign rule criteria

IPvG Address ‘ | Port | | IPv6 DSCP ‘ | Flow Label |
IPvG Address
@ Any Q@ Any
Source Destinati
Port
Source Port Please Select ~
[ eesss [ s
Destination Port Please Select ~
[ Josss [ Jeess
IPv6 DSCP
DSCP(0-63) Please Select A I:l
Flow Label
Flow Label (0-1048575) |
Time Range 22 chars
Action @ Permit Deny

Back Next

Figure 8-13 ACL Configuration Wizard (Add Rule for IPv6é ACL) UDP Window

The dynamic fields that can be configured are described below:

Parameter Description

Source Select and enter the source information here. Options to choose
from are:

e Any - Any source traffic will be evaluated according to the
conditions of this rule.

¢ Host - Enter the source host’s IPv6 address here.

e |IPv6 - The Prefix Length option will also be available. Enter
the source IPv6 address and prefix length value in the
spaces provided.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

e Host - Enter the destination host’s IPv6 address here.

e IPv6 - The Prefix Length option will also be available. Enter
the destination IPv6 address and prefix length value in the
spaces provided.

Source Port Select and enter the source port value here. Options to choose
from are:

e =-The specific selected port number will be used.

e > - All ports greater than the selected port, will be used.

e < - All ports smaller than the selected port, will be used.

e # - All ports, excluding the selected port, will be used.

¢ Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s)
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Parameter Description

provided, if the port number(s) is/are not available in the
drop-down list.

Destination Port Select and enter the destination port value here. Options to choose
from are:

= - The specific selected port number will be used.

> - All ports greater than the selected port, will be used.

< - All ports smaller than the selected port, will be used.
# - All ports, excluding the selected port, will be used.
Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s)
provided, if the port number(s) is/are not available in the
drop-down list.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

Flow Label Enter the flow label value here. This value must be between 0 and
1048575.

Time Range Enter the name of the time range to associate with this ACL rule.

Action Select the action that this rule will take here. Options to choose
from are Permit and Deny.

After selecting the ICMP option as the Protocol Type, the following section will appear.

0 guratio wizard
ACL Configuration Wizard

Access-List Assignment >> Select Packet Type >> Add Rule >> Apply Port

Please assign a sequence number to create a new rule.

@ Sequence Mo. (1-65535) l:l Auto Assign
Protocol Type ICMP M |:| (0-255) Fragments
Assign rule criteria
IPv6 Address || ICMP || IPv6 DSCP || Flow Label |
IPv6 Address
@ Any @ Any
Host Host 20121
Source B Destination —
1= 20121 1= 20121
Prefctengtn [ ] Prefctengtn [ ]
ICMP
Specify ICMP Message Type Please Select hd
ICMP Message Type (0-255))  |MessageCode (0255) |
IPv6 DSCP
DSCP (0-63) Please Select v | |
Flow Label
FlowLabel 0-10d8s75) |
Time Range
Action @ Permit Deny

Back J Next

Figure 8-14 ACL Configuration Wizard (Add Rule for IPvé ACL) ICMP Window

226




DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

The dynamic fields that can be configured are described below:

Parameter Description

Source Select and enter the source information here. Options to choose
from are:

e Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IPv6 address here.

e |IPv6 - The Prefix Length option will also be available. Enter
the source IPv6 address and prefix length value in the
spaces provided.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

e Host - Enter the destination host’s IPv6 address here.

¢ |IPv6 - The Prefix Length option will also be available. Enter
the destination IPv6 address and prefix length value in the
spaces provided.

Specify ICMP Message Type |Select the ICMP message type used here.

ICMP Message Type When the ICMP Message Type is selected, this numerical value
will automatically be entered.

When the ICMP Message Type is not selected, enter the ICMP
Message Type numerical value used here.

Message Code When the ICMP Message Type is selected, this numerical value
will automatically be entered.

When the ICMP Message Type is not selected, enter the Message
Code numerical value used here.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

Flow Label Enter the flow label value here. This value must be between 0 and
1048575.

Time Range Enter the name of the time range to associate with this ACL rule.

Action Select the action that this rule will take here. Options to choose

from are Permit and Deny.
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After selecting the Protocol ID, ESP, PCP, or SCTP option as the Protocol Type, the following
section will appear.

0 guratio yviZzard

ACL Configuration Wizard

Access-List Assignment == Select Packet Type => Add Rule »> Apply Port

Please assign a sequence number to create a new rule.

‘@ Sequence No. (1-65535) l:l Auto Assign
Protocol Type Protocal ID h I:l (0-255) Fragments
Assign rule criteria
IPv6 Address || IPv6 DSCP || Flow Label |
IPV6 Address
@ Any @ Any

Host

Source Destination

IPvE IPvE
Prefciengn[ ] Prectengn[ ]

IPv6 DSCP

DSCP (0-63) Please Select | |
Flow Label

FlowLabel 0-1048575) |

Time Range

Action @ Permit Deny

Back J Next

Figure 8-15 ACL Configuration Wizard (Add Rule for IPv6 ACL) Protocol ID Window

The dynamic fields that can be configured are described below:

Parameter Description

Protocol Enter the Protocol ID value used here. This value must be between
0 and 255.

Fragments Select the Fragments option to include packet fragment filtering.

Source Select and enter the source information here. Options to choose
from are:

¢ Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IPv6 address here.

e [Pv6 - The Prefix Length option will also be available. Enter
the source IPv6 address and prefix length value in the
spaces provided.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

o Host - Enter the destination host’s IPv6 address here.

o |Pv6 - The Prefix Length option will also be available. Enter
the destination IPv6 address and prefix length value in the
spaces provided.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

Flow Label Enter the flow label value here. This value must be between 0 and
1048575.

Time Range Enter the name of the time range to associate with this ACL rule.
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Parameter Description

Action Select the action that this rule will take here. Options to choose
from are Permit and Deny.

After selecting the None option as the Protocol Type, the following section will appear.

0 gurato wizard
ACL Configuration Wizard

Access-List Assignment >> Select Packet Type >> Add Rule >> Apply Port

Please assign a sequence number to create a new rule.

@ Sequence No. (1-65535) [ 1 ®auoassion
Protocol Type None - I:l (0-255) Fragments
Assign rule criteria
IPv Address || IPvi DSCP || Flow Label |
IPV6 Address
@ Any @ Any
Source B Destination B
1= 20121 1= 20121

Prefxiengh [ | PrefixLengh [ |
IPV6 DSCP
DSCP (0-63) Please Select | |
Flow Label

FlowLabel 0-1048575) |

Time Range

Action @ Permit Deny

Back J Next

Figure 8-16 ACL Configuration Wizard (Add Rule for IPv6 ACL) None Window

The dynamic fields that can be configured are described below:

Parameter Description

Fragments Select the Fragments option to include packet fragment filtering.
Source Select and enter the source information here. Options to choose
from are:

¢ Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IPv6 address here.

e [Pv6 - The Prefix Length option will also be available. Enter
the source IPv6 address and prefix length value in the
spaces provided.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

¢ Host - Enter the destination host’s IPv6 address here.

o |Pv6 - The Prefix Length option will also be available. Enter
the destination IPv6 address and prefix length value in the
spaces provided.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

Flow Label Enter the flow label value here. This value must be between 0 and
1048575.
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Parameter Description
Time Range Enter the name of the time range to associate with this ACL rule.
Action Select the action that this rule will take here. Options to choose

from are Permit and Deny.

Click the Back button to return to the previous window.

Click the Next button to continue.

After clicking the Next button, the following window will appear.

0 guratio wizard
ACL Configuration Wizard

Access-List Assignment >> Select Packet Type >> Add Rule >> Apply Port
Which port{s) do you want to apply the Access-List?
Unit From Port To Port Direction
1 M eth1/0/1 - eth1/0/1 - In -

[ Back ] [ Apphy ]

Figure 8-17 ACL Configuration Wizard (Apply Port) Window

The fields that can be configured are described below:

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
Direction Select the direction here. Option to choose from is In.

Click the Back button to return to the previous window.

Click the Apply button to accept the changes made.

ACL Access List

This window is used to view and configure the ACL access list settings.

To view the following window, click ACL > ACL Access List, as shown below:

ACL Access List

ciwe A - @by [ o tnme
Total Entries: 0
I N e S N I

lCIear All Cuunter] I Clear Counter | [ Add Rule ]

I S N S R

Figure 8-18 ACL Access List Window

The fields that can be configured are described below:

Parameter Description

ACL Type Select the ACL profile type to find here. Options to choose from are
All, IP ACL, IPv6 ACL, MAC ACL, and Expert ACL.
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Parameter Description

ID Enter the ACL ID here. The range is from 1 to 14999.
ACL Name Enter the ACL name here. This name can be up to 32 characters
long.

Click the Find button to locate a specific entry based on the information entered.
Click the Add ACL button to create a new ACL profile.

Click the Clear All Counter button to clear all the counter information displayed.
Click the Clear Counter button to clear the counter information for the rule displayed.
Click the Add Rule button to create an ACL rule for the ACL profile selected.

Standard IP ACL

After clicking the Add ACL button, users can create a new ACL profile, as shown below:
Rad P ARCCEesSs LIS

Add ACL Access List

ACL Type [Standard IP ACL 7|
ID (1-1999) | |

ACL Name | |

Apply
MNote: The first character of ACL name must be a letter.

Figure 8-19 Standard IP ACL (Add ACL Access List) Window

The fields that can be configured are described below:

Parameter Description

ACL Type Select the ACL profile type here. Options to choose from are
Standard IP ACL, Extended IP ACL, Standard IPv6 ACL,
Extended IPv6 ACL, Extended MAC ACL, and Extended Expert

ACL.
ID Enter the ACL ID from 1 to 1999.
ACL Name Enter the ACL profile’s name here. This name can be up to 32

characters long.

Click the Apply button to create the new ACL profile.

After creating a Standard IP ACL profile, the newly created Standard IP ACL profile will be displayed
in the ACL profile display table, as shown below:

a ACCess LIS

ACL Access List

AcLType Al - @109 [ ] ©nactName
Total Entries: 1 Add ACL

e S e T N
StandardIP Standard IP ACL Disabled [ Edt | [ Delete |

11 7] [ [ce

Clear all Cuunte_r] Clear Cuuntﬂ] [ Add Rule
e = == E— i I ——

Figure 8-20 Standard IP ACL (Main) Window
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Click the Edit button to re-configure the specific ACL profile.
Click the Delete button to remove the specific ACL profile.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

To add an ACL rule in the ACL profile, select it (the ACL profile will toggle to the bold font), and click
the Add Rule button.

a ACCESS LIS

ACL Access List

ACL Type Al M ® 1D (1-14999) [ ] ©AcLName

Total Entries: 1 Add ACL

o e g S
StandardIP Standard IP ACL Disabled [ Edit | [ Delete |

n Kl [ [ce
StandardIP (ID: 1) Rule Clear All Counter] [ Clear Counter | [ Add Rule |
T S N N

Figure 8-21 Standard IP ACL (Selected) Window

After selecting the ACL profile and clicking the Add Rule button, users can configure the new ACL
rule, in the selected ACL profile, as shown below:

Add ACL Rule
D 1
ACL Name StandardIP
ACL Type Standard IP ACL
Sequence No. (1-65535) [ Juritisntspecified, the system automatically assigns.)
Action @ Permit () Deny

Match IP Address

@ Any @ Any
Source Destination
wideard [ | wideard [ ]
Time Range
[ Back J[ mpply |

Figure 8-22 Standard IP ACL (Add Rule) Window

The fields that can be configured are described below:

Parameter Description

Sequence No. Enter the ACL rule number here. This value must be between 1
and 65535. If this value is not specified, the system will
automatically generate an ACL rule number for this entry.

Action Select the action that this rule will take here. Options to choose
from are Permit and Deny.

Source Select and enter the source information here. Options to choose
from are:

e Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IP address here.

e |IP - The Wildcard option will also be available. Enter the
group of source IP addresses by using a wildcard bitmap.
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Parameter Description

The bit corresponding to the bit value 1 will be ignored. The
bit corresponding to the bit value 0 will be checked.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

¢ Host - Enter the destination host’s IP address here.

e |IP - The Wildcard option will also be available. Enter the
group of destination IP addresses by using a wildcard
bitmap. The bit corresponding to the bit value 1 will be
ignored. The bit corresponding to the bit value 0 will be
checked.

Time Range Enter the name of the time range to associate with this ACL rule.

Click the Back button to discard the changes made and return to the previous page.

Click the Apply button to accept the changes made.

To enable the Counter State option or to enter a Remark for the profile, click the Edit button, next to
the specific ACL profile (found in the ACL profile table).

ACL Access List
ACL Type Al - © 1D (1-14999) [ ] OnAcLName
Total Entries: 1
I N T I T T
StandardIP Standard IP ACL Disabled M Apply Delete
1n [ Go
StandardIP (ID: 1) Rule Clear All Cuunte_r] Clear Cuuntil[ Add Rule ]
I S NS S
Permit any any
1n [ Go

Figure 8-23 Standard IP ACL (Edit ACL) Window

The fields that can be configured are described below:

Parameter Description

Start Sequence No. Enter the start sequence number here.

Step Enter the sequence number increment here.

Counter State Select to enable or disable the counter state option here.

Remark IIqEnter an optional remark that will be associated with this profile
ere.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specific entry.
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To view the list of rules, that are associated with an ACL profile, select the ACL profile (found in the

ACL profile table). The rule of ACL rules, connected to the selected ACL profile, will be displayed in
the ACL rule table, as shown below:

a ACCEesSsS LIS

ACL Access List
ACLType Al - © ID(1-12999) [ ] ©nacthame
Total Entries: 1 Add ACL
D= T N
StandardIP Standard IP ACL Enabled [ Edt | [ Delete |
n [7] S
StandardIP (ID: 1) Rule Clear All Counter] | Clear Counter | [ Add Rule
“—
Permit any any (Ing: 0 packets)
n [7] S

Figure 8-24 Standard IP ACL (Rule Display) Window

Click the Delete button to remove the specific ACL rule.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

Extended IP ACL

After clicking the Add ACL button, users can create a new ACL profile, as shown below:
ROd R ACCESS LIS

Add ACL Access List

ACL Type |Extended IPACL 7]
D (2000-3999) | |

ACL Name | |

Apply
MNote: The first character of ACL name must be a letter.

Figure 8-25 Extended IP ACL (Add Profile) Window

The fields that can be configured are described below:

Parameter Description

ACL Type Select the ACL profile type here. Options to choose from are
Standard IP ACL, Extended IP ACL, Standard IPv6 ACL,
Extended IPv6 ACL, Extended MAC ACL, and Extended Expert

ACL.
ID Enter the ACL ID from 2000 to 3999.
ACL Name Enter the ACL profile’s name here. This name can be up to 32

characters long.

Click the Apply button to create the new ACL profile.
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After creating an Extend IP ACL profile, the newly created Extend IP ACL profile will be displayed in
the ACL profile display table, as shown below:

a ACCesSs LIS

ACL Access List

T R — T
Total Entries: 2 Add ACL
StandardP Standard IP ACL Enabled [ Edt | [ Delete |
2000 ExtendIP Extended IP ACL 10 10 Disabled [ Edit || Delete |
AEEAEE &

Clear All Counter| | Clear Counter Add Rule
I S N N B

Figure 8-26 Extended IP ACL (Main) Window

Click the Edit button to re-configure the specific ACL profile.
Click the Delete button to remove the specific ACL profile.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

To add an ACL rule in the ACL profile, select it (the ACL profile will toggle to the bold font), and click
the Add Rule button.

a ACCEesSsS LIS

ACL Access List

sttes Al v eopwues [ | ©AcLname
Total Entres:2

I S T T T T
StandardP Standard IP ACL Enabled
2000 ExtendIP Extended IP ACL 10 10 Disabled
[1n1] [ 1] [ lee
ExtendIP {ID: 2000) Rule Clear All Counter| | Clear Counter Add Rule

T S N S N

Figure 8-27 Extended IP ACL (Selected) Window
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After selecting the ACL profile and clicking the Add Rule button, users can configure the new ACL
rule, in the selected ACL profile, as shown below:

Add A Rle

Add ACL Rule
D 2000
ACL Name ExtendIP
ACL Type Extended IP ACL
Sequence Mo. (1-65535) l:l (Ifitisn't specified, the system automatically assigns )
Action @ Permit ' Deny
Protocol Type TCP hd l:l (0-255) Fragments
Match IP Address
@ Any @ Any
Source Destination
e [T o [T
wideard [ ] Wideard[ ]
Match Port
Source Port Please Select ~
[ Jwessm [ Jwesss
Destination Port Please Select =
[ lwosssas [ losssas
TCP Flag [Flack [[fin [Fpsh [Frst [F]syn [Furg
@ P Precedence Please Select = ToS Please Select -
- bsCe 053 —
Time Range

[ Back ][ Apply

Figure 8-28 Extended IP ACL (Add Rule) Window

This is a dynamic page. Every selection made in the Protocol Type drop-down list will change the
bottom part of this window.

The fixed fields that can be configured are described below:

Parameter Description

Sequence No. Enter the ACL rule number here. This value must be between 1
and 65535. If this value is not specified, the system will
automatically generate an ACL rule number for this entry.

Action Select the action that this rule will take here. Options to choose
from are Permit and Deny.

Protocol Type Select the protocol type option here. Options to choose from are
TCP, UDP, ICMP, EIGRP, ESP, GRE, IGMP, OSPF, PIM, VRRP,
IP-in-IP, PCP, Protocol ID, and None.
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After selecting the TCP option as the Protocol Type, the following page and parameters will be
available, as shown below:

Add A Rule
Add ACL Rule

D
ACL Name
ACL Type

Sequence No. (1-65535)

@ |P Precedence Please Select

DSCP (0-63)

Time Range

2000
ExtendIP
Extended IP ACL

l:l (Ifitisnt specified, the system automatically assigns )

Action @ Permit Deny
Protocol Type TCP hd l:l (0-255) Fragments
Match IP Address
@ Any @ Any
Source Destination
P T e ]
wideard [ ] Wideard[ ]
Match Port
Source Port Please Select ~
[ Jwessm [ Jwesss
Destination Port Please Select ~
[ lwosssas [ losssas
TCP Flag ack fin psh rst syn urg

= ToS Please Select -

I

| Back I Apply

Figure 8-29 Extended IP ACL (Add Rule) TCP Window

The dynamic fields that can be configured are described below:

Parameter ‘ Description

Source Select and enter the source information here. Options to choose
from are:
¢ Any - Any source traffic will be evaluated according to the
conditions of this rule.
¢ Host - Enter the source host’s IP address here.
e |IP - The Wildcard option will also be available. Enter the
group of source IP addresses by using a wildcard bitmap.
The bit corresponding to the bit value 1 will be ignored. The
bit corresponding to the bit value 0 will be checked.
Destination Select and enter the destination information here. Options to
choose from are:
¢ Any - Any destination traffic will be evaluated according to
the conditions of this rule.
Host - Enter the destination host’s IP address here.
IP - The Wildcard option will also be available. Enter the
group of destination IP addresses by using a wildcard
bitmap. The bit corresponding to the bit value 1 will be
ignored. The bit corresponding to the bit value 0 will be
checked.
Source Port Select and enter the source port value here. Options to choose
from are:
e =-The specific selected port number will be used.
e > - All ports greater than the selected port, will be used.
e < - All ports smaller than the selected port, will be used.
o ¥ - All ports, excluding the selected port, will be used.
[ )

Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
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Parameter ‘ Description

number(s) can manually be entered in the space(s) provided,
if the port number(s) is/are not available in the drop-down
list.

Destination Port Select and enter the destination port value here. Options to choose
from are:

= - The specific selected port number will be used.

> - All ports greater than the selected port, will be used.

< - All ports smaller than the selected port, will be used.

# - All ports, excluding the selected port, will be used.

Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s) provided,
if the port number(s) is/are not available in the drop-down
list.

TCP Flag Tick the appropriate TCP flag option to include the flag in this rule.
Options to choose from are ack, fin, psh, rst, syn, and urg.

IP Precedence Select the IP precedence value used here. Options to choose from
are 0 (routine), 1 (priority), 2, (immediate), 3 (flash), 4 (flash-
override), 5 (critical), 6 (internet), and 7 (network).

ToS After selecting the IP precedence value, select the Type-of-Service
(ToS) value that will be used here. Options to choose from are 0
(normal), 1 (min-monetary-cost), 2 (max-reliability), 3, 4 (max-
throughput), 5, 6, 7, 8 (min-delay), 9, 10, 11, 12, 13, 14, and 15.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

Time Range Enter the name of the time range to associate with this ACL rule.

After selecting the UDP option as the Protocol Type, the following page and parameters will be
available, as shown below:

Add A Rule

Add ACL Rule
|] 2000
ACL Name ExtendIP
ACL Type Extended IP ACL
Sequence No. (1-65535) I:l (IFitisnt specified, the system automatically assigns )
Action @ Permit Deny
Protocol Type UDP M l:l (0-255) Fragments
Match IP Address
@ Any @ Any
Source Destination
e [ L
Wideard [ ] Wildeard [ ]
Match Port
Source Port Please Select ~
[ Jwess3 [ Jwoesss
Destination Port Please Select =
|:|(0-55535) |:|(0-55535)
@ IP Precedence Please Select ~ ToS Please Select -
DscP 049 —

Time Range

| Back J Apply

Figure 8-30 Extended IP ACL (Add Rule) UDP Window
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The dynamic fields that can be configured are described below:

Parameter Description

Source Select and enter the source information here. Options to choose
from are:

e Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IP address here.

e [P - The Wildcard option will also be available. Enter the
group of source IP addresses by using a wildcard bitmap.
The bit corresponding to the bit value 1 will be ignored. The
bit corresponding to the bit value 0 will be checked.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

e Host - Enter the destination host’s IP address here.

e [P - The Wildcard option will also be available. Enter the
group of destination IP addresses by using a wildcard
bitmap. The bit corresponding to the bit value 1 will be
ignored. The bit corresponding to the bit value 0 will be
checked.

Source Port Select and enter the source port value here. Options to choose
from are:

= - The specific selected port number will be used.

> - All ports greater than the selected port, will be used.
< - All ports smaller than the selected port, will be used.
# - All ports, excluding the selected port, will be used.
Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s)
provided, if the port number(s) is/are not available in the
drop-down list.

Destination Port Select and enter the destination port value here. Options to choose
from are:

e =-The specific selected port number will be used.

e > - All ports greater than the selected port, will be used.

e < - All ports smaller than the selected port, will be used.

e # - All ports, excluding the selected port, will be used.

¢ Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s)
provided, if the port number(s) is/are not available in the
drop-down list.

IP Precedence Select the IP precedence value used here. Options to choose from
are 0 (routine), 1 (priority), 2, (immediate), 3 (flash), 4 (flash-
override), 5 (critical), 6 (internet), and 7 (network).

ToS After selecting the IP precedence value, select the Type-of-Service
(ToS) value that will be used here. Options to choose from are 0
(normal), 1 (min-monetary-cost), 2 (max-reliability), 3, 4 (max-
throughput), 5, 6, 7, 8 (min-delay), 9, 10, 11, 12, 13, 14, and 15.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

Time Range Enter the name of the time range to associate with this ACL rule.
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After selecting the ICMP option as the Protocol Type, the following page and parameters will be
available, as shown below:

Add A Rle

Add ACL Rule

D 2000
ACL Name ExtendIP
ACL Type Extended IP ACL
Sequence Mo (1-65535) l:l (Ifitisnt specified, the system automatically assigns.)
Action @ Permit Deny
Protocol Type ICMP hd l:l (0-255) Fragments
Match IP Address
@ Any @ Any
Source Destination
e [ e [
wideard [ ] Wideard[ ]
Match ICMP
Specify ICMP Message Type Please Select hd
ICMP Message Type (0—255)|:|Message Code (0—255)|:|
@ IP Precedence Please Select v ToS Please Select A
Dsce (083 —

Time Range

| Back J Apply

Figure 8-31 Extended IP ACL (Add Rule) ICMP Window

The dynamic fields that can be configured are described below:

Parameter Description

Source Select and enter the source information here. Options to choose
from are:

e Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IP address here.

¢ [P - The Wildcard option will also be available. Enter the
group of source IP addresses by using a wildcard bitmap.
The bit corresponding to the bit value 1 will be ignored. The
bit corresponding to the bit value 0 will be checked.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

e Host - Enter the destination host’s IP address here.

e |IP - The Wildcard option will also be available. Enter the
group of destination IP addresses by using a wildcard
bitmap. The bit corresponding to the bit value 1 will be
ignored. The bit corresponding to the bit value 0 will be
checked.

Specify ICMP Message Type |Select the ICMP message type used here.

ICMP Message Type When the ICMP message type is selected in the Specify ICMP
Message Type drop-down list, this numerical value will
automatically be entered.

When the ICMP message type is not selected in the Specify ICMP
Message Type drop-down list, enter the ICMP Message Type
numerical value used here.

Message Code When the ICMP message type is selected in the Specify ICMP
Message Type drop-down list, this numerical value will
automatically be entered.
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Parameter Description

When the ICMP message type is not selected in the Specify ICMP
Message Type drop-down list, enter the Message Code numerical
value used here.

IP Precedence Select the IP precedence value used here. Options to choose from
are 0 (routine), 1 (priority), 2, (immediate), 3 (flash), 4 (flash-
override), 5 (critical), 6 (internet), and 7 (network).

ToS After selecting the IP precedence value, select the Type-of-Service
(ToS) value that will be used here. Options to choose from are 0
(normal), 1 (min-monetary-cost), 2 (max-reliability), 3, 4 (max-
throughput), 5, 6, 7, 8 (min-delay), 9, 10, 11, 12, 13, 14, and 15.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

Time Range Enter the name of the time range to associate with this ACL rule.

After selecting the EIGRP, ESP, GRE, IGMP, OSPF, PIM, VRRP, IP-in-IP, PCP, Protocol ID, or
None option as the Protocol Type, the following page and parameters will be available, as shown
below:

Add A Rule

Add ACL Rule
[8] 2000
ACL Name ExtendIP
ACL Type Extended IP ACL
Sequence Mo. (1-65535) l:l (Ifitisnt specified, the system automatically assigns.)
Action @ Permit Deny
Protocol Type EIGRP - (0-255) Fragments
Match IP Address
@ Any @ Any
Source Destination
P [ L
Wideard [ ] Wildeard [ ]
@ IFPrecedence Please Select ~ ToS Please Select -
D80 053 —
Time Range 32 chars
| Back J Apply

Figure 8-32 Extended IP ACL (Add Rule) EIGRP Window

The dynamic fields that can be configured are described below:

Parameter Description

Fragments Select the Fragments option to include packet fragment filtering.
Source Select and enter the source information here. Options to choose
from are:

e Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IP address here.

e |IP - The Wildcard option will also be available. Enter the
group of source IP addresses by using a wildcard bitmap.
The bit corresponding to the bit value 1 will be ignored. The
bit corresponding to the bit value 0 will be checked.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.
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Parameter Description

¢ Host - Enter the destination host’s IP address here.

e |IP - The Wildcard option will also be available. Enter the
group of destination IP addresses by using a wildcard
bitmap. The bit corresponding to the bit value 1 will be
ignored. The bit corresponding to the bit value 0 will be
checked.

IP Precedence Select the IP precedence value used here. Options to choose from
are 0 (routine), 1 (priority), 2, (immediate), 3 (flash), 4 (flash-
override), 5 (critical), 6 (internet), and 7 (network).

ToS After selecting the IP precedence value, select the Type-of-Service
(ToS) value that will be used here. Options to choose from are 0
(normal), 1 (min-monetary-cost), 2 (max-reliability), 3, 4 (max-
throughput), 5, 6, 7, 8 (min-delay), 9, 10, 11, 12, 13, 14, and 15.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

Time Range Enter the name of the time range to associate with this ACL rule.

Click the Back button to discard the changes made and return to the previous page.

Click the Apply button to accept the changes made.

To enable the Counter State option or to enter a Remark for the profile, click the Edit button, next to
the specific ACL profile (found in the ACL profile table).

ACL Access List

ACL Type Al - © ID (1-14999) [ ] © aAcLName
Total Entries: 2
I e ey N T S
StandardlP  Standard IP ACL Enabled
2000 ExtendlP  Extended IP ACL [10 | [10 | Disabled  ~ o Anpiy..| [ Delete
n 1] S
ExtendIP {ID: 2000) Rule [clear ANl Counter] [ Clear Counter | [ Add Rule
m“—
Permit any any
n 4] S

Figure 8-33 Extended IP ACL (Edit ACL) Window

The fields that can be configured are described below:

Parameter Description

Start Sequence No. Enter the start sequence number here.

Step Enter the sequence number increment here.

Counter State Select to enable or disable the counter state option here.

Remark IIqEnter an optional remark that will be associated with this profile
ere.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specific entry.
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To view the list of rules, that are associated with an ACL profile, select the ACL profile (found in the
ACL profile table). The rule of ACL rules, connected to the selected ACL profile, will be displayed in
the ACL rule table, as shown below:

a ACCEesSsS LIS

ACL Access List
ACL Type Al - © 1D (1-14999) [ ] ©nacthame
Total Entries: 2 Add ACL
StandardiP Standard IP ACL Enabled [ Edt | [ Delete |
2000 ExtendIP Extended IP ACL 10 10 Enabled [ Edit || Delete |
n 7] S
ExtendIP {ID: 2000) Rule [clear ANl Counter] [ Clear Counter | [ Add Rule
“—
Permit any any (Ing: 0 packets)
n [7] S

Figure 8-34 Extended IP ACL (Rule Display) Window

Click the Delete button to remove the specific ACL rule.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

Standard IPv6 ACL

After clicking the Add ACL button, users can create a new ACL profile, as shown below:
alels s ACCESS LIS

Add ACL Access List

ACL Type | Standard IPv6 ACL ¥ |
ID (11000-12999) | |

ACL Name | |

Apply
MNote: The first character of ACL name must be a letter.

Figure 8-35 Standard IPv6 ACL (Add Profile) Window

The fields that can be configured are described below:

Parameter Description

ACL Type Select the ACL profile type here. Options to choose from are
Standard IP ACL, Extended IP ACL, Standard IPv6 ACL,
Extended IPv6 ACL, Extended MAC ACL, and Extended Expert

ACL.
ID Enter the ACL ID from 11000 to 12999.
ACL Name Enter the ACL profile’s name here. This name can be up to 32

characters long.

Click the Apply button to create the new ACL profile.
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After creating a Standard IPv6 ACL profile, the newly created Standard IPv6 ACL profile will be
displayed in the ACL profile display table, as shown below:

a ACCesSs LIS

ACL Access List

LT S —
Total Entries: 3 Add ACL
StandardiP Standard IP ACL Enabled [ Edt | [ Delete |
2000 ExtendIP Extended IP ACL 10 10 Enabled [ Edit || Delete |
11000 Standardve Standard IPv6 ACL 10 10 Disabled
mEEEEE &

Clear All Counter| | Clear Counter Add Rule

Comcato e | e wemwe | cowe

Figure 8-36 Standard IPv6 ACL (Main) Window

Click the Edit button to re-configure the specific ACL profile.
Click the Delete button to remove the specific ACL profile.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

To add an ACL rule in the ACL profile, select it (the ACL profile will toggle to the bold font), and click
the Add Rule button.

a ACCESS LIS

ACL Access List
ACL Type Al - © ID (1-14999) [ ] © AcLName Find
Total Entries: 3 A,dd ACL
StandardlP Standard IP ACL Enabled [ Edit |[ Delete |
2000 ExtendlP Extended IP ACL 10 10 Enabled [ edt |[ Delete |
11000 Standardvé Standard IPv6 ACL 10 10 Disabled
DR &
Standardvi (ID: 11000) Rule Clear All Counter| | Clear Counter Add Rule
T N S T R R

Figure 8-37 Standard IPv6 ACL (Selected) Window
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After selecting the ACL profile and clicking the Add Rule button, users can configure the new ACL
rule, in the selected ACL profile, as shown below:

Add A Rle

Add ACL Rule

D
ACL Name
ACL Type

Sequence No. (1-65535)
Action
Match IPvG Address
@ Any
Host

Source
IPvE

Time Range

11000
Standardvi
Standard IPv ACL

l:l (Ifitisnt specified, the system automatically assigns )

@ Permit

Deny

@ Any

Host

Destination
IPv&

Back | | Apply

Figure 8-38 Standard IPv6é ACL (Add Rule) Window

The fields that can be configured are described below:

Parameter Description

Sequence No.

Enter the ACL rule number here. This value must be between 1
and 65535. If this value is not specified, the system will
automatically generate an ACL rule number for this entry.

Action

Select the action that this rule will take here. Options to choose
from are Permit and Deny.

Source

Select and enter the source information here. Options to choose
from are:

¢ Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IPv6 address here.

e [Pv6 - The Prefix Length option will also be available. Enter
the source IPv6 address and prefix length value in the
spaces provided.

Destination

Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

o Host - Enter the destination host’s IPv6 address here.

o |Pv6 - The Prefix Length option will also be available. Enter
the destination IPv6 address and prefix length value in the
spaces provided.

Time Range

Enter the name of the time range to associate with this ACL rule.

Click the Back button to discard the changes made and return to the previous page.

Click the Apply button to accept the changes made.
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To enable the Counter State option or to enter a Remark for the profile, click the Edit button, next to
the specific ACL profile (found in the ACL profile table).

a ACCesSs LIS

ACL Access List
ACL Type Al M @ 1D (1-14999) L ] ©actname
Total Entries: 3 Add ACL
StandardP  Standard IP ACL Enabled [ Edt | [ Delete |
2000  ExtendlP Extended IP ACL 10 10 Enabled [ Edit || Delete |
11000 Standaravé  Standard IPv6 ACL [10 | o |  Disabled < | | | ElEmhe) [ pelete |
n Kl [ [ce
Standardvé (ID: 11000) Rule Clear All Counter] [ Clear Counter | [ Add Rule |
I S B R
Permit any any
10 [ 1| [ [ce

Figure 8-39 Standard IPv6 ACL (Edit ACL) Window

The fields that can be configured are described below:

Parameter Description

Start Sequence No. Enter the start sequence number here.

Step Enter the sequence number increment here.

Counter State Select to enable or disable the counter state option here.

Remark Enter an optional remark that will be associated with this profile
ere.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specific entry.

To view the list of rules, that are associated with an ACL profile, select the ACL profile (found in the
ACL profile table). The rule of ACL rules, connected to the selected ACL profile, will be displayed in
the ACL rule table, as shown below:

a ACCESS LIS

ACL Access List

ACL Type Al - @ ID (1-14999) [ ] ©AcLName [ZaE ] [ finaJ
Total Entries: 3 [ addact
I S g T
StandardIP Standard IP ACL Enabled [ Edit |[ Delete |
2000 ExtendlP Extended IP ACL 10 10 Enabled [ edt |[ Delete |
11000 Standardvé Standard IPv6 ACL 10 10 Enabled [ Edt | [ Delete |
11 ] S
Standardvé (ID: 11000) Rule Clear All Counter] | Clear Counter | [ Add Rule |
T S S N
Permit any any (Ing: 0 packets)

n [7] S

Figure 8-40 Standard IPv6 ACL (Rule Display) Window

Click the Delete button to remove the specific ACL rule.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

246




DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

Extended IPv6 ACL

After clicking the Add ACL button, users can create a new ACL profile, as shown below:
Rad F RCCESS LIS

Add ACL Access List

ACL Type [ Extended IPv6 ACL ¥ |
ID (13000-14999) | |

ACL Name | |

Apply
MNote: The first character of ACL name must be a letter.

Figure 8-41 Extended IPv6 ACL (Add Profile) Window

The fields that can be configured are described below:

Parameter Description

ACL Type Select the ACL profile type here. Options to choose from are
Standard IP ACL, Extended IP ACL, Standard IPv6 ACL,
Extended IPv6 ACL, Extended MAC ACL, and Extended Expert

ACL.
ID Enter the ACL ID from 13000 to 14999.
ACL Name Enter the ACL profile’s name here. This name can be up to 32

characters long.

Click the Apply button to create the new ACL profile.

After creating an Extend IPv6 ACL profile, the newly created Extend IPv6 ACL profile will be displayed
in the ACL profile display table, as shown below:

a ACCESS LIS

ACL Access List

ACL Type Al - © 1D (1-14939) [ ] ©ACLName
Total Entries: 4
0T e |t syt | Sp | Covtrie |t |
1 StandardIP Standard IP ACL 10 10 Enabled
2000 ExtendlP Extended IP ACL 10 10 Enabled
11000 Standardvé Standard IPvé ACL 10 10 Enabled
13000 Extendv Extended IPv6 ACL 10 10 Disabled
n 1] S

Clear All Cuuntg’] Clear Cuunti] [ Add Rule ]
Y T S T B R

Figure 8-42 Extended IPv6 ACL (Main) Window

Click the Edit button to re-configure the specific ACL profile.
Click the Delete button to remove the specific ACL profile.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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To add an ACL rule in the ACL profile, select it (the ACL profile will toggle to the bold font), and click
the Add Rule button.

a ACCesSs LIS

ACL Access List
ACLType Al - ©® ID (1-14999) [ ] ©aciname [2ehEE ] [ Fnd ]
Total Entries: 4
1 StandardIP Standard IP ACL 10 10 Enabled
2000 ExtendlP Extended IP ACL 10 10 Enabled
11000 Standardvé Standard IPv6 ACL 10 10 Enabled
13000 Extendve Extended IPv6 ACL 10 10 Disabled
1n [ 1| S
Extendvé (ID: 13000) Rule Clear All Counter] [ Clear Counter | [ Add Rule |
T T S T N R

Figure 8-43 Extended IPv6 ACL (Selected) Window

After selecting the ACL profile and clicking the Add Rule button, users can configure the new ACL
rule, in the selected ACL profile, as shown below:

Add A
Add ACL Rule
D 13000
ACL Name Extendvi
ACL Type Extended IPvG ACL
Sequence Mo. (1-65535) l:l (Ifitisnt specified, the system automatically assigns.)
Action @ Permit () Deny

Protocol Type TCP hd l:l (0-255) Fragments

Match IPvG Address

@ Any @ Any
™1 Host 2012:1 1 Host 2012:1
Source Destination
o P o P
Match Port
Source Port Please Select ~

[ Jossss [ Jossss
Destination Port Please Select
[ Jossss [ Jossss

TCP Flag [Flack [[fin [T psh [Frst [F]syn [Furg
DSCP (0-63) PleaseSolect  ~[ |

Flow Label (0-1048575) |:|

[ Back ][ Apply

Figure 8-44 Extended IPv6 ACL (Add Rule) Window

This is a dynamic page. Every selection made in the Protocol Type option will change the bottom
part of this window.

The fixed fields that can be configured are described below:

Parameter Description

Sequence No. Enter the ACL rule number here. This value must be between 1
and 65535. If this value is not specified, the system will
automatically generate an ACL rule number for this entry.

248




DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

Parameter Description

Action Select the action that this rule will take here. Options to choose
from are Permit and Deny.

Protocol Type Select the protocol type option here. Options to choose from are
TCP, UDP, ICMP, Protocol ID, ESP, PCP, SCTP, and None.

After selecting the TCP option as the Protocol Type, the following page and parameters will be
available, as shown below:

Add A Rule

Add ACL Rule
D 13000
ACL Name Extendvi
ACL Type Extended IPvG ACL
Sequence Mo. (1-65535) l:l (Ifitisnt specified, the system automatically assigns.)
Action @ Permit Deny
Protocol Type TCP hd l:l (0-255) Fragments
Match IPvE Address
@ Any @ Any
Host 2012:1 Host 2012:1
Source Destination
IPvG IPvE
Prefix Length l:l Prefix Length l:l
Match Port
Source Port Please Select =
[ Jwess3 [ Jwoess3
Destination Port Please Select
[ Jwoesssm [ Jwoesss
TCP Flag ack fin psh rst syn urg
DSCP (0-63) Please Select h l:l
Flow Label (0-1048575) |:|
Time Range 32 chars
| Back J Apply

Figure 8-45 Extended IPv6 ACL (Add Rule) TCP Window

The dynamic fields that can be configured are described below:

Parameter Description

Source Select and enter the source information here. Options to choose
from are:

e Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IPv6 address here.

e |IPv6 - The Prefix Length option will also be available. Enter
the source IPv6 address and prefix length value in the
spaces provided.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

e Host - Enter the destination host’s IPv6 address here.

¢ |IPv6 - The Prefix Length option will also be available. Enter
the destination IPv6 address and prefix length value in the
spaces provided.

Source Port Select and enter the source port value here. Options to choose
from are:
e = - The specific selected port number will be used.
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Parameter Description

> - All ports greater than the selected port, will be used.
< - All ports smaller than the selected port, will be used.
# - All ports, excluding the selected port, will be used.
Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s)
provided, if the port number(s) is/are not available in the
drop-down list.

Destination Port Select and enter the destination port value here. Options to choose
from are:

= - The specific selected port number will be used.

> - All ports greater than the selected port, will be used.
< - All ports smaller than the selected port, will be used.
# - All ports, excluding the selected port, will be used.
Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s)
provided, if the port number(s) is/are not available in the
drop-down list.

TCP Flag Tick the appropriate TCP flag option to include the flag in this rule.
Options to choose from are ack, fin, psh, rst, syn, and urg.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

Flow Label Enter the flow label value here. This value must be between 0 and
1048575.

Time Range Enter the name of the time range to associate with this ACL rule.

After selecting the UDP option as the Protocol Type, the following page and parameters will be
available, as shown below:

Acd A Rule

Add ACL Rule

D 13000

ACL Name Extendvi
ACL Type Extended IPv6 ACL
Sequence No. (1-65535) [ ] uritisntspecified, the system automatically assigns )
Action @ Permit Deny
Protocaol Type UpP h l:l (0-255) Fragments
Match IPvG Address
@ Any @ Any

Host

Host

Source Destination

IPvG IPvE

Match Port
Source Port Please Select ~
[ lwssss [ lwsssss
Destination Fort Please Select
[ Jeesss [ Joess
DSCP (0-63) PleaseSelect  ~[ |

Flow Label (0-1048575) 1

Time Range

| Back I Apply |

Figure 8-46 Extended IPv6 ACL (Add Rule) UDP Window
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The dynamic fields that can be configured are described below:

Parameter Description

Source Select and enter the source information here. Options to choose
from are:

e Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IPv6 address here.

e |IPv6 - The Prefix Length option will also be available. Enter
the source IPv6 address and prefix length value in the
spaces provided.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

e Host - Enter the destination host’s IPv6 address here.

¢ |IPv6 - The Prefix Length option will also be available. Enter
the destination IPv6 address and prefix length value in the
spaces provided.

Source Port Select and enter the source port value here. Options to choose
from are:

= - The specific selected port number will be used.

> - All ports greater than the selected port, will be used.
< - All ports smaller than the selected port, will be used.
# - All ports, excluding the selected port, will be used.
Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s)
provided, if the port number(s) is/are not available in the
drop-down list.

Destination Port Select and enter the destination port value here. Options to choose
from are:

= - The specific selected port number will be used.

> - All ports greater than the selected port, will be used.
< - All ports smaller than the selected port, will be used.
# - All ports, excluding the selected port, will be used.
Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s)
provided, if the port number(s) is/are not available in the
drop-down list.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

Flow Label Enter the flow label value here. This value must be between 0 and
1048575.

Time Range Enter the name of the time range to associate with this ACL rule.

251



DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

After selecting the ICMP option as the Protocol Type, the following page and parameters will be
available, as shown below:

Add A Rle

Add ACL Rule

D 13000

ACL Name Extendvi
ACL Type Extended IPvG ACL
Sequence Mo (1-65535) l:l (Ifitisnt specified, the system automatically assigns.)
Action @ Permit Deny
Protocol Type ICMP hd l:l (0-255) Fragments
Match IPvG Address
@ Any @ Any

Host Host

Source Destination

IPvE IPvG

Match ICMP
Specify ICMP Message Type Please Select -

ICMP Message Type (0-255)  |MessageCode(0-255) |

DSCP (0-63) Please Select ~| |
Flow Label (0-1048575) |:|

Time Range

| Back J Apply

Figure 8-47 Extended IPv6 ACL (Add Rule) ICMP Window

The dynamic fields that can be configured are described below:

Parameter Description

Source Select and enter the source information here. Options to choose
from are:

e Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IPv6 address here.

e |IPv6 - The Prefix Length option will also be available. Enter
the source IPv6 address and prefix length value in the
spaces provided.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

e Host - Enter the destination host’s IPv6 address here.
IPv6 - The Prefix Length option will also be available. Enter
the destination IPv6 address and prefix length value in the
spaces provided.

Specify ICMP Message Type |Select the ICMP message type used here.

ICMP Message Type When the ICMP Message Type is selected in the Specify ICMP
Message Type drop-down list, this numerical value will
automatically be entered.

When the ICMP Message Type is not selected in the Specify
ICMP Message Type drop-down list, enter the ICMP Message
Type numerical value used here.

Message Code When the ICMP Message Type is selected in the Specify ICMP
Message Type drop-down list, this numerical value will
automatically be entered.

When the ICMP Message Type is not selected in the Specify
ICMP Message Type drop-down list, enter the Message Code
numerical value used here.
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Parameter Description

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

Flow Label Enter the flow label value here. This value must be between 0 and
1048575.
Time Range Enter the name of the time range to associate with this ACL rule.

After selecting the Protocol ID, ESP, PCP, SCTP, or None option as the Protocol Type, the
following page and parameters will be available, as shown below:

Add A Rule

Add ACL Rule

D 13000

ACL Name Extendvi
ACL Type Extended IPvG ACL
Sequence Mo. (1-65535) l:l (Ifitisnt specified, the system automatically assigns.)
Action @ Permit Deny
Protocol Type Protocol ID hd l:l (0-255) Fragments
Match IPvG Address
@ Any @ Any

Host Host

Source Destination

IPvG IPvE

DSCP (0-63) Please Select h l:l

Flow Label (0-1048575) |:|

Time Range

| Back J Apply

Figure 8-48 Extended IPv6 ACL (Add Rule) Protocol ID Window

The dynamic fields that can be configured are described below:

Parameter Description

Protocol Enter the Protocol ID value used here. This value must be between
0 and 255.

Fragments Select the Fragments option to include packet fragment filtering.

Source Select and enter the source information here. Options to choose
from are:

¢ Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IPv6 address here.

e [IPv6 - The Prefix Length option will also be available. Enter
the source IPv6 address and prefix length value in the
spaces provided.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

¢ Host - Enter the destination host’s IPv6 address here.

o |Pv6 - The Prefix Length option will also be available. Enter
the destination IPv6 address and prefix length value in the
spaces provided.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.
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Parameter Description

Flow Label Enter the flow label value here. This value must be between 0 and
1048575.
Time Range Enter the name of the time range to associate with this ACL rule.

Click the Back button to discard the changes made and return to the previous page.

Click the Apply button to accept the changes made.

To enable the Counter State option or to enter a Remark for the profile, click the Edit button, next to
the specific ACL profile (found in the ACL profile table).

a ACCESS LIS

ACL Access List
ACLType Al - © ID(1-14999) [ ] ©acLName
Total Entries: 4 Add ACL
StandardP ~ Standard IP ACL Enabled [ edt |[ Delete |
2000  ExtendlP Extended IP ACL 10 10 Enabled [ Edt ][ Delete |
11000 Standardvé  Standard IPv6 ACL 10 10 Enabled
13000 Extendvé  Extended IPv6 ACL 10 | [10 || Disabled <~ || | iy [ pelete |
10 [ 1| [ [ce
Extendvé (ID: 13000) Rule Clear All Ccu_mte_r] Clear Counti] [ AddRrule
m“—
Parmit any any
1n [ Go

Figure 8-49 Extended IPv6 ACL (Counter State Enabled) Window

The fields that can be configured are described below:

Parameter Description

Start Sequence No. Enter the start sequence number here.

Stop Enter the stop sequence number here.

Counter State Select to enable or disable the counter state option here.

Remark Enter an optional remark that will be associated with this profile
ere.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specific entry.
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To view the list of rules, that are associated with an ACL profile, select the ACL profile (found in the
ACL profile table). The rule of ACL rules, connected to the selected ACL profile, will be displayed in
the ACL rule table, as shown below:

a ACCEesSsS LIS

ACL Access List
ACLType Al - © ID(1-12999) [ ] ©acLName
Total Entries: 4 Add ACL
StandardIP Standard IP ACL Enabled
2000 ExtendlP Extended IP ACL 10 10 Enablad
11000 Standardvé Standard IPv6 ACL 10 10 Enabled
13000 Extendve Extended IPv6 ACL 10 10 Enabled
n 1| S
Extendv6 (ID: 13000) Rule Clear All Counter| | Clear Counter | [ Add Rule
“—
Permit any any (Ing: 0 packets)
10 [ 1| [ [ce

Figure 8-50 Extended IPv6 ACL (Rule Display) Window

Click the Delete button to remove the specific ACL rule.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

Extended MAC ACL

After clicking the Add ACL button, users can create a new ACL profile, as shown below:
Rad P ARCCEesSs LIS

Add ACL Access List

ACL Type [ Extended MAC ACL 7|
ID (5000-7933) | |

ACL Name | |

Apply
MNote: The first character of ACL name must be a letter.

Figure 8-51 Extended MAC ACL (Add Profile) Window

The fields that can be configured are described below:

Parameter Description

ACL Type Select the ACL profile type here. Options to choose from are
Standard IP ACL, Extended IP ACL, Standard IPv6 ACL,
Extended IPv6 ACL, Extended MAC ACL, and Extended Expert

ACL.
ID Enter the ACL ID from 6000 to 7999.
ACL Name Enter the ACL profile’s name here. This name can be up to 32

characters long.

Click the Apply button to create the new ACL profile.
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After creating an Extend MAC ACL profile, the newly created Extend MAC ACL profile will be
displayed in the ACL profile display table, as shown below:

ACCesSs LIS

ACL Access List

ACL Type Al - © ID (1-14999) [ ] ©AcLname
Total Entries: 5 Add ACL
I S T T T
StandardlP Standard IP ACL Enablzd
2000 ExtendlP Extended IP ACL 10 10 Enabled
5000 ExtendMAC Extended MAC ACL 10 10 Disabled
11000 Standardvé Standard IPv6 ACL 10 10 Enabled
13000 Extendvé Extended IPv6 ACL 10 10 Enabled Edit

(] =171 K e

Clear All Counter| | Clear Counter Add Rule
oo pem | e | meme | e |

Figure 8-52 Extended MAC ACL (Main) Window

Click the Edit button to re-configure the specific ACL profile.
Click the Delete button to remove the specific ACL profile.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

To add an ACL rule in the ACL profile, select it (the ACL profile will toggle to the bold font), and click
the Add Rule button.

ACCESS LIS

ACL Access List

sottee Al - eouss [ ] ©actname
Total Entries: 5 Add ACL
StandardIP Standard IP ACL Enabled
2000 ExtendlP Extended IP ACL 10 10 Enabled
6000 ExtendMAC Extended MAC ACL 10 10 Disabled Edit
11000 Standardve Standard IPv6 ACL 10 10 Enabled
13000 Extendvé Extended IPv6 ACL 10 10 Enabled
ExtendMAC (ID: 6000) Rule Clear All Counter| | Clear Counter Add Rule

e S N A R

Figure 8-53 Extended MAC ACL (Selected) Window
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After selecting the ACL profile and clicking the Add Rule button, users can configure the new ACL
rule, in the selected ACL profile, as shown below:

Add ACL Rule
D G000
ACL Name E-MAC-ACL
ACL Type Extended MAC ACL
Sequence No. (1-65535) l:l (If it isn't specified, the system automatically assigns.)
Action (@ Pemmit () Deny
Match MAC Address
(® Any ® Any
() Host 11-DF-36-4B-A7-CC () Host 11-DF-36-4B-AT-CC
Source Destination
) MAC 11-DF-36-4B-A7-CC ) MAC 11-DF-36-4B-AT-CC
Wildcard 11-DF-36-4B-A7-CC Wildcard 11-DF-36-4B-A7-CC
Match Ethemet Type
Specify Ethemnet Type Please Select  [¥]

Ethemet Type (0x0-0xFFFF) |:|
Ethemet Type Mask (0x0-0xFFFF) |:|

CoS |Please Select [V
(® VID(1-4094) |:|

() VLAN Range [ |~

Time Range 32 chars

Back | ‘ Apply

Figure 8-54 Extended MAC ACL (Add Rule) Window

The fields that can be configured are described below:

Parameter Description

Sequence No. Enter the ACL rule number here. This value must be between 1
and 65535. If this value is not specified, the system will
automatically generate an ACL rule number for this entry.

Action Select the action that this rule will take here. Options to choose
from are Permit and Deny.

Source Select and enter the source information here. Options to choose
from are:

e Any - Any source traffic will be evaluated according to the
conditions of this rule.

¢ Host - Enter the source host's MAC address here.

e MAC - The Wildcard option will also be available. Enter the
source MAC address and wildcard value in the spaces
provided.

Destination Select and enter the destination information here. Options to
choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.

e Host - Enter the destination host’s MAC address here.

e MAC - The Wildcard option will also be available. Enter the
destination MAC address and wildcard value in the spaces
provided.

Specify Ethernet Type Select the Ethernet type option here. Options to choose from are
aarp, appletalk, decent-iv, etype-6000, etype-8042, lat, lavc-
sca, mop-console, mop-dump, vines-echo, vines-ip, xns-idp,
and arp.

Ethernet Type Enter the Ethernet type hexadecimal value here. This value must
be between 0x0 and OxFFFF. When any Ethernet type profile is
selected in the Specify Ethernet Type drop-down list, the
appropriate hexadecimal value will automatically be entered.

257




DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

Parameter Description

Ethernet Type Mask Enter the Ethernet type mask hexadecimal value here. This value
must be between 0x0 and OxFFFF. When any Ethernet type profile
is selected in the Specify Ethernet Type drop-down list, the
appropriate hexadecimal value will automatically be entered.

CoS Select the CoS value used here. This value is between 0 and 7.

VID Enter the VLAN ID that will be associated with this ACL rule here.
This value must be between 1 and 4094.

VLAN Range Enter the VLAN range here. Enter the minimum and maximum
VLAN ID in the range here.

Time Range Enter the name of the time range to associate with this ACL rule.

Click the Back button to discard the changes made and return to the previous page.

Click the Apply button to accept the changes made.

To enable the Counter State option or to enter a Remark for the profile, click the Edit button, next to
the specific ACL profile (found in the ACL profile table).

ACL Access List
ACLType Al - © ID(1-14999) [ ] ©acLname
Total Entries: 5 Add ACL
StandardlP Standard IP ACL Enabled [ Edit |[ Delete |
2000 ExtendlP Extended IP ACL 10 10 Enabled [ edt |[ Delete |
6000 ExtendMAC  Extended MAC ACL [10 | [10 |  Disabled ~ | | ErEnpid [ Delete ]
11000 Standardvé  Standard IPve ACL 10 10 Enabled
13000  Extendvé Extended IPv6 ACL 10 10 Enabled
1n [ Go
ExtendMAC (ID: 6000) Rule [clear ANl Counter] [ Clear Counter | [ Add Rule
m“—
Permit any any
1n [ Go

Figure 8-55 Extended MAC ACL (Edit ACL) Window

The fields that can be configured are described below:

Parameter Description

Start Sequence No. Enter the start sequence number here.

Stop Enter the stop sequence number here.

Counter State Select to enable or disable the counter state option here.

Remark IIqEnter an optional remark that will be associated with this profile
ere.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specific entry.
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To view the list of rules, that are associated with an ACL profile, select the ACL profile (found in the
ACL profile table). The rule of ACL rules, connected to the selected ACL profile, will be displayed in
the ACL rule table, as shown below:

a ACCEesSsS LIS

ACL Access List
ACLType Al - © ID(1-12999) [ ] ©nacthame
Total Entries: 5
1 StandardIP Standard IP ACL 10 10 Enabled
2000 ExtendlP Extended IP ACL 10 10 Enabled
6000 ExtendMAC Extended MAC ACL 10 10 Enabled
11000 Standardvé Standard IPv6 ACL 10 10 Enabled
13000 Extendvé Extended IPv6 ACL 10 10 Enabled
11 7] [ [ce
ExtendMAC (ID: 6000) Rule Clear All Counter] | Clear Counter | [ Add Rule |
Y I S T R
10 Permit any any (Ing: 0 packets)
11 7] [ [ce

Figure 8-56 Extended MAC ACL (Rule Display) Window

Click the Delete button to remove the specific ACL rule.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

Extended Expert ACL

After clicking the Add ACL button, users can create a new ACL profile, as shown below:
Rad F RCCESS LIS

Add ACL Access List

ACL Type | Extended Expert AL ¥ |
ID (8000-9999) | |
ACL Name | |

Apply
MNote: The first character of ACL name must be a letter.

Figure 8-57 Extended Expert ACL (Add Profile) Window

The fields that can be configured are described below:

Parameter Description

ACL Type Select the ACL profile type here. Options to choose from are
Standard IP ACL, Extended IP ACL, Standard IPv6 ACL,
Extended IPv6 ACL, Extended MAC ACL, and Extended Expert

ACL.
ID Enter the ACL ID from 8000 to 9999.
ACL Name Enter the ACL profile’s name here. This name can be up to 32

characters long.

Click the Apply button to create the new ACL profile.
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After creating an Expert ACL profile, the newly created Expert ACL profile will be displayed in the ACL
profile display table, as shown below:

Access Lis
ACL Access List
sottee Al - @oeassy [ ] ©actname
Total Entries: 6 Add ACL
StandardiP Standard IP ACL Enabled
2000 ExtendlP Extended IP ACL 10 10 Enabled
6000 ExtendMAC Extended MAC ACL 10 10 Enabled
8000 ExtendExpe... Extended Expert ACL 10 10 Disabled
11000 Standardvé Standard IPv ACL 10 10 Enabled Edit
13000 Extendvé Extended IPvG ACL 10 10 Enabled
CEEL EEI
Clear All Counter| [w Add Rule
I T S S N N

Figure 8-58 Extended Expert ACL (Main) Window

Click the Edit button to re-configure the specific ACL profile.
Click the Delete button to remove the specific ACL profile.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

To add an ACL rule in the ACL profile, select it (the ACL profile will toggle to the bold font), and click
the Add Rule button.

Access Lis
ACL Access List

ACL Type Al M © ID (1-14999) [ ] OACLName
Total Entries: 6

StandardIP Standard IP ACL Enabled

2000 ExtendlP Extended IP ACL 10 10 Enabled

6000 ExlendMAC Extended MAC ACL 10 10 Enabled

2000 ExtendExpe... Extended Expert ACL 10 10 Disabled

11000 Standardus Standard IPv6 ACL 10 10 Enabled Edit

13000 Extendvé Extended IPvé ACL 10 10 Enabled
(1] 1 =y

ExtendExpert (ID: 8000) Rule Clear All Counter| | Clear Counter Add Rule
T S T S B

Figure 8-59 Extended Expert ACL (Selected) Window
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After selecting the ACL profile and clicking the Add Rule button, users can configure the new ACL
rule, in the selected ACL profile, as shown below:

Add ACL Rule
1D 2000
ACL Name E-E-ACL
ACL Type Extended Expert ACL
Sequence No. (1-65535) (If it isn't specified, the system aulomatically assigns.)
Action (@) Permit (O) Deny
Protocol Type |TCP ﬂ| | | (0-255) Fragments
Match IP Address
®  Any ®  Any
) Host - - ) Host
Source O P 7 D Destination O P
Wildcard Wildcard
Match MAC Address
(@ Any Any
Host 11-DF-36-4B-A7-CC Host 11-DF-36-4B-A7-CC
SONCEE Y WA 11-DF-36-4B-A7-CC LU e 11-DF-36-48-A7-CC
Wildcard 11-DF-36-4B-A7-CC Wildcard 11-DF-36-4B-A7-CC
Match Port
Source Port Please Select |v|
Please Select [¥] | | (0-65535)| Please Select [V]| | | (0-65535)
Destination Port Please Select |v|
Please Select [v] | | (0-65535) [ Please Select [V] | | t0-65535)
@®  IP Precedence Please Select  |v| ToS Please Select [
DSCP (0-63) Please Select  [V] :l
TCP Flag [Jack [ffin [jpsh [st [Jsyn [ Jurg
®) VID(1-4094)
() VLAN Range ~| |
Time Range
Back H Apply

Figure 8-60 Extended Expert ACL (Add Rule) Window

This is a dynamic page. Every selection made in the Protocol Type option will change the bottom
part of this window.

The fixed fields that can be configured are described below:

Parameter Description

Sequence No. Enter the ACL rule number here. This value must be between 1
and 65535. If this value is not specified, the system will
automatically generate an ACL rule number for this entry.

Action Select the action that this rule will take here. Options to choose

from are Permit and Deny.

Protocol Type Select the protocol type option here. Options to choose from are
TCP, UDP, ICMP, EIGRP, ESP, GRE, IGMP, OSPF, PIM, VRRP,

IP-in-IP, PCP, Protocol ID, and None.
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After selecting the TCP option as the Protocol Type, the following page and parameters will be
available, as shown below:

Add ACL Rule
1D 2000
ACL Name E-E-ACL
ACL Type Extended Expert ACL
Sequence No. (1-65535) (If it isn't specified, the system aulomatically assigns.)
Action (@) Permit (O) Deny
Protocol Type |TCP ﬂ| | | (0-255} Fragments
Match IP Address
® Any ®  Any
Host () Host
Source O P Destination O P
Wildcard Wildcard
Match MAC Address
e  Any (®  Any
Host 11-DF-36-4B-A7-CC O Host 11-DF-36-4B-A7-CC
BN O MAC 11-DF-36-4B-A7-CC DEluatos O MAC 11-DF-36-4B-A7-CC
Wildcard 11-DF-36-4B-A7-CC Wildcard 11-DF-36-4B-A7-CC
Match Port
Source Port Please Select |v|
Please Select [¥] | | (0-65535)| Please Select [V]| | | (0-65535)
Destination Port Please Select |v|
Please Select [v] | | (0-65535) [ Please Select [V] | | t0-65535)
@®  IP Precedence Please Select  |v| ToS Please Select [
DSCP (0-63) Please Select  [V] :l
TCP Flag [Jack [ffin [jpsh [st [Jsyn [ Jurg
(@) VID(1-4094)
() VLAN Range ~| |
Time Range
| Back H Apply

Figure 8-61 Extended Expert ACL (Add Rule) TCP Window

The dynamic fields that can be configured are described below:

Parameter Description

Source IP Address Select and enter the source information here. Options to choose
from are:

Any - Any source traffic will be evaluated according to the
conditions of this rule.

Host - Enter the source host’s IP address here.

IP - The Wildcard option will also be available. Enter the
group of source IP addresses by using a wildcard bitmap.
The bit corresponding to the bit value 1 will be ignored. The
bit corresponding to the bit value 0 will be checked.

Destination IP Address Select and enter the destination information here. Options to

choose from are:

Any - Any destination traffic will be evaluated according to
the conditions of this rule.

Host - Enter the destination host’s IP address here.

IP - The Wildcard option will also be available. Enter the
group of destination IP addresses by using a wildcard
bitmap. The bit corresponding to the bit value 1 will be
ignored. The bit corresponding to the bit value 0 will be
checked.

Source MAC Address Select and enter the source information here. Options to choose

from are:

¢ Any - Any source traffic will be evaluated according to the
conditions of this rule.

Host - Enter the source host's MAC address here.

MAC - The Wildcard option will also be available. Enter the
source MAC address and wildcard value in the spaces
provided.
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Parameter Description

Destination MAC Address Select and enter the destination information here. Options to
choose from are:

¢ Any - Any destination traffic will be evaluated according to
the conditions of this rule.

¢ Host - Enter the destination host's MAC address here.

e MAC - The Wildcard option will also be available. Enter the
destination MAC address and wildcard value in the spaces
provided.

Source Port Select and enter the source port value here. Options to choose
from are:

e =-The specific selected port number will be used.

e > - All ports greater than the selected port, will be used.

e < - All ports smaller than the selected port, will be used.

o ¥ - All ports, excluding the selected port, will be used.

¢ Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s)
provided, if the port number(s) is/are not available in the
drop-down list.

Destination Port Select and enter the destination port value here. Options to choose
from are:

= - The specific selected port number will be used.

> - All ports greater than the selected port, will be used.

< - All ports smaller than the selected port, will be used.
# - All ports, excluding the selected port, will be used.
Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s)
provided, if the port number(s) is/are not available in the
drop-down list.

IP Precedence Select the IP precedence value used here. Options to choose from
are 0 (routine), 1 (priority), 2, (immediate), 3 (flash), 4 (flash-
override), 5 (critical), 6 (internet), and 7 (network).

ToS After selecting the IP precedence value, select the Type-of-Service
(ToS) value that will be used here. Options to choose from are 0
(normal), 1 (min-monetary-cost), 2 (max-reliability), 3, 4 (max-
throughput), 5, 6, 7, 8 (min-delay), 9, 10, 11, 12, 13, 14, and 15.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

TCP Flag Tick the appropriate TCP flag option to include the flag in this rule.
Options to choose from are ack, fin, psh, rst, syn, and urg.
VID Enter the VLAN ID that will be associated with this ACL rule here.

This value must be between 1 and 4094.

VLAN Range Enter the VLAN range here. Enter the minimum and maximum
VLAN ID in the range here.

CoS Select the Class of Service (CoS) value here. Options to choose
from are from 0 to 7.

Time Range Enter the name of the time range to associate with this ACL rule.
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After selecting the UDP option as the Protocol Type, the following page and parameters will be
available, as shown below:

Add ACL Rule

1D

ACL Name

ACL Type

Sequence No. (1-65535)

Action

Protocol Type

Match |P Address
® Ay
() Host
Source O P
Wildcard

Match MAC Address

3000
E-E-ACL
Extended Expert ACL
(If it isn't specified, the system aulomatically assigns.)
(@) Permit (O) Deny
|UDF’ ﬂ| | | (0-255) Fragments

®  Any

) Host

IP
Wildcard

Destination

(@ Any ®  Any
(O Host 11-DF-36-4B-A7-CC () Host 11-DF-36-4B-A7-CC
BONCEE N M 11-DF-36-4B-A7-CC Dl At~ AN AT 11-DF-36-4B-AT-CC
Wildcard 11-DF-36-4B-A7-CC Wildcard 11-DF-36-4B-A7-CC
Match Port
Source Port Please Select | v|
Please Select [¥] | | (0-65535)| Please Select [V] | | (0-65535)
Destination Port Please Select |v|
Please Select [V] | | (0-65535)| Please Select [V] | | t0-65538)
(O] IP Precedence Please Select v ToS Please Select ﬂ
DSCP (0-63) Please Select  |Vv] :l

(@) VID(1-4094)

(C) VLAN Range

CoS |Please Select | v|

Time Range

| Back | ‘ Apply

Figure 8-62 Extended Expert ACL (Add Rule) UDP Window

The dynamic fields that can be configured are described below:

Parameter Description

Source IP Address

Select and enter the source information here. Options to choose
from are:

¢ Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host’s IP address here.

e |IP - The Wildcard option will also be available. Enter the
group of source IP addresses by using a wildcard bitmap.
The bit corresponding to the bit value 1 will be ignored. The
bit corresponding to the bit value 0 will be checked.

Destination IP Address Select and enter the destination information here. Options to

choose from are:

e Any - Any destination traffic will be evaluated according to
the conditions of this rule.
Host - Enter the destination host’s IP address here.
IP - The Wildcard option will also be available. Enter the
group of destination IP addresses by using a wildcard
bitmap. The bit corresponding to the bit value 1 will be
ignored. The bit corresponding to the bit value 0 will be
checked.

Source MAC Address Select and enter the source information here. Options to choose

from are:

¢ Any - Any source traffic will be evaluated according to the
conditions of this rule.

o Host - Enter the source host's MAC address here.

e MAC - The Wildcard option will also be available. Enter the
source MAC address and wildcard value in the spaces
provided.
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Parameter Description

Destination MAC Address Select and enter the destination information here. Options to
choose from are:

¢ Any - Any destination traffic will be evaluated according to
the conditions of this rule.

¢ Host - Enter the destination host's MAC address here.

e MAC - The Wildcard option will also be available. Enter the
destination MAC address and wildcard value in the spaces
provided.

Source Port Select and enter the source port value here. Options to choose
from are:

e =-The specific selected port number will be used.

e > - All ports greater than the selected port, will be used.

e < - All ports smaller than the selected port, will be used.

o ¥ - All ports, excluding the selected port, will be used.

¢ Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s)
provided, if the port number(s) is/are not available in the
drop-down list.

Destination Port Select and enter the destination port value here. Options to choose
from are:

= - The specific selected port number will be used.

> - All ports greater than the selected port, will be used.

< - All ports smaller than the selected port, will be used.
# - All ports, excluding the selected port, will be used.
Range - The start port number and end port number
selected, of the range, will be used. Alternatively, the port
number(s) can manually be entered in the space(s)
provided, if the port number(s) is/are not available in the
drop-down list.

IP Precedence Select the IP precedence value used here. Options to choose from
are 0 (routine), 1 (priority), 2, (immediate), 3 (flash), 4 (flash-
override), 5 (critical), 6 (internet), and 7 (network).

ToS After selecting the IP precedence value, select the Type-of-Service
(ToS) value that will be used here. Options to choose from are 0
(normal), 1 (min-monetary-cost), 2 (max-reliability), 3, 4 (max-
throughput), 5, 6, 7, 8 (min-delay), 9, 10, 11, 12, 13, 14, and 15.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.
VID Enter the VLAN ID that will be associated with this ACL rule here.

This value must be between 1 and 4094.

VLAN Range Enter the VLAN range here. Enter the minimum and maximum
VLAN ID in the range here.

CoS Select the Class of Service (CoS) value here. Options to choose
from are from 0 to 7.

Time Range Enter the name of the time range to associate with this ACL rule.
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After selecting the ICMP option as the Protocol Type, the following page and parameters will be
available, as shown below:

Add ACL Rule
1D 8000
ACL Name E-E-ACL
ACL Type Extended Expert ACL
Sequence No. (1-65535) l:l (If it isn't specified, the system aulomatically assigns.)
Action (@) Permit (O) Deny
Protocol Type |ICIVIP ﬂ| | | (0-255} Fragments
Match IP Address
®  Any ®  Any
() Host . . () Host
Source O P 7 D Destination O P
‘Wildcard - - Wildcard
Match MAC Address
(@ Any ®  Any
() Host 11-DF-36-4B-AT-CC () Host 11-DF-36-4B-A7-CC
BONCEE N M 11-DF-36-4B-A7-CC Dl At~ AN AT 11-DF-36-4B-A7-CC
Wildcard 11-DF-36-4B-A7-CC Wildcard 11-DF-36-4B-A7-CC
Match ICMP
Specify ICMP Message Type| Please Select ﬂ|
ICMP Message Type (0-255) Message Code (0255 |
@  IP Precedence Please Select ~ ToS Please Select [V
()  DSCP (0-63) Please Select | V|
(@) VID(1-4094)
() VLAN Range -
Cos
| Back H Apply

Figure 8-63 Extended Expert ACL (Add Rule) ICMP Window

The dynamic fields that can be configured are described below:

Parameter Description

Source IP Address Select and enter the source information here. Options to choose
from are:

¢ Any - Any source traffic will be evaluated according to the
conditions of this rule.

¢ Host - Enter the source host’s IP address here.

e |IP - The Wildcard option will also be available. Enter the
group of source IP addresses by using a wildcard bitmap.
The bit corresponding to the bit value 1 will be ignored. The
bit corresponding to the bit value 0 will be checked.

Destination IP Address Select and enter the destination information here. Options to
choose from are:

¢ Any - Any destination traffic will be evaluated according to
the conditions of this rule.
Host - Enter the destination host’s IP address here.
IP - The Wildcard option will also be available. Enter the
group of destination IP addresses by using a wildcard
bitmap. The bit corresponding to the bit value 1 will be
ignored. The bit corresponding to the bit value 0 will be
checked.

Source MAC Address Select and enter the source information here. Options to choose
from are:

¢ Any - Any source traffic will be evaluated according to the
conditions of this rule.

e Host - Enter the source host's MAC address here.

e MAC - The Wildcard option will also be available. Enter the
source MAC address and wildcard value in the spaces
provided.
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Parameter Description

Destination MAC Address Select and enter the destination information here. Options to
choose from are:

¢ Any - Any destination traffic will be evaluated according to
the conditions of this rule.

¢ Host - Enter the destination host's MAC address here.

e MAC - The Wildcard option will also be available. Enter the
destination MAC address and wildcard value in the spaces
provided.

Specify ICMP Message Type |Select the ICMP message type used here.

ICMP Message Type When the ICMP Message Type is selected in the Specify ICMP
Message Type drop-down list, this numerical value will
automatically be entered.

When the ICMP Message Type is not selected in the Specify

ICMP Message Type drop-down list, enter the ICMP Message
Type numerical value used here.

Message Code When the ICMP Message Type is selected in the Specify ICMP
Message Type drop-down list, this numerical value will
automatically be entered.

When the ICMP Message Type is not selected in the Specify
ICMP Message Type drop-down list, enter the Message Code
numerical value used here.

IP Precedence Select the IP precedence value used here. Options to choose from
are 0 (routine), 1 (priority), 2, (immediate), 3 (flash), 4 (flash-
override), 5 (critical), 6 (internet), and 7 (network).

ToS After selecting the IP precedence value, select the Type-of-Service
(ToS) value that will be used here. Options to choose from are 0
(normal), 1 (min-monetary-cost), 2 (max-reliability), 3, 4 (max-
throughput), 5, 6, 7, 8 (min-delay), 9, 10, 11, 12, 13, 14, and 15.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

VID Enter the VLAN ID that will be associated with this ACL rule here.
This value must be between 1 and 4094.

VLAN Range Enter the VLAN range here. Enter the minimum and maximum
VLAN ID in the range here.

CoS Select the Class of Service (CoS) value here. Options to choose

from are from 0 to 7.

Time Range Enter the name of the time range to associate with this ACL rule.
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After selecting the EIGRP, ESP, GRE, IGMP, OSPF, PIM, VRRP, IP-in-IP, PCP, Protocol ID, or
None option as the Protocol Type, the following page and parameters will be available, as shown
below:

Add ACL Rule
1D 2000
ACL Name E-E-ACL
ACL Type Extended Expert ACL
Sequence No. (1-65535) [ ] uritisnt specified, the system automatically assigns )
Action (@) Permit (7) Deny
Protocol Type |E\GRP ﬂ| |SB | (0-255) [ Fragments
Match IP Address
@ Any ® Ay
) Host () Host
Source O P 7 ; Destination O P
Wildcard - - Wildcard
Maich MAC Address
(@ Any (® Any
(0 Host 11-DF-36-4B-A7-CC () Host 11-DF-36-4B-A7-CC
B gl e 11-DF-364B-A7-CC Bl & 11-DF-36-4B-A7-CC
Wildcard 11-DF-36-4B-A7T-CC Wildcard 11-DF-36-4B-A7-CC
@® P Precedence Please Select  |v| ToS Please Select [+
DSCP (0-63) Please Select [v|
@) VID(1-4094)
() VLAN Range -
CoS |Please Select  [v]
| Back H Apply

Figure 8-64 Extended Expert ACL (Add Rule) EIGRP Window

The dynamic fields that can be configured are described below:

Parameter Description

Fragments Select the Fragments option to include packet fragment filtering.
Source IP Address Select and enter the source information here. Options to choose
from are:

¢ Any - Any source traffic will be evaluated according to the
conditions of this rule.

¢ Host - Enter the source host’s IP address here.

o [P - The Wildcard option will also be available. Enter the
group of source IP addresses by using a wildcard bitmap.
The bit corresponding to the bit value 1 will be ignored. The
bit corresponding to the bit value 0 will be checked.

Destination IP Address Select and enter the destination information here. Options to
choose from are:

¢ Any - Any destination traffic will be evaluated according to
the conditions of this rule.

¢ Host - Enter the destination host’s IP address here.

e |IP - The Wildcard option will also be available. Enter the
group of destination IP addresses by using a wildcard
bitmap. The bit corresponding to the bit value 1 will be
ignored. The bit corresponding to the bit value 0 will be
checked.

Source MAC Address Select and enter the source information here. Options to choose
from are:

¢ Any - Any source traffic will be evaluated according to the
conditions of this rule.
Host - Enter the source host’'s MAC address here.
MAC - The Wildcard option will also be available. Enter the
source MAC address and wildcard value in the spaces
provided.
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Parameter Description

Destination MAC Address Select and enter the destination information here. Options to
choose from are:

¢ Any - Any destination traffic will be evaluated according to
the conditions of this rule.

o Host - Enter the destination host’s MAC address here.

e MAC - The Wildcard option will also be available. Enter the
destination MAC address and wildcard value in the spaces
provided.

IP Precedence Select the IP precedence value used here. Options to choose from
are 0 (routine), 1 (priority), 2, (immediate), 3 (flash), 4 (flash-
override), 5 (critical), 6 (internet), and 7 (network).

ToS After selecting the IP precedence value, select the Type-of-Service
(ToS) value that will be used here. Options to choose from are 0
(normal), 1 (min-monetary-cost), 2 (max-reliability), 3, 4 (max-
throughput), 5, 6, 7, 8 (min-delay), 9, 10, 11, 12, 13, 14, and 15.

DSCP Select or enter the DSCP value used here. This value must be
between 0 and 63.

VID Enter the VLAN ID that will be associated with this ACL rule here.
This value must be between 1 and 4094.

VLAN Range Enter the VLAN range here. Enter the minimum and maximum
VLAN ID in the range here.

CoS Select the Class of Service (CoS) value here. Options to choose

from are from 0 to 7.

Time Range Enter the name of the time range to associate with this ACL rule.

Click the Back button to discard the changes made and return to the previous page.

Click the Apply button to accept the changes made.

To enable the Counter State option or to enter a Remark for the profile, click the Edit button, next to
the specific ACL profile (found in the ACL profile table).

ACL Access List
ACL Type Al - © ID(1-14999) [ ] OAcLName
Total Entries: 6 Add ACL
StandardIP Standard IP ACL Enabled
2000  ExtendlP Extended IP AGL 10 10 Enabled
5000  ExtendWAC Extended MAC ACL 10 10 Enabled
2000 ExtendExpe.. Extended Expert ACL 10 | [10 Disabled  ~ P EAsny.] [ Delete |
11000 Standardvé Standard IPvG ACL 10 10 Enabled
13000  Extenave Extended PV ACL 10 10 Enabled m%
7 4] S
ExtendExpert (ID: 8000) Rule Clear All Counter| [ Clear Counter | [ Add Rule
m“—
Permit any any any any
10 [ 1| [ [ce

Figure 8-65 Extended Expert ACL (Edit ACL) Window

The fields that can be configured are described below:

Parameter Description

Start Sequence No. Enter the start sequence number here.

269



DGS-1510 Series Gigabit Ethernet SmartPro Switch Web Ul Reference Guide

Parameter Description

Stop Enter the stop sequence number here.

Counter State Select to enable or disable the counter state option here.

Remark Enter an optional remark that will be associated with this profile
here.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specific entry.

To view the list of rules, that are associated with an ACL profile, select the ACL profile (found in the
ACL profile table). The rule of ACL rules, connected to the selected ACL profile, will be displayed in
the ACL rule table, as shown below:

a ACCESS LIS

ACL Access List
ACL Type Al - © ID (1-14999) [ ] © AcLName
Total Entries: 6
I T ™ S Ty ey ey e
1 StandardiP Standard IP ACL 10 10 Enabled
2000 ExtendlP Extended IP ACL 10 10 Enabled
6000 ExtendMAC Extended MAC ACL 10 10 Enabled
2000 ExtendExpe... Extended Expert ACL 10 10 Enabled
11000 Standarave Standard IPve ACL 10 10 Enabled
13000 Extendvé Extended IPv6 ACL 10 10 Enabled
n [7] [ [es
ExtendExpert (ID: 8000) Rule Clear All Counter] [ Clear Counter | [ Add Rule |
T S T R R
10 Permit any any any any (Ing: 0 packets)
n [7] [ [es

Figure 8-66 Extended Expert ACL (Rule Display) Window

Click the Delete button to remove the specific ACL rule.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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ACL Interface Access Group

This window is used to view and configure the ACL interface access group settings.

To view the following window, click ACL > ACL Interface Access Group, as shown below:

ACL Interface Access Group

Unit From Port To Port Direction Action Type ACL Name
[ [ [ethton [=] [ethtoii [=] [in [=] [Add [=] lpact  [-] | |[ Please select |
Unit 1 Settings

IPACL IPvé ACL MAC ACL Expert ACL

eth1/0/1
eth1/0/2
eth1/0/3
eth1/0/4
eth1/0/5
eth1/0/6
eth1/0/7
eth1/0/8
eth1/0/9
eth1/0/10
eth1/0/11
eth1/0M12
eth1/0/13
ein1/0/14
eth1/0/15

m

Figure 8-67 ACL Interface Access Group Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

Direction Select the direction here. Option to choose from is In.

Action Select the action that will be taken here. Options to choose from
are Add and Delete.

Type Select the ACL type here. Options to choose from are IP ACL,
IPvé ACL, MAC ACL, and Expert ACL.

ACL Name Enter the ACL profile’s name here. This name can be up to 32

characters long.

Click the Please Select button to choose the ACL profile that has been created.

Click the Apply button to accept the changes made.
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ACL VLAN Access Map

This window is used to view and configure the ACL VLAN access map settings.

To view the following window, click ACL > ACL VLAN Access Map, as shown below:

ACL VLAN Access Map

Sub Map Number {1-65535) [ ]

Adion
Access Map Name Courter stae Disabled __[7]
Access Map Name [ Clear &Il Counter | [ Clear Counter | [ Find ]
Total Entries: 1

Access Map Name Sub Map Number m Match Access-List Counter State
AccessMap e Forward Disabled
1N i

Figure 8-68 ACL VLAN Access Map Window

The fields that can be configured are described below:

Parameter Description

Access Map Name Enter the access map’s name here. This name can be up to 32
characters long.

Sub Map Number Enter the sub-map’s number here. This value must be between 1
and 65535.
Action Select the action that will be taken here. Options to choose from

are Forward, Drop, and Redirect. When the Redirect option is
selected, select the redirected interface from the drop-down list.

Counter State Select whether to enable or disable the counter state.

Click the Apply button to accept the changes made for each individual section.

Click the Clear All Counter button to clear the counter information for all the access maps.

Click the Clear Counter button to the clear the counter information for the specified access map.
Click the Find button to locate a specific entry based on the information entered.

Click the Binding button to configure a new match access list.

Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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After clicking the Binding button, the following page will appear.

Match Access-List

Access Map Name Access-Map
Sub Map Mumber 1

# Match IP Access-List

Flease Select Apphy Delete

Match IPvG Access-List

Flease Select Apply I Delete I

Match MAC Access-List

Please Select Apply | Delete |

Figure 8-69 Match Access-List Window

The fields that can be configured are described below:

Parameter Description

Match IP Access-List Select the standard or extended IP ACL.
Match IPv6 Access-List Select the standard or extended IPv6 ACL.
Match MAC Access-List Select the standard or extended MAC ACL.

Click the Please Select button to choose the ACL profile that has been created.
Click the Apply button to accept the changes made for each individual section.

Click the Delete button to remove the specified entry.

ACL VLAN Filter

This window is used to view and configure the ACL VLAN filter settings.

To view the following window, click ACL > ACL VLAN Filter, as shown below:

ACL VLAN Filter

Access Map Name
Action Add ]

Total Entries: 1

AccessMap 1
n [ &

Figure 8-70 ACL VLAN Filter Window

The fields that can be configured are described below:

Parameter Description

Access Map Name Enter the access map’s name here. This name can be up to 32
characters long.
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Parameter Description

Action Select the action that will be taken here. Options to choose from
are Add and Delete.

VID List Enter the VLAN ID list that will be used here. Select the All VLANs
option to apply this configuration to all the VLANs configured on
this switch.

Click the Apply button to accept the changes made.
Click the Delete button to remove the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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9. Security

Port Security

802.1X

AAA

RADIUS

TACACS+

IMPB

DHCP Server Screening

ARP Spoofing Prevention
BPDU Attack Protection

MAC Authentication
Web-based Access Control
Japanese Web-based Access Control
Network Access Authentication
Safeguard Engine

Trusted Host

Traffic Segmentation Settings
Storm Control Settings

DoS Attack Prevention Settings
SSH

SSL

Network Protocol Port Protection Settings

Port Security

Port Security Global Settings

This window is used to view and configure the port security global settings. Port Security is a security
feature that prevents unauthorized computers (with source MAC addresses) unknown to the Switch
prior to locking the port (or ports) from connecting to the Switch's locked ports and gaining access to
the network.

To view the following window, click Security > Port Security > Port Security Global Settings, as
shown below:

Port Security Trap Settings

Trap State Enabled (@ Disabled
Port Security Trap Rate Settings

Trap Rate (0-1000) b
Port Security System Settings

System Maximum Address (1-6656) [ | =Noumt

Figure 9-1 Port Security Global Settings Window

The fields that can be configured for Port Security Trap Settings are described below:

Parameter Description

Trap State Click to enable or disable port security traps on the Switch.

Click the Apply button to accept the changes made.
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The fields that can be configured for Port Security Trap Rate Settings are described below:

Parameter

Trap Rate

Description

Enter the number of traps per second. The range is from 0 to 1000.
The default value 0 indicates an SNMP trap to be generated for
every security violation.

Click the Apply button to accept the changes made.

The fields that can be configured for Port Security System Settings are described below:

Parameter

Description

System Maximum Address

Enter the maximum number of secure MAC addresses allowed. If
not specified, the default value is No Limit. The valid range is from
1 to 6656. Tick the No Limit checkbox to allow the maximum
number of secure MAC address.

Click the Apply button to accept the changes made.

Port Security Port Settings

This window is used to view and configure the port security port settings.

To view the following window, click Security > Port Security > Port Security Port Settings, as

shown below:

Port Security Port Settings

Maximum Aging

Unit  From Port To Port State (0-6656) Violation Action Security Mode Time (0-1440) Aging Type

[1 [v][eth1/0/1 [v][eth1/0/1 [v][Disabled |2 |[Protect ][ Delete-on-Timeot ]| || Absolute ]

Unit 1 Settings

o | Caronite. | Voatoncton| VeltonCount | _Souty ods | i S | ont St | Agg T | g e

eth1/0/1 3z 1] Protect - Delete-on-Timeout Disabled - 0 Absolute
eth1/0/2 32 1] Protect = Delete-on-Timeout Disabled 0 Absolute
eth1/0/3 32 1] Protect = Delete-on-Timeout Disabled 0 Absolute
eth1/0/4 32 0 Protect = Delete-on-Timeout Disabled 0 Absolute
eth1/0/5 32 0 Protect = Delete-on-Timeout Disabled 0 Absolute
eth1/0/6 32 1] Protect = Delete-on-Timeout Disabled 1] Absolute
eth1/0/7 32 0 Protect = Delete-on-Timeout Disabled 0 Absolute
eth1/0/8 32 1] Protect = Delete-on-Timeout Disabled 1] Absolute

Figure 9-2 Port Security Port Settings Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

State Select to enable or disable the port security feature on the port(s)
specified.

Maximum Enter the maximum number of secure MAC addresses that will be

allowed on the port(s) specified. This value must be between 0 and
6656. By default, this value is 32.

Violation Action

Select the violation action that will be taken here. Options to
choose from are:
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Parameter Description

e Protect - Specifies to drop all packets from the insecure
hosts at the port-security process level, but does not
increment the security-violation count.

e Restrict - Specifies to drop all packets from the insecure
hosts at the port-security process level and increments the
security-violation count and record the system log.

e Shutdown - Specifies to shut down the port if there is a
security violation and record the system log.

Security Mode Select the security mode option here. Options to choose from are:

¢ Permanent - Specifies that all learned MAC addresses are
not be purged out unless the user manually deletes those
entries.

¢ Delete-on-Timeout - Specifies that all learned MAC
addresses are purged out when an entry is aged out or when
the user manually deletes these entries.

Aging Time Enter the aging time value used for auto-learned dynamic secured
addresses on the specified port here. This value must be between
0 and 1440 minutes.

Aging Type Select the aging type here. Options to choose from are:

o Absolute - Specifies that all the secure addresses on this
port age out exactly after the time specified and is removed
from the secure address list. This is the default type.

¢ Inactivity - Specifies that the secure addresses on this port
age out only if there is no data traffic from the secure source
address for the specified time period.

Click the Apply button to accept the changes made.

Port Security Address Entries

This window is used to view, clear, and configure the port security address entries.

To view the following window, click Security > Port Security > Port Security Address Entries, as
shown below:

D yecu v Address

Port Security Address Entries

Unit Port MAC Address VID (1-4094)
[7] Permanent l:l
I Add ] l Delete J l Clear by Port ] l Clear by MAC ]
Total Entries: 1
e T s e e i e
eth1/0/1 1 00-84-57-00-00-00 Permanent =

n 1] [ Teo

Figure 9-3 Port Security Address Entries Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
Port Select the port used for the configuration here.
MAC Address Enter the MAC address here. Tick the Permanent check box so

that all learned MAC addresses would not be purged out unless the
user manually deletes those entries.
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Parameter
VID

Description
Enter the VLAN ID here. This value must be between 1 and 4094.

Click the Add button to add a new entry based on the information entered.

Click the Delete button to remove a new entry based on the information entered.

Click the Clear by Port button to clear the information based on the port selected.

Click the Clear by MAC button to clear the information based on the MAC address entered.
Click the Clear All button to clear all the information in this table.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

802.1X

802.1X (Port-based and Host-based Access Control)

The IEEE 802.1X standard is a security measure for authorizing and authenticating users to gain
access to various wired or wireless devices on a specified Local Area Network by using a Client and
Server based access control model. This is accomplished by using a RADIUS server to authenticate
users trying to access a network by relaying Extensible Authentication Protocol over LAN (EAPOL)
packets between the Client and the Server.

The following figure represents a basic EAPOL packet:

Ethernet Frame
Destination & Type CRC
(0150C2-000003) AR (66-5E) s e
- £ g ‘:'
5
- = I\'\
- A I\
) : \\
- _-‘-_-— \I
Prmuc?tz:ﬁemn Packet Typs Palc;ftm'x:]oﬂv Packet Body 5
EAPOL packet

Figure 9-4 The EAPOL Packet

Utilizing this method, unauthorized devices are restricted from connecting to a LAN through a port to
which the user is connected. EAPOL packets are the only traffic that can be transmitted through the
specific port until authorization is granted. The 802.1X access control method has three roles, each of
which are vital to creating and up keeping a stable and working Access Control security method.

Wireless PC Card, efc.

Ethernet Switch, etc.

EAP Ower LAN Encapsulated EAP
EAP Over Wireless Messages, typically
(802 3 or BO2.11) iR o

“Authentication
“Client” “ Authenticator” Server”
NIC Card Metwork Port AAA Server
Ethermet802.3. [ Access Point, Any EAF Server,

Mostly RADIUS

Figure 9-5 The three roles of 802.1X
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The following section will explain the three roles of Client, Authenticator, and Authentication Server in
greater detail.

Authentication Server

The Authentication Server is a remote device that is connected to the same network as the Client and
Authenticator, must be running a RADIUS Server program and must be configured properly on the
Authenticator (Switch). Clients connected to a port on the Switch must be authenticated by the
Authentication Server (RADIUS) before attaining any services offered by the Switch on the LAN. The
role of the Authentication Server is to certify the identity of the Client attempting to access the network
by exchanging secure information between the RADIUS server and the Client through EAPOL

packets and, in turn, informs the Switch whether or not the Client is granted access to the LAN and/or
switches services.

Authentication Server

pue SRR PR IR
& L e

1 |

L ;JT =1 I Wi

Client Client Client Client

Switch

Figure 9-6 The Authentication Server

Authenticator

The Authenticator (the Switch) is an intermediary between the Authentication Server and the Client.
The Authenticator serves two purposes when utilizing the 802.1X function. The first purpose is to
request certification information from the Client through EAPOL packets, which is the only information
allowed to pass through the Authenticator before access is granted to the Client. The second purpose
of the Authenticator is to verify the information gathered from the Client with the Authentication
Server, and to then relay that information back to the Client.

= —
Qa ' Switch

{Authenticator)

RADIUS Server
Workstation {Authentication Server)

{Client)

Figure 9-7 The Authenticator

Three steps must be implemented on the Switch to properly configure the Authenticator.

e The 802.1X state must be enabled. (Security > 802.1X > 802.1X Global Settings)
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o The 802.1X settings must be implemented by port (Security > 802.1X > 802.1X Port Settings)

o A RADIUS server must be configured on the Switch. (Security > RADIUS > RADIUS Server
Settings)

Client

The Client is simply the end station that wishes to gain access to the LAN or switch services. All end
stations must be running software that is compliant with the 802.1X protocol. For users running
windows XP and windows Vista, that software is included within the operating system. All other users
are required to attain 802.1X client software from an outside source. The Client will request access to
the LAN and or Switch through EAPOL packets and, in turn will respond to requests from the Switch.

Switch
{Authenticator)

RADIUS Server

{Authentication Server)

Workstation
(Client)

Figure 9-8 The Client

Authentication Process

Utilizing the three roles stated above, the 802.1X protocol provides a stable and secure way of
authorizing and authenticating users attempting to access the network. Only EAPOL traffic is allowed
to pass through the specified port before a successful authentication is made. This port is “locked”
until the point when a Client with the correct username and password (and MAC address if 802.1X is
enabled by MAC address) is granted access and therefore successfully “unlocks” the port. Once the
port is unlocked, normal traffic is allowed to pass through the port. The following figure displays a
detailed explanation of how the authentication process is completed between the three roles stated
above.

802.1X Authentication process
. Swritch RADIUS Server
Workstation . {Authentication Server)
{Client) (Authenticator)
Bl -
EAPOL-Start
- -
EAP-Request/ Identity
_.;
EAP-Response; Identity RADIUS Access-Request
;" L ail
EAP-Request/OTP RADIUS Access-Challenge
-~ -t
EAP-Response/0TP RADIUS Access-Request
L -
EAP-SuCCess RADIUS Access-Accept
-t -t
Port Authorized
EAPOL-Logoff RADIUS Account-Stop
ol -
RADIUS Ack
i}
Port Unauthorized * OTP {(One-Time-Pasgsword)

Figure 9-9 The 802.1X Authentication Process
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The D-Link implementation of 802.1X allows network administrators to choose between two types of
Access Control used on the Switch, which are:

o Port-based Access Control - This method requires only one user to be authenticated per port
by a remote RADIUS server to allow the remaining users on the same port access to the
network.

o Host-based Access Control - Using this method, the Switch will automatically learn up to a
maximum of 448 MAC addresses by port and set them in a list. Each MAC address must be
authenticated by the Switch using a remote RADIUS server before being allowed access to the
Network.

Understanding 802.1X Port-based and Host-based Network Access Control

The original intent behind the development of 802.1X was to leverage the characteristics of point-to-
point in LANs. As any single LAN segment in such infrastructures has no more than two devices
attached to it, one of which is a Bridge Port. The Bridge Port detects events that indicate the
attachment of an active device at the remote end of the link, or an active device becoming inactive.
These events can be used to control the authorization state of the Port and initiate the process of
authenticating the attached device if the Port is unauthorized. This is the Port-based Network Access
Control.

Port-based Network Access Control

Once the connected device has successfully been authenticated, the Port then becomes Authorized,
and all subsequent traffic on the Port is not subject to access control restriction until an event occurs
that causes the Port to become Unauthorized. Hence, if the Port is actually connected to a shared
media LAN segment with more than one attached device, successfully authenticating one of the
attached devices effectively provides access to the LAN for all devices on the shared segment.
Clearly, the security offered in this situation is open to attack.

—

RADIUS
Server
Ethernet Switch
‘ql.ll! ql-lIF [==p==p =] --*I:I‘
802.1X 8021X  8021X  B021X 802.1X% 802.1X  802.1X  802.1X 802.1X
Client Client Client Client Client Client Client Client Client

= Network access controlled port

= Network access uncontrolled port

Figure 9-10 Example of Typical Port-based Configuration

Host-based Network Access Control

In order to successfully make use of 802.1X in a shared media LAN segment, it would be necessary
to create “logical” Ports, one for each attached device that required access to the LAN. The Switch
would regard the single physical Port connecting it to the shared media segment as consisting of a
number of distinct logical Ports, each logical Port being independently controlled from the point of
view of EAPOL exchanges and authorization state. The Switch learns each attached devices’
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individual MAC addresses, and effectively creates a logical Port that the attached device can then use
to communicate with the LAN via the Switch.

i

RADIUS
Server

Ethemet Switch

OO DDDOD Do@EE --IIEI‘

F— V¥ W W ¥ W W ¥ W N - == =
802.1X 8021X  802.IX 802.1X  8021X  8021X 802.1X  8021X  802.1X 8021X  8021X  802.IX
Client  Client Client Client  Client Client Client  Client  Client Client  Client Client

= Network access controlled port

= Network access uncontrolled port

Figure 9-11 Example of Typical Host-based Configuration

802.1X Global Settings

This window is used to view and configure the 802.1X global settings.

To view the following window, click Security > 802.1X > 802.1X Global Settings, as shown below:

802.1X Global Settings

302.1X State Disabled| v
802 1X Trap State Disabled[¥]

Figure 9-12 802.1X Global Settings Window

The fields that can be configured are described below:

Parameter Description

802.1X State Select to enable or disable the 802.1X global state here.
802.1X Trap State Select to enable or disable the 802.1X trap state here.

Click the Apply button to accept the changes made.
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802.1X Port Settings

This window is used to view and configure the 802.1X port settings.

To view the following window, click Security > 802.1X > 802.1X Port Settings, as shown below:

80 0 yettings

802.1X Port Settings

Unit From Port To Port Direction

Port Control Forward PDU MaxReq (1-10) PAE Authenticator

E umes

ServerTimeout (1-65535) SuppTimeout (1-65535) TX Period (1-65535)

Unit 1 Settings
eth1/0/1 Both Auto Disabled 2 MNone 30 30 30
eth1/0/2 Both Auto Disabled 2 Mone 30 30 30
eth1/0/3 Both Auto Disabled 2 None 30 30 30
eth1/0/4 Both Auto Disabled 2 MNone 30 30 30
eth1/0/5 Both Auto Disabled 2 Mone 30 30 30
eth1/0/6 Both Auto Disabled 2 None 30 30 30
eth1/0/7 Both Auto Disabled 2 Mone 30 30 30
eth1/0/8 Both Auto Disabled 2 None 30 30 30
eth1/0/9 Both Auto Disabled 2 None 30 30 30
eth1/0/10 Both Auto Disabled 2 Mone 30 30 30
eth1/0/11 Both Auto Disabled 2 None 30 30 30
eth1/0/12 Both Auto Disabled 2 Mone 30 30 30
eth1/0/13 Both Auto Disabled 2 None 30 30 30
eth1/0/14 Both Auto Disabled 2 MNone 30 30 30
eth1/0/15 Both Auto Disabled 2 Mone 30 30 30
eth1/0/16 Both Auto Disabled 2 None 30 30 30
eth1/0/17 Both Auto Disabled 2 Mone 30 30 30
eth1/0/18 Both Auto Disabled 2 Mone 30 30 30
eth1/0/19 Both Auto Disabled 2 MNone 30 30 30
eth1/0/20 Both Auto Disabled 2 Mone 30 30 30
ethi/0/21 Both Auto Disabled 2 None 30 30 30
eth1/0/22 Both Auto Disabled 2 MNone 30 30 30
eth1/0/23 Both Auto Disabled 2 Mone 30 30 30

m

Figure 9-13 802.1X Port Settings Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
Direction Select the direction here. Options to choose from are Both and In.

This option configures the direction of the traffic on a controlled port
as unidirectional (In) or bidirectional (Both). The In control direction
is only valid when the Host Mode is configured as Multi Host in
the Network Access Authentication Port Settings window.

Port Control Select the port control option here. Options to choose from are:

o ForceAuthorized - Specifies that the port is not controlled in
both directions.

e Auto - Specifies that access to the port for the controlled
direction needs to be authenticated.

o ForceUnauthorized - Specifies that access to the port for
the controlled direction is blocked.

Forward PDU Select to enable or disable the forward PDU option here.

MaxReq Enter the maximum required times value here. This value must be
between 1 and 10. By default, this option is 2. This option
configures the maximum number of times that the backend
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Parameter Description

authentication state machine will retransmit an Extensible
Authentication Protocol (EAP) request frame to the supplicant
before restarting the authentication process.

PAE Authenticator Select to enable or disable the PAE authenticator option here. This
option configures a specific port as an IEEE 802.1X port access
entity (PAE) authenticator.

Server Timeout Enter the server timeout value here. This value must be between 1
and 65535 seconds. By default, this value is 30 seconds.

Supp Timeout Enter the supplicant timeout value here. This value must be
between 1 and 65535 seconds. By default, this value is 30
seconds.

TX Period Enter the transmission period value here. This value must be
between 1 and 65535 seconds. By default, this value is 30
seconds.

Click the Apply button to accept the changes made.

Authentication Session Information

This window is used to view and configure the authentication session information.

To view the following window, click Security > 802.1X > Authentication Session Information, as
shown below:

AL [icatio 0 0 Atlo

Authentication Sessions Information
Unit From Port To Port
[1 =1 [eth1i0/1 [] eth1/0/1 [+] [ nit by Port | [ ReAuth by Port |
Total Entries: 0
i A ]

Figure 9-14 Authentication Session Information Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

Click the Init by Port button to initiate the session information based on the selections made.

Click the ReAuth by Port button to re-authenticate the session information based on the selections
made.
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Authenticator Statistics

This window is used to view and clear the authenticator statistics.

To view the following window, click Security > 802.1X > Authenticator Statistics, as shown below:

Authenticator Statistics

Unit Port eth1/0/1 [7] [ Find | [ Clear Counters |
Unit 1 Settings

Total Entries: 0
Frames Start Regld LogOff Req Respid Resp Error
Port Last Version Last Source
™ RX ™ RX X RX RX RX

Figure 9-15 Authenticator Statistics Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this query here.

Port Select the appropriate port used for the query here.

Click the Find button to locate a specific entry based on the information entered.
Click the Clear Counters button to clear the counter information based on the selections made.

Click the Clear All button to clear all the information in this table.

Authenticator Session Statistics

This window is used to view and clear the authenticator session statistics.

To view the following window, click Security > 802.1X > Authenticator Session Statistics, as
shown below:

Authenticator Session Statistics

Unit Port eth1/0/1 [ Find | [ clear counters |

Clear All

Unit 1 Settings
Total Entries: 0

I e T Y e e N

Figure 9-16 Authenticator Session Statistics Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this query here.

Port Select the appropriate port used for the query here.

Click the Find button to locate a specific entry based on the information entered.
Click the Clear Counters button to clear the counter information based on the selections made.

Click the Clear All button to clear all the information in this table.
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Authenticator Diagnostics

This window is used to view and clear the authenticator diagnostics information.

To view the following window, click Security > 802.1X > Authenticator Diagnostics, as shown
below:

Authenticator Diagnostics

unit Port eth1/0/1 [=] Find | [_Clear Counters |
Unit 1 Settings

Total Entries: 0

Figure 9-17 Authenticator Diagnostics Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this query here.

Port Select the appropriate port used for the query here.

Click the Find button to locate a specific entry based on the information entered.
Click the Clear Counters button to clear the counter information based on the selections made.

Click the Clear All button to clear all the information in this table.

AAA

AAA Global Settings

This window is used to enable or disable the Authentication, Authorization, and Accounting (AAA)
global state.

To view the following window, click Security > AAA > AAA Global Settings, as shown below:

AAA State Settings

AAA State @ Disabled Enabled

Figure 9-18 AAA Global Settings Window

The fields that can be configured are described below:

Parameter Description

AAA State Select to enable or disable the Authentication, Authorization, and
Accounting (AAA) global state.

Click the Apply button to accept the changes made.
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Application Authentication Settings

This window is used to view and configure the application authentication settings.

To view the following window, click Security > AAA > Application Authentication Settings, as
shown below:

Application Authentication Settings
I T S R
Console default
Telnet default
S8H default
HTTP default

Figure 9-19 Application Authentication Settings Window

The fields that can be configured are described below:

Parameter Description

Login Method List After clicking the Edit button for the specific entry, enter the login
method list name used here.

Click the Edit button to re-configure the specific entry.
Click the Apply button to accept the changes made.

Application Accounting Settings

This window is used to view and configure the application accounting settings.

To view the following window, click Security > AAA > Application Accounting Settings, as shown
below:

Application Accounting Exec Method List
Pt o s Y
Console
Teinet
SSH
HITP
Application A ting C ds Method List
Application Level Commands Method List
Total Entries: 1
st Commani ot ]
Telnet 1 Method1
n [l [ leo

Figure 9-20 Application Accounting Settings Window

The fields that can be configured are described below:

Parameter Description

Exec Method List After clicking the Edit button for the specific entry, enter the EXEC
method list name used here.

Application Select the application used here. Options to choose from are
Console, Telnet, and SSH.
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Parameter Description

Level Select the privilege level used here. Options to choose from are
levels 1 to 15.
Commands Method List Enter the commands method list name used here.

Click the Edit button to re-configure the specific entry.
Click the Apply button to accept the changes made.
Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

Authentication Settings

This window is used to view and configure the AAA network and EXEC authentication settings.

To view the following window, click Security > AAA > Authentication Settings, as shown below:

| AAA Authentication Network | AAA Authentication Exec

AAA Authentication 802.1X

Status Disabled E

Method 3 [Please Select [~ Method 4 [Please Select [~ [ apply |
AAA Authentication JWAC

Status

Method 3 [Please Select [~ Method 4 [Please Select [~ [ aoply ]
AAA Authentication MAC-Auth

Status

Method 3 |Please Select [ Method 4 [Please Select [~] [ apply |
AAA Authentication WEB-Auth

Status

Method 3 [Please Select [ Method 4 [Please Select [~ ]] [ apply

Figure 9-21 Authentication Settings Window

The fields that can be configured for AAA Authentication 802.1X are described below:

Parameter Description

Status Select to enable or disable the AAA 802.1X authentication state
here.

Method 1 to 4 Select the method lists that will be used for this configuration here.
Options to choose from are none, local, group and radius.

Click the Apply button to accept the changes made.

The fields that can be configured for AAA Authentication JWAC are described below:

Parameter Description

Status Select to enable or disable the AAA JWAC authentication state
here.

Method 1 to 4 Select the method lists that will be used for this configuration here.
Options to choose from are none, local, group and radius.
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Click the Apply button to accept the changes made.

The fields that can be configured for AAA Authentication MAC-Auth are described below:

Parameter Description
Status Select to enable or disable the AAA MAC authentication state here.
Method 1 to 4 Select the method lists that will be used for this configuration here.

Options to choose from are none, local, group and radius.

Click the Apply button to accept the changes made.

The fields that can be configured for AAA Authentication WEB-Auth are described below:

Parameter Description
Status Select to enable or disable the AAA Web authentication state here.
Method 1 to 4 Select the method lists that will be used for this configuration here.

Options to choose from are none, local, group and radius.

Click the Apply button to accept the changes made.

After clicking the AAA Authentication Exec tab, the following page will appear.

AL [Icatio eting

AAA Authentication Network | AAA Authentication Exec |
AAA Authentication Enable
Status Disabled E
AAA Authentication Login
Total Entries: 1
I T T T 7
Method1 local

Figure 9-22 AAA Authentication Exec Window

The fields that can be configured for AAA Authentication Enable are described below:

Parameter Description

Status Select to enable or disable the AAA authentication enable state
here.

Method 1 to 4 Select the method lists that will be used for this configuration here.
Options to choose from are none, enable, group, radius, and
tacacs+.

Click the Apply button to accept the changes made.

The fields that can be configured for AAA Authentication Login are described below:

Parameter Description

List Name Enter the method list name that will be used with the AAA
authentication login option here.

Status Select to enable or disable the AAA authentication login state here.
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Parameter Description

Method 1 to 4 Select the method lists that will be used for this configuration here.
Options to choose from are none, enable, group, radius, and
tacacs+.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

Accounting Settings

This window is used to view and configure the AAA accounting settings.

To view the following window, click Security > AAA > Accounting Settings, as shown below:

| AAA Accounting Network | AAA Accounting System AAA Accounting Exec AAA Accounting Commands
Default Disabled

Figure 9-23 Accounting Settings Window

The fields that can be configured are described below:

Parameter Description

Default Select to enable or disable the use of the default method list here.

Method 1 to 4 Select the method lists that will be used for this configuration here.
Options to choose from are none, group, radius, and tacacs+.

Click the Apply button to accept the changes made.

After clicking the AAA Accounting System tab, the following page will appear.

AAA Accounting Network | AAA Accounting System | AAA Accounting Exec AAA Accounting Commands
Defaull Disabled [=]

Figure 9-24 AAA Accounting System Window

The fields that can be configured are described below:

Parameter Description

Default Select to enable or disable the use of the default method list here.

Method 1 to 4 Select the method lists that will be used for this configuration here.
Options to choose from are none, group, radius, and tacacs+.

Click the Apply button to accept the changes made.
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After clicking the AAA Accounting Exec tab, the following page will appear.

Accounting Setling

AAA Accounting Network AAA Accounting System | AAA Accounting Exec | AAA Accounting Commands
Total Entries: 1
Method 1 Method 2 Method 3 Method 4 I
Method radius

Figure 9-25 AAA Accounting Exec Window

The fields that can be configured are described below:

Parameter Description

List Name Enter the method list name that will be used with the AAA
accounting EXEC option here.

Method 1 to 4 Select the method lists that will be used for this configuration here.
Options to choose from are none, group, radius, and tacacs+.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

After clicking the AAA Accounting Commands tab, the following page will appear.

Accounting Settings

AAA Accounting Network AAA Accounting System AAA Accounting Exec | AAA Accounting Commands

Method 1 Method 2 Please Select  [v]

Method 3 Please Select  [¥] Method 4 Please Select  [v] Apply

Total Entries: 1

I O N T S TR
1 Method tacacs=

1n [1] [ leo

Figure 9-26 AAA Accounting Commands Window

The fields that can be configured are described below:

Parameter Description

Level Select the privilege level used here. Options to choose from are
levels 1 to 15.

List Name Enter the method list name that will be used with the AAA

accounting commands option here.

Method 1 ~ Method 4 Select the method lists that will be used for this configuration here.
Options to choose from are none, group, and tacacs+. The none
option is only available for Method 1.

Click the Apply button to accept the changes made.
Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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Server RADIUS Dynamic Author Settings

This window is used to view and configure the dynamic author settings for the RADIUS server.

To view the following window, click Security > AAA > Server RADIUS Dynamic Author Settings, as
shown below:

Server RADIUS Dynamic Author Global Settings

Dynamic Author Enabled ] Port (1-65535) [
Server RADIUS Dynamic Author Settings
@ Client IP Address |:| () Client Host Name 255 chars

Total Entries: 1

T G iy
10.90.90.25 wae

Figure 9-27 Server RADIUS Dynamic Author Settings Window

The fields that can be configured for Server RADIUS Dynamic Author Global Settings are
described below:

Parameter Description

Dynamic Author Select to enable or disable the dynamic author function here.
Dynamic authorization allows an external policy server to
dynamically send updates to a device.

Port Enter the port number that is used for the data transmission of the
update packets here. The range is from 1 to 65535.

Click the Apply button to accept the changes made.

The fields that can be configured for Server RADIUS Dynamic Author Settings are described

below:

Parameter Description

Client IP Address Select and enter the IP address of the RADIUS client here.

Client Host Name Select and enter the hostname of the RADIUS client here.

Server Key Type Select the RADIUS server key type here. Options to choose from
are:

¢ Plain Text - Select this option to use the plain text RADIUS
server key type.

e Encrypted - Select this option to use the encrypted RADIUS
server key type.

Server Key When Plain Text is selected as the key type, enter the key for the
RADIUS server connection in the plain text form here. This key can
be up to 32 characters long.

When Encrypted is selected as the key type, enter the key for the
RADIUS server connection in the encrypted form here. This key
can be up to 64 characters long.

Click the Apply button to add a new entry.

Click the Delete button to remove the specified entry.
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RADIUS
RADIUS Global Settings

This window is used to view and configure the RADIUS global settings.

To view the following window, click Security > RADIUS > RADIUS Global Settings, as shown below:

RADIUS Global Settings
RADIUS Global IPv4 Source Interface

IPv4 RADIUS Source Interface State Disabled v

IPv4 RADIUS Source Interface Type VLAN [~] Interface 1D (1-4094) |:|
RADIUS Global IPvé Source Interface

IPvE RADIUS Source Interface State Disabled V]

IPvE RADIUS Source Interface Type [~] Interface 1D (1-4084) |:|
RADIUS Server Attribute Settings

RADIUS Server Atribute NAS-IP-Address - ]

RADIUS Server Atfribute Event-Timestamp Disabled ﬂ

Figure 9-28 RADIUS Global Settings Window

The fields that can be configured for RADIUS Global Settings are described below:

Parameter Description

Dead Time Enter the dead time value for the RADIUS server connection here.
This is used to improve the authentication processing time by
setting the dead time to skip unresponsive server host entries. The
range is from 0 to 1440 minutes. By default, this value is 0 minutes.
When this option is 0, the unresponsive server will not be marked
as dead.

Click the Apply button to accept the changes made.

The fields that can be configured for RADIUS Global IPv4 Source Interface are described below:

Parameter Description

IPv4 RADIUS Source Select to enable or disable the state of the IPv4 RADIUS source
Interface State interface here.
IPv4 RADIUS Source Select the IPv4 RADIUS source interface type here. Options to
Interface Type choose from are:
e VLAN - Specifies the IPv4 RADIUS source interface type as
VLAN.
Interface ID Enter the VLAN interface ID here. The range is from 1 to 4094.

Click the Apply button to accept the changes made.

The fields that can be configured for RADIUS Global IPv6 Source Interface are described below:

Parameter Description
IPv6 RADIUS Source Select to enable or disable the state of the IPv6 RADIUS source
Interface State interface here.
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Parameter

IPv6 RADIUS Source
Interface Type

Description
Select the IPv6 RADIUS source interface type here. Options to
choose from are:

e VLAN - Specifies the IPv6 RADIUS source interface type as
VLAN.

Interface ID

Enter the VLAN interface ID here. The range is from 1 to 4094.

Click the Apply button to accept the changes made.

The fields that can be configured for RADIUS Server Attribute Settings are described below:

Parameter

RADIUS Server Attribute
NAS-IP-Address

Description

Enter the IPv4 address of the RADIUS server attribute 4 in the
RADIUS packet here.

RADIUS Server Attribute
Event-Timestamp

Select to enable or disable the RADIUS server attribute event-
timestamp function here.

Click the Apply button to accept the changes made.

RADIUS Server Settings

This window is used to view and configure the RADIUS server settings.

To view the following window, click Security > RADIUS > RADIUS Server Settings, as shown below:

tADITU 1 ettings

RADIUS Server Settings
Authentication Port (0-65535) 1812 Accounting Port (0-65535) 1813
Retransmit (0-20) fimes Timeout (1-255) sec
Key Type Plain Text Key 32 chars Apply
Total Entries: 1
e I N N I
10.90.90.254 1812 1813 5 a | ==

Figure 9-29 RADIUS Server Settings Window

The fields that can be configured are described below:

Parameter Description

IP Address Enter the RADIUS server’s IPv4 address here.
IPv6 Address Enter the RADIUS server’s IPv6 address here.

Authentication Port

Enter the authentication port number used here. This value must
be between 0 and 65535. By default, this value is 1812. If no
authentication is used, use the value 0.

Enter the accounting port number used here. This value must be
between 0 and 65535. By default, this value is 1813. If no
accounting is used, use the value 0.

Accounting Port

Retransmit Enter the retransmit value used here. This value must be between
0 and 20. By default, this value is 3. To disable this option, enter
the value 0.

Timeout Enter the timeout value used here. This value must be between 1

and 255 seconds. By default, this value is 5 seconds.
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Parameter Description

Key Type Select the key type that will be used here. Options to choose from
are Plain Text and Encrypted.

Key Enter the key, used to communicate with the RADIUS server, here.
This key can be up to 32 characters long.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

RADIUS Group Server Settings

This window is used to view and configure the RADIUS group server settings.

To view the following window, click Security > RADIUS > RADIUS Group Server Settings, as

shown below:
RADIU roup server setungs
RADIUS Group Server Settings
() IPv6 Address 20131 Add
Total Entries: 2
group 192.168.1.... - - - - - - - Show Detail Delete
radius

Figure 9-30 RADIUS Group Server Settings Window

The fields that can be configured are described below:

Parameter Description

Group Server Name Enter the name of the RADIUS group server here. This name can
be up to 32 characters long.

IPv4 Address Enter the IPv4 address of the RADIUS group server here.

IPv6 Address Enter the IPv6 address of the RADIUS group server here.

Click the Add button to add a new entry based on the information entered.
Click the Show Detail button to view and configure detailed settings for the RADIUS group server.

Click the Delete button to remove the specified entry.

After clicking the Show Detail button, the following page will be available.

RADIUS Group Server Settings

Group Server Name: Group1

IPv4 RADIUS Source Interface State Disabled [v]

IPv4 RADIUS Source Interface Type m Interface ID (1-4084) |:|

IPv6 RADIUS Source Interface State

IPv6 RADIUS Source Interface Type VLAN ~] Interface ID (1-4084) | [[ apoly ]

Group Server Name: Group1

e e I
192.168.1.254

Figure 9-31 RADIUS Group Server Settings - Detail Window
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The fields that can be configured are described below:

Parameter Description

IPv4 RADIUS Source Select to enable or disable the state of the IPv4 RADIUS source
Interface State interface here.
IPv4 RADIUS Source Select the IPv4 RADIUS source interface type here. Options to
Interface Type choose from are:
¢ VLAN - Specifies the IPv4 RADIUS source interface type as
VLAN.

Interface ID - Enter the VLAN interface ID for the IPv4 RADIUS
source interface here. The range is from 1 to 4094.

IPv6 RADIUS Source Select to enable or disable the state of the IPv6 RADIUS source
Interface State interface here.
IPvé RADIUS Source Select the IPv6 RADIUS source interface type here. Options to
Interface Type choose from are:
e VLAN - Specifies the IPv6 RADIUS source interface type as
VLAN.

Interface ID - Enter the VLAN interface ID for the IPv6 RADIUS
source interface here. The range is from 1 to 4094.

Click the Apply button to accept the changes made.
Click the Delete button to remove the specified entry.

Click the Back button to return to the previous window.

RADIUS Statistic

This window is used to view and clear the RADIUS statistics information.

To view the following window, click Security > RADIUS > RADIUS Statistic, as shown below:

RADIU [atist

RADIUS Statistic

Group Server Name
Total Entries: 1
T L R R
10.90.90.254 1812 1813 Up
i [T [ leo
RADIUS Server Address: 10.90.90.254
Round Trip Time 1] L1}
Access Reguests 1] NA
Access Accepts 0 NA
Access Rejects 0 NA
Access Challenges 1] NA
Acct Request NA 0
Acct Response MNA 0
Retransmissions 0 0
Malformed Responses 1] 0
Bad Authenticators 1] 0
Pending Requests 0 0
Timeouts 1] 0
Unknown Types 0 0
Packets Dropped 1] 0

Figure 9-32 RADIUS Statistic Window
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The fields that can be configured are described below:

Parameter Description

Group Server Name Select the RADIUS group server name from this list here.

Click the Clear button to clear the information based on the selections made.
Click the Clear All button to clear all the information in this table.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

TACACS+

TACACS+ Global Settings

This window is used to display and configure the global TACACS+ server settings.

To view the following window, click Security > TACACS+ > TACACS+ Global Settings, as shown
below:

TACACS+ Global IPv4 Source Interface

IPv4 TACACS+ Source Interface State Disabled ~]

IPv4 TACACS+ Source Interface Type Interface 1D (1-4094) 1 Apply
TACACS+ Global IPvG Source Interface

IPvE TACACS+ Source Interface Stafe Disabled v

IPvG TACACS+ Source Interface Type Interface 1D (1-4094) |:|

Figure 9-33 TACACS+ Global Settings Window

The fields that can be configured in TACACS+ Global IPv4 Source Interface are described below:

Parameter Description

IPv4d TACACS+ Source Select to enable or disable the state of the IPv4 TACACS+ source
Interface State interface here.
IPv4 TACACS+ Source Select the IPv4 TACACS+ source interface type here. Options to
Interface Type choose from are:
e VLAN - Specifies the IPv4 TACACS+ source interface type
as VLAN.
Interface ID Enter the VLAN interface ID here. The range is from 1 to 4094.

Click the Apply button to accept the changes made.

The fields that can be configured in TACACS+ Global IPv6 Source Interface are described below:

Parameter Description

IPvé TACACS+ Source Select to enable or disable the state of the IPv6 TACACS+ source
Interface State interface here.
IPvé TACACS+ Source Select the IPv6 TACACS+ source interface type here. Options to
Interface Type choose from are:
e VLAN - Specifies the IPv6 TACACS+ source interface type
as VLAN.
Interface ID Enter the VLAN interface ID here. The range is from 1 to 4094.
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Click the Apply button to accept the changes made.

TACACS+ Server Settings

This window is used to view and configure the TACACS+ server settings.

To view the following window, click Security > TACACS+ > TACACS+ Server Settings, as shown
below:

TACACS+ Server Settings

@® IP Address [ ] () IPV6 Address 2013:1
S Tenout (1759
Key Type Plain Text [v] Key 254 chars

Total Entries: 1

T . O S N S R
192.168.1.1 49 5 s

Figure 9-34 TACACS+ Server Settings Window

The fields that can be configured are described below:

Parameter Description

IP Address Enter the TACACS+ server’s IPv4 address here.
IPv6 Address Enter the TACACS+ server’s IPv6 address here.
Port Enter the port number used here. This value must be between 1

and 65535. By default, this value is 49.

Timeout Enter the timeout value here. This value must be between 1 and
255 seconds. By default, this value is 5 seconds.

Key Type Select the key type that will be used here. Options to choose from
are Plain Text and Encrypted.

Key Enter the key, used to communicate with the TACACS+ server,
here. This key can be up to 254 characters long.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.
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TACACS+ Group Server Settings

This window is used to view and configure the TACACS+ group server settings.

To view the following window, click Security > TACACS+ > TACACS+ Group Server Settings, as
shown below:

ACH roup Server Settings

TACACS+ Group Server Settings

© ot s —

Total Entries: 2

v s s e I
Group2 192.168.... - - - - - - - Show Detail Delete

tacacs+

Figure 9-35 TACACS+ Group Server Settings Window

The fields that can be configured are described below:

Parameter Description

Group Server Name Enter the name of the TACACS+ group server here. This name can
be up to 32 characters long.

IPv4 Address Enter the IPv4 address of the TACACS+ group server here.

IPv6 Address Enter the IPv6 address of the TACACS+ group server here.

Click the Add button to add a new entry based on the information entered.
Click the Show Detail button to view and configure detailed settings for the TACACS+ group server.

Click the Delete button to remove the specified entry.

After clicking the Show Detail button, the following page will be available.

ACA roup Server Settings

Group Server Name: Group2

IPv4 TACACS+ Source Interface State [Disabled  [v]

IPv4 TACACS+ Source Inferface Type VLAN V] Interface 1D (1-4094) 1

IPvE TACACS+ Source Interface State Disabled [v]

IPv6 TACACS+ Source Interface Type m Interface 1D (1-4004) | | [ Apply |

Group Server Name: Group2

e s I
192.168.1.254

Figure 9-36 TACACS+ Group Server Settings - Detail Window

The fields that can be configured are described below:

Parameter Description

IPv4 TACACS+ Source Select to enable or disable the state of the IPv4 TACACS+ source
Interface State interface here.

IPv4 TACACS+ Source Select the IPv4 TACACS+ source interface type here. Options to
Interface Type choose from are:
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Parameter Description

e VLAN - Specifies the IPv4 TACACS+ source interface type
as VLAN.

Interface ID - Enter the VLAN interface ID for the IPv4 TACACS+
source interface here. The range is from 1 to 4094.

IPvé TACACS+ Source Select to enable or disable the state of the IPv6 TACACS+ source
Interface State interface here.
IPv6 TACACS+ Source Select the IPv6 TACACS+ source interface type here. Options to
Interface Type choose from are:
e VLAN - Specifies the IPv6 TACACS+ source interface type
as VLAN.

Interface ID - Enter the VLAN interface ID for the IPv6 TACACS+
source interface here. The range is from 1 to 4094.

Click the Apply button to accept the changes made.
Click the Delete button to remove the specified entry.

Click the Back button to return to the previous window.

TACACS+ Statistic

IMPB

This window is used to view and clear the TACACS+ statistic information.

To view the following window, click Security > TACACS+ > TACACS+ Statistic, as shown below:

TACACS+ Statistic

Group Server Name Please Select ﬂ Clear Clear all

Total Entries: 1

TACACS+ Server Address m Socket Opens | SocketCloses | Total Packets Sent | Total Packets Recv | Reference Count _
192.168.1.1/49 Up 0 0 0 0 0

Figure 9-37 TACACS+ Statistic Window

The fields that can be configured are described below:

Parameter Description

Group Server Name Select the TACACS+ group server name from this list here.

Click the Clear button to clear the information based on the group selected.
Click the Clear All button to clear all the information in this table.

Click the Clear button to clear all the information for the specific port.

The IP network layer uses a four-byte address. The Ethernet link-layer uses a six-byte MAC address.
Binding these two address types together allows the transmission of data between the layers. The
primary purpose of IP-MAC-Port Binding (IMPB) is to restrict the access to a switch to a number of
authorized users. Authorized clients can access a switch’s port by either checking the pair of IP-MAC
addresses with the pre-configured database or if DHCP snooping has been enabled in which case the
switch will automatically learn the IP/MAC pairs by snooping DHCP packets and saving them to the
IMPB white list. If an unauthorized user tries to access an IP-MAC binding enabled port, the system
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will block the access by dropping its packet. Active and inactive entries use the same database. The
function is port-based, meaning a user can enable or disable the function on the individual port.

IPv4

DHCPv4 Snooping

DHCP Snooping Global Settings

This window is used to view and configure the DHCP snooping global settings.

To view the following window, click Security > IMPB > IPv4 > DHCPv4 Snooping > DHCP
Snooping Global Settings, as shown below:

DHCP Snooping Global Settings

DHCP Snooping

Information Option Allow Untrusted
Source MAC Verification

Station Move Deny

Enabled
Enabled
Enabled
Enabled

@ Disabled
@ Disabled
@ Disabled

Figure 9-38 DHCP Snooping Global Settings Window

The fields that can be configured are described below:

Parameter Description

DHCP Snooping

Select to enable or disable the DHCP snooping global status.

Untrusted

Information Option Allow

Select to enable or disable the option to globally allow DHCP
packets with the relay Option 82 on the untrusted interface.

Source MAC Verification

Select to enable or disable the verification that the source MAC
address in a DHCP packet matches the client hardware address.

Station Move Deny

Select to enable or disable the DHCP snooping station move state.
When DHCP snooping station move is enabled, the dynamic
DHCP snooping binding entry with the same VLAN ID and MAC
address on the specific port can move to another port if it detects
that a new DHCP process belong to the same VLAN ID and MAC
address.

Click the Apply button to accept the changes made.
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DHCP Snooping Port Settings

This window is used to view and configure the DHCP snooping port settings.

To view the following window, click Security > IMPB > IPv4 > DHCPv4 Snooping > DHCP
Snooping Port Settings, as shown below:

DHCP Snooping Port Settings
From Port
To Port
Entry Limit (0-1024) [ |l NoLmit
Rate Limit (1-300) [ | "l NoLimit
Trusted No ]
e T e | e | num
eth1/0/1 No No Limit No Limit
eth1/0/2 No Mo Limit Mo Limit
eth1/0/3 No No Limit No Limit
eth1/0/4 No Mo Limit Mo Limit
eth1/0/5 No No Limit No Limit =
eth1/0/6 No Mo Limit Mo Limit
eth /07 No Mo Limit Mo Limit
eth1/0/8 No No Limit No Limit
eth1/0/9 No No Limit Mo Limit
eth1/0/10 No Mo Limit Mo Limit
eth1/0/11 No Mo Limit Mo Limit
eth1/0/112 No Mo Limit Mo Limit
eth1/0/13 No No Limit No Limit
eth1/0/14 No Mo Limit Mo Limit
eth1/0/15 No Mo Limit Mo Limit
eth1/0/16 No Mo Limit Mo Limit
eth1/0/17 No Mo Limit Mo Limit
eth1/0/18 No No Limit No Limit
eth1/0/19 No Mo Limit Mo Limit
eth1/020 No Mo Limit Mo Limit
eth1/0/21 No No Limit No Limit
eth1/0/22 No Mo Limit Mo Limit
eth1/0/23 No No Limit No Limit .

Figure 9-39 DHCP Snooping Port Settings Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
Entry Limit Enter the entry limit value here. This value must be between 0 and

1024. Tick the No Limit option to disable the function.

Rate Limit Enter the rate limit value here. This value must be between 1 and
300. Tick the No Limit option to disable the function.

Trusted Select the trusted option here. Options to choose from are No and
Yes. Ports connected to the DHCP server or to other switches
should be configured as trusted interfaces. The ports connected to
DHCP clients should be configured as untrusted interfaces. DHCP
snooping acts as a firewall between untrusted interfaces and
DHCP servers.

Click the Apply button to accept the changes made.
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DHCP Snooping VLAN Settings

This window is used to view and configure the DHCP snooping VLAN settings.

To view the following window, click Security > IMPB > IPv4 > DHCPv4 Snooping > DHCP
Snooping VLAN Settings, as shown below:

DHCP Snooping VLAN Settings

VID List State  [Enabled [] apply

DHCP Snooping Enabled VID 1

Figure 9-40 DHCP Snooping VLAN Settings Window

The fields that can be configured are described below:

Parameter Description

VID List Enter the VLAN ID list used here.
State Select to enable or disable the DHCP snooping VLAN setting here.

Click the Apply button to accept the changes made.

DHCP Snooping Database

This window is used to view and configure the DHCP snooping database settings.

To view the following window, click Security > IMPB > IPv4 > DHCPv4 Snooping > DHCP
Snooping Database, as shown below:

[ DataDase

DHCP Snooping Database

Write Delay (60- 86400) sec [ Default Apply

Store DHCP Snooping Database

WL |TFTP ﬂ” Apply | ‘ Clear
A URL beginning with this prefix /locationffilename

Load DHCP Snooping Database

[ L]

A URL beginning with this prefix /ocationffilename

Last ignored Bindings counters

Binding Collisions 0 Expired Lease 0
Invalid Interfaces 0 Unsupported VLAN 0
Parse Failures 0 Checksum Errors 0

Figure 9-41 DHCP Snooping Database Window

The fields that can be configured for DHCP Snooping Database are described below:

Parameter Description

Write Delay Enter the write delay time value here. This value must be between
60 and 86400 seconds. By default, this value is 300 seconds.

Select the Default option to use the default value.

Click the Apply button to accept the changes made.
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The fields that can be configured for Store DHCP Snooping Database are described below:

Parameter Description

URL Select the location from the drop-down list and enter the URL
where the DHCP snooping database will be stored to here.
Location to choose from is TFTP.

Click the Apply button to accept the changes made.
Click the Clear button to clear the stored DHCP snooping database.

The fields that can be configured for Load DHCP Snooping Database are described below:

Parameter Description

URL Select the location from the drop-down list and enter the URL
where the DHCP snooping database will be loaded from here.
Location to choose from is TFTP.

Click the Apply button to accept the changes made.

Click the Clear button to clear all the counter information.

DHCP Snooping Binding Entry

This window is used to view and configure the DHCP snooping binding entries.

To view the following window, click Security > IMPB > IPv4 > DHCPv4 Snooping > DHCP
Snooping Binding Entry, as shown below:

) ooping Binding Ty

DHCP Snooping Manual Binding

MAC Address

VID (1-4094) [
IP Address |:|
Expiry (60-4294967295) |:| sec

Add

Total Entries: 1

S S S A

00-84-57-00-00-00 10.90.90.254 eth1/0/1 3600 dhcp-snooping
n 1] Go

Figure 9-42 DHCP Snooping Binding Entry Window

The fields that can be configured are described below:

Parameter Description

MAC Address Enter the MAC address of the DHCP snooping binding entry here.

VID Enter the VLAN ID of the DHCP snooping binding entry here. This
value must be between 1 and 4094.

IP Address Enter the IP address of the DHCP snooping binding entry here.

Unit Select the switch unit that will be used for this configuration here.

Port Select the appropriate port used for the configuration here.

Expiry Enter the expiry time value used here. This value must be between

60 and 4294967295 seconds.

Click the Add button to add a new entry based on the information entered.
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Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

Dynamic ARP Inspection

ARP Access List

This window is used to view and configure the dynamic ARP inspection settings.

To view the following window, click Security > IMPB > IPv4 > Dynamic ARP Inspection > ARP
Access List, as shown below:

ARP Access List

ARP Access List Name Add

Total Entries: 1

T
ARP-Accass-List

Figure 9-43 ARP Access List Window

The fields that can be configured are described below:

Parameter Description

ARP Access List Name Enter the ARP access list name used here. This name can be up to
32 characters long.

Click the Add button to add a new entry based on the information entered.
Click the Edit button to re-configure the specific entry.

Click the Delete button to remove the specified entry.

After clicking the Edit button, the following window will appear.

acton

@ E S — =
e = S B —
( Back Il Apply ]

ARP Access List Name: ARP-Access-List

Total Entries: 1

m 1P Type Sender IP Sender IP Mask MAC Type Sender MAC Sender MAC Mask _
Any - - Any = 5

Permit

Figure 9-44 ARP Access List - Edit Window

The fields that can be configured are described below:

Parameter Description

Action Select the action that will be taken here. Options to choose from
are Permit and Deny.

IP Select the type of sender IP address that will be used here. Options
to choose from are Any, Host, and IP with Mask.

Sender IP After selecting the Host or IP with Mask options as the type of IP,
enter the sender IP address used here.
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Parameter Description

Sender IP Mask After selecting the IP with Mask option as the type of IP, enter the
sender IP mask used here.

MAC Select the type of sender MAC address that will be used here.
Options to choose from are Any, Host, and MAC with Mask.

Sender MAC After selecting the Host or MAC with Mask options as the type of
MAC, enter the sender MAC address used here.

Sender MAC Mask After selecting the MAC with Mask option as the type of MAC,

enter the sender MAC mask used here.

Click the Back button to return to the previous page.
Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

ARP Inspection Settings

This window is used to view and configure the ARP inspection settings.

To view the following window, click Security > IMPB > IPv4 > Dynamic ARP Inspection > ARP
Inspection Settings, as shown below:

ARP Inspection Validation

Src-MAC (_)Enabled (eDisabled
Dst-MAC (_Enabled (e)Disabled
P (Enabled (@Disabled

ARP Inspection VLAN Logging

Total Entries: 1

I v S ™ e
2 None Mone
11 EA [ [eo
ARP Inspection Filter
ARP Access List Name
Vo s
Static ACL No [~] [ add || pelete |

Total Entries: 1

“ ARP Access List Name Static ACL

1 ARP-ACL No

1 [ [ [eo

Figure 9-45 ARP Inspection Settings Window

The fields that can be configured for ARP Inspection Validation are described below:

Parameter Description

Src-MAC Select to enable of disable the source MAC option here. This option
specifies to check for ARP requests and response packets and the
consistency of the source MAC address in the Ethernet header
against the sender MAC address in the ARP payload.

Dst-MAC Select to enable of disable the destination MAC option here. This
option specifies to check for ARP response packets and the
consistency of the destination MAC address in the Ethernet header
against the target MAC address in the ARP payload.

IP Select to enable of disable the IP option here. This option specifies
to check the ARP body for invalid and unexpected IP addresses. It
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Parameter Description

also specifies to check the validity of IP address in the ARP
payload. The sender IP in both the ARP request and response and
target IP in the ARP response are validated. Packets destined for
the IP addresses 0.0.0.0, 255.255.255.255, and all IP multicast
addresses are dropped. Sender IP addresses are checked in all
ARP requests and responses, and target IP addresses are checked
only in ARP responses.

Click the Apply button to accept the changes made.
Click the Edit button to configure the ARP inspection VLAN logging settings.

After clicking the Edit button, the following fields can be configured:

Parameter Description

ACL Logging Select the ACL logging action here. This specifies the logging
criteria for packets that are dropped or permitted based on ACL
matches. Options to choose from are:

¢ Deny - Specifies logging when denied by the configured
ACL.

o Permit - Specifies logging when permitted by the configured
ACL.

¢ All - Specifies logging when permitted or denied by the
configured ACL.

¢ None - Specifies that ACL-matched packets are not logged.

DHCP Logging Select the DHCP logging action here. This specifies the logging
criteria for packets dropped or permitted based on matches against
the DHCP bindings. Options to choose from are:

¢ Deny - Specifies logging when denied by DHCP bindings.

e Permit - Specifies logging when permitted by DHCP
bindings.

¢ All - Specifies logging when permitted or denied by DHCP
bindings.

¢ None - Specifies to prevent the logging of all packets
permitted or denied by DHCP bindings.

Click the Apply button to accept the changes made.

The fields that can be configured for ARP Inspection Filter are described below:

Parameter Description

ARP Access List Name Enter the ARP access list name used here. This name can be up to
32 characters long.

VID List Enter the VLAN ID list used here.

Static ACL Select whether to use a static ACL or not here by either selecting
Yes or No.

Click the Add button to add a new entry based on the information entered.
Click the Delete button to remove an entry based on the information entered.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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ARP Inspection Port Settings

This window is used to view and configure the ARP inspection port settings.

To view the following window, click Security > IMPB > IPv4 > Dynamic ARP Inspection > ARP
Inspection Port Settings, as shown below:

Unit From Port To Port eth1/0/1
Rate Limit (1-150) [ ees Burst Interval (1-15) [ ] ™ Nome
Trust State l Apply J l Set to Default ]
I S T S T S

eth1/0/1 Unirusted 15 1

elhi/or2 Unirusted 15 1

eth1/03 Untrusted 15 1

ethi/o/a Untrusted 15 1

ethi/o/s Untrusted 15 1

eth1/0/5 Unirusted 15 1

elhi/o7 Unirusted 15 1

eth1/0/3 Unirusted 15 1 |

eth/o/g Untrusted 15 1 [

eth1/0/10 Untrusted 15 1

eth1/0/11 Untrusted 15 1

eth1/0/12 Unirusted 15 1

eth1/013 Untrusted 15 1

eth1/0/44 Untrusted 15 1

eth1/0/15 Untrusted 15 1

eth1/0/16 Untrusted 15 1

eth 17017 Unirusted 15 1

eth1/0/18 Untrusted 15 1

eth1/019 Untrusted 15 1

eth1/0/20 Untrusted 15 1

eth1/0/21 Untrusted 15 1

elh1/0/22 Unirusted 15 1

eth1/0/23 Untrusted 15 1

eth1/0/24 Unirusted 15 1

eth1/0/25 Unirusted 15 1

eth1/0/26 Unirusted 16 1 -

Figure 9-46 ARP Inspection Port Settings Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
Rate Limit Enter the rate limit value here. This value must be between 1 and

150 packets per seconds.

Burst Interval Enter the burst interval value here. This value must be between 1
and 15. Tick the None option to disable the option.

Trust State Select to enable or disable the trust state here.

Click the Apply button to accept the changes made.

Click the Set to Default button to change the information to the default values.
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ARP Inspection VLAN

This window is used to view and configure the ARP inspection VLAN settings.

To view the following window, click Security > IMPB > IPv4 > Dynamic ARP Inspection > ARP
Inspection VLAN, as shown below:

VID List State  [Enabled

ARP Inspection Enabled VID : 1

Figure 9-47 ARP Inspection VLAN Window

The fields that can be configured are described below:

Parameter Description

VID List Enter the VLAN ID list used here.

State Select to enable or disable the ARP inspection option’s state for the
specified VLAN here.

Click the Apply button to accept the changes made.

ARP Inspection Statistics

This window is used to view and clear the ARP inspection statistics information.

To view the following window, click Security > IMPB > IPv4 > Dynamic ARP Inspection > ARP
Inspection Statistics, as shown below:

hectio tatistics

VID List [[Clear by vian | [ clearal |

Total Entries: 1

m DHCP Drops | ACL Drops DHCP Permits ACL Permits Source MAC Failures Dest MAC Failure IP Validation Failure
1 ] ] 0 0 1] 0 1] 0 0
1n Bl [ leo

Figure 9-48 ARP Inspection Statistics Window

The fields that can be configured are described below:

Parameter Description
VID List Enter the VLAN ID list used here.

Click the Clear by VLAN button to clear the information based on the VLAN ID(s) entered.
Click the Clear All button to clear all the information in this table.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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ARP Inspection Log

This window is used to view, configure, and clear the ARP inspection log information.

To view the following window, click Security > IMPB > IPv4 > Dynamic ARP Inspection > ARP
Inspection Log, as shown below:

ARP Inspection Log

Log Buffer (1-1024) [ mpply J[ cleariog |

Total Entries: 0

S sosorinc———oceurrcs

Figure 9-49 ARP Inspection Log Window

The fields that can be configured are described below:

Parameter Description

Log Buffer Enter the log’s buffer value used here. This value must be between
1 and 1024. By default, this value is 32.

Click the Apply button to accept the changes made.
Click the Clear Log button to clear the log.

IP Source Guard
IP Source Guard Port Settings

This window is used to view and configure the IP source guard port settings.

To view the following window, click Security > IMPB > IPv4 > IP Source Guard > IP Source Guard
Port Settings, as shown below:

From Port eth1/0/1 [=] To Port eth1/0/1 [=]

State Enabled [=] Validation P [=]

S
eth1/0/10 ip

Figure 9-50 IP Source Guard Port Settings Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
State Select to enable or disable the IP source guard’s state for the

specified port(s) here.

Validation Select the validation method used here. Options to choose from
are IP and IP-MAC. Selecting IP means that the IP address of the
received packets will be checked. Selecting IP-MAC means that
the IP address and the MAC address of the received packets will
be checked.

Click the Apply button to accept the changes made.
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IP Source Guard Binding

This window is used to view and configure the IP source guard binding settings.

To view the following window, click Security > IMPB > IPv4 > IP Source Guard > IP Source Guard

Binding, as shown below:

ource lard o C |

IP Source Binding Settings

MAC Address

Total Entries: 1

00-84-57-00-00-00

VID (1-4094)
IF Address

Unit 1 M

From Port eth1/0/1 - To Port eth1/0/1 -
IP Source Binding Entry

Unit 1 -

From Port None - To Port None -

10.80.90.254 infinite Static eth1/0/1

’_Gu

1

Figure 9-51 IP Source Guard Binding Window

The fields that can be configured for IP Source Binding Settings are described below:

Parameter Description

MAC Address Enter the MAC address of the binding entry here.

VID Enter the VLAN ID of the binding entry here.

IP Address Enter the IP address of the binding entry here.

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.

Click the Apply button to accept the changes made.

The fields that can be configured for IP Source Binding Entry are described below:

Parameter Description

Unit Select the switch unit that will be used for this query here.

From Port/ To Port Select the appropriate port range used for the query here.

IP Address Enter the IP address of the binding entry here.

MAC Address Enter the MAC address of the binding entry here.

VID Enter the VLAN ID of the binding entry here.

Type Select the type of binding entry to find here. Options to choose from

are:

¢ All - Specifies that all the DHCP binding entries will be
displayed.

e DHCP Snooping - Specifies to display the IP-source guard
binding entry learned by DHCP binding snooping.
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Parameter Description

e Static - Specifies to display the IP-source guard binding
entry that is manually configured.

Click the Find button to locate a specific entry based on the information entered.
Click the Delete button to remove the specified entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

IP Source Guard HW Entry

This window is used to view the IP source guard hardware entries.

To view the following window, click Security > IMPB > IPv4 > IP Source Guard > IP Source Guard
HW Entry, as shown below:

youUrce uard [TV

Unit From Port eth1/0/1 [=] To Port eth1/01 [=] Find
Total Entries: 1
I O S N S S
eth1/0/10 ip Active 10.90.90.254 5 1
" E [ les

Figure 9-52 IP Source Guard HW Entry Window

The fields that can be configured are described below:

Parameter Description

Unit Select the switch unit that will be used for this query here.

From Port/ To Port Select the appropriate port range used for the query here.

Click the Find button to locate a specific entry based on the information entered.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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Advanced Settings
IP-MAC-Port Binding Settings

This window is used to view and configure the IP-MAC-Port binding settings.

To view the following window, click Security > IMPB > IPv4 > Advanced Settings > IP-MAC-Port
Binding Settings, as shown below:

IP-MAC-Port Binding Trap Settings
Trap State Enabled @ Disabled [ apply |
IP-MAC-Port Binding Port Settings
Mode Apply
. =
eth1/0/1 Disabled
eth1/0/2 Disabled
eth1/0/3 Disabled
eth1/0/4 Disabled
eth1/0/5 Disabled =
eth1/0/6 Disabled
eth1/0/7 Disabled
eth1/0/8 Disabled
eth1/0/9 Disabled
eth1/0V10 Disabled
eth1/0/11 Disabled
eth1/0/12 Disabled
eth1/0/13 Disabled
eth1/0/14 Disabled
eth1/if15 Disabled
eth1/0/16 Disabled
eth1/0/17 Disabled
eth1/0/18 Disabled
eth1/0/19 Disabled
eth1/0/20 Disabled
eth1/0/21 Disabled
eth1/0/22 Disabled
eth1/0/23 Disabled
athd N4 Nizablad S

Figure 9-53 IP-MAC-Port Binding Settings Window

The fields that can be configured for IP-MAC-Port Binding Trap Settings are described below:

Parameter Description
Trap State Select the enable or disable the IP-MAC-Port binding option’s trap
state.

Click the Apply button to accept the changes made.

The fields that can be configured for IP-MAC-Port Binding Port Settings are described below:

Parameter Description

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.
Mode Select the mode of access control that will be used here. Options to

choose from are Disabled, Strict, and Loose. When a port is
enabled for IMPB strict-mode access control, a host can only
access the port after the host sends ARP or IP packets and the
ARP packet or IP packet sent by the host passes the binding
check. To pass the binding check, the source IP address, source
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Parameter Description

MAC address, VLAN ID, and arrival port number must match any of
the entries defined by either the IP source guard static binding
entry or the DHCP snooping learned dynamic binding entry. When
a port is enabled for IMPB loose-mode access control, a host will
be denied to access the port after the host sends ARP or IP
packets and the ARP packet or IP packet sent by the host does not
pass the binding check. To pass the binding check, the source IP
address, source MAC address, VLAN ID, and arrival port must
match any of the entries defined by either the IP source guard
static binding entry or the DHCP snooping learned dynamic binding
entry.

Click the Apply button to accept the changes made.

IP-MAC-Port Binding Blocked Entry

This window is used to view and clear the IP-MAC-Port binding blocked entry table.

To view the following window, click Security > IMPB > IPv4 > Advanced Settings > IP-MAC-Port
Binding Blocked Entry, as shown below:

Clear @ by Port  Unit[1[~]| From Port[eth1/0/1 [v]  ToPort[eth1/0/1 M  Owmacl () Clear All

Total Entries: 0

I e

Figure 9-54 IP-MAC-Port Binding Blocked Entry Window

The fields that can be configured are described below:

Parameter Description

Clear All Leave all fields unselected and click the Apply button to clear all
IMPB blocked entry information.

Clear by Port Select this option to clear the entry table based on the port(s)
selected.

Unit Select the switch unit that will be clear here.

From Port/ To Port Select the appropriate port range that will be cleared here.

Clear by MAC Select this option to clear the entry table based on the MAC

address entered. Enter the MAC address that will be cleared in the
space provided.

Clear All Select this option to clear all entries that contain MAC addresses.

Click the Apply button to accept the changes made.
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IPv6

IPv6 Snooping

This window is used to view and configure the IPv6 snooping settings.

To view the following window, click Security > IMPB > IPv6 > IPv6 Snooping, as shown below:

poping
Station Move Setting

Station Move Apply

IPvG Snooping Policy Settings

Policy Name

Limit Address Count (0-511) [ | @ NoLmit

Protocol Disabled E|
Vo st EE— ——

Total Entries: 1

Snooping Policy Limit Address Count Target VL AN
511 1

Policy

Figure 9-55 IPv6 Snooping Window

The fields that can be configured for Station Move Setting are described below:

Parameter Description

Station Move Select the station move options here. Options to choose from are
Permit and Deny.

Click the Apply button to accept the changes made.

The fields that can be configured for IPv6 Snooping Policy Settings are described below:

Parameter Description

Policy Name Enter the IPv6 snooping policy name used here. This name can be
up to 32 characters long.

Limit Address Count Enter the address count limit value used here. This value must be
between 0 and 511. Tick the No Limit option to disable this option.

Protocol Select the protocol that will be associated with this policy here.
Options to choose from are Disabled, DHCP, NDP, and All.
DHCPv6 Snooping sniffs the DHCPv6 packets sent between the
DHCPV6 client and server in the address assigning procedure.
When a DHCPV6 client successfully got a valid IPv6 address,
DHCPvV6 snooping creates its binding database. ND Snooping is
designed for a stateless auto-configuration assigned IPv6 address
and manually configured IPv6 address. Before assigning an IPv6
address, the host must perform Duplicate Address Detection first.
ND snooping detects DAD messages (DAD NS and DAD NA) to
build its binding database. The NDP packet (NS and NA) is also
used to detect whether a host is still reachable and determine
whether to delete a binding or not.

VID List Enter the VLAN ID list used here.

Click the Apply button to accept the changes made.
Click the Edit button to re-configure the specific entry.

Click the Delete button to remove the specified entry.
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IPv6 ND Inspection

This window is used to view and configure the IPv6 ND inspection settings.

To view the following window, click Security > IMPB > IPv6 > IPv6 ND Inspection, as shown below:

‘|8 spectio

IPv6 ND Inspection

Policy Name

Device Role

Validate Source-MAC

[T[Target Port Unit I:l From Port l:l To Port :l

Total Entries: 1

Pt tome T T
Polocy Disabled [ edt J[ Delete |

Figure 9-56 IPv6 ND Inspection Window

The fields that can be configured are described below:

Parameter Description

Policy Name Enter the policy name used here. This name can be up to 32
characters long.

Select the device role here. Options to choose from are Host and
Router. By default, the device’s role is set as host and inspection
for NS and NA messages are performed. If the device role is set as
router, the NS and NA inspection is not performed. When
performing NS/NA inspection, the message will be verified against
the dynamic binding table learned from the ND protocol or from the
DHCP.

Select to enable or disable the validation of the source MAC
address option here. When the Switch receives an ND message
that contains a link-layer address, the source MAC address is
checked against the link-layer address. The packet will be dropped
if the link-layer address and the MAC addresses are different from

Device Role

Validate Source-MAC

each other.
Target Port Tick this option to specify the target port.
Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port

Select the appropriate port range used for the configuration here.

Click the Apply button to accept the changes made.
Click the Edit button to re-configure the specific entry.

Click the Delete button to remove the specified entry.
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IPv6 RA Guard

This window is used to view and configure the IPv6 Router Advertisement (RA) guard settings.

To view the following window, click Security > IMPB > IPv6 > IPv6 RA Guard, as shown below:

D A arc

IPv6 RA Guard
Device Role
Match IPv6 Access List
Please Select
[Target Port Unit 1[v] From Port  [eth1/0/1 7] ToPort  [eth1/0/1 ~] [ apply |

Total Entries: 1

Policy Name Match IPv6 Access List Target Port
Policy Host Extended-IPvG-ACL eth1/010 Edit Delete

Figure 9-57 IPv6 RA Guard Window

The fields that can be configured are described below:

Parameter Description

Policy Name Enter the policy name here. This name can be up to 32 characters
long.
Device Role Select the device role here. Options to choose from are Host and

Router. By default, the device's role is Host, which will block all the
RA packets. If the device's role is Router, RA packets will be
forwarded according to the port's bound ACL.

Match IPv6 Access List Enter or select the IPv6 access list to match here.

Target Port Tick this option to specify the target port.

Unit Select the switch unit that will be used for this configuration here.
From Port/ To Port Select the appropriate port range used for the configuration here.

Click the Apply button to accept the changes made.
Click the Edit button to re-configure the specific entry.

Click the Delete button to remove the specified entry.

IPv6é DHCP Guard

This window is used to view and configure the IPv6 DHCP guard settings.

To view the following window, click Security > IMPB > IPv6 > IPv6 DHCP Guard, as shown below:

FYO0 URLr Larc

IPvé DHCP Guard

Device Role Client  [v]
Match IPv6 Access List
Please Select
[[Target Port Unit 1[v] From Port [eth1/0/1 7] ToPort  [eth1/0/1 ~ [ apply |

Total Entries: 1

oty e T
Policy Client Extended-IPv5-ACL eth1/0/11 Edit Delete

Figure 9-58 IPvé DHCP Guard Window
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The fields that can be configured are described below:

Parameter Description

Policy Name Enter the policy name here. This name can be up to 32 characters
long.

Select the device role here. Options to choose from are Client and
Server. By default, the device's role is set as Client, which will
block all the DHCPv6 packets from the DHCPv6 Server. If the
device's role is set as Server, DHCPv6 Server packets will be
forwarded according to the port's bound ACL.

Device Role

Match IPv6 Access List Enter or select the IPv6 access list to match here.
Target Port
Unit

From Port/ To Port

Tick this option to specify the target port.

Select the switch unit that will be used for this configuration here.

Select the appropriate port range used for the configuration here.

Click the Apply button to accept the changes made.
Click the Edit button to re-configure the specific entry.

Click the Delete button to remove the specified entry.

IPv6 Source Guard

IPv6 Source Guard Settings

This window is used to view and configure the IPv6 source guard settings.

To view the following window, click Security > IMPB > IPv6 > IPv6 Source Guard > IPv6 Source
Guard Settings, as shown below:

IPv6 Source Guard Settings

Paolicy Name 32 chars

Global Auto-Configure
Address Permit El
Link Local Traffic
Total Entries: 1

Policy Name Global Auto-Configure Address Link Local Traffic Target Port
Policy Permt Deny

Figure 9-59 IPv6 Source Guard Settings Window

The fields that can be configured are described below:

Parameter Description

Policy Name

Enter the policy name here. This name can be up to 32 characters
long.

Global Auto-Configure
Address

Select to permit of deny data traffic from the auto-configured global
address. It is useful when all global addresses on a link are
assigned by DHCP and the administrator that wants to block hosts
with self-configured addresses from sending traffic.

Link Local Traffic

Select to permit of deny hardware permitted data traffic send by the
link-local address.

Target Port

Tick this option to specify the target port.

Unit

Select the switch unit that will be used for this configuration here.
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Parameter Description

From Port/ To Port Select the appropriate port range used for the configuration here.

Click the Apply button to accept the changes made.
Click the Edit button to re-configure the specific entry.

Click the Delete button to remove the specified entry.

IPv6 Neighbor Binding

This window is used to view and configure the IPv6 neighbor binding settings.

To view the following window, click Security > IMPB > IPv6 > IPv6 Source Guard > IPv6 Neighbor
Binding, as shown below:

MAC Address
VID (1-4004)

IPvG Address
Unit

From Port To Port eth1/0/1 [~]
IPv Neighbor Binding Entry

Unit

From Port

IPv Address MAC Address

Hlzl =
5[
]

VID (1-4094)

Total Entries: 1

s s e N T L

2233:1 00-84-57-00-00-00 &th1/0/10 1 Static NIA
1 [T] Go

Figure 9-60 IPv6 Neighbor Binding Window

The fields that can be configured for IPv6 Neighbor Binding Settings are described below:

Parameter Description

MAC Address Enter the MAC address used here.

VID Enter the VLAN ID used here. This value must be between 1 and
4094.

IPv6 Address Enter the IPv6 address used here.

Unit Select the switch unit that will be used for this configuration here.

From Port/ To Port Select the appropriate port range used for the configuration here.

Click the Apply button to accept the changes made.

The fields that can be configured for IPv6 Neighbor Binding Entry are described below:

Parameter Description

Unit Select the switch unit that will be used for this search here.
From Port/ To Port Select the appropriate port range used for the search here.
IPv6 Address Enter the IPv6 address to find here.

MAC Address Enter the MAC address to find here.

VID Enter the VLAN ID to find here.
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Click the Find button to locate a specific entry based on the information entered.

Click the Delete button to remove the specified entry.

DHCP Server Screening

This function allows users to not only to restrict all DHCP server packets but also to receive any
specified DHCP server packet by any specified DHCP client. It is useful when one or more DHCP
servers are present on the network and both provide DHCP services to different distinct groups of
clients.

The first time the DHCP filter is enabled it will create both an access profile entry and an access rule
per port entry, it will also create other access rules. These rules are used to block all DHCP server
packets. In addition to a permit DHCP entry it will also create one access profile and one access rule
entry the first time the DHCP client MAC address is used as the client MAC address. The Source IP
address is the same as the DHCP server’s IP address (UDP port number 67). These rules are used to
permit the DHCP server packets with specific fields, which the user has configured.

When DHCP server filter function is enabled all DHCP server packets will be filtered from a specific
port.

DHCP Server Screening Global Settings

This window is used to view and configure the DHCP server screening global settings.

To view the following window, click Security > DHCP Server Screening > DHCP Server Screening
Global Settings, as shown below:

Trap Settings

Trap State Disabled | ¥
Profile Settings

Profile Name

Cllent MAC
Total Entries: 1

Profil 00-84-57-00-00-00

Log Information

Log Buffer Entries (10-1024) [ apply [ cleariog |
Total Entries: 0

T T chnnc

Figure 9-61 DHCP Server Screening Global Settings Window

The fields that can be configured for Trap Settings are described below:

Parameter Description

Trap State Select to enable or disable the DHCP server screening trap here.

Click the Apply button to accept the changes made.

The fields that can be configured for Profile Settings are described below:

Parameter Description

Profile Name Enter the DHCP server screening profile name here. This name
can be up to 32 characters long.
Client MAC Enter the MAC address used here.
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Click the Apply button to accept the changes made.
Click the Delete button to remove the specified entry.

Click the Delete Profile button to remove the specified profile.

The fields that can be configured for Log Information are described below:

Parameter Description

Log Buffer Entries Enter the logged buffer entries value here. This value must be
between 10 and 1024. By default, this value is 32.

Click the Apply button to accept the changes made.
Click the Clear Log button to clear the log.

DHCP Server Screening Port Settings

This window is used to view and configure the DHCP server screening port settings.

To view the following wi